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Tools and Utilities

The Tools and Utilities documentation explains how Natural invokes a utility and describes the

utilities available in Natural.

Utility Activation

Describes how Natural invokes a utility.

Component Browser

This utility views ActiveX components that are available for developing
NaturalX applications.

Data Browser

This utility is used to generate, print and store data reports from Natural
DDMs (data definition modules).

¢ ¢ L ¢ ¢ e e

FTOUCH This utility makes a downloaded object executable by Natural.

INPL This utility loads or scans Natural objects and shared resources supplied
by Software AG.

Installer This utility helps install Natural add-on products.

Object Handler This utility processes Natural and non-Natural objects for distribution in
Natural environments. This is done by unloading the objects in the source
environment into work files and loading them from work files into the
target environment.

& |SYSAPI This utility locates Application Programming Interfaces (APIs) provided
by Natural add-on products.

SYSCP This utility provides code page information.

& |SYSERR This utility creates application-specific messages. In addition, it can be
used to modify the texts of the existing Natural system messages (not
recommended).

& |SYSEXT This utility locates Natural Application Programming Interfaces (APIs).

SYSEXV This utility contains examples of the new features of the current Natural

versions.
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& |SYSMAIN This utility performs object operations in Natural such as copy, move,
delete and import.

& |SYSNCP This utility defines command-driven navigation systems for Natural
applications.

& |SYSRPC This utility establishes and maintains Natural Remote Procedure Call
environments.

<9

Tamino Server Extensions| This utility extends the query and mapping Tamino Server functionality
by adding user-defined logic.

2 Tools and Utilities




2 Utility Activation

Natural invokes a Natural utility without performing a logon to the corresponding utility library
in the FNAT system file. As a result, Natural preserves the global data area (GDA) and/or applica-
tion-independent variables (AIV). The current user library and the settings are maintained. (To
reset the GDA and/or the AIVs, see the profile parameter FREEGDA in the Parameter Reference.)

To preserve the settings of your application environment, do not log on to a utility library. Instead,
invoke a utility by using the Natural system command that corresponds to the utility.

After terminating a utility, you will be returned to the library from which you invoked the utility.
However, if you explicitly log on to a utility library before invoking the utility, you will stay in
this (utility) library after utility termination.

Exception:

The SYSEXT utility and the SYSEXV application still perform an implicit logon to the corresponding
utility library since object sources can only be edited within an active library.

For information on how to control the use of Natural utilities with Natural Security, see the section
Protecting Utilities in the Natural Security documentation.







3 Component Browser

B Tree VIEW coovee e
B Data View ..o,

= |nteraction Tree View and Data View

B MenuBar........oooooeieiiiiis
= Application Development Support ...




Component Browser

The Component Browser can be used to view ActiveX components which are available for deve-
loping NaturalX applications. It presents the information in a way that is especially useful to
Natural application developers.

The Component Browser comprises the following features:

" Available ActiveX components and their dispatch and dual interfaces are listed.

® Data types are mapped to Natural data formats.

® The external components' help files are directly accessible.

® Natural programming examples are automatically generated.

® Many programming errors can be prevented.

The Component Browser uses a split window. The left pane contains a tree view that represents

the available external components, and the right pane contains the data view that provides infor-
mation on a selected node item.

Tree View

At startup the Component Browser's tree view consists of four nodes that group the available
external components:

= All ActiveX Components

This group lists ActiveX controls and Automation Objects.

= ActiveX Controls

This group lists only the ActiveX controls.

® Automation Objects

This group lists the Automation Objects.
* Interfaces

This group lists all dual and dispatch interfaces that can be addressed in a Natural application.
In this context, their relation to an ActiveX component is not taken into account.

In general, a node in the tree view represents either an ActiveX component or an interface. It
provides textual information on the node and has a specific icon assigned that represents additional
information.
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Component Browser

The following table lists all available nodes with their icons and gives a short description:

Type Icon |Description

Group 3 Group node.

ActiveX component Op ActiveX component.

Interface [_=_] Interface of the current ActiveX component.
Default interface s |Default interface of the current ActiveX component.

By default, the ActiveX component nodes are inserted in alphabetical order of their external names.
Interface nodes are always inserted in alphabetical order.

» To sort ActiveX component nodes according to their ProgID

From the View menu, choose Show by ProgID.

Data View

The data view uses a property sheet to display the specific information for a selected node. This
sheet consists of four tabbed pages:

General

Components and interface specific information such as name, globally unique identifier (GUID)
and help file name. It is always the active page if a new node is selected.

Properties

Specific information on the properties offered by an interface. These are, for example, the pro-
perty's name and type.

Events

Specific information on a component's event interface. These are, for example, the event's name
and parameters.

Methods

Specific information on the methods and complex properties (that is, properties with parameters)

offered by an interface. Displayed are, for example, the method's name, return type and para-
meters.
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These pages are discussed in more detail in the context of interaction between tree and data
view.

Interaction Tree View and Data View

The contents of the data view depend on the node selected in the tree view.

If any of the group nodes All ActiveX Components, ActiveX Controls, Automation Objects or
Interfaces is selected, the data view remains empty.

This section describes the tabbed pages that may be displayed in the data view.

= ActiveX Component
= |nterface

ActiveX Component

If a component node is selected, all four tabbed pages are available. The page General provides
the following information:

Name Component name

Description |Short textual description.
Unique ID |GUID.
ProgID ProglID.

Example |Example Natural source code. See also Application Development Support.

Help

Help file name. This file can be opened by choosing @
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mNaluml Component Browser
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Microzoft TabStrip Cantrol, version 6.0 ;I
Microzoft TabStip Cantrol, version B.0

Microzoft Toolbar Contral, version 5.0 [SP2)
Microzaft Toolbar Contral, version 5.0 [SP2)
icrozoft Toolbar Contral, verzion 6.0

Microzoft Toolbar Control, version B.0

Microzaft Treeview Contral, wersion 5.0 [SP2)
Microzoft TreeView Contral, version 5.0 [SP2)

icrozoft Web Browser

Microzoft Web Browser

Microzoft Web Browser

MIDI Sequence

taniker to a'Windows Script Component
totion Blur Effect

MoweBwr Clazs

tawie Clip

M5 Remote

M5 Remaote

MSDAINITIALIZE Class J
MSDASC Eror Lookup

M5S0 ataShape

MSD ataShape

S Parsizt

5 Persizt

b sl

tyFilter Class
| IS S Rl P I _ILI
»

All Activer

Caompaongnts

General |F'n:|perties| Evenlsl Methodsl

IMiCIDSth TrecWiew Control, version B.0

Deseription IDispIays a hierarchical list of Hode objects, each of which congistz of a lab

— |dentification
Wrique D |{C?41 90BE-8583-1101-B16A-00C0F 0283628}
ProgiD |MSCametLib. TresChl

— Example

DEFINE DATA LOCAL

EMD-DEFINE

PROCESS GUI ACTION ADD

/|ITH PARSMETERS
HANDLEARIABLE = #OC<-1

EMD-FPARAMETERS

1 #0C-1HANDLE OF <<0C<-MSCometLib. TreeCrl: »

TvPE=<<0Cx-MSComctLib. TreeChrlsx ..

R‘HE:'\WINNT'\S_I,Islem32\cmctl1 38 chm

[

If a component is selected and the page Properties, Events or Methods is activated, the information
displayed on this page refers to the default interface.

Interface

If an interface node is selected, the number of available tabbed pages depends on the type of the
interface.

® If an interface is browsed in the context of a component and if it is an event interface, then only
the pages General and Events are set.

" Otherwise, the pages General, Properties and Methods are set.

Each page is described in the following section.

= General
= Properties
= Methods
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= Events

General

The page General provides the following information:

Name Interface name
Description|Short textual description.
Unique ID |GUID.

Help

Help file name. This file can be opened by choosing @

@Natural Component Browser

File Edit Miew

Help

=] B3

B BZ b2 B bS b bE bS

bg

BE BE BE B BS BT 1F BS bS BE b BS BT 13 BS bE bD
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a
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1]

Microzoft TabStip Caontrol, version B.0 ;I
Microzoft TabStrip Control, version B.0

Microzoft Toaolbar Caontral, version 5.0 [SP2]
Microzoft Taaolbar Contral, version 5.0 [SP2) IITree\-"iewEvents
Microzoft Toolbar Contral, version 6.0
icrozoft Toolbar Contral, verzion 6.0 Description |Evenl interface for Tree Control
Microzoft TreeView Contral, version 5.0 [SP2)
Microzoft Treetiew Control, verzsion 5.0 [SP2)
Microzaft Treetiew Caontral, werzsion 6.0
ITreetfiew Urique 10 |{E?41 90B5-8589-1101-B164-00C0F 0283628}

Microzaft Treeview Contral, wersion 6.0
icrozoft Web Browser

icrozoft Web Browser

Microzaft Web Browser

MIDI Sequence

taniker to a'Windows Script Component
tation Blur Effect

MoweBwr Clazs

tawie Clip

M5 Remote

M5 Remaote J
MSDAINITIALIZE Class

MSDASC Eror Lookup

M5S0 ataShape
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M5 Persist ME:\WINNT\SystemSZ\cmctH 98.chm

S Persizt =
) I _'I_I

kA el

General | Ewails |

|dentification

Microzoft TreeView Control, version B.0

[
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Properties

The page Properties provides the list of properties that belong to the selected interface. For a
specific property, the following information is displayed:

Description Short textual description for the selected property.

Type Definition | List of valid Natural data formats for the property's type. Additional type info on the
selected Natural data format, e.g. valid values for enumeration types.

Example Example Natural source code. See also Application Development Support.
Help

Help file name. This file can be opened by choosing @

[& Matural Component Browser =] 3
Fil= Edit “iew Help

128 Microsoft TabStrip Cantral, wersion 5.0 ;I
. Microzoft TabStrip Cantrol, version 6.0
Microzoft Toolbar Contral, vergion 5.0 [SP2) =
Microzaft Toolbar Contral, verzion 5.0 [SP2) s
icrozoft Toolbar Contral, verzion 6.0 IHeturnsHsets a walue that determings if a uzer can edit the label of & Listiter or Mode
icrozoft Toolbar Contral, verzion B.0 Type Defirition
icrozaft Treeview Contral, wersion 5.0 (SP2) —
icrozoft Treetiew Contral, wersion 5.0 [SP2) |[|2] j Enumeratl;ﬁmmatic
Microzoft TreeView Contral, version 6.0 1 b aral
[ TreeYiew
= | TreetiewE vents
Microzoft Treetiew Contral, wersion 6.0
icrozoft Web Browser
icrozaft Web Browser
icrozoft Web Browser
MIDI Sequence
Moniker to aWindows Script Component
tation Blur Effect
MaoweBvr Class E xamnple
Movie Clip e ariable := HOCH-1.<<PROPERTY-LabelE dits >
M5 Remaote J
M5 Remote
MSDAINITIALIZE Class
MSDASC Eror Lookup
M5S0 ataShape
M5S0 ataShape

M3 Persist [ CAWINNT S pstem32emeti 38.chm

28 MSPersizt
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« | _>I_I

Microzaft TreeView Contral, version 5.0 &

General Properties | Methodsl

BOCA-1.<<PROPERTY-LabelEdit>> := #a\ariable
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o
o
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Methods

The page Methods provides the list of methods that belong to the selected interface. This list
includes properties with parameters. For a specific method or complex property, the following
information is displayed:

Description

Short textual description for the selected method.

Return Type Definition

List of valid Natural data formats for the method's type.

Additional type information on a selected Natural data format, e.g. Name and
GUID of the interface if a handle of object corresponds to a dispatch interface. This
interface can then be found in group Interfaces.

Parameter Definition

List of parameters that are required by the method.

List of Natural data formats for each parameter together with additional info on
the call mode (by ref). Additional type info on a selected Natural data format, e.g.
Name and GUID of the interface if a handle of object corresponds to a dispatch
interface. This interface can then be found in group Interfaces.

Example

Example Natural source code. See also Application Development Support.

Help

Help file name. This file can be opened by choosing @

@Natural Component Browser
File Edit “iew Help

=] E3
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wnn | Treeiiew

o | TreeiewE vents

icrazaft Web Browser
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Microzoft TabStip Cantrol, version B.0 ;I
Microzoft TabStrip Control, version B.0

Microzaft Toolbar Contral, version 5.0 [SP2)
Microzoft Toolbar Contral, version 5.0 [SP2)
Microzoft Toolbar Contral, version 6.0 IHeturns a reference to the Ligtltem object or Mode object located at the coordinates of
Microzaft Toolbar Contral, version 6.0
Microzoft TreeView Contral, version 5.0 [SP2)
Microzoft TreeView Contral, version 5.0 [SP2)
Microzaft Treeview Contral, wersion 6.0

Microzoft Treeview Control, version 6.0 ~ Parameter Definition

taniker to a'Windows Script Camponent

Genelall Properties  Methods |

— Return Type Definition

Ihandle of objsct [by ref] j Digpatch Interface INode
{C¥4190B8-8583-1101-B16A-O0COF0283628)

[ =
[iF4) 4

— Example

PROCESS GUI ACTION <<METHOD-HitT est:>
J WITH #OCx-1 %y
USIMNG #a ariable

ME:\WINNT\System32\cmctl1 38 chm

-l

Microzoft Treetiew Control, version B.

0 [
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Events

The page Events provides the list of events that belong to the selected event interface. For a specific
event, the following information is displayed:

Description Short textual description for the selected event.

Parameter Definition |List of parameters that are required by the event.

List of valid data Natural data formats for each parameter together with additional
info on the call mode (by ref). Additional type info on selected Natural data format,
e.g. Name and GUID of the interface if a handle of object corresponds to a dispatch
interface. This interface can then be found in group Interfaces.

Example Example Natural source code. See also Application Development Support.
Help

Help file name. This file can be opened by choosing m

m MNatural Component Browser =l
File Edit “iew Help

; Microzoft TabStrip Cantrol, version 6.0 ;I
Microzoft TabStip Cantrol, version B.0

Microzoft Toolbar Contral, version 5.0 [SP2)
Microzoft Toolbar Contral, verzion 5.0 [SP2)
Microzoft Toolbar Contral, version 6.0 IDccurs when a Mode object in a TreeYiew control is expanded:; that is, when its child
Microzoft Toolbar Control, version B.0
Microzaft Treeview Contral, wersion 5.0 [SP2)
Microzoft TreeView Contral, version 5.0 [SP2)
icrozoft Treetiew Control, wersion 6.0

= I Treetiew

General Events |

b5 bZ b bZ BE bG b bG BE

o | TreetiewE vents
Microsaft Treeview Contral, wersion 5.0 ~ Parameter Definition
Microsoft Wweb Browser INode j
icrazaft Web Browser
Microzoft Web Browser Ihandle aof object [y ref] j Dizpatch Interface Mode

MIDI Sequence {C74130B9-8585-1101-B164-O0COF0283628}
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toveBwr Class — Example
Mavie Clip & Querying parameters by name:
M5 Remote J H=vaniable = BOCk-1 <<PARAMETER-Mode:>»
M5 Femote #* Huerving parameters by position;
MEDAIMITIALIZE Class Haariable := #0C<-1.<<PARAMETER-15>
MSDASC Error Lookup
M5S0 ataShape
M5S0 ataShape
MSPersist MC:\WINNT\System32\cmctl1 38.chm
28 MSPersizt
LY [ | T
1| | »
Microsoft TreeView Control, version B.0 v
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Menu Bar

The following menus are available in the Component Browser window:

Menu |ltem Description
File |EXIT Leaves the Component Browser.
Edit |Copy This item is enabled if the data view has the focus.
Copies the selected text to the clipboard.
Copy CLSID to Clipboard | This item is enabled if either the tree view or the data view has the focus.

Copies a component's CLSID to the clipboard.

Copy ProglID to Clipboard

This item is enabled if either the tree view or the data view has the focus.
Copies a component's ProglID to the clipboard.

Find Unique ID This item is enabled if the tree view has the focus.
Searches for a Unique ID in the selected group of components.
View |Show by ProgID This item is enabled if the tree view has the focus.

By default, the tree view is sorted according to the component's external
names. If this option is checked, it is sorted according to the component's
ProglIDs. The currently displayed information is updated.

Show Current Version

This item is enabled if the tree view has the focus.

By default, the tree view shows all versions of a component.

If this option is checked, only the current version of a component is shown.
The currently displayed information is updated.

Status Bar

Shows or hides the status bar.

Refresh

This item is enabled if the tree view has the focus.
Refreshes the tree view, that is, the information currently displayed is
updated.

Help

About Component
Browser

This item is enabled if either the tree view or the data view has the focus.
Displays general information on the Component Browser such as
Copyright and Version.

Application Development Support

The Example boxes in the pages of the data view provide detailed examples of Natural source
code. These examples show how to use a selected object in a Natural application. Which statements
are generated depends on the object's type.

The example source code or just parts of it can be selected, copied to the clipboard and used
directly in an application. Only variable names might have to be adapted to meet the application's
requirements.

14
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» To copy frequently used identifiers to the clipboard

s From the Edit menu, choose Copy CLSID to Clipboard.
Or:
From the Edit menu, choose Copy ProgID to Clipboard.
This section covers the following topics:

= ActiveX Controls
= Automation Objects
= |nterfaces

ActiveX Controls

For ActiveX controls, the appropriate PROCESS GUI statement is generated that shows how to use
these components in Natural applications.

This section describes example source code shown on the pages provided for items contained in
the ActiveX Controls node.

= General
= Properties
= Events

= Methods

General

The example on the page General shows how an object of this type is instantiated. Here #0CX-1
denotes a variable that can be adapted to the current application.
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mNaluml Component Browser
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Microzoft Toolbar Control, version B.0
Microzaft Treeview Contral, wersion 5.0 [SP2)
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All Activex Components

General |F'n:|perties| Evenlsl Methodsl

Deseription IDispIays a hierarchical list of Hode objects, each of which congistz of a lab

r Identification
Urique D |{C74190B6-8583-1101-B16A-D0COF 0263626}
ProgiD |MSCametLib. TresChl

— Example

DEFINE DATA LOCAL

EMD-DEFINE

PROCESS GUI ACTION ADD

/|ITH PARSMETERS
HANDLEARIABLE = #OC<-1

EMD-FPARAMETERS

1 #0C-1HANDLE OF <<0C<-MSCometLib. TreeCrl: »

TvPE=<<0Cx-MSComctLib. TreeChrlsx ..

R‘HE:'\WINNT'\S_I,Islem32\cmctl1 38 chm

[

Properties

The example on the page Properties shows how to assign a property to a variable and how to
assign a variable to a property. Here #0CX-1 is the defined object handle and #aVariable refers

to an application-specific variable. Both names can be adapted if required.
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Microzoft TabStrip Cantrol, version 6.0 ;I
Microzoft TabStip Cantrol, version B.0
Microzoft Toolbar Contral, version 5.0 [SP2)
Microzaft Toolbar Contral, version 5.0 [SP2)
icrozoft Toolbar Contral, verzion 6.0
Microzoft Toolbar Control, version B.0
Microzaft Treeview Contral, wersion 5.0 [SP2)
Microzoft TreeView Contral, version 5.0 [SP2)
icrozoft Treetiew Control, wersion 6.0
Microzaft Treeview Contral, wersion 6.0
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All Activex Components

General Properties | Evenlsl Methodsl

IHeturnsHsets the style of lines displayed between Mode ohjects.

Tvpe Definition

[12] | |Enumeration:

I J a Treelines
1 RootLines

Ezample

Haariable := #OCX-1.<<PROPERTY -LineStyles »
BOCH-1.<<PROFPERTY-LineStyles» = Havariable

R‘HE:'\WINNT'\S_I,Islem32\cmctl1 38 chm

[

Events

The example on the page Events shows how to query event parameters by name or by position.
Here #0CX- 1 is the defined object handle and #aVariab1e refers to an application-specific variable.

Both names can be adapted if required.
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m Matural Component Browszer _ (O] x|
File Edit “iew Help

Microzoft TabStrip Cantrol, version 6.0 ;I
Microzoft TabStip Cantrol, version B.0

Microzoft Toolbar Contral, version 5.0 [SP2)
Microzaft Toolbar Contral, version 5.0 [SP2)
Microzoft Toolbar Contral, version 6.0 IDccurs when a Mode object in a TreeYiew control is expanded:; that is, when its child
Microzoft Toolbar Control, version B.0
Microzaft Treeview Contral, wersion 5.0 [SP2)
Microzoft TreeView Contral, version 5.0 [SP2)
icrozoft Treetiew Control, wersion 6.0
Microzaft Treeview Contral, wersion 6.0
icrozoft Web Browser

Microzaft web Browser — Barameter Definition
Microsoft Wweb Browser INode ﬂ
MIDI Sequence
taniker to a'Windows Script Component Ihandle of abject [by ref] j Dizpatch Interface Mode

W ation Blur E frect {C74190B9-8589-1101-B1E4-00COF 0283628}
MoweBwr Clazs
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M5 Remote — Example

u}
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Generall Properties  Ewents |Methnds|

wpand

M3 Remate  [uerying parameters by name:
MSDAINITIALIZE Class J Haariable ;= HOCA-1.<<PARAMETER-Mode>>
MSDASC Eror Lookup B Que_,r_l,ung pararmeters by position:
M5DataShape Haariable := #0C<-1.<<PARAMETER-15>
MSD ataShape
S Parsizt

M SPersist

b sl ﬂt:\WINNT\System32\cmctl1 38.chm
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Methods

The example on the page Methods shows how to use methods and properties with parameters.
Here #0CX- 1 is the defined object handle and #aVariab1e refers to an application-specific variable.
Both names can be adapted if required. The actual parameter names are already inserted into the
statement if they are available. Otherwise, default parameter names such as P0 and P1 are used
as placeholders. These names can be replaced by application-specific variables.
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m MNatural Component Browser =l
File Edit “iew Help
---&' Microzoft TabStrip Cantrol, version 6.0 ;I

u}

Generall F'n:upertiesl Events Methads |

8 Microzoft TabStip Contral, version 6.0

O Microzoft Toolbar Control, version 5.0 [SF2) =
® Microzoft Toolbar Contral, version 5.0 [SF2) ey

® Microzoft Toolbar Contral, version 6.0 IHeturnsHsets a walue that determines if a uzer can edit the label of & Listitem or Mode

Microzoft Toolbar Control, version B.0
Microzaft Treeview Contral, wersion 5.0 [SP2) —
Microzoft TreeView Contral, version 5.0 [SP2) |[|2] j Enumeratl;ﬁmmatic
Microzoft TreeWiew Contral, version B.0 1 b anwal
Microzaft Treeview Contral, wersion 6.0
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Microzoft Web Browser
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M3 Remate PROCESS GUIACTION <<GET-PROPERT'Y-LahelE dit»
MSDAINITIALIZE Class J /I TH HOCx-1

MSDASE Enor Laokup USING #a\ ariable

M5S0 ataShape
MSD ataShape
® bSPersist

M SPersist

Mzl R‘HE:'\WINNT'\S_I,Islem32\cmctl1 33 chm

Return Type Definition
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Automation Objects

This section describes example source code shown on the pages provided for items contained in
the Automation Objects node.

= General
= Properties
= Methods

General

The example on the page General shows how an object of this type is instantiated. Here ffaObject
denotes a variable that can be adapted to the current application.
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mNaluml Component Browser
File Edit “iew Help

=] E3

]
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gotobar Class
Gradient

Gradient

Grapzcale Effect
Handler Clazs

Handler Class

HHCtl Object

HHCtl Object
HiFiTimer Uszes
HomePage Class
HTHL Thumbnail Extractor
HtmiDlgH elper Class
lIrngCtx

Image Document
InztallE nairelCtl Object
InztallE nginelCtl Object

Internet Explarer [Wer 1.0)
Internet Shorteut

Irevert Effect

Java Clazs: com.me.whc. btml. Dhkdaduls
java:

JetEngine Class

JPEG Image

JFPEG Image

JScript Language

JScript Language

JScript Language
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‘I 0 IZ ik | it mmm, I

Automation Objects

i

General |F'n:|perties| Evenlsl Methodsl

IIntemet E xplarer

Deseription IIntemet Ewplorer Application.

— |dentification
Urigque ID I{DEIEI2DFD'I -0000-0000-CO00-000000000046}
FraglD IIntemetEleorer.AppIicatinn
— Example
DEFINE DATA LOCAL
1 #albject HAMDLE OF OBJECT
EMD-DEFINE

CREATE OBJECT #aObject OF CLASS “InternetE splorer Application'
CREATE OBJECT #aObject OF CLASS "00020F01-0000-0000-CO00-000000000046"

[

Properties

The example on the page Properties shows how to assign a property to a variable and how to
assign a variable to a property. Here #aObject is the defined objecthandle and #aVariable refers
to an application-specific variable. Both names can be adapted if required.
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m MNatural Component Browser =l
File Edit “iew Help

---&' gotobar Class ;I
Gradient

Gradient

Grapzcale Effect

Handler Class IGets the short [Ul-friendly] name of the URL/file currently viewed.

Handler Class I,
Tvpe Definition
HHCtl Object

HHCHl Object lie [
HiFiTimer Uszes

HomePage Class

HTHL Thumbnail Extractor

HtmiDlgH elper Class

lIrngCtx

28 Image Document

B |nztallE ngineCH Object

InstalE ngineCH Object _
Internet Explorer

Internet Explarer [Wer 1.0)

Intermet Shartcut Ezample
£ Invert Effect CREATE DBJECT Halbjsct OF CLASS “IntemetE xplorer. &pplication™
Java Clazs: com.me.whc. btml. Dhkdaduls
java Haariable ;= #a0bjzct LocationM ame

Haariable ;= #a0bjzct, < <" ebBrowser2 LocationM ames »
Halbject LocationM ame ;= #aVariable

u}

General Properties | Evenlsl Methodsl

| ocationtame

Bg BE bG bG bS BE b bG bE bE bG bS

o0

3 bS bE b bg

u}
=]

b5 BE BE Y

JetEngine Class
-28 JPEG Image

® IPEG Image
JScript Language
JScript Language

=38 JSeript Language
o OB 1 cieb | e o hal
4| | »

Autarnation Ohjects A

o0

b2 B BT b2

u}

Methods

The example on the page Methods shows how to use methods. Here #a0bject is the defined object
handle and #aVariable refers to an application-specific variable. Both names can be adapted if
required.

The actual parameter names are already inserted into the statement if they are available. Otherwise,
default parameter names such as P0 and P1 are used as placeholders. These names can be replaced
by application-specific variables.
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mNaluml Component Browser
File Edit

Wiew Help

=] E3

il:

u}
7]

5 b5 bg b5 bg g g g b5 b5 ba b5 b I bS BS b b b b b b bg bg bE bE bg bg I

gotobar Class

Gradient

Gradient

Grapzcale Effect

Handler Clazs

Handler Class

HHCtl Object

HHCtl Object

HiFiTimer Uszes
HomePage Class

HTHL Thumbnail Extractor
HtmiDlgH elper Class
lIrngCtx

Image Document

InztallE nairelCtl Object
InztallE nginelCtl Object
Internet Explorer

Internet Explarer [Wer 1.0)
Internet Shorteut

Irevert Effect

Java Clazs: com.me.whc. btml. Dhkdaduls
java:

JetEngine Class
JPEG Image
JFPEG Image
JScript Language
JScript Language
JScript Language

IZ ik | it mmm,

il

Generall F'n:upertiesl Events Methads |

INavigates to a URL or file.

— Parameter Definition

|uRL
i)

— Example
CREATE OBJECT #aObject OF CLASS “InternetE splorer Application'

SEMND "Mavigate” TO Halbject
WwITH URL Flags TargetFrameM arme PostD ata Headers

SEND "WebBrowser2 Mavigate" TO #albject
WITH URL Flags T argetFrameM ame PoztD ata Headers

[

Automation Obiects

Interfaces

For interfaces that belong to group Interfaces and that are not considered in the context of a class,
the examples are generated as for Automation Objects. Only the CREATE 0BJECT statement is left
aside.

This section describes example source code shown on the pages provided for items contained in
the Interfaces node.

= Properties
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= Methods

Properties

The example on the page Properties shows how to assign a property to a variable and how to
assign a variable to a property. Here #faObject is the defined object handle and #aVariab1e refers

to an application-specific variable. Both names can be adapted if required.

@Natural Component Browser
File Edit

Wiew Help

=] E3

1

g O o g Y e O o O |
i 2R X T £ K

508 b3 bG b b bg DS

Bg DG BS BE BE bE bE b bg bS bE bS BE BE BE D,

DE...............

gotobar Class ;I
Gradient

Gradient

Grayscale Effect

Handler Clazs

Handler Class

HHCtl Object

HHCtl Object

HiFiTirmer Uses

HomePage Class

HTHL Thumbnail Extractor

HtmiDlgH elper Class

lIrngChs

Image Document

InztallE nginelCtl Object

InstallEnginelCtl Object J
Internet Explarer

{5 DwebBrowserE vents

== DwebBrowserE vents2

= |webBrowser2

{5 Mw/ebBrowsertpp

Intermet Explarer [Wer 1.0)

Internet Shorteut

Irvvert Effect

Java Clazs: comome wic. html Dhkdodule

[ELEN
-
| 3

JetEngine Class
JFPEG Image

IDC 2 lra—me

Internet Explarer

General Properties | Methodsl

lionLIBL

IGets the full URL/path currently viewed.

Type Definition

f14) 4

Example

CREATE OBJECT #aObject OF CLASS "InternetE splorer Application!

Haariable := #albject Locationl /AL

Haariable := #albject. < <'ebBrowser2 LocationRL>»

#albject. LocationEL := #aV ariable

[

Methods

The example on the page Methods shows how to use methods. Here #a0bject is the defined object
handle and #aVariable refers to an application-specific variable. Both names can be adapted if
required.
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The actual parameter names are already inserted into the statement if they are available. Otherwise,
default parameter names such as P0 and P1 are used as placeholders. These names can be replaced
by application-specific variables.

@Natural Component Browser

=] B3

File Edit “iew Help

¥ gotobar Class

Gradient

Gradient

Grapzcale Effect

Handler Class

Handler Clazz

HHCtl Object

HHCtl Object

HiFiTirmer Uzes
HomePage Class

HTHL Thumbnail Estractor
HtmiDIgH elper Class
lIrnaCts

Image Document
InstallEnginelCtl Object
InztallE naginelCtl Object
Intermet Explarer

~feta) D'WebBrowserE vents
== [webBrowszerEvents2
2a IWebBrowser?

~{ea) Iw/ebBrowsertpp
Internet Explorer (Wer 1.0)
Internet Shorteut

Irvvert Effect

Java Clazs: com.me.wic.html.DhiModule
[ERES

JetEngine Class

JFPEG Image

1002 lem—me

1 |

Internet Explarer

-b§ bE bg bg bE DE b5 bg bE g b5 bg g g 15 b b

D O g O e O e O g O g B e B e |
i E R B R X ET i SR R
O [0 [0 [0 [0 [0 [0 [0
l[>.[>.[>.[>.[>.[>.[>.

i

Generall Propeties Methods |

INavigates to a URL or file.

r Parameter Defirition
{uRL -
[1a) =]

— Example
CREATE OBJECT #aObject OF CLASS "InternetE xplorer. Application”!

SEND "Mavigate' TO #albject
WITH URL Flags T argetFrameM ame FostD ata Headers

SEMD ""webBrowser2 Mavigate' TO #albject
WITH URL Flags T argetFrameM ame PostD ata Headers

I
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The data browser is used to generate data reports from Natural DDMs (data definition module)
created from an Adabas, XML or SQL database available in your current Natural environment.
You can select the DDM fields to be included in the report and specify filter criteria.

The data reports generated can be displayed in either the Results window of Natural Studio or
in a text file downloaded to the PC. From the Results window, you can select records for printing
or for saving as text files. You can generate one or more reports, where each report comprises a
separate tabbed page of the Results window.

Navigation

Help |Activates the Natural Help system and leads to this chapter.

Cancel |Closes the dialog box without making any changes.

Back |Displays the previous page in the data browser.

Next |Displays the next page in the data browser.

Finish |Ends the report definition, generates the database request and displays the report layout in the
Results window.

File Selection List

The file selection list displays all cataloged DDMs created from an Adabas file, an SQL table or
an XML doctype which are available in the current Natural environment:
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Dal:a Browser - Page 1 of 6 EEd |

Thiz wizard creates a report from the data of the selected file.

4 software~

Fleaze fill in the information requested and press Medt to
continue ar press Finigh, |F you press Finish after zelecting
only one file, an 'easy’ report iz created using the first 5 felds
and 100 recaords of paur file.

Natural

Select a file for pour report [mandatony]: Filtered list!

DATA BROWSER

EMFLOYEES-TAMINO

FINANCE

34G-TOURS

ALG-TOURS-E-CH-FRICES

AbLG-TOURS-E-COMPANY

AaG-TOURS-E-CONTRACT

34G-TOURS-E-CRUISE ll

Help | Cancel Back Mext Finizh |

In a local Windows environment or in a remote Windows, UNIX or OpenVMS environment, the
DDMs are contained in the current Natural library and concatenated steplibs (if defined) in the
current FNAT or FUSER system file.

If the FDDM option is set in a local Windows environment or in a remote Windows, UNIX or
OpenVMS environment, the DDMs are contained in the FDDM system file.

In a remote mainframe environment, the DDMs are contained in the current FDIC system file.
This section provides information on the following:

= Natural Studio Filter
= Context Menu
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= DDM Selection

Natural Studio Filter

A filter that has been defined and activated with the corresponding Natural Studio function (see
also Filtering Libraries and Objects in the Natural Studio documentation), by default, also applies to
the data browser. Therefore, if a filter is used for the current library, concatenated steplibs or the
system file, the selection list contains a reduced number of DDMs.

Exceptions
The data browser ignores a filter that contains any of the following definitions:

® In a remote Windows, mainframe, UNIX or OpenVMS environment, a filter that contains a
name range ( - ).

® In a local Windows environment, a filter that contains a name range ( - ) combined with a
wildcard (* or ?).

An active filter is indicated by the message Filtered 1ist!, which appears above the selection
list as shown in the example screen above. The data browser ignores an active filter if you select
Show Unfiltered List from the context menu. If selected, the message Unfiltered 1ist! appears
above the selection list and the selection list contains all DDMs available in the current Natural
environment.

Context Menu

The context menu for the file selection list on Page 1 provides the following functions:

Show Unfiltered List Deactivates or activates the Natural Studio filter as described
above.
List DDMs with Database Types Indicates the type of database (Adabas, XML or SQL) from which

the DDMs were created.

List DDMs with Database IDs and File |Indicates the database IDs (DBID) and file numbers (FNR) where
Numbers the DDMs are stored.
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DDM Selection

The selection of a DDM is mandatory. After selecting a DDM from the selection list, a check is
performed whether the appropriate database is available.

If this is not the case, the DDM check will report the reason for the error, usually a database
response code. Based on this information, the user can take measures to correct the error and

restart the database.

After DDM selection, you can choose Next to go to the next data browser page where you can
specify field selection criteria, or you can choose Finish to immediately generate the data report.
If you choose Finish, the data browser creates an ,,easy” report that outputs the first 100 records
of the selected DDM with the first 5 fields of the record. As soon as you specify any field selection
or filter criteria on one of the following pages of the data browser, the ,,easy” report is replaced

by an individual report.

Field Selection

All fields of the selected DDM are displayed in a tree view similar to the example shown below:

Dal:a Browser - Page Z of 6 EEd |

4 software~

DATA BROWSER

Mark: the figldz pou want to display in the report:

=l

IBL [File EMPLOYEES ]

----- [¥] PERSONNEL-ID

=& FULL-HAME [Group]

------ [] FIRST-NAME

[ MIDDLE-I

:||:| FULL-ADDEESS [Group]

-] TELEFHONE [Group]

Help |

Cancel | Back Mext

Eirish |

Tools and Utilities
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Groups are collapsed and can be expanded by clicking on them. Every item in the tree view has
a check box. The fields that are selected here are taken over into the list of output fields. If groups
are selected, all individual fields and subgroups that belong to them are automatically selected
too. If in a group, because of manual intervention, not all fields are selected, the check box with
the check mark is grayed out for the corresponding group name (in the example above, FULL-NAME).
A cleared check box causes the field or fields of a group to be removed from the output list.

This section provides information on the following:

= Context Menu

Context Menu

The context menu of the tree view on Page 2 provides the following functions:

Expand All  |Expands all group fields of the DDM.
Collapse All |Collapses all group fields of the DDM.
Select All Selects all fields of the DDM.

Deselect All |Deselects all fields of the DDM.

Properties  |Opens a pop-up window containing properties of the selected field.

(For more information, refer to Field Properties).

Or, if the DDM name is selected, the file properties show the DBID (database ID), the file
number and the database type (Adabas, SQL or XML).

Output Report Fields

All individual fields that were selected in the tree view are listed on Page 3 as shown in the follo-
wing example:
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Dal:a Browser - Page 3 of 6 EEd |

Dretermine the dizplay sequence by wusing Up, Down or
 softwsare - Femove to repogition fields or remoyve them.
NAME Bemowve |
PERZONNEL-ID
EIRTH
Natural
Up
DATA BROWSER
Dawn
Drefault
Cancel Back Mext Finizh

For a field that has been defined as an array, the list indicates the dimension(s) of this array.

The sequence in which the fields appear in the list corresponds to the sequence in the report (from
left to right).

The buttons Up und Down are provided for modifying the output sequence. They move the cor-
responding selected field one position up or down.

Using Remove, the selected field can be deleted from the report list.
With the Default button, the output sequence corresponding to the DDM structure is recreated.

If no fields were selected in the tree view, this page is skipped and per default the first 5 fields of
the DDM are used for the report output.

This section provides information on the following:
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= Context Menu

Context Menu

The context menu of the output sequence on Page 3 provides the following functions:

Position Top Positions the selected field at the top of the field list.

Position Bottom |Positions the selected field at the bottom of the field list.

Properties Opens a pop-up window containing properties of the selected field.
(For more information, refer to Field Properties).

Filter Criteria

Page 4 of the data browser provides the option to specify filter criteria similar to the example

shown below:

Dal:a Browser - Page 4 of 6 K Ed

'ou zan limit the number of data records by specifving filker

4 software~ critenia.

Select a filker criterion:

NAME

Natural
Enter a gtart value in format 820 ;

[

I3

GATA. EROWSEE Enter an end value in format A20 ;

3

Filter by rumber of records: MO [Dis Mo Limit)

Help | Cancel Back Mext

Finizh
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A report can be generated unfiltered in that the records are read as they stand physically in the
file (physical read). This is the default.

The range of values of the descriptor field can be defined by a start value and, additionally, by an
end value. An end value can be applied only if a start value exists and the start value must be less
than the end value. The appropriate value format is shown on the label of the start/end value box.

For a date field, you can enter a start/end date in the Natural format D (see the Programming Guide)
according to the example date indicated on the box label where YYYY represents the year, MM the
month and DD the day. Note that the format in which the date has to be entered also depends on
the setting of the profile parameter DTFORM (see the Parameter Reference documentation).

For a time field, you can enter a start/end time in the Natural format T or in the extended format
T according to the example date/time indicated on the box label where HH:I1:SS represents the
time (HH =hour, 11 =minutes, SS=seconds), YYYY the year, MM the month and DD the day. Note that
the format in which the date has to be entered also depends on the setting of the profile parameter
DTFORM (see the Parameter Reference documentation). In addition, consider the format used when
storing the fields in your database system.

All filter criteria can be further limited by entering an absolute record limit (the default setting is
100 records). Independent of any filter criteria, only the corresponding number of records is
written in the result list (report). By entering 0 (zero), the record limit is switched off.

@ Caution: A large number of records can result in a long response time for data retrieval

from the database. Therefore, if you switch the record limit off (value set to 0) or if you
specify a value greater than 1000, a message will warn you of a possible delay in generating
the result list.

This section provides information on the following:

= Context Menu

Context Menu

The context menu of the filter criteria on Page 4 provides the following function:

Properties |Opens a pop-up window containing properties of the selected field.
(For more information, refer to Field Properties).
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Report Options

The report options of the data browser are provided on Page 5:

Dal:a Browser - Page 5 of 6

§ software~

DATA BEROWSER

HE|
Select the repart generation options:

W Court the number of records before report generation
¥ Only if filker limit greater than 1000 ar Mo Limit

Select the report output ophions:
[ Use field edit masks if defined
[ Show field column header if defined

Select the report destination optians:

& wiite report to Besults window

7 wiite report to file with value separatar: I_

[ Bestart with current definitions after report generation

Help |

Caticel Back

Eirizh |

Count the number of records before
report generation

Displays the number of records that meet the selection and filter
criteria specified on the previous pages of the data browser. The
number is displayed before the report is generated.

This option is selected by default.

Only if filter limit greater than 1000
or 'No Limit'

Displays the number of records only if a number greater than 1000 is
entered as filter limit or if no filter limit is set on Page 4 (see Filter
Criteria).

This option is selected by default.

Use field edit masks if defined

If defined for the selected fields, uses edit masks for displaying the
field values.

Show field column headers if
defined

If defined for the selected fields, displays the column headers instead
of the field names.
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Write report to Results window

Displays the report generated in the Results window.

This option is selected by default.

Write report to file with value
separator

Writes the report generated to a text file, which can be used for

spreadsheet manipulation.

This file contains character-separated values that delimiter rows and
columns. You can change the value separator for columns by replacing
the default value separator semicolon (;) with another special character.

A blank character is not allowed.

Restart with current definitions
after report generation

Restarts the data browser on Page 2, with the definitions used for the

previous report generation.

Summary

When you have finished specifying report generation options, all report definitions are summarized
on the last page of the data browser:

Dal:a Browser - Page 6 of 6

4 software~

tau have finished the definition af wour repaort,
Prezs the Finizh button o start with the generation.

Beport Short Description:

1]

ITEMF'LEI'T'EES by NAME from P to R |

Natural -
Surnmary of the gefmltlnn:
Selected File -
EMPLOYEES
DATA BROWSER Report Fields
MNakE
FERSOMMEL-ID
BIRTH
Filker Selection
MaME -
4 | b
Help | Cancel | Back Hewt | Finizh
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In the Report Short Description text box, you can replace the default description (Report of
ddm-name) by your own text of up to 253 characters as shown in the example above. The first 30
characters of this description are then shown as a tab in the Results window. The full text is dis-
played on the tabbed page Description of the report properties (see also Properties of Report).
The full text is also contained in the header section of a printout (see also Print).

| Note: When you choose Finish, a warning appears if more than 200 columns are to be

created for the report, which can cause significant performance problems. A large number
of columns can result from a large number of fields or a wide range of array occurrences
specified for the report.

Field Properties

You can use the context menu to view the properties of each field that is listed on a page (Pages
2 to 4) or in the Results window.

The property sheet of each field always contains the tabbed pages General and Details. An addi-
tional page is provided for the following fields:

* For fields with header or edit-mask entries, an Extended page with layout information.

* For fields with array definitions, an Array Range page with the option to specify a range of
occurrences.

The tabbed page General shows the following:
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EPruperties of field LANG K Ed |

EEHETE" D etailz | Extended I Aray Range I
M arne: LAMI
Format: i, Alphanumernc
Length: 3
Type: b Multiple-value field
Lewel 1
Degzcrptor: D Drezcrptar
Rernark:
File: Marne: EMPLOYEES
File Type: ADABRAS
OF. Cancel
Name Name as of the DDM.
Format Format as of the DDM.
Length Length as of the DDM.
Type Field type: group, periodic group, multiple-value field or elementary field.
Level Level as of the DDM.
Descriptor | Descriptor type:
blank No descriptor.
D Descriptor
S Subdescriptor or superdescriptor
(not applicable to an XML database)
H Hyperdescriptor
(not applicable to an XML database)
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Non-descriptor
(not applicable to an XML database)

See further information, see also Columns of Field Attributes in the DDM Editor documentation.

Remark Remark as of the DDM.

File Name |File name as of the DDM.

File Type |Database type.

The tabbed page Details shows the following;:

Pruperties of field LANG

General | Details | E:-:tenu:le::ll Aray Range

Suppression; M Mull value suppresszion

Short Hame: A7

Group Hierarchy:
Level Tepe Mame

Camment:

N IO

i

[~

ak.

Cancel
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Suppression Null value suppression, fixed storage, not null.
Short Name Adabas short name of the field.

Group Hierarchy |All groups and group levels to which a field belongs.
Comment Comment as of the DDM.

The (optional) tabbed page Extended shows the following;:

Pruperties of field LANG

Attnibutes:

HD=LANG/SPOKEM

OF.

Cancel

Attributes |Edit mask (EM=) or header (HD=) as of the DDM.

Tools and Utilities
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The (optional) tabbed page Array Range shows the following;:

Pruperl:ies of field LANG

Selected Hange
Dimenszion  Available Bange from to
Multiple 1:191 | 1 | 1
aFk. Cancel
Dimension

Array dimension(s) of the field:

Periodic For a periodic group or a multiple-value field from an Adabas database.
and/or
Multiple
1 For the dimension of a field from an SQL database.
1,2,3 For one, two or three dimensions of a field from an XML database.
Available Shows the range of valid values that can be entered in the from and to fields:
Range
1 - 191 A number range from 1 to 191 for a field created from an
Adabas or SQL database.
40 Tools and Utilities



Data Browser

1-n A number range from 1 to 1 for a field created from an XML
database where n denotes the maximum number of
occurrences as defined for this field in the DDM.

Selected Range

For each dimension of an array, you can specify the range of occurrences to be displayed
in the report:

In the from field, you enter the first occurrence to be displayed and in the to you can enter
the last occurrence. The value entered in from must be greater than the value entered in
to. See also Available Range below.

The default setting for both fields is 1 for the first occurrence of each dimension.

The selected range(s) of occurrences are indicated on Page 3 (see Output Report Fields)
and Page 6 (see Summary).

In the report, each occurrence is listed in a separate column, in a left-to-right order, from
the first occurrence of the first dimension to the last occurrence of the last dimension.

Vorsicht: A wide range of occurrences can result in a large number of columns, which can

cause significant performance problems.

Results Window

The result list(s) of the data browser are displayed in the Results window of Natural Studio
similar to the example shown below:

ﬂ MAME PERSOMNMEL-ID BIR.TH |
PAGELS 11500320 24,0454
PALIMG 30034651 14.035.46
PALLUDAMN 400001356 11.03.79
PAPAYANOPO,., 20006&00 15.12.71
PARGITTER. J0016512 02.11.53
PARKIM 30016424 03.10,55
PARKIMNSOMN 30021287 03.10.43
PARSOMS 0034209 14.01.54
PATALIT 20019200 27.01.48
PALIL 20017700 07.07.43
"y Find Objects | (85 Catal i EMPLOYEES by NAME from P to R |_

Tools and Utilities
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You can have as many reports as you want in parallel. With a click on the column header, the lines
are sorted by the column value ascending or descending. Modification of the column sequence is
possible by shifting the column headers. One or more lines of the result list can be selected for

further processing by using the context menu.

| Note: A field header definition that spans multiple lines in a DISPLAY statement, is displayed

in a single line, where each line break is denoted by a slash (/).

This section provides information on the following:

= Context Menu

= Properties of Report

Context Menu

The context menu of the results list provides the following functions:

Select All All lines of the result list are selected.
Expand All Columns |Expands all columns in the result list.
Collapse All Columns|Collapses all columns in the result list.
Output Print Selection Prints the selected lines of the result list. For more
information, refer to Print.
Export Selection to Writes the selected lines of the result list in a text file
Textfile (-txt). For more information, refer to Save Report Data.
Delete Tab Deletes the current tab.
Delete Tab and Hide |Deletes the current tab and closes the Results window.
Properties Additional information for the current report is displayed.
(For more information, refer to Properties of Report).

This section provides information on the following:

® Print
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= Save Report Data

Print

The Print Selection function invokes a window similar to the example below:

[f]Print - Report of EMPLOYEES B |

~Page — Layout 0. I
Width: IE characters I Brint report header
— Cancel |
Height: |EE lines " Full epart
£ Feport with zut feld names
— Marginz £ Report with cut felds
Left: 0 characters ™ Vertical [multi-ling] report
Top: 0 lines
Bottom: |0 lines
Printer Setup
|Numl:ner of records to be printed 1 ;. Report width iz 57 characters.

The Print window provides the following options:

Page Define the report width and height as matching to printer page size.

Margins |You can change the margin settings to adjust the distance between the report data and the left,
top or bottom edge of the printed page.

Layout

For some criteria you can define the printed report layout.

A report header can be specified which contains the report creation date, the selection criteria,

the number of records printed, and the full text of the report description as created by the data
browser wizard on Page 6.

A record format can be selected, as far as depending on the report size offered, to see a full report

list, report list with cut header or fields or a report list with field headers and values in vertical
sequence.

The status line informs about the selected number of records and the original width of the report
in characters. With the Printer Setup button, you can open the PC printer setup dialog to select
one of the printers available in your system.

Tools and Utilities

43



Data Browser

Save Report Data

The Export Selection to Textile function invokes a Save Report Data window similar to the
example below:

Save Report Data ﬂ E

Save I@ RES j a ? - "

by B
Drocum

Ciezktap

Y

My Documents

o

ty Compuiter

File narme: I j Save
Save as lupe: I Text filez j Cancel

The standard save dialog enables you to enter a file name completed with the file type . txt.

The text file contains the selected lines of the result list with the delimiters: the input delimiter
character as specified with the 1D session parameter (default is a comma) separates field values
and carriage return/line feed separates records.
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Properties of Report

The Properties function invokes a property sheet similar to the example below:

Pruperties of Report | x| |

General | Field F'rcupertiesl Descriptinnl

File: EMPLOYEES
DBIDAFMR Type: 0417 A ADABAS
Selection criteria;  NAME

Start walue: F
End value: R
Recard lirmit: 10

Result recaords: 10

Creation date: 261007 , 14:26:55

E rviranment; Local
Library: SAGTEST
ak.

The tabbed page General shows the following;:
File DDM name.
DID/FAR/Type |Database ID, file number and database type.
Selection criteria |Selection criteria as entered in the data browser.
Start value Start value as entered in the data browser.
End value End value as entered in the data browser.
Record limit Record limit as entered in the data browser.
Result records Number of records shown in the report.
Creation date Date and time when the report was created.
Environment Name or alias name of the environment where the data were retrieved.
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‘Library ‘The library from which the data browser was started to create the current report.

EPruperties of Report |

General | Field Properties | Descriptinnl

Name: [ MAME |

Format: i, Alphanumernc
Length: 20
Type: - Elermentan Field

Dimension:

Range:

Lewel: 2

Descrptar:

=

Drezcnptaor

OF.

The tabbed page Field Properties shows the following:

Name Enables a field name selection to see its properties.
Format Format as of the DDM.
Length Length as of the DDM.

Type Group, periodic group, multiple-value field or elementary field.

Dimension |Shows Periodic for a periodic group or Multiple for a multiple-value field (Adabas), or
one or more numbers of array dimensions (1 for SQL or 1 to 3 for XML).

Range Shows the range of array occurrences specified for a field.

Level Level as of the DDM.

Descriptor |Descriptor, subdescriptor/superdescriptor, hyperdescriptor or non-descriptor.
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Pruperties of Report | x| |

Report Short Dezcrption:

EMPLOYEES by MAME from P to B. Thiz repart containg a list of
thie Firgt then names of employees ik the range from letterz P o
R, along with their perzonnel |0z and birth dates.

Ok,

The tabbed page Description shows the full text of the report description as created by the data
browser wizard on Page 6.
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5  FroucH Utility

= Using the Utility FTOUCH .......oiii e

= Syntax of ftouch ....

= Examples of ftouch
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FTOUCH Utility

The FTOUCH utility is used to make a downloaded object executable by Natural. This is done by
importing the object into the Natural system file FNAT or FUSER and updating the FILEDIR.SAG
file.

Related Topics:

® The File FILEDIR.SAG - Operations documentation
= Using NFS to Store Natural Libraries - Operations documentation

® Transferring Natural Generated Programs - Programming Guide

Using the Utility FTOUCH

This section provides instructions for executing the FTOUCH utility.

] Note: Terms enclosed in brackets ([ ]) are optional; bold letters are actual values that must

be entered as shown.

» To execute the FTOUCH utility

1  Go to an operating system command prompt.

2 Ensure that the transferred file is in the desired FNAT or FUSER directory (as specified in
your global configuration file) and has the correct extension.

3 Enter the command ftouch using the following syntax:

ftouch [fnat=dbid, fnrl [fuser=dbid, fnrllbp=bp-name]
[parm=parm-filel [lib=I1ibrary-name]l [encoding=encoding-name]
[userep=rep-usel [-ignoreext][-v] [-q] [model [kind] files

Or:

For migration, use the following syntax:

ftouch [fnat=dbid, fnr]l [fuser=dbid, fnr]
[parm=parm-filel [1ib=1ibrary-namellencoding=encoding-namell[-q] convert

Or:
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For endian conversion of the FILEDIR.SAG file, use the following syntax:

ftouch [fnat=dbid, fnr]l [fuser=dbid, fnr]
[parm=parm-file]l [1ib=17ibrary-namellendian=endian-mode]

Or:

For encoding of single or multiple objects contained in the FILEDIR.SAG file, use the following

syntax:

ftouch [fnat=dbid, fnrl [fuser=dbid, fnr]
[parm=parm-file] [1ib=Iibrary-namellobjname=object-namellencoding=encoding-name]

Or:

For setting the line number suppression state of a library in FILEDIR.SAG, use the following

syntax:

ftouch [fnat=dbid, fnr] [fuser=dbid, fnr]
[parm=parm-file]l [1ib=17ibrary-namellsuprin=Iiibrary-state]

Syntax of ftouch

The following options are provided with the ftouch command:

Option

Explanation

fnat=dbid, fnr

Specifies the database ID and file number of the FNAT system file to be used;
default is the value specified in the NATPARM parameter file.

See also Example 2.

fuser=dbid, fnr

Specifies the database ID and file number of the FUSER system file to be used;
default is the value specified in the NATPARM parameter file.

See also Example 2.

bp=bp-name

Specifies the buffer pool to be used. You can omit the bp -name if you want
to use the Natural default buffer pool NATBP; otherwise, you have to specify
the appropriate bp -name.

Anmerkung:
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Option

Explanation

1. If the Natural default buffer pool is not active or if the specified buffer pool
does not exist, an appropriate error message is displayed.

2. Do not delete the default buffer pool NATBP, as it is possible that Natural
may no longer function properly.

parm=parm-name

Specifies the name of the parameter file to be used if you want to use a
parameter file other than the default NATPARM parameter file.

lib=Tibrary-name

Specifies the library to be used. You can omit the 77brary-name if you are
already in the appropriate subdirectory; otherwise you have to specify the
appropriate 17brary-name.

userep=rep-use

Specifies whether to use the repository or not. rep -use must be one of the
following:

ON ‘The repository is used.

OFF ‘The repository is not used.

-V

Displays statistics on disk I/Os during processing.

-q

Indicates that quiet mode is to be used: only error messages but no status
messages are displayed.

-ignoreext

Specifies that files with unkown extensions contained in a library are ignored.
The -ignoreext option can be combined with one of the following options:

-3
-d

mode

Specifies the programming mode; smspecifies that a program is in structured
mode; the default is reporting mode.

See also Example 1.

kind

Specifies the subdirectories SRC and/or GP for input; it can be one of the
following:

-s  for source objects (default),
-g  for cataloged objects/generated programs,

-b  for both source objects and cataloged objects/generated programs.

See also Example 2.

files

Specifies the files to be processed; you can specify f7/ename. ext for
individual files or:

-a  toadd new files; all files in the directory which are currently found in
FILEDIR.SAG are added (already existing files are not touched).
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Option Explanation
-d  tobuild a new FILEDIR.SAG directory.
Vorsicht: Be careful when using this option, since the old FILEDIR.SAG is
deleted and rebuilt from scratch.
See also Example 4.

-f Forces an update of the specified object's timestamp in FILEDIR.SAG. This
option can only be specified if an individual file has been specified with the
files option (see above).

convert Indicates that an old FILEDIR.SAG file is to be migrated. The FILEDIR.SAG
file from a Natural version earlier than Version 6.2 is converted into a new
portable FILEDIR.SAG file. A copy of the original (old) FILEDIR.SAG file is
saved as FILEDIR.BCK file in the directory of the specified library. If a
FILEDIR.BCK file already exists in the specified library, the old FILEDIR.SAG
will not be converted.
For further information, see Portable Natural System Files in the Operations
documentation.
See also Example 3 and Example 5.

sync Indicates that the specified library and system files are to be synchronized

between Natural and the repository (Windows only); this function must be
executed each time FILEDIR.SAG is modified by FTOUCH.

Vorsicht: When specifying sync, ensure that either userep=0N is set or the
Natural profile parameter USEREP is set to ON.

encoding=encoding-name

Specifies the code page to be used for the files contained in FILEDIR.SAG.

The encoding option generates or changes the internal code page information
maintained in FILEDIR.SAG for each object affected by the ftouch command.
This option does not convert the contents of a source object or a cataloged
object/generated program.

The encoding option can be combined with the following options:

-a
-d

convert
objname

encoding-name can be any code page name valid with the CP session
parameter specified in the NATPARM parameter file. See also CP - Default
Code Page Name in the Parameter Reference.

See also Example 4, Example 5, Example 7 and Example §.

endian=endian-mode

Specifies the endian format to be used for the FILEDIR.SAG directory.
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Option

Explanation

The endian option applies to the entire FILEDIR.SAG directory.

The option does not apply when adding files to FILEDIR.SAG or when
generating a new FILEDIR.SAG.

endian-mode can be one of the following formats:

BIG Converts to big endian.
LITTLE Converts to little endian.

DEFAULT Converts to the endian format used on your current platform.

See also Example 6.

objname=object-name

Selects the object(s) for which to maintain internal format information in
FILEDIR.SAG.

The objname option only applies if the encoding option is specified.

object -name selects all objects with names equal to the specified value. You
can use asterisk (*) notation for a name range.

See also Example 7 and Example 8.

suprin=IJlibrary-state

Specifies whether the line number suppression state is set for the specified
library. 17brary-state must be one of the following:

ON Source line numbers are not written to the files
contained in FILEDIR.SAG, when saving the
sources of the objects contained in this library.

OFF Source line numbers are written to the files
contained in FILEDIR.SAG.

Examples of ftouch

The following section provides examples of the ftouch command.
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Example 1:

Change to the following directory: fuser-directory/TESTLIB/SRC
Enter the following command: ftouch sm TESTFILE.NSP

As aresult, the program TESTFILE in library TESTLIB is available in structured mode to Natural.

Example 2:

Change to the following directory:  fuser-directory/MYLIB
Enter the following command: ftouch fnat=21,21 fuser=22,22 -b

As a result, all files in the directories MYLIB/SRC and MYLIB/GP are available in reporting mode
(default) to Natural.

Example 3:

Change to the following directory: ~ fuser-directory

Enter the following command: ftouch Tib=MYLIB convert

As aresult, anew portable FILEDIR.SAG file is saved for the MY LB library and the old FILEDIR.SAG
is saved as FILEDIR.BCK file in this library.

Example 4:

Change to the following directory: ~ fuser-directory
Enter the following command: ftouch 1ib=MYLIB encoding=UTF-8 -a -s

As a result, the internal format information is generated as UTF -8 for all objects which are added
to the FILEDIR.SAG directory from the MYLIB/SRC subdirectory.

Example 5:

Change to the following directory:  fuser-directory

Enter the following command: ftouch Tib=0LDLIB encoding=windows-1251 convert

As aresult, anew portable FILEDIR.SAG file is saved for the OLDLIB library and the internal format
information changes to windows-1251 for all objects contained in the FILEDIR.SAG file.
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Example 6:

Change to the following directory:  fuser-directory
Enter the following command: ftouch Tib=MYLIB endian=BIG

As aresult, the FILEDIR.SAG file of the MY LIB library is converted to big endian. The internal format
information changes to BIG for all objects contained in the MYLIB library.

Example 7:

Change to the following directory: ~ fuser-directory
Enter the following command: ftouch Tib=MYLIB objname=MYPROGl encoding=UTF-8

As a result, the internal format information of object MYPROG1 changes to UTF -8 if MYPROG1 is con-
tained in library MYLIB in the FILEDIR.SAG file.

Example 8:

Change to the following directory:  fuser-directory
Enter the following command: ftouch 1ib=MYLIB objname=MY* encoding=UTF-8

As a result, the internal information of all objects with names that start with MY changes to UTF-8
if they are contained in library MYLIB in the FILEDIR.SAG file.

Example 9:

Change to the following directory:  fuser-directory

Enter the following command: ftouch 1ib=MYLIB suprin=0N

As a result, the line number suppression state is set to ON for library MYLIB in the FILEDIR.SAG
file.
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6 INPL Utility

= |ntroducing the

INPL UBIIRY .o

B L0A0 LIBranies ONlY .....oveiiiie e e
B 1080 DDMS ONIY .ttt et s
B L0ad Error MESSAGES ONIY ...
B 080 Al ODJECES ...t e e a e

= Scan INPL File

B NATUral SECUMLY RECOVET . ...ttt e e s
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INPL Utility

The INPL utility (Initial Natural Program Load) is used to load or scan Natural objects and shared
resources from files supplied by Software AG.

Introducing the INPL Utility

The INPL utility processes Natural objects and shared resources provided by Software AG.

The following diagram is a basic illustration of the INPL functionality:

INPL Uhtility
Matural Objects
Software AG ; Load
File | » Work File 1 Scan " and I Load = System File

Shared Resources

The Natural objects and shared resources are delivered as installation or update files which are
assigned to Work File 1. The INPL utility loads the Natural objects and shared resources from
Work File 1 into Natural system files.

The Natural objects and shared resources include cataloged objects and source objects that are
contained in libraries in the Natural system files FNAT and FUSER.

In addition to loading Natural objects and shared resources, the INPL utility provides a scan
function to check the contents of the file assigned to Work File 1 and a Natural Security Recover
function which forces initialization of the Natural Security environment.

When loading cataloged objects into Natural system files, the INPL utility deletes any buffer pool
entries of cataloged objects with identical names if contained in the same buffer pool used by the
INPL utility.

If an error occurs during INPL execution, the INPL will be interrupted and terminate abnormally
with Condition Code 40.

This section covers the following topics:

= Restrictions

= Special Case

= |nvoking INPL

= Batch and Direct Command Mode
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= Options Available
= [NPL Report

Restrictions

You can process only files which are marked as ,SAG system INPL file”.

Special Case

When an INPL is to be performed in a Natural Security environment, the INPL command can be
specified using the dynamic Natural profile parameter STACK.

Invoking INPL

» To invoke the INPL utility

1

Enter the following Natural system command:

INPL

An INPL utility window similar to the example below is displayed:

[#4]INPL Utility - Load all Dbjects

Funckion Help

Load file: || Browse...
Beport file: I Browse...
] % Cancel Optiokz...

Mame of the worlk, file o be processed. |

Select the file you want to load and the file into which the INPL report (see below) is to be
written. For detailed information, refer to Options Available.

Choose OK to confirm your entries.

From the Function menu, choose one of the following functions:

" Load Libraries Only
Load DDMs Only

® Error Messages Only
Load All Objects
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® Scan INPL File

® Natural Security Recover

For detailed information on these functions, refer to the corresponding sections.

5  Choose the Options button and, in the Options dialog box, enter the parameters to be applied
during execution of this function.

[F4]INPL Utility - Options

Library: |.|
Object narme:
DD name:
D ate start:
Murnber: EI_
¥ Replace

[T Check date before replace
[ Load except

)% Cancel Help

Libary or library range to be loaded or scanned.

For details, refer to Options Available.
Batch and Direct Command Mode

When you run INPL in batch or when you use the direct-command mode, the input data used in
connection with the INPL command corresponds to the codes and values that apply to the fields
provided with a character user interface as shown in the example of an INPL menu in a UNIX
environment below and described in Options Available. For example, assuming the session
parameter 1D is set to comma (,), the instruction for loading a specific DDM may read:

INPL D,,,ddm-name
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11:04:48 #xxxx NATURAL INPL UTILITY ***** 2001-11-09
User: SAG Library: SYSTEM
Code Function
L Load Libraries Only
D Load DDMs Only
E Load Error Messages Only
B Load ATl Objects
S Scan INPL File
R Natural Security Recover
? Help
Exit
Code ........ B
Replace ..... Y (Y/N/O) Load Except . N (Y/N)
DDM Name ....
Library .....
Object Name . Date ........ (YYYY-MM-DD)
Check Date .. N (Y/N) Number ...... 0
File Type ... D (D/P)
Load File ... $NATWORK/SAGLOAD.sag
Report File . $HOME/report.txt
Options Available

The following section describes the text boxes in the INPL utility dialog boxes where you can
specify the file to be used for the INPL and one or more parameters as object selection criteria for
the INPL function selected from the Function menu. The use of a parameter depends on the
respective function as indicated in the relevant documentation sections.

Item Description
Load file The name of the file to be loaded.
File type INPL automatically recognizes the type of the load file such as binary or portable.
. However, due to compatibility reasons, the File type parameter must still be specified
(batch or direct when executing INPL in batch or direct command mode, but it will not be evaluated.
commands only)
Report file The name of the file into which the INPL report (see below) is to be written.
Library The name of a library or a range of names.

If you enter a value that ends with an asterisk (*), each library with a name that starts
with the specified value is processed. The library name is mandatory if Object name
is specified.

Object name

The name of a Natural object (except DDMs) or a range of names.

If the value ends with an asterisk (*), each object with a name that starts with the
specified value is processed.
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ltem

Description

If this text box is empty, all objects contained in the library specified in the Library text
box are processed.

DDM name

The name of a DDM or a range of names.

If you enter a value that ends with an asterisk (*), each DDM with a name that starts
with the specified value is processed. If only an asterisk (*) is entered or if this text box
is empty, all DDMs are processed.

Date start

Restricts processing to Natural objects and shared resources which were saved or
cataloged on or after the date entered in this text box.

The date must be entered in the format YYYVY-MM-DD (YYYY =year, MM=month, DD =
day).

Number

Limits processing of Natural objects and shared resources to a specified number. All
objects are counted which are loaded or scanned according to the specified selection
criteria.

If the number of Natural objects processed has reached the value entered in the Number
text box, processing is terminated with a corresponding message.

Replace

Specifies whether the Natural objects and shared resources to be processed are to
replace any that already exist on the system files.

Possible settings are:

Checked  All existing Natural objects and shared resources are replaced. This is the
default setting.

Unchecked Existing Natural objects and shared resources are not replaced.

See also Check date before replace to replace only Natural objects and shared resources
that are older than the Natural objects and shared resources to be loaded.

Check date before
replace

Specifies whether existing Natural objects and shared resources are to be replaced
depending on their time stamp.

This parameter has no effect if Replace is not selected.

Possible settings are:

Checked  Only objects which are older than the Natural objects or shared resources
of the same name are replaced. An object is older if it was saved or
cataloged before the object to be loaded.

Unchecked All objects are replaced. This is the default setting.

Load except

Specifies whether to exclude Natural objects and shared resources from processing.

This parameter does not apply to error messages.

Possible settings are:
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Item Description

Checked  All Natural objects and shared resources are processed except for the
objects specified in the text boxes DDM name, Library and/or Object
name.

Unchecked No exceptions; all Natural objects and shared resources are processed.
This is the default setting.

Examples of load exceptions:

All libraries except the library ABC are loaded:
Function = Load Libraries Only
Library = ABC

All DDMs with a prefix other than XY are loaded:
Function = Load DDMs Only
DDM name = XY *

All objects contained in libraries with a prefix other than AB and all DDMs with a
prefix other than CD are loaded:

Function = Load All Objects

Library = AB*

DDM name = CD*

Natural Security |Only applies if the function Natural Security Recover has been selected.
recover object

If checked, resets the owner information of specified Natural objects.

INPL Report

When the selected INPL function is complete, a corresponding INPL report is displayed in a list
box (online mode).

Load Libraries Only

This function of the INPL utility is used to load Natural cataloged objects and source objects and
shared resources into specified libraries in the Natural system file FNAT or FUSER.

» To load libraries

1  From the Function menu, choose Load Libraries Only. You can specify parameters to be
valid during execution of this function:

" Replace
® Load except
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2

® Library

Object name

Date start

Check date before replace

® Number

For detailed information on these parameters, refer to Options Available in the section
Introducing the INPL Utility.

Confirm your entries.

When the function is complete, a corresponding INPL report (see the section Introducing the INPL
Utility) is output.

Load DDMs Only

This function of the INPL utility is used to load DDMs into the libraries indicated in the work file.

» Toload DDMs

2

From the Function menu, choose Load DDMs Only. You can specify parameters to be valid
during execution of this function:

® Replace

" Load except

®* DDM name

® Number

For detailed information on these parameters, refer to Options Available in the section
Introducing the INPL Ultility.

Confirm your entries.

When the function is complete, a corresponding INPL report (see the section Introducing the INPL
Utility) is output.
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Load Error Messages Only

This function of the INPL utility is used to load user-defined error messages or system error
messages into specified libraries in the Natural system file FUSER or FNAT respectively.

» To load error messages

1  From the Function menu, choose Load Error Messages Only. You can specify parameters to
be valid during execution of this function:

® Replace
® Library

For detailed information on these parameters, refer to Options Available in the section
Introducing the INPL Utility.

2 Confirm your entries.

When the function is complete, a corresponding INPL report (see the section Introducing the INPL
Utility) is output.

Load All Objects

This function of the INPL utility is used to load all Natural objects (including error messages and
DDMs) and shared resources into the libraries indicated in Work File 1.

» To load all objects and shared resources

1 From the Function menu, choose Load All Objects. You can specify parameters to be valid
during execution of this function:
® Replace
® Load except
®" DDM name
® Library
® Object name
® Date start
® Check date before replace

® Number
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For detailed information on these parameters, refer to Options Available in the section
Introducing the INPL Utility.

2 Confirm your entries.

When the function is complete, a corresponding INPL report (see the section Introducing the INPL
Utility) is output.

Scan INPL File

This function of the INPL utility is used to scan the contents of the file assigned to Work File 1.

» To scan an INPL File

1  From the Function menu, choose Scan INPL File. You can specify parameters to be valid
during execution of this function:
® Load except
" DDM name
® Library

® Object name

Check date before replace

" Number

For detailed information on these parameters, refer to Options Available in the section
Introducing the INPL Utility.

2 Confirm your entries.

When the function is complete, a corresponding INPL report (see the section Introducing the INPL
Utility) is output.

Natural Security Recover

This function of the INPL utility is used to force initialization of the Natural Security environment.
The following options are provided:

= Reset Environment
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= Remove Owners
Reset Environment

@ Caution: Execution of this function will reset the user profile DBA and the library profile

SYSSEC as well as the link between these two objects as they were after the initial installa-
tion; all other links to the library SYSSEC will be canceled. Other Natural Security profiles
and links will not be modified. Contact Software AG technical support for further informa-
tion.

» To reset the environment

= From the Function menu, choose Natural Security Recover.

Remove Owners

» To remove owners

1  From the Function menu, choose Natural Security Recover.
2 Choose the Options button.

3  Inthe Options dialog box, select the Natural Security recover object check box to reset the
owner information of specified objects.
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7 Installer

The Natural Installer is used to install in your local environment packed versions of Natural add-
on products such as, Natural Security. In addition, you can update Natural add-on products or
uninstall Natural add-on products that have been installed with the Natural Installer.

The Natural Installer provides a wizard that guides you through a sequence of windows. These
help you perform the installation step by step.

The Natural Installer is stored in the Natural system library SYSOBJH.

» To invoke the Natural Installer

= In the Natural main window, from the Tools menu, choose Configuration Tools > Natural
Installer.

Or:

In the Natural main window, from the View menu, choose Command Line and enter the
system command SYSINST.

Or:
Execute the Natural program NATINST.
NATINST is stored in the Natural system library SYSOBJH.

The Natural Installer welcome window is displayed. Follow the instructions specified in this
window and all subsequent windows.
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8 Object Handler

The Object Handler is designed to process Natural and non-Natural objects for distribution in
Natural environments. This is done by unloading the objects in the source environment into work
files and loading them from work files into the target environment.

@ General Information on the Object Invoking the Object Handler in batch or online mode; applying
Handler Natural Security.
@ Functions Using the Object Handler menu functions: unload, load, restart
load, scan, view, find and administration.
i@ Object Specification Specifying the objects to be processed with Object Handler menu
functions.
i@ Settings Specifying option and parameter settings for Object Handler
menu functions.
& Workplans Using standard procedures to execute Object Handler functions.
& Name, Date and Time Specification Specifying names, dates, times and ranges.
& Work Files Work files used by the Object Handler.
& Direct Commands Using direct commands to perform Object Handler functions.
& Batch Condition Codes and User ~ Condition codes and user exit routines provided in batch mode.
Exit Routines
& Tools Displaying status information, setting trace and report options,
and transferring work files.
& Options Invoking or activating specific Object Handler options.
@ Profile Settings Setting up a profile to define individual defaults and standard
procedures.
& Migration from SYSTRANS to the Migrating from the utility SYSTRANS to the Object Handler.
Object Handler
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9 General Information on the Object Handler

= Principles of Object Transfer
= |nvoking the Object Handler

m Batch or Direct Command CallS ...........ooiiii e
= |ssuing Object Handler Commands from @ Natural Program .............ccccooiiiiiiiiiiiiiiiiceecce e
= Text Members for Reports, Restarts and TraCes ..........coovvvviiiiiiiiiiiiiiie e,

= Natural Security ................
= Using FDDM System Files ..
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The Object Handler consists of the utility SYSOBJH which is located in the Natural system library
SYSOBJH, and the direct command interface. Additionally, the Application Programming Interface
OBJHAPI is provided for executing Object Handler functions from a Natural program.

Principles of Object Transfer

The diagram below illustrates how the Object Handler transfers objects by unloading them from
the source environment into work files and loading them from work files into the target environ-
ment. If required, an application protocol such as FTP can be used for transferring work files from
source to target environments.

When connected to a Natural Development Server in a remote environment located on a Windows,
mainframe, UNIX or an OpenVMS platform, the Object Handler can be used to directly unload
or load objects from or into a work file that is located on the local Windows client.

»  Object Handler Object Handler
unicad lead
objecls wiile L objects
 J
ol hatural *re e Matural Mew
Environment Work File Work File Environment
Mainframe Mainframe
LM LIMIX
OpenVMS OpenVMs
Windows Windows

Related Topic:

Natural Development Server documentation

This section covers the following topics:

74

Tools and Utilities



General Information on the Object Handler

= Transfer Environment and File Security
= Objects Processed by the Object Handler
= Formatting Options

Transfer Environment and File Security

An old or a new environment is an FNAT, FUSER or FDIC system file contained in an Adabas
database or a VSAM file system on a mainframe, or in the file system on a UNIX, an OpenVMS
or a Windows platform. Natural objects on the FNAT or FUSER system file can be contained in
libraries as indicated in the following section.

The file security (that is, passwords and cipher codes) relates to the security that has been defined
for a system file in an Adabas or a VSAM environment. If file security has been defined for a system
file, you need to specify a password, cipher code and/or VSAM name for the source and/or target
system file required before you perform an Object Handler function. Otherwise, Adabas or VSAM
will issue an appropriate error message. You do not have to provide security information for the
default system files assigned to the Natural session at the start of the Object Handler.

Objects Processed by the Object Handler

The Object Handler transfers Natural source objects (also referred to as saved objects) and cataloged
objects which are contained in Natural libraries, Natural error messages, Natural command pro-
cessor sources, Natural-related objects, Adabas FDTs (Field Definition Tables) and external files.

Formatting Options

You can transfer data of binary or text format, depending on the source and target environment
where the objects are processed.

Binary format can be used for source objects and cataloged objects, error messages, Natural com-
mand processor sources, Natural-related objects and Adabas FDTs and external files.

Text format applies to source objects, Natural command processor sources, error messages and
Adabas FDTs. You can only transfer text data between mainframe and UNIX/OpenVMS/Windows
platforms. You can transfer binary data between identical platforms. Between UNIX or OpenVMS
and Windows platforms, you can transfer binary data by using portable work files of internal
format.

Tools and Utilities 75



General Information on the Object Handler

Invoking the Object Handler

This section provides instructions for invoking the Object Handler by using either menu functions
or direct commands:

If you start the Object Handler while a remote Natural Development Server environment is active,
the Object Handler will be invoked for the remote environment currently mapped and will process
only the objects contained in this environment. In Natural Studio, the current environment is
indicated in the title of the SYSOBJH - Object Handler window, which appears when you invoke
the Object Handler as described in the following section.

» To invoke the Object Handler using menu functions

1

In the Natural Studio window, from the Tools menu, choose Development Tools and Object
Handler.

Or:

In the Natural Studio window, from the View menu, choose Command Line and enter the
following system command:

SYSOBJH

The Welcome to the Natural Object Handler window of the Object Handler appears with
the following options:

® Unload
" Load

" Administration

Select the Advanced user check box if you do not want to use the Object Handler wizards for
function processing.

Select the function required either by choosing the corresponding command button or by
selecting the corresponding function from the Actions menu.

In addition to the functions listed above, the Actions menu provides the following;:

B View
® Find
® Scan Work File

Change Workplan Library
® Restart Load
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See the section Functions for descriptions of these functions, and how to process the functions
in advanced-user mode or by using wizards.

» To invoke the Object Handler in batch or direct command online mode

= Enter the system command SYS0BJH followed by a direct command as described in Batch or
Direct Command Calls and Direct Commands.

After execution of a direct command, you can enter either another direct command or a
period (.) to exit the Object Handler.

Batch or Direct Command Calls

Several commands can be issued to the Object Handler online or in batch mode. The last command
in the command sequence must be a period (.), STOP, END, QUIT or FIN, where FIN ends the Natural
session.

The section covers the following topics:

= Batch Mode
= Online Mode

Batch Mode

If you invoke the Object Handler in batch mode, you must issue a direct command to execute an
Object Handler function.

The commands to the Object Handler are read from standard input. Each command can be sepa-
rated into a maximum of 20 command parts/strings by entering input delimiters (session parameter
ID) after any keyword or keyword value. Each command part/string must not exceed 248 bytes.

If the command is longer than a single line, at the end of every line except the last that belongs to
the command, enter the character defined with the session parameter CF (defaultis %) This indicates
continuation on the next line. However, this is only possible if you specify the command SYS0BJH
in a line by itself. That is, you cannot use CF, if you enter SYSOBJH in the same line where a multi-
line command starts.

Example (assuming ID is set to ,):

UNLOAD * LIB EXAMPLE, WHERE, WORK C:\TEMP\TEST.SAG
STOP

Related Topics:

® Direct Commands
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® Batch Processing in a Remote Environment in Examples of Using Direct Commands

® Natural in Batch Mode - Operations documentation
Online Mode

The command to the Object Handler in the Command line can consist of up to 20 command parts.
Several commands can be issued to the Object Handler. The last command in the command
sequence must be a period (.), STOP, END, QUIT or FIN, where FIN ends the Natural session.

Example:

SYSOBJH UNLOAD * LIB EXAMPLE WHERE WORK C:\TEMP\TEST.SAG
STOP

Issuing Object Handler Commands from a Natural Program

You can issue commands to the Object Handler with a Natural program by using the OBJHAPI
Application Programming Interface, which is supplied as a subprogram in the Natural system
library SYSOBJH. For the parameters required and examples, see the Natural program DOC-API
supplied in the library SYSOBJH.

Text Members for Reports, Restarts and Traces

Only applies to remote environments located on mainframe platforms.

Report, restart and trace data created by the Object Handler are stored as Natural text members
(Natural objects of the type Text) in the Workplan library. The Object Handler generates names
for text members that have not been explicitly specified in the Options window. The names
generated are a combination of the weekday and the time. For example: a member with the name
21415568 was created on Tuesday (the second day of the week) at 14:15:56,8.

Natural Security

The use of the Object Handler under Natural Security requires that utility profiles be defined for
itin Natural Security. Atleast, a default profile must be defined. For information on utility profiles,
see the section Protecting Utilities in the Natural Security documentation.

If Natural Security is installed, the Object Handler checks the SYSOBJH utility profiles in Natural
Security to find out whether the requested function is allowed.
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Should a Natural Security error occur during the load function, the following applies:
= If the Write report option is set, in online mode, the error message is written to the report file
and processing continues for the current load command.

= If the Write report option is set, in batch mode, the error message is written to the report file
and the Object Handler terminates after the load command where the error occurred has finished
processing.

= If the Write report option is not set, an error message is issued and the load command is termi-
nated.

Using FDDM System Files

Natural DDMs (data definition modules) can be stored in libraries or the system file FDDM. See
also: FDDM - Natural System File for DDMs in the Parameter Reference documentation).

To use the system file FDDM for processing DDMs with the load, unload or find function, the
Object Handler provides the option Use FDDM file for processing DDMs. This option is set by
selecting Use additional options (see the section Settings).

Consider the following when selecting Use FDDM file for processing DDMs:

® This option is selected by default if FDDM has been activated in the NATPARM module.
® You cannot process DDMs that are stored in libraries.

" You need to specify the library SYSTEM and the Natural object type V (see Natural Library
Object Details in the section Object Specification.

If used with the load function, all DDMs are loaded into the system file FDDM. In this case, the
parameter NEWLIBRARY is ignored.
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10 Functions

This section describes the main functions provided by the Object Handler.

If you execute an Object Handler function while a remote Natural Development Server environment
is active, this function will process all objects in the remote environment currently mapped in
Natural Studio or with a direct command if used.

You can take advantage of the Object Handler wizards to guide you through the steps required
to execute the unload, load, scan and administration functions. The wizards are activated by
default. If you prefer the unload, load or scan mode for the experienced user instead, in the Wel-
come to the Natural Object Handler window, select the check box next to Advanced user. You
can also set advanced-user mode as the default by using the appropriate Object Handler profile
option. See also the section Profile Settings.

You can create standard procedures to define recurring settings and object specifications which
automate the processing of the unload, load or scan function. See the section Workplans for further
information.

] Note: You cannot unload, load or scan external files in remote environments located on

mainframe platforms. Natural DDMs (data definition modules) can only be unloaded, loaded
or scanned in remote environments located on mainframe platforms.

This section covers the following topics:

9 Wizards
Y Advanced User
Y Restart Load

9 View
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Find
Scan
Administration

Change Workplan Library

) e & ¢ @

Note: Change Workplan Library is described in the section Administration.
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The Object Handler provides wizards that determine the processing sequence for the following:

* Unloading data from the Natural system environment into Natural work files.
* Loading data from work files into the Natural system environment.

* Finding objects in your Natural environment.

" Scanning the contents of Natural work files.

® Performing administration functions.

This section provides general information on the wizards and detailed instructions for using the
unload and load wizards:

3 General Information on Wizards
9 Unload Wizard

9 Load Wizard

J Notes:

1. The unload wizard includes the find function and the load wizard includes the scan.

2. The administration wizard is described in the section Administration.
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= |nvoking Wizards ............cccoeveeeene

= Navigation and Command Execution
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This section provides information on invoking the Object Handler wizards, navigating between
the windows provided and executing commands.

Invoking Wizards

» To invoke the wizards

s Inthe Welcome to the Natural Object Handler window, remove the mark from the Advanced
user check box if required (the box is not selected by default).

Or:

From the Options menu, select Advanced User.

Navigation and Command Execution

To navigate between the processing windows of a wizard, choose the command buttons Next and
Back: choose Next to confirm settings and continue processing, choose Back to modify settings
made in a previous step. Choose the Cancel command button whenever you want to stop the
processing sequence and return to the Welcome to the Natural Object Handler window.

Before finally executing a function, the wizard displays the command or command procedure
generated for the relevant function and the settings and object specifications made. You can again
choose Back to return to a previous window and modify the setting, or confirm and execute the
command with Next.

After you have executed the command or command procedure for the unload, load or scan func-
tion, you can continue processing and reuse the settings previously made or choose the Cancel
command to terminate the function.
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This section provides instructions for using the unload wizard and describes the items available
in wizard windows.

» To start the unload wizard

s Inthe Welcome to the Natural Object Handler window, remove the mark from the Advanced
user check box and choose the Unload command button.

Or:
From the Actions menu, choose Unload.
The initial Unload Wizard window appears.

The options provided in the Unload Wizard window are described in this section.

Unload Objects into Natural Work File(s)

With the wizard function Unload objects into Natural work file(s), you are guided through the
sequence of windows described below, where you can specify option and parameter settings and
the type of object for the unload to be performed:

= Set Options
= Set Parameters
= Select Objects

Set Options

In the options window of the unload wizard, select any of the options to be used for function
processing and, if required, fill the text box:

Item Explanation

Transfer format Only valid if Use default options (this is the default) or Use additional options has
been selected (see below).

If selected, the data to be processed is written in Transfer format to the work file.
See also Work File Format in Work Files.

Local work file Only applies to remote environments.

Only valid if Use default options (this is the default) or Use additional options has
been selected (see below).
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Explanation

Specifies the location of the work file when using Object Handler functions in
connection with SpoD (Single Point of Development). If Local work file is selected,
the data to be processed is written to the specified work file in the local file system.

See also WFLOC in Direct Commands.

Portable work file

Not applicable to work files located in a remote environment on a mainframe
platform.

This option is only valid if the following applies:

= Use default options (this is the default) or Use additional options has been
selected (see below).
= Transfer format has not been selected.

If Portable work file has been selected, the work file is written or read in portable
format. See also Work File Format in Work Files.

Unicode work file

Only applies if Transfer format has been selected.

If this option is selected, all object sources are converted to Unicode/UTF-8 (Universal
Transformation Format, 8-bit form) before they are written to the work file.

Fixed length See FIXEDLENGTH in Direct Commands.

Unload file Only valid if Use default options (this is the default) or Use additional options has
been selected. See below.

(Server)
The name of the work file to be used for the function. See also Work Files. On
mainframes, the current Work File 1 is used as the default unload file.

Browse Not applicable to server unload files.

Invokes the browse function to select a work file from a directory.

Use default options

Default options are used (this is the default). For the options available, see Set
Additional Options in Settings - Options.

Use additional Used in connection with Set (see below).

options

Set Only activated if Use additional options has been selected.
Invokes the Unload Options window where you can modify the default settings
and enter additional options for the processing sequence. See also Set Additional
Options in Settings - Options.

Use Option Workplan |If selected, a Workplan of the type OPTION is used.

Select a Workplan from the combo box or type the name of a Workplan of the type
OPTION.

See also Workplans.
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Item Explanation

List Only valid if Use Option Workplan (see above) has been selected and the name of
a valid Workplan of the type OPTION was entered.

Displays the contents of the Workplan specified.

Set Parameters

Applies to the unload function only.

In the parameters window of the unload wizard, select any of the options to be used for function
processing and, if required, fill the text box:

Item Explanation

Do not use parameters |If selected (default setting), no parameters are set.

Use global parameters |If selected, global parameters are used. See also Set Global Parameters in Settings.

Set Only activated if Use global parameters has been selected.

If selected, the global parameters window is invoked. See Set Global Parameters
in Settings and parameter-setting (Direct Commands) for descriptions of
keywords and valid values.

Use Parameter Workplan |If selected, a Workplan of the type PARAMETER is used.

Select a Workplan from the combo box or type the name of a Workplan of the
type PARAMETER.

See also Workplans.

List Only valid if Use Parameter Workplan (see above) has been selected and the
name of a valid Workplan of the type PARAMETER was entered.

Displays the contents of the Workplan specified.

Select Objects

| Note: You cannot unload Natural-related objects or external files in remote environments

located on mainframe platforms. Natural DDMs can only be unloaded in remote environ-
ments located on mainframe platforms.

In the object type specification window, choose either of the following methods to specify the type
of object you want to process:
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1. Direct Specification
Select one of the following types of object:

® Natural library objects

® Natural system error messages

® Natural command processor sources
® Natural-related objects

® External files

= FDTs

® Natural DDMs

Depending on the type of object selected, a window appears where you can specify selection
criteria for the objects to be processed.

Specify the objects and choose Details (if available for the type of object selected) for more
detailed specifications, if required. For the keywords and valid values that apply to each object
type, see the relevant explanations in the section Object Specification.

2. Using a Workplan
Select Use Selection or List if you want to use a Workplan of the type SELECTION or LIST that
predefines object selection criteria: see the section Workplans for more information.

In the Selection or List window, enter the name of a Workplan of the type SELECTION or LIST
by using either option:

* Type in the name of a Workplan.

Or:
From the drop-down list box, choose a name from the list of Workplans available.

Choose the List command button if you want to list the contents of the Workplan specified.

Find Objects

The wizard function Find objects is used to locate objects in your Natural environment and
generate a report list of the objects found.

Find objects guides you through the same sequence of windows and the same setting or object
specification options as described earlier for the wizard function Unload objects into Natural
work file(s) above. Settings or specifications that only apply to the unload function (for example,
unload file) are excluded from the respective windows.

The report generated by the Find objects function contains several table columns with information
on the objects listed. For information on the table columns, refer to the section Object Specification.
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For general information on the execution of the find command and possible error messages,
choose the Details button. See also Last Result in the section Tools.

Start Object Handler Command Procedure

Choose the function Start Object Handler command procedure if you want to execute a standard
procedure (Workplan) of the type PROCEDURE with predefined settings and object specifications
for the unload function to be performed. See also the section Workplans for further information.

» To start and execute an Object Handler command procedure

1 In the initial Unload Wizard window, choose Start Object Handler command procedure.

The procedure window appears.
2 Inthe field Procedure name, enter the name of a Workplan of the type PROCEDURE (see
also Workplans) by using either option:
® Type in the name of a Workplan.
Or:
From the drop-down list box, choose a name from the list of Workplans available.

® Choose the List command button if you want to display the contents of the Workplan
specified.

3 Confirm the contents of the PROCEDURE Workplan and execute the transaction.
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This section provides instructions for using the load wizard and describes the items available in
wizard windows.

» To start the load wizard

s Inthe Welcome to the Natural Object Handler window, remove the mark from the Advanced
user check box (if necessary) and choose the Load command button.

Or:
From the Actions menu, choose Load.
The initial Load Wizard window appears.

The options provided in the Load Wizard window are described in this section.

Load/Scan Objects from/in Work Files

With the wizard function Load objects from Natural work file(s) or Scan objects in Natural work
file(s), you are routed through the sequence of windows described in this section, where you can
specify the option or parameter settings and the type of object for the load or scan to be performed.

= Set Options
= Set Parameters
= Select Objects

Set Options

In the options window of the load/scan wizard, select any of the options to be used for function
processing and, if required, fill the text box.

Item Explanation

Transfer format Only valid if Use default options (this is the default) or Use additional options has
been selected. See below.

If selected, the data to be processed is written in Transfer format from the work file.
Load/scan data is expected to be in Transfer format. See also Work File Format in
Work Files.

Local work file Only applies to remote environments.

Only valid if Use default options (this is the default) or Use additional options has
been selected. See below.
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Explanation

Specifies the location of the work file when using Object Handler functions in
connection with SpoD (Single Point of Development). If Local work file is selected,
the data to be processed is read from the work file specified in the local file system.

See also WFLOC in Direct Commands.

Portable work file

This option is not required for the load and scan functions, which automatically
choose the appropriate work file type and ignore the option if set.

In addition, this option does not apply to work files located in a remote environment
on a mainframe platform.

Portable work file is only valid if the following applies:

= Use default options (this is the default) or Use additional options has been selected
(see below).

= Transfer format has not been selected.

See also Work File Format in Work Files.

Load file
or
Scan file

(Server)

Only valid if Use default options (this is the default) or Use additional options has
been selected. See below.

The name of the work file to be used for the function. See also Work Files. On
mainframes, the current Work File 1 is used as the default load/scan file.

Browse

Not applicable to server load/scan files.

Invokes the browse function to select a work file from a directory.

Use default options

Default options are used (this is the default). For the options available, see Set
Additional Options in Settings - Options.

Use additional Used in connection with Set (see below).

options

Set Only activated if Use additional options has been selected.
Invokes the Load/Scan Options window where you can modify the default settings
and enter additional options for the processing sequence. See also Set Additional
Options in Settings - Options.

Use Option If this option is selected, a Workplan of the type OPTION is used.

Workplan
Select a Workplan from the combo box or type the name of a Workplan of the type
OPTION.
See also Workplans.

List Only valid if Use Option Workplan (see above) has been selected and the name of

a valid Workplan of the type OPTION was entered.

Displays the contents of the Workplan specified.
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Set Parameters

Applies to the load function only.

In the parameters window of the load wizard, select any of the options to be used for function
processing and, if required, fill the text box:

Item Explanation

Do not use parameters |If selected (default setting), no parameters are set.

Use global parameters |If selected, global parameters are used. See also Set Global Parameters in Settings.

Set Only activated if Use global parameters has been selected.

If selected, the global parameters window is invoked. See Set Global Parameters
(Settings) and parameter-setting (Direct Commands) for descriptions of
keywords and valid input values.

Use Parameter Workplan |If selected, a Workplan of the type PARAMETER is used.

Select a Workplan from the combo box or type the name of a Workplan of the
type PARAMETER.

See also Workplans.

List Only valid if Use Parameter Workplan (see above) has been selected and the
name of a valid Workplan of the type PARAMETER was entered.

Displays the contents of the Workplan specified.

Select Objects

| Note: You cannot load or scan Natural-related objects or external files in remote environ-

ments located on mainframe platforms. Natural DDMs can only be loaded or scanned on
mainframe platforms.

For loading FDTs, see also FDTs in the section Object Specification.

In the object type specification window, choose any of the following options to specify the type
of object you want to process:

1. Select Load/Scan all objects from work file if you want to process all objects from the work
file.
2. Select Load/Scan selected objects from work file to process a particular type of object:
® Natural library objects
® Natural system error messages
® Natural command processor sources

® Natural-related objects
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= External files
= FDTs

® Natural DDMs (remote environments only)

Depending on the type of object selected, a window appears where you can specify selection
criteria for the objects to be processed.

Specify the objects and choose Details (if available for the type of object selected) for more
detailed specifications, if required.

For the keywords and valid values that apply to each object type, see the relevant explanations
in the section Object Specification.

. Select Use Selection or List if you want to use a Workplan of the type SELECTION or LIST that

predefines object selection criteria: see the section Workplans for more information.

In the Selection or List window, enter the name of a Workplan of the type SELECTION or LIST
by using either option:

Type in the name of a Workplan.

Or:
From the drop-down list box, choose a name from the list of Workplans available.

Choose the List command button if you want to list the contents of the Workplan specified.

Start Object Handler Command Procedure

Choose the function Start Object Handler command procedure if you want to execute a standard
procedure (Workplan) of the type PROCEDURE with predefined settings and object specifications.
See also the section Workplans for further information.

» To start and execute an Object Handler command procedure

1

In the initial window of a wizard, choose Start Object Handler command procedure.

The Start Procedure window appears.

In the field Procedure name, enter the name of a Workplan of the type PROCEDURE (see
also Workplans) by using either option:

® Type in the name of a Workplan.

Or:
From the drop-down list box, choose a name from the list of Workplans available.
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® Choose List if you want to display the contents of the Workplan specified.

3  Confirm the contents of the PROCEDURE Workplan and execute the transaction.

Load SYSPAUL Application

Note that the Object Handler covers the functionality of the utility SYSPAUL, which is no longer
installed per default.

SYSPAUL Applications can only be loaded in local environments.

» To load a SYSPAUL Application

1 Make sure that the utility SYSPAUL has been installed in the current FNAT system file.

2 Inthe Load SYSPAUL Application window, choose Select to select the name of the file app-
linfo.txt of the SYSPAUL Application to be loaded. It is located in the first directory of the
SYSPAUL Application.

3 In the next window, the name of the SYSPAUL Application is displayed in the field Name.

4  The Object Handler loads the SYSPAUL Application and displays the result. The report file
sysload.log is located in the temporary directory of Natural.
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Advanced User

The Object Handler provides a function processing sequence for the advanced user. The following
functions are available if advanced-user mode is activated:

® Unload

" Load

® Administration
" View

® Find

® Scan Work File
® Restart Load

For the functions administration, view, find, scan work file and restart load, refer to the relevant
sections in Functions.

This section describes how to activate advanced-user mode and provides a description of the
unload or load processing sequence performed in this mode.

Activating Advanced User

» To activate advanced-user mode

s In the Welcome to the Natural Object Handler window, select the Advanced user check box
(not selected by default).

Or:
From the Options menu, select Advanced User.
Or:

Set advanced-user mode as the default by choosing Profile from the Options menu, and
changing the entries in the SYSOBJH - Modify Profile window:

From the New user profile entry drop-down list box, select Advanced User, in the Entry
value box, enter a Y (Yes), and choose Add.

See also the section Profile Settings.
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Advanced User Unload

Note: You cannot unload Natural-related objects and external files in remote environments

located on mainframe platforms. Natural DDMs can only be unloaded in remote environ-
ments located on mainframe platforms.

» To unload objects in advanced-user mode

1

In the Welcome to the Natural Object Handler window, choose the Unload command button.
Or:
From the Actions menu, choose Unload.

The Unload window appears with a list of the types of object currently available in your
Natural system environment.

Select one type of object and, from the context menu, choose Unload.
Or:
From the Actions menu, choose Unload and select the type of object required.

If you want to use a SELECTION or a LIST Workplan, you need to choose the second method
and choose Unload from the Actions menu.

The Unload window appears for the type of object selected.
Specity the objects to be processed:

= If available for the type of object selected, choose the Details button for further object spe-
cifications: see also the relevant sections in Object Specification.

® Choose the Settings button to specify unload options and parameters as described in the
section Settings.

Choose the Unload command button.

A message appears confirming the execution of the unload.
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Advanced User Load

You cannot load Natural-related objects and external files in remote environments located on
mainframe platforms. Natural DDMs can only be loaded in remote environments located on
mainframe platforms.

To load FDTs, see also FDTs in the section Object Specification.

This section contains information on how to execute the load function in advanced-user mode.

» To load objects in advanced-user mode

1

In the Welcome to the Natural Object Handler window, choose the Load command button.
Or:
From the Actions menu, choose Load.

The Load window appears with a list of the types of objects currently available in your
Natural system environment.

Select one type of object and, from the context menu, choose Load.
Or:
From the Actions menu, choose Load and select the type of object required.

If you want to use a SELECTION or a LIST Workplan, you need to choose the second method
and choose Load from the Actions menu.

The Load window appears for the type of object selected.
Specify the objects to be processed:

= If available for the type of object selected, choose the Details button for further object spe-
cifications: see also the relevant sections in Object Specification.

® Choose the Settings button to specify load options and parameters as described in the
section Settings.

Choose the Load command button.

A message appears confirming the load.
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Only applies to the load function and if Write restart information is set.

You can use the restart load function to resume load functions that terminated abnormally. If the
load function terminates before the work file has been processed completely, with the restart load
you can continue from the point of termination.

The restart load requires that restart information is written to Work File 6 or a specified restart
file in accordance with the selection criteria, options and parameter settings specified for the load.

In local environments, the restart file is located in the local file system. Work File 6 is used for
writing and reading restart data.

In remote environments, restart load data is written to a Natural object of the type Text (text
member) located in the Workplan library. By default, this text member is a temporary object. We
recommend that you specify a permanent text member for restart data as described below.

For information on setting the Write restart information option and specifying a restart file, see
Special in Set Additional Options in the section Settings - Options.

| Note: To display the name of the text member containing the restart data, from the Tools

menu, choose Show Status.
Related Topics:

RESTART under option-clause in the section Direct Commands
Change Workplan Library in the section Administration

Invoking Restart Load

» To invoke the restart load function

1  Inthe Welcome to the Natural Object Handler window, from the Actions menu, choose
Restart Load.

The Restart Load window appears.

2 Inlocal environments, in the field Restart file, enter the name of the restart file.

In remote environments, in the field Restart file, enter the name of the text member containing
the restart data.

Or:
Choose the Browse button and select a file from a directory.

Or:
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From the drop-down list box, select a file.

Specifying Permanent Members

Applies to remote environments only.

» To specify a permanent restart text member

1  From the Actions menu, choose Change Workplan Library.

The Workplan Library window appears.

2 Select the check box Use permanent text member for restart data and enter the name required
in the corresponding input field.

3 Choose the OK command button to confirm your settings.
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View

This function is used to display objects currently located in your Natural system environment.
From the view function you can invoke the find function (see the relevant section) to specify further

selection criteria for the search.

You can view all objects available on the relevant platform:

In a local Windows environment, or in a remote environment on a Windows, a UNIX or an

OpenVMS platform:

Natural library objects

Natural system error messages
Natural command processor sources
Natural-related objects

External files

FDTs

In a remote environment on a mainframe platform:

Natural library objects

Natural system error messages
Natural command processor sources
Natural DDMs

Natural-related objects

FDTs

For information on the table columns and cells that appear in the windows generated by the view

function, refer to the section Object Specification.

Invoking View

» To invoke the view function

m  Activate advanced-user mode and, from the Actions menu, choose View.

The View window appears with a list of the types of object available for selection.
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Terminating View

» To leave the view function

From the Object menu, choose Close.
Or:

Choose the standard Windows close button.

Navigating

» To navigate between the windows of the view function and to select objects

1

In the initial View window and in any subsequent object-specification window, double-click
on a list item to go to the next object-specification window.

Or:

Select a list item and, from the Object menu, choose Open to go to the next specification
window.

From the Object menu, choose Back to return to a previous object-specification window.

» To view Natural library objects from different system files in a remote environment

1

In the initial View window, double-click on the type of object required.
Or:
From the Object menu, choose Open.

A window appears with a list of specified system files.

In the System File table, double-click on User-defined System File.

Or:

Select user-defined system file and, from the Object menu, choose Open.

If required, in the appropriate text boxes, enter a valid Adabas database ID (DBID), file
number (FNR), password (Password) and cipher key (Cipher key), and choose the OK com-
mand button.
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Saving Object Selections

» To save a list of selected objects as Workplan of the type LIST

1  Inany of the object selection tables generated by the view function, select the objects required.

2 From the Object menu, choose Save Into.

The Save into List window appears.

3 In the Workplan name text box, enter the name of a new Workplan of the type LIST, and fill
the Workplan description text box.

Or:

From the drop-down list box, choose a Workplan from a list of all Workplans available.

4 Choose the OK command button to add the specified objects to the Workplan.

Sorting Objects

» To sort a list of selected objects by columns

= Inthe View window, select the entire column by which you want to sort the table and double-
click on this column.

Or:

Select the column by which you want to sort the table and, from the context or Edit menu,
choose Sort Objects.

Listing Objects Separately

» To list source objects separately from cataloged objects (GPs)

= In the View windows, from the Options menu, choose Single Objects.

Source objects (Src) and cataloged objects (Gp) are listed in separate table rows.
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Deleting Objects

» To delete objects

1  Inany of the object selection tables generated by the view function, select the objects you want
to delete.

2 From the Object menu, choose Delete.

A confirmation box appears.

3  Choose the Yes command button to execute the deletion.
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Find

This function is used to locate objects in your Natural environment and generate a report list of
the objects found. In addition to the view function (see the relevant section), the find function
provides options to specify further criteria for the object selection.

» To invoke the find function

= Activate advanced-user mode and use the Find menu option as described below.
Or:

Use the Find objects function of the unload wizard as described in the section Wizard.

Find in Advanced User Mode

» To invoke the find function in advanced-user mode

1  From the Actions menu, choose Find.
A window appears where you select one object type:

® Natural library objects
® Natural system error messages
® Natural command processor sources

DDMs
(remote environments only)

Natural-related objects

FDTs

B Use Selection or List

2 Choose the OK command button.
3  Depending on the object type selected, one or more additional windows appear where you
can specify selection criteria and option or parameter settings:
* For the keywords and valid values that apply to each object type, see the relevant explana-
tions in the section Object Specification.

* For possible settings, see the section Settings.

4  After you have made all object specifications and specified the settings, choose the Find
command button to execute the find function.
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The find window appears with an object selection table of all objects available in your current
Natural environment that match the object specifications made earlier.

For information on the table columns, refer to the section Object Specification.

For the options provided in the find window, see Table Functions below.

5 To terminate the find function:

From the Object menu, choose Close.

Or:

Choose the standard Windows close button.

This section covers the following topic:

= Table Functions

Table Functions

Listed below are the options provided in the object selection table of the find window, along with
explanations and instructions on how to invoke them:

Option

Explanation/Instruction

Refresh Table

Rebuilds the table to show the latest status.

Choose this function from the context or Object menu.

Details

Invokes the scroll bar for displaying additional table columns.

From the Options menu, choose Details so that you can scroll to list further table columns
with more information on the objects found.

Single Objects

Lists source objects (Src) and cataloged objects (Gp) in separate table rows.

Set this option in the Options menu.

Sort Objects

Sorts the table by columns.

Select the entire column by which you want to sort the table and double-click on this
column.

Alternatively, select the column by which you want to sort the table and, from the context
or Edit menu, choose Sort Objects.

Unload

Unloads objects.

This function can only be applied, if the unload function of the Object Handler has been
activated (see also Advanced User Unload in the section Advanced User).

Select one or more objects and, from the context or Object menu, choose Unload.
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Option Explanation/Instruction

Load Loads objects.

This function can only be applied, if the load function of the Object Handler has been
activated (see also Advanced User Load in the section Advanced User).

Select one or more objects and, from the context or Object menu, choose Load.

Save Into Saves a list of selected objects as Workplan of the type LIST.

Select one or more objects and, from the context or Object menu, choose Save Into.

Delete Deletes objects.

Select one or more objects and, from the context or Object menu, choose Delete.
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Scan

This functions is used to scan for objects in Natural work files.
The following restrictions apply to the scan function:

" You cannot scan Natural-related objects and external files in remote environments located on
mainframe platforms. Natural DDMs can only be scanned in remote environments located on
mainframe platforms.

" You cannot apply the scan function while you are executing an unload function. If you end the
current unload to perform a scan, the unload file will be closed. A subsequent unload then
writes the data to a new work file. So, if you do not change the work file name, the existing file
will be overwritten.

» To invoke the scan function

= Activate advanced-user mode and use the Scan Work File for menu option as described
below.

Or:

Use the function Scan objects in Natural work file(s) of the load wizard as described in the
section Wizards.

Scan in Advanced User Mode

For information on the table columns and cells that appear in the boxes generated by the scan
function, refer to the section Object Specification.

» To scan objects in advanced-user mode

1 From the Actions menu, choose Scan Work File for.
A window appears where you can select one object type or select all object types:

= All objects

Natural library objects

Natural system error messages

Natural command processor sources

" DDMs
(remote environments only)

Natural-related objects

External files
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= FDTs

= Use Selection or List

2 Choose the OK command button.

3  Depending on the object type selected, one or more additional windows appear where you
can specify selection criteria and option and parameter settings:

® For the keywords and valid values that apply to each object type, see the relevant explana-
tions in the section Object Specification.

® For possible settings, see the section Settings.

4  After you have made all object specifications and specified the settings, choose the Scan
command button to execute the function.

The scan window appears with a table of all objects that meet the selection criteria specified
and that are contained in the work file.

For information on the table columns, refer to the section Object Specification.

For the options provided in the scan window, see Table Functions below.

5 To terminate the scan function:

From the Object menu, choose Close.

Or:

Choose the standard Windows close button.

This section covers the following topic:

= Table Functions

Table Functions

The following functions are available in the object selection table of the scan window:

Function |Explanation/Instruction

Details |Shows further table columns.
From the Options menu, choose the Details button so that you can scroll to list further table
columns with more information on the objects found.

Unload |Unloads objects.

This function can only be applied, if the unload function of the Object Handler has been activated
(see also Advanced User Unload in the section Advanced User).
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Function |Explanation/Instruction

Select one or more objects and, from the context or Object menu, choose Unload.

Load Loads objects.

This function can only be applied, if the load function of the Object Handler has been activated
(see also Advanced User Load in the section Advanced User).

Select one or more objects and, from the context or Object menu, choose Load.

Save Into|Saves a list of selected objects as Workplan of the type LIST.

Select one or more objects and, from the context or Object menu, choose Save Into.
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Administration

This function is used to maintain Object Handler Workplans.

For information on Workplans and the syntax that applies, refer to the sections Workplans and
Direct Commands.

The Object Handler provides the option to use the administration wizard which determines the
processing sequence, or to use the administration function for advanced users.

Note that you can set the default library for Workplans by using the Workplan-Library entry of
the Profile option. See also the section Profile Settings.

] Note: The administration wizard offers a restricted set of administration functions that does

not provide the option to create, modify, delete, export or import Workplans. To get the
full set of administration functions, activate advanced-user mode.

Administration Wizard

The administration wizard provides the Next and Back command buttons to navigate between
the windows (steps). Use the Cancel command button to cancel the processing sequence.

» To invoke the administration wizard

»  Inthe Welcome to the Natural Object Handler window, remove the mark from the Advanced
user check box if required (not selected by default) and choose the Administration button.

The Administration Wizard window appears.

Instructions for using the functions provided in the Administration Wizard window are explained
in the following section:

= |ist and Check Workplan
= Start Object Handler Command Procedure
= Change Workplan Library

List and Check Workplan

This function is used to list the contents of all Workplans that are available in the Workplan
library.

» To list and check Workplans

1 In the initial Administration Wizard window, choose List and Check Workplan.

A window appears with the text boxes Workplan Name and Workplan Type.
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Enter the name of a Workplan.
Or:

From the drop-down list box, choose a name from the list of Workplans available.

Choose the Next command button.

A window appears with the contents of the Workplan specified.

Choose the Next command button.
The Object Handler checks the syntax and displays the result.

Note that this step does not apply to Workplans of the types TEXT and LIST.

Choose the Next command button.

The initial Administration Wizard window appears.

Start Object Handler Command Procedure

1.

In the initial Administration Wizard window, choose Start Object Handler command proce-
dure.

A window appears with the Procedure name text box.

Enter the name of a Workplan of the type PROCEDURE.

Or:
From the drop-down list box, choose a name from the list of all Workplans available.

Choose the Next command button.

A window appears with the contents of the Workplan specified.

Choose the Next command button.

The Object Handler executes the command procedure and displays the result.

Choose the Next command button.

The initial Administration Wizard window appears.
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Change Workplan Library

For instructions, see the corresponding function Change Workplan Library described in Advanced
User Administration.

Advanced User Administration

» To invoke the administration function in advanced-user mode

s Inthe Welcome to the Natural Object Handler window, select the Advanced user check box
and choose the Administration button.

The Administration window appears with a table of all Workplans available in your Workplan
library (see also Change Workplan Library below).

The following columns are provided:

Column Explanation

Name The name of the Workplan.

Type The type of Workplan: see Types of Workplan in the section Workplans.
Description|The description of the Workplan.

User The ID of the user who last modified the Workplan.

Date The date and time of the last modification.

If the Workplan library does not contain any Workplan, the table is empty.

» To terminate the administration function in advanced-user mode

= From the Object menu, choose Close.
Or:
Choose the standard Windows close button.

This section covers the following topic:

124 Tools and Utilities



Administration

= Advanced User Administration Table

Advanced User Administration Table

Listed below are the options provided in the Workplan table, along with explanations and
instructions on how to apply them to a Workplan:

Option

Explanation/Instruction

Sort Objects

Sorts Workplans by the columns Name, Type, Description, User or Date.

Select the entire column by which you want to sort the table and double-click on this
column.

Alternatively, select the column by which you want to sort the table and, from the context
or Edit menu, choose Sort Objects.

New Workplan

Creates a new Workplan.

From the Object menu, select New Workplan and the type of Workplan. Depending on
the editing option chosen by selecting or not selecting Free Format Editing from the
Options menu, the following applies:

= With Free Format Editing selected (activated), or if you create a Workplan of a type
other than OPTION, PARAMETER or SELECTION, a window with an edit area appears.
Enter the contents of the Workplan.

= With Free Format Editing not selected (deactivated; this is the default), windows with
input and selection options are provided for Workplans of the type OPTION,
PARAMETER or SELECTION. Select the required check boxes and option buttons and
fill the text boxes.

For information on the syntax used, see the section Direct Commands.

Edit

Modifies an existing Workplan.

Select the Workplan required and double-click on it. Alternatively, select the Workplan
required and, from the context or Object menu, choose Edit.

Open Workplan

Selects and opens a Workplan from a list of all Workplans available.

From the Object menu, choose Open Workplan and, in the Workplan window, enter the
name of a Workplan or select a Workplan from the drop-down list box. In the window
provided, you can edit the Workplan.

For information on the syntax used, see the section Direct Commands.

Delete

Deletes a Workplan.

Select the Workplan required and, from the context or Object menu, choose Delete.

Check

Verifies that the correct syntax is used in a Workplan.

Select the Workplan required and, from the context or Object menu, choose Check.
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Option Explanation/Instruction

Note that the Check option does not apply to Workplans of the type TEXT or LIST.
Execute Executes a Workplan of the type PROCEDURE.

Select the Workplan required and, from the context or Object menu, choose Execute.

Import Imports a Workplan into the file system.

Select any Workplan and, from the context or Object menu, choose Import.

Export Exports a Workplan from the file system.

Select one or more Workplans and, from the context or Object menu, and choose Export.

Change Workplan Library

This function is used to change the Workplan library. All Workplans must be stored in a Workplan
library, as otherwise Workplans cannot control data processing, such as the function Select
OPTION Workplan.

This section covers the following topics:

= | ocal Environments
= Remote Environments

Local Environments

» To change the Workplan library in a local environment

1 From the Actions menu, choose Change Workplan Library.

Or:
Using the administration wizard, in the initial Administration window;, select the option
button Change Workplan library and then choose the Next command button.

A window appears with the following items:

Item Explanation

Library |The name of the Workplan library. Default is the library WORKPLAN.

From the drop-down list box, choose the name of a Workplan library available.

DBID |Specifies the database ID where the Workplan library is located. If no values are specified,
the current FUSER or FNAT system file is used.

FNR  |Specifies the file number where the Workplan library is located. If no values are specified,
the current FUSER or FNAT system file is used.
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2 Enter or select the data required.

3  Choose the OK command button.

Or:

Using the administration wizard, choose the Next command button.

The Workplan library has been changed, and the window appears from where the function
Change Workplan Library was invoked (for the administration wizard, this is the initial
Administration window).

Remote Environments

In remote environments, the function Change Workplan Library also provides the option to
specify permanent files for reports, traces and restarts of load functions (see also the sections Tools

and Restart Load).

In remote environments, report, trace and restart data is written to Natural objects (members) of
the type Text in the Workplan library. The Object Handler assigns them temporary names and
automatically deletes them after two days. When using Change Workplan Library with the Use
permanent text member check box selected, data can be stored in permanent text members that
are kept until overwritten by new data or intentionally deleted by the user.

» To change the Workplan library in a remote environment and specify permanent record files

1  In the initial Administration window, choose the option button Change Workplan library.

A window appears with the following items:

ltem Explanation

Library See Library above.

DBID See DBID above.

FNR See FNR above.

Password The Adabas password of the Adabas file where the Workplan library is
located.

Cipher key The Adabas cipher code of the Adabas file where the Workplan library is

located.

Work file text members

To specify a text member for storing report, restart or trace data, select the
relevant Use permanent text member check box and enter the name of a
Natural object of the type Text in the corresponding text box:

For report data, see also Reports in the section Tools.
For restart data, see also the section Restart Load.
For trace data, see also Traces in the section Tools.
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2 Enter the data required and confirm your changes by choosing the OK command button or
by choosing ENTER.
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21 Object Specification

For the unload, load and scan functions, the Object Handler provides a selection window where
you can select the types of object to be processed or specify a Workplan of the type SELECTION
or LIST.

For each type of object selected, you are provided object-specification windows. These windows
are used to specify selection criteria for the objects to be processed.

This section describes the options provided in the individual object-specification windows.

All Objects

Natural Library Objects

Natural System Error Messages
Natural Command Processor Sources
Natural DDMs

Natural-Related Objects

External Files

FDTs

C L L L L L L L L

Use Selection or List
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22 Object Specification - All Objects

Applies to the load and scan functions only.

The option All objects is used to select all objects available in the work file for processing. For
descriptions of keywords and valid input values, see select -clausein the section Direct Commands.
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23 Object Specification - Natural Library Objects
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Object Specification - Natural Library Objects

This section describes the options provided in the object-specification windows for processing
Natural library objects.

Natural library objects are programming objects (including Natural DDMs), user-defined error
messages and shared resources.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

Natural Library Objects

The specification window for Natural library objects provides the following items:

Item

Explanation

Library

The name of a library or a range of names: see Name in Name, Date and Time Specification.

To choose a name from a selection list of all libraries available, open the drop-down list
box.

DBID

Only applies to the unload function.

The database ID of the system file where the Natural libraries are stored.

FNR

Only applies to the unload function.

The file number of the system file where the Natural libraries are stored. If no values
(or 0) are specified for DBID and FNR, the current FUSER or FNAT system file is used.

Password

Only applies to the unload function if executed in remote environments located on
mainframe platforms.

The Adabas password of the system file where the Natural libraries are stored.

Cipher key

Only applies to the unload function if executed in remote environments located on
mainframe platforms.

The Adabas cipher code of the system file where the Natural libraries are stored.

Name

The name of a Natural programming object or shared resource or a range of names: see
Name.

The default is an asterisk (*), which selects all objects available.

Only evaluated if the check boxes Natural programming objects and/or Shared
resources are selected in the details window, which is the default. See also Natural
Library Object Details.
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Item Explanation

Message from/to |A valid range (1 - 9999) of user-defined error messages delimited by the first and the
last message number.

Only evaluated if the Error messages check box is selected in the details window, which
is the default. See also Natural Library Object Details.

Details Invokes an additional window where you can enter more detailed object specifications:
see Natural Library Object Details.

Settings Only applies to functions executed in advanced-user mode.

Invokes the Settings window where you can specify option and parameter settings:
see the section Seftings.

Unload file Only applies to functions executed in advanced-user mode.
or

Load file The name of the work file to be used for the function.
o See also the section Work Files.

Scan file

(Server)

Browse Only applies to functions executed in advanced-user mode.

Invokes the browse function to select a work file from a directory.

Natural Library Object Details

The details window for Natural library objects is used to specify further selection criteria for
Natural library objects.

For descriptions of keywords and valid input values, see also select-clause in the section Direct
Commands.

The details window for Natural library objects provides the following items:

Item Explanation
Library The name of a library or a range of names: see Name in Name, Date and Time
Specification.

To choose a name from a selection list of all libraries available, open the drop-down
list box.

Ranges are not allowed if the Predict set option is selected.

DBID See DBID in Natural Library Objects above.
FNR See FNR in Natural Library Objects above.
Password See Password in Natural Library Objects above.
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ltem

Explanation

Cipher key

See Cipher key in Natural Library Objects above.

Natural programming
objects

Natural programming objects.

Natural DDMs (data definition modules): In remote environments located on
mainframe platforms, DDMs are located in the FDIC system file. They are not
considered Natural library objects. In other system environments, DDMs are
considered Natural programming objects, which are stored in Natural libraries.

If the FDDM system file has been activated, see also Use FDDM file for processing
DDMs in Settings - Options.

Error messages

User-defined error messages.

Shared resources

Any non-Natural file that is used in a Natural environment and is maintained in
the Natural library system.

Note that shared resources are not defined in remote environments located in
mainframe systems.

Name See Name in Natural Library Objects above.
S/C-Kind The kind of Natural programming object:
Src Source objects only.
Gp Generated programs (cataloged objects) only.
Any All source and/or cataloged objects (generated programs). This is the
default.
Stowed  AllSTOWed objects: source and cataloged objects with identical date
and time.
Both Both source and cataloged objects if both exist.
Anmerkung: Stowed and Both are valid for the unload function only.
Predict set Only applies to the unload and find functions and if Predict is installed.

This option is used to read the names of the objects to be processed from a retained
set. A retained set is created with the save set option of the LIST XREF command.

If the Predict set option is selected, the following applies:

= The Name text box must contain asterisk (*) indicating all objects. This is the
default setting.

® The Library list box must contain the name of a single library. Name ranges are
not allowed.

® The Set number box must be filled.

For detailed information on Predict sets, refer to the Predict documentation.

Set number

Only applies if Predict set is selected.

A one- or two-digit number that identifies the retained set to be used.
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ltem Explanation

Set library Only applies if Predict set is selected.
The name of the library to be searched for a Predict set. If you do not specify a
name, the library entered in the Library list box is used by default.

Set user Only applies if Predict set is selected.
The ID of the user who created the retained set. If no ID is entered, the ID specified
with the system variable *USER (see the System Variables documentation) is used.

Natural Object Types |The types of Natural programming object.

Select All Selects all types of Natural programming object (this is the default).

Deselect All Deselect all types of Natural programming object.

User-defined Messages:

from/to

A range of user-defined error messages as entered in the Message from/to boxes
(see Natural Library Objects above).

User-defined Messages:

S/L-Kind

The kind of user-defined error message text:

Short Short text.

Long Long text.

Any Short and/or long text. This is the default.

Both Short and long texts if both exist (unload function only).

User-defined Messages:

Language codes

Up to 8 valid language codes (for example, code 1 for English) of the specified
error messages.

An asterisk (*) selects all language codes.

Properties

Invokes an extra window where you can specify additional properties of Natural
programming objects: see Natural Library Object Properties below.

Once you have specified any properties, you can activate them by selecting the
check box to the left of the Properties button, or deactivate them by removing the
mark from the check box.

Exceptions

Invokes an extra window where you can specify exceptions to the selection of
Natural programming objects: see Natural Library Object Exceptions below.

Once you have specified any exceptions, you can activate them by selecting the
check box to the left of the Exceptions button, or deactivate them by removing the
mark from the check box.
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Natural Library Object Properties

The Properties window for Natural library objects is used to specify properties for the Natural
library objects selected for processing.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

The Properties window for Natural library objects provides the following items:

Iltem

Explanation

User ID

The ID of the user who last saved the object. Specify a single user ID or a
range of user IDs: see Name in Name, Date and Time Specification.

Natural version

The Natural version of the Natural programming objects. Valid version
format: VRS

where Vis the 1-digit version, R the 1-digit release, and S the 2-digit system
maintenance level.

You can also specify a range of versions: see Naimne.

Mode The programming mode of the Natural programming objects:
Structured Structured mode only.
Report Reporting mode only.
Any No mode check performed. This is the default.

DDM DBID Not valid in remote environments located on mainframe platforms.
The database ID (DBID) of the data definition modules (DDMs). Valid entries
are: 1 to 65535 or 0 (all DBIDs)

DDM FNR Not valid in remote environments located on mainframe platforms.
The file number (FNR) of the DDMs: Valid entries are: 1 to 65535 or 0 (all
FNRs).

Date: Selects all objects, regardless of their date.

Select all objects

Date: Selects all objects with a save or catalog date and/or time within the range
specified in the Date boxes.

Select objects modified

between/and Select a value from the combo box or type values for a start date and/or time
and/or values for an end date and/or time. For valid input values, see Date
and Time in Name, Date and Time Specification. Special dates allowed are:
TODAY, YESTERDAY, MONTH and YEAR.
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Item Explanation
Date: Selects all objects with a save or catalog date and/or time that fits the date/time
specified in the Date box.

Select objects modified on
Select or type values for a date and/or time. For valid input values, see Date
and Time. Special dates allowed are: TODAY and YESTERDAY.

Size: Selects all objects, regardless of their size.
Select all objects
Size: Selects all objects with a size within the range specified in the Size boxes:

type a value for a start size and/or an end size.
Select objects with size

between/and

Size: Selects all objects with a size that fits the size specified in the Size box.

Select objects with size

Natural Library Object Exceptions

The Exceptions window for Natural library objects is used to specify exceptions to the selection
of Natural library objects.

All objects that match the selection criteria specified in Natural Library Objects, Natural Library
Object Details and Natural Library Object Properties are checked against the specifications made
in the Exceptions window. Objects that match all specifications defined as exceptions, are
exempted from processing.

For descriptions of keywords and valid input values, see also select-clause in the section Direct
Commands.

The Exceptions window for Natural library objects is basically identical to the details window.
For explanations of the items listed in the table below, see the relevant section. The Properties
button is used to specify additional properties for Natural programming object exceptions: see
Natural Library Object Exception Properties below.

Iltem

Location:

Library

Object Types:

Natural programming objects
Error messages
Shared resources

Tools and Utilities 139



Object Specification - Natural Library Objects

ltem

Natural Programming Objects and Shared Resources:

Name

Natural Programming Objects:

S/C-Kind
Natural Object Types

Natural System Error Messages:

from/to
Language codes
S/L-Kind

Extras:

Properties

Natural Library Object Exception Properties

The Exception Properties window for Natural library objects is used to specify exceptions to the
properties of the Natural library objects selected for processing.

For descriptions of keywords and valid input values, see also select-clause in the section Direct
Commands.

The Exception Properties window for Natural library objects provides the following items:

Item Explanation

User ID See User ID in Natural Library Object Properties.

Natural version See Natural version in Natural Library Object Properties.

Mode See Mode in Natural Library Object Properties.

DDM DBID See DDM DBID in Natural Library Object Properties.

DDM FNR See DDM FNR in Natural Library Object Properties.

Date: Performs no date check. Objects are processed, regardless of their date.

Ignore date

Date: Exempts from processing all objects with a save or catalog date and/or

time within the range specified in the Date boxes.
Exclude objects modified

between/and Select or type values for a start date and/or time and/or values for an end
date and/or time. For valid input values, see Date and Time in Name, Date
and Time Specification. Special dates allowed are: TODAY, YESTERDAY, MONTH
and YEAR.
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Item Explanation

Date: Exempts from processing all objects with a save or catalog date and/or

time that fits the date/time specified in the Date box.
Exclude objects modified on

Select or type values for a date and/or time. For valid input values, see
Date and Time. Special dates allowed are: TODAY and YESTERDAY.

Size: Performs no size check. Objects are processed, regardless of their size.

Ignore size

Size: Exempts from processing all objects with a size within the range specified

in the Size boxes: type a value for a start size and/or an end size.
Exclude objects with size

between/and

Size: Exempts from processing all objects with a size that fits the size specified

in the Size box.
Exclude objects with size
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Object Specification - Natural System Error Messages

This section describes the options provided in the object-specification windows for processing
Natural system error messages.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

Natural System Error Messages

The specification window for Natural system error messages provides the following items:

Item

Explanation

Number from/to

The range of Natural system error messages delimited by the first and the last message
number.

DBID Only applies to the unload function if executed in remote environments located on
mainframe platforms.
The database ID of the system file where the Natural system error messages are stored.

FNR Only applies to the unload function if executed in remote environments located on
mainframe platforms.
The file number of the system file where the Natural system error messages are stored.
If no values (or 0) are specified for DBID and FNR, the current FNAT system file is used.

Password Only applies to the unload function if executed in remote environments located on
mainframe platforms.
The Adabas password of the system file where the Natural system error messages are
stored.

Cipher key Only applies to the unload function if executed in remote environments located on
mainframe platforms.
The Adabas cipher code of the system file where the Natural system error messages are
stored.

Details Invokes the details window where you can enter more detailed object specifications: see
Natural System Error Message Details below.

Settings Only applies to functions executed in advanced-user mode.
Invokes the Settings window where you can specify option and parameter settings. See
Settings.

Unload file Only applies to functions executed in advanced-user mode.

or

Load file The name of the work file to be used for the function.

or .

Scan file See also Work Files.
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Item Explanation
(Server)
Browse Only applies to functions executed in advanced-user mode.

Invokes the browse function to select a work file from a directory.

Natural System Error Message Details

The details window for Natural system error messages is used to specify further selection criteria
for Natural system error messages.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

The details window for Natural system error messages provides the following items:

Iltem

Explanation

Number from/to

See Number from/to in Natural System Error Messages above.

DBID

See DBID in Natural System Error Messages above.

FNR See FNR in Natural System Error Messages above.
Password See Password in Natural System Error Messages above.
Cipher key See Cipher key in Natural System Error Messages above.
S/L-Kind See S/L-Kind in Natural Library Object Details.

Language codes

See Language codes in Natural Library Object Details.

Exceptions

Invokes an extra window where you can specify exceptions to the selection of Natural
system error messages: see Natural System Error Message Exceptions.

Once you have specified any exceptions, you can activate them by selecting the check
box to the left of the Exceptions button, or deactivate them by removing the mark from
the check box.

Natural System Error Message Exceptions

The Exceptions window for Natural system error messages is used to specify exceptions to the
selection of Natural system error messages.

All Natural system error messages that match the selection criteria specified in Natural System
Error Messages and Natural System Error Message Details are checked against the specifications
made in the Exceptions window. Error messages that match all specifications defined as exceptions,
are exempted from processing.

Tools and Utilities

145



Object Specification - Natural System Error Messages

For explanations of the items contained in the Exceptions window, see Natural System Error
Message Details above.

For descriptions of keywords and valid input values, see also select-clause in the section Direct
Commands.
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Object Specification - Natural Command Processors

This section describes the options provided in the object-specification windows for processing
Natural command processor sources. Natural command processor sources are stored in Adabas

files.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

Natural Command Processor Sources

The specification window for Natural command processor sources provides the following items:

Item

Explanation

Library

The name of a Natural command processor library or a range of names: see Namne in Name,
Date and Time Specification.

DBID

Only applies to the unload function.
The database ID where the Natural command processor sources are stored.

For details, see the SYSNCP Utility in the Utilities documentation.

FNR

Only applies to the unload function.
The file number of the Adabas file where the Natural command processor sources are stored.

If no values are specified, the current setting of LFILE 190 is used. For details, see the SYSNCP
Utility in the Utilities documentation.

Password

Only applies to the unload function.

The Adabas password of the Adabas file where the Natural command processor sources are
stored.

Cipher key

Only applies to the unload function.

The Adabas cipher code of the Adabas file where the Natural command processor sources
are stored.

Name

The name of a Natural command processor source or a range of names: see Name.

Exceptions

Invokes the Exceptions window where you can specify exceptions to the selection of Natural
command processor sources: see Natural Command Processor Source Exceptions below.

Once you have specified any exceptions, you can activate them by selecting the check box to
the left of the Exceptions button, or deactivate them by removing the mark from the check
box.

Settings

Only applies to functions executed in advanced-user mode.

Invokes the Settings window where you can specify option and parameter settings. See
Settings.
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Item Explanation

Unload file |Only applies to functions executed in advanced-user mode.

or
Load file |The name of the work file to be used for the function.

or .
Scan file See also Work Files.

(Server)

Browse Only applies to functions executed in advanced-user mode.

Invokes the browse function to select a work file from a directory.

Natural Command Processor Source Exceptions

The Exceptions window for Natural command processor sources is used to specify exceptions to
the selection of Natural command processor sources.

All objects that match the selection criteria specified in Natural Command Processor Sources are
checked against the specifications made in the Exceptions window. Natural command processor
sources that match a7 specifications defined as exceptions, are exempted from processing.

For descriptions of keywords and valid input values, see also select -clause in the section Direct
Commands.

The Exceptions window for Natural command processor sources provides the following items:

Item Explanation

Library|The name of a Natural command processor library or a range of names: see Name in Name, Date
and Time Specification.

Name |The name of a Natural command processor source or a range of names: see Namze.
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Object Specification - Natural DDMs

Only applicable to remote environments located on mainframe platforms.

This section describes the options provided in the object-specification windows for processing
Natural DDMs (data definition modules).

On mainframe platforms, DDMs are stored in the FDIC system file. The DDMs to be processed
by the Object Handler are located in the default FDIC file. If you want to specify a different FDIC
file, use the option-setting clause described in the section Direct Commands.

For descriptions of keywords and valid input values, see also the select-clause described in the
section Direct Commands.

Natural DDMs

The specification window for Natural DDMs provides the following items:

Item Explanation
Name The name of a DDM or a range of names: see Name in Name, Date and Time Specification.
Details Invokes an additional window where you can enter further object specifications: see Natural
DDM Details.
Display FDIC |This field is available in advanced-user mode only.
Displays the current FDIC setting.
Set FDIC This field is available with the load or unload wizard only.
Provides a window where you can modify the current FDIC setting.
Settings Only applies to functions executed in advanced-user mode.
Invokes the Settings window where you can specify option and parameter settings. See
Settings.
Unload file  [Only applies to functions executed in advanced-user mode.
or
Load file The name of the work file to be used for the function.
or .
Scan file See also Work Files.
(Server)
Browse Only applies to functions executed in advanced-user mode.
Invokes the browse function to select a work file from a directory.
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Natural DDM Details

The details window for Natural DDM:s is used to specify further selection criteria for Natural

DDMs.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

The details window for Natural DDMs provides the following items:

Select all objects

Item Explanation

Name The name of the DDM or a range of names: see Name in Name, Date
and Time Specification.

DDM DBID See DDM DBID in Natural Library Object Properties.

DDM FNR See DDM FNR in Natural Library Object Properties.

Date: Selects all objects, regardless of their date.

Date:

Select objects modified
between/and

See Date in Natural Library Object Properties.

Date:

Select objects modified on

See Date in Natural Library Object Properties.

Select objects with size
between/and

Size: Selects all objects, regardless of their size.
Select all objects
Size: Selects all objects with a size within the range specified in the Size

boxes: type a value for a start size and/or an end size.

Size:

Select objects with size

Selects all objects with a size that fits the size specified in the Size box.

Exceptions

Invokes an extra window where you can specify exceptions to the
selection of Natural DDMs: see Natural DDM Exceptions.

Once you have specified any exceptions, you can activate them by
selecting the check box to the left of the Exceptions button, or
deactivate them by removing the mark from the check box.
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Natural DDM Exceptions

The Exceptions window for Natural DDMs is used to specify exceptions to the selection of Natural
DDMs.

All objects that match the selection criteria specified in Natural DDMs and Natural DDM Details
are checked against the specifications made in the Exceptions window. DDMs that match all spe-
cifications defined as exceptions, are exempted from processing.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

The Exceptions window for Natural DDMs provides the following items:

Ignore date

Item Explanation

Name The name of a DDM or a range of names: see Name in Name, Date
and Time Specification.

User ID See User ID in Natural Library Object Properties.

DDM DBID See DDM DBID in Natural Library Object Properties.

DDM FNR See DDM FNR in Natural Library Object Properties.

Date: Performs no date check. Objects are processed, regardless of their

date.

Date:

Exclude objects modified
between/and

See Date in Natural Library Object Exception Properties.

Date:

Exclude objects modified on

See Date in Natural Library Object Exception Properties.

Size:

Ignore size

Performs no size check. Objects are processed, regardless of their
size.

Size:

Exclude objects with size
between/and

Exempts from processing all objects with a size within the range
specified in the Size boxes: type a value for a start size and/or an
end size.

Size:

Exclude objects with size

Exempts from processing all objects with a size that fits the size
specified in the Size box.
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Object Specification - Natural-Related Objects

This section describes the options provided in the object-specification windows for processing
Natural-related objects located on Windows, UNIX, OpenVMS or mainframe platforms. On Win-
dows, UNIX and OpenVMS platforms, Natural-related objects are objects that exist in a Natural
environment but are not located in Natural libraries, such as the Natural parameter module
NATPARM, which is located in Natural path PARM_PATH. On mainframe platforms, Natural-
related objects are profiles, debug environments and DL/I subfiles.

Note that not all of the fields may appear in the object-specification windows because they depend
on the object location, the version of the Natural Development Server installed, the type of object
selected and the function used.

Process Natural-related objects in internal format, that is, do not select the Transfer format check
box. See also Work File Format in the section Work Files.

For descriptions of keywords and valid input values, see also select-clause in the section Direct
Commands.

Natural-Related Objects - Windows, UNIX and OpenVMS

The specification window for Natural-related objects located on Windows, UNIX or OpenVMS
platforms provides the following items:

Item Explanation

Natural path |Enter the name of the path where the Natural-related object is located or select a path from
the drop-down list box.

Valid path names are:

NATDIR, NATVERS, NATBIN, NATERR, NATSAG, PARM_PATH, PROFILE_PATH,
TEXT PATH, TMP_PATH.

Load and scan:
Enter the name of a path or asterisk (¥) to select all paths.

Object name |The name of a Natural-related object.

Load and scan:
A single name or a range of names: see Name in Name, Date and Time Specification.

Select Invokes the browse function to select a Natural-related object from a directory.

Details Invokes the details window where you can enter further object specifications: see
Natural-Related Object Details - Windows, UNIX and OpenVMS.

Settings Only applies to functions executed in advanced-user mode.

Invokes the Settings window where you can specify option and parameter settings. See
Settings.
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Item Explanation

or

Unload file |Only applies to functions executed in advanced-user mode.

Load file The name of the work file to be used for the function.

or .

Scan file See also Work Files.

(Server)

Browse Only applies to functions executed in advanced-user mode.

Invokes the browse function to select a work file from a directory.

This section covers the following topics:

= Natural-Related Object Details - Windows, UNIX and OpenVMS
= Natural-Related Object Exceptions - Windows, UNIX and OpenVMS

Natural-Related Object Details - Windows, UNIX and OpenVMS

The details window is used to specify further selection criteria for Natural-related objects located
on Windows, UNIX or OpenVMS platforms.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

The details window for Natural-related objects located on Windows, UNIX or OpenVMS platforms

provides the following items:

Item

Explanation

Natural path

See Natural path in Natural-Related Objects - Windows, UNIX and
OpenVMS above.

Object name

See Object name in Natural-Related Objects - Windows, UNIX and
OpenVMS above.

Select objects modified on

Select Invokes the browse function to select an object from a directory.
Date: Selects all objects, regardless of their date.

Select all objects

Date: See Date in Natural Library Object Properties.

Select objects modified

between/and

Date: See Date in Natural Library Object Properties.

Size:

Selects all objects, regardless of their size.
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Item Explanation

Select all objects

Size: Selects all objects with a size within the range specified in the Size

boxes: type a value for a start size and/or an end size.
Select objects with size

between/and

Size: Selects all objects with a size that fits the size specified in the Size box.

Select objects with size

Exceptions Invokes an extra window where you can specify exceptions to the
selection of Natural-related objects: see Natural-Related Object
Exceptions - Windows, UNIX and OpenVMS.

Once you have specified any exceptions, you can activate them by
selecting the check box to the left of the Exceptions button, or deactivate
them by removing the mark from the check box.

Natural-Related Object Exceptions - Windows, UNIX and OpenVMS

The Exceptions window is used to specify exceptions to the selection of Natural-related objects
located on Windows, UNIX or OpenVMS platforms.

All Natural-related objects that match the selection criteria specified in Natural-Related Objects
- Windows, UNIX and OpenVMS and Natural-Related Object Details - Windows, UNIX and
OpenVMS are checked against the specifications made in the Exceptions window for Natural-
related objects. Objects that match all specifications defined as exceptions, are exempted from
processing.

For descriptions of keywords and valid input values, see also select-clause in the section Direct
Commands.

The Exceptions window for Natural-related objects located on Windows, UNIX or OpenVMS
platforms provides the following items:

Item Explanation

Natural path See Natural path in Natural-Related Objects - Windows, UNIX and
OpenVMS above.

Object name See Object name in Natural-Related Objects - Windows, UNIX and
OpenVMS above.

Select Invokes the browse function to select an object from a directory.

Date: Performs no date check. Objects are processed, regardless of their
date.

Ignore date

Date: See Date in Natural Library Object Exception Properties.
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Exclude objects modified on

Item Explanation

Exclude objects modified

between/and

Date: See Date in Natural Library Object Exception Properties.

Size:

Ignore size

Performs no size check. Objects are processed, regardless of their
size.

Size:

Exclude objects with size
between/and

Exempts from processing all objects with a size within the range
specified in the Size boxes: type a value for a start size and/or an
end size.

Size:

Exclude objects with size

Exempts from processing all objects with a size that fits the size
specified in the Size box.

Natural-Related Objects - Mainframes

The specification window for Natural-related objects located on mainframe platforms provides

the following items:

Item Explanation

Profile

DL/I subfile

Object type |The type of object to be processed:

Debug environment

FNR

DBID Only applies to the unload function.

Password The database ID (DBID), file number (FNR), password and cipher code (cipher key) of the
Cipher key Adabeas file where the objects are stored.

If no values (or 0) are specified, the current FNAT system file is used.

Load and scan:

Object name |The name of the object.

A single name or a range of names: see Name in Name, Date and Time Specification.

Details Invokes the details window where you can enter further object specifications: see
Natural-Related Object Details - Mainframes.

Settings.

Settings Only applies to functions executed in advanced-user mode.

Invokes the Settings window where you can specify option and parameter settings. See
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Item Explanation

Unload file |Only applies to functions executed in advanced-user mode.

E:)ad file The name of the work file to be used for the function.

gl;:an file See also Work Files.

(Server)

Browse Only applies to functions executed in advanced-user mode.
Invokes the browse function to select a work file from a directory.

This section covers the following topics:

= Natural-Related Object Details - Mainframes
= Natural-Related Object Exceptions - Mainframes

Natural-Related Object Details - Mainframes

The details window is used to specify further selection criteria for Natural-related objects located
on mainframe platforms.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

The details window for Natural-related objects located on mainframe platforms provides the fol-
lowing items:

Item Explanation

Object type |See Object type in Natural-Related Objects - Mainframes above.
DBID See DBID/FNR in Natural-Related Objects - Mainframes above.
FNR

Password

Cipher key

Object name

See Object name in Natural-Related Objects - Mainframes above.

Subtype

Applies to profiles and DL/I subfiles.

The type(s) of profile or the type(s) of DL/I subfile to be processed:

Device profile
Editor profile
Map profile
Parameter profile

NSB subfile
NDB subfile

160

Tools and Utilities




Object Specification - Natural-Related Objects

Item Explanation
Library Applies to debug environments.
The name of a library or a range of names: see Name in Name, Date and Time Specification.
To choose a name from a selection list of all libraries available, open the drop-down list box.
Exceptions |Invokes an extra window where you can specify exceptions to the selection of Natural-related

objects: see Natural-Related Object Exceptions - Mainframes.

Once you have specified any exceptions, you can activate them by selecting the check box
to the left of the Exceptions button, or deactivate them by removing the mark from the check
box.

Natural-Related Object Exceptions - Mainframes

The Exceptions window is used to specify exceptions to the selection of Natural-related objects
located on mainframe platforms.

All Natural-related objects that match the selection criteria specified in Natural-Related Objects
- Mainframes and Natural-Related Object Details - Mainframes are checked against the specifi-
cations made in the Exceptions window for Natural-related objects on mainframes. Objects that
match all specifications defined as exceptions, are exempted from processing.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

The Exceptions window for Natural-related objects located on mainframe platforms provides the
following items:

Item Explanation

Object type |See Object type in Natural-Related Objects - Mainframes above.
DBID See DBID/FNR in Natural-Related Objects - Mainframes above.
FNR

Password

Cipher key

Object name

See Object name in Natural-Related Objects - Mainframes above.

Subtype

See Subtype in Natural-Related Object Details - Mainframes above.

Library

See Library in Natural-Related Object Details - Mainframes above.
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Object Specification - External Files

Not applicable to remote environments located on mainframe platforms.

This section describes the options provided in the object-specification windows for processing
external files. External files are files that are located outside Natural and Adabas environments,
such as bitmaps.

Process external files in internal format, that is, do not select the Transfer format check box. See
also Work File Format in the section Work Files.

For descriptions of keywords and valid input values, see also select-clause in the section Direct
Commands.

External Files

The specification window for external files provides the following items:

Item Explanation

External path |Enter the name of the path where the external file is located or select a path from the
drop-down list box.

Load and scan:
Enter the name of a path or asterisk (*) to select all paths.

Object name |The name of an external file.

Load and scan:
A single name or a range of names: see Name in Name, Date and Time Specification.

Select Invokes the browse function to select an object from a directory.

Details Invokes the details window where you can enter further object specifications: see External
File Details.

Settings Only applies to functions executed in advanced-user mode.

Invokes the Settings window where you can specify option and parameter settings. See

Settings.
Unload file  |Only applies to functions executed in advanced-user mode.
or
Load file The name of the work file to be used for the function.
or .
Scan file See also Work Files.
(Server)
Browse Only applies to functions executed in advanced-user mode.

Invokes the browse function to select a work file from a directory.
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External File Details

The details window for external files is used to specify further selection criteria for external files.

For descriptions of keywords and valid input values, see also select -clause in the section Direct

Commands.

The details window for external files provides the following items:

Item

Explanation

External path

See External path in External Files above.

Object name

See Object name in External Files above.

Select objects modified between/and

Select Invokes the browse function to select an object from a directory.
Date: Selects all objects, regardless of their date.

Select all objects

Date: See Date in Natural Library Object Properties.

Date:

Select objects modified on

See Date in Natural Library Object Properties.

Select objects with size between/and

Size: Selects all objects, regardless of their size.
Select all objects
Size: Selects all objects with a size within the range specified in the Size

boxes: type a value for a start size and/or an end size.

Size:

Select objects with size

Selects all objects with a size that fits the size specified in the Size
box.

Exceptions

Invokes an extra window where you can specify exceptions to the
selection of external files: see External File Exceptions.

Once you have specified any exceptions, you can activate them by
selecting the check box to the left of the Exceptions button, or
deactivate them by removing the mark from the check box.

Tools and Utilities

165



Object Specification - External Files

External File Exceptions

The Exceptions window for external files is used to specify exceptions to the selection of external

files.

All external files that match the selection criteria specified in External Files and External File
Details are checked against the specifications made in the Exceptions window. Objects that match
all specifications defined as exceptions, are exempted from processing.

For descriptions of keywords and valid input values, see also select-clause in the section Direct

Commands.

The Exceptions window for external files provides the following items:

Iltem

Explanation

External path

See External path in External Files above.

Object name

See Object name in External Files above.

Select

Invokes the browse function to select an object from a directory.

Date:

Ignore date

Performs no date check. Objects are processed, regardless of their
date.

Date:

Exclude objects modified between/and

See Date in Natural Library Object Exception Properties.

Date:

Exclude objects modified on

See Date in Natural Library Object Exception Properties.

Size:

Ignore size

Performs no size check. Objects are processed, regardless of their
size.

Size:

Exclude objects with size between/and

Exempts from processing all objects with a size within the range
specified in the Size boxes: type a value for a start size and/or an
end size.

Size:

Exclude objects with size

Exempts from processing all objects with a size that fits the size
specified in the Size box.
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The specification window for FDTs is used to select Adabas FDTs (Field Definition Tables) for
processing.

] Note: When loading FDTs, all FDT data is written to Work File 5. You can use the contents

of this work file as input for the Adabas utility ADAFDU. To select another work file,
choose Settings from the Options menu, and, in the Additional Options window, on the
tabbed page Special, specify the ADAFDU file.

For descriptions of keywords and valid input values, see also select-clause in the section Direct
Commands.

The specification window for FDTs provides the following items:

Item Explanation

DBID The database ID where the FDT is located.

Load and scan:
A valid DBID or 0 for all DBIDs.

FNR The file number where the FDT is located.

Load and scan:
A valid FNR or 0 for all FDTs.

Password |The Adabas password of the Adabas file where the FDT is located.
Cipher key | The Adabas cipher code of the Adabas file where the FDT is located.

Settings  |Only applies to functions executed in advanced-user mode.

Invokes the Settings window where you can specify option and parameter settings. See
Settings.

Unload file |Only applies to functions executed in advanced-user mode.

or
Load file |The name of the work file to be used for the function.
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Item Explanation

or See also Work Files.

Scan file

(Server)

Browse Only applies to functions executed in advanced-user mode.
Invokes the browse function to select a work file from a directory.
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Use Selection or List

This option is used to specify a Workplan of the type SELECTION or LIST. These Workplans
specify selection criteria for the objects to be processed. See also the section Workplans.

The specification window provides the following items:

Item Explanation
Name The name of the Workplan to be processed.
To choose a name from a selection list of Workplans available, open the drop-down list box.
Settings  |Only applies to functions executed in advanced-user mode.
Invokes the Settings window where you can specify option and parameter settings. See
Settings.
Unload file |Only applies to functions executed in advanced-user mode.
or
Load file |The name of the work file to be used for the function.
or .
Scan file See also Work Files.
(Server)
Browse Only applies to functions executed in advanced-user mode.

Invokes the browse function to select a work file from a directory.
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31 Settings

The settings option is used to specify option settings for the unload, load, find or scan function
and parameter settings for the unload or load function.

» To invoke the Settings window

s In the Welcome to the Natural Object Handler window, from the Options menu, choose
Settings.

Or:

In advanced-user mode, during the unload or load function, from the Options menu, choose
Settings.

Or:

In advanced-user mode, during the unload or load function, in an object-specification window,
choose the Settings button.

The Settings window appears with the tabs Options and Parameters.

This section describes the items contained on the pages that belong to the tabs Options and Para-
meters of the Settings window and associated windows and window tabs:

@ Settings - Options

Settings - Parameters
- g
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On the tabbed page Options of the Settings window you can specify the following:

Item

Explanation

Transfer format

Only activated if Use default options (this is the default) or Use additional options
has been selected. See below.

Unload:
The data to be unloaded is written in Transfer format to the work file.

Load and scan:
The data to be loaded or scanned are expected to be in Transfer format.

Local work file

Only applies to remote environments.

Specifies the location of the work file when using Object Handler functions in
connection with SpoD (Single Point of Development). If Local work file is selected,
depending on the function used, the data to be processed is written to or read from
the work file specified in the local file system.

See also WFLOC in Direct Commands.

Portable work file

Not applicable to work files located in a remote environment on a mainframe
platform.

In addition, this option is not required for the load and scan functions, which
automatically choose the appropriate work file type and ignore the option if set.

Portable work file is only activated if the following applies:

® Use default options (this is the default) or Use additional options has been
selected (see below) and
= Transfer format has not been selected.

If Portable work file has been selected, the work file is written or read in portable
format. See also Work File Format in Work Files.

Fixed length

Only available with the unload function.

See FIXEDLENGTH in Direct Commands.

Unicode work file

Only applies to the unload function and if Transfer format has been selected.

If this option is selected, all object sources are converted to Unicode/UTF-8
(Universal Transformation Format, 8-bit form) before they are written to the work
file.

If a unicode work file is specified, you cannot use the transfer options Use
conversion table, Substitute line references and Incorporate free rules.

Unload file Only activated if Use default options (this is the default) or Use additional options
has been selected (see below).

or

Load file The name of the work file to be used for the function. See also Work Files.

or
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Item Explanation

Scan file

(Server)

Browse Not applicable to server unload/load/scan files.

Invokes the browse function to select a work file from a directory.

Use default options | Default options are used (this is the default). See also Set Additional Options below.

Use additional options |Used in connection with Set (see below).

Set Only activated if Use additional options has been selected.

Invokes the Options window where you can modify the default settings and enter
additional options for the processing sequence. For the options available, see Set
Additional Options below.

Use Option Workplan |If this option is selected, a Workplan of the type OPTION is used.

Select a Workplan from the combo box or type the name of a Workplan of the type
OPTION.

See also Workplans.

List Only activated if Use Option Workplan (see above) has been selected and the

name of a valid Workplan of the type OPTION is entered.
(Option Workplan)

Displays the contents of the Workplan specified.

Set Additional Options

Special unload options are set in the Additional Options window.

» To invoke the Additional Options window

= Inthe Settings window, on the tabbed page Options, select the option button Use additional
options and choose the Set button.

The Additional Options window contains the tabs General, Special, Transfer and XREF. Note
that not all of the tabs may appear on the screen, because they depend on the function used, the
settings defined and the products installed.

The options provided on the tabbed pages are described in the following section. For descriptions
of mentioned keywords and valid input values, see also option-settingin the section Direct
Commands.

This section covers the following topics:

= General
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= Special
= Transfer
= XREF

General

The tabbed page General of the Additional Options window contains the group boxes Report,
FDIC and FSEC where you can specify the following;:

Item

Explanation

Write report

Writes a report of the objects processed to Work File 4. This is the default setting for
object processing except for the find function.

In remote environments, the report data is written to a Natural text member that is
stored in the Workplan library.

To display a report, select Show Report File from the Options menu. See also Reports
in Tools.

Start new report

Only activated if Write report has been selected.

Deletes the contents of Work File 4 before a new report is written.

Use Report option
in Find
commands

Only applies to the find function and if Write report has been selected.

If selected, this option writes a report of the objects found by using the same report
settings (for example, the name of the report file and the additional option Start new
report) specified for the unload, load or scan function.

If this option has not been activated for the current find command, no report is written.
In this case, the Show Report File option (see also Reports in Tools) will only display
old report data of a previous find, unload, load or scan function, if performed.

Report file

Only available in local environments and if Write report has been selected.

The name of a report file. Choose the Browse button to select a name from a directory.

FDIC

Only applies if Predict is installed.

With the FDIC option, you specify the Predict file (FDIC) used for processing XRef data:

DBID The database ID where the FDIC file is located.
FNR The file number where the FDIC file is located.

Password Optional. The Adabas password of the Adabas file where the FDIC file is
located.

Cipher key Optional. The cipher code of the Adabas file where the FDIC file is located.

FSEC

Only applies if Natural Security is installed.

With the FSEC option, you specify the Natural Security data file (FSEC) used for security

checks:
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Item Explanation
DBID The database ID where the FSEC file is located.
FNR The file number where the FSEC file is located.

Password Optional. The Adabas password of the Adabas file where the FSEC file is

Cipher key Optional. The cipher code of the Adabas file where the FSEC file is located.

located.

Special

The tabbed page Special contains the group boxes Replace, Load/Scan and Load where you can

specify the following;:
Item Explanation
Replace all Replaces all objects.

Do not replace

Does not replace any objects. This is the default.

Replace obsolete objects

Replaces objects with a date older than the date of the objects in the load file.

Replace except newer

Replaces all objects except those with a date newer than the date of the objects in
the load file.

Write restart

Only applies to the load function.

information
When this option is set, restart information is provided for the restart load function.
See also Restart Load in Functions.

Restart file Only applies to the load function in local environments and if Write restart

information has been selected.

The name of the work file to be used for the restart data: Work File 6 (default
setting) or the restart-file specified.

Choose the Browse button to select a name from a directory.

For further information, see Restart Load in Functions.

Check version

Only applies when loading objects in a mainframe environment.

Checks the Natural version of the cataloged object to be loaded: the Natural
version under which the objects were cataloged and written to the work file is
compared with the current Natural version. Objects cataloged under a Natural
version higher than the current one will be rejected.

ADAFDU file

See ADAFDUWORKFILE in option-settingin Direct Commands.

Choose the Browse button to select a name from a directory.
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Item Explanation

Number of objects to  |Specifies the number of objects to be processed.

process
Enter a value with a maximum of 5 digits. If a value greater than 0 (zero) is

specified, the load or scan function stops after the specified number of objects has
been processed.

Anmerkung: If a cataloged Natural object is processed directly after the source

object of the same name, they are considered one object.

Use FDDM file for Only applies in environments where the FDDM system file has been activated in
processing DDMs the NATPARM module.

If this option has been activated (this is the default), the FDDM system file is used
for processing DDMs with the load, unload or find function.

Specify the library SYSTEM and the Natural object type V (see Natural Library
Object Details in Object Specification) for processing DDMs.

If used with the load function, all DDMs are loaded into the FDDM system file.
In this case, the parameter NEWLIBRARY is ignored.

See also the syntax diagram of the option-clause in Direct Commands.

Transfer

The tabbed page Transfer of the Additional Options window contains the group boxes Load,
Conversion Table, Unload and Data Area Format.

The items provided in these group boxes and the functions to which they apply are described in
the following section.

Item Explanation Function
Translate into upper |Translates any source code to be loaded to upper case. Load
case

Load code page In this text box, you can enter the name of the code page to be used for the|Load

load function.

If a code page is specified, all object sources unloaded into a work file in
UTE-8 will be converted with the specified code page when they are loaded
into a work file. See also Unicode work file.

If you enter *CODEPAGE as the code page name, the value assigned to the
system variable *CODEPAGE is used (see the System Variables
documentation).

If no code page name is specified, the source objects are converted with
the code page used when unloading them.
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Item Explanation Function

If Load code page is specified, you cannot use the options Use conversion
table and Translate into upper case.

Use conversion table |Unload: Unload
Converts data to EBCDIC format by using the internal Natural conversion|Load
table (System table) or a conversion table defined by the user (User-defined
table).

Load:

Converts data to ASCII format by using the internal Natural conversion
table (System table) or a conversion table defined by the user (User-defined
table). Note that this only applies if the data in the work file is in EBCDIC
format or if a conversion program is specified (see User-defined table).

System table Only activated if Use conversion table has been selected. Unload
Load
Unload:
Converts data to EBCDIC format by using the internal Natural conversion
table.
Load:
Converts data to ASCII format by using the internal Natural conversion
table.
User-defined table  |Only activated if Use conversion table has been selected. Unload
Load

Specifies that a user-defined table is to be used for conversion.

If the name of a conversion program has been entered in the text box Table
Name for Load function or Table name for Unload function (see below),
data is converted to EBCDIC or ASCII format by using the conversion
program defined.

To specify an individual conversion program, the program must be stored
in the library SYSOBJH or one of its steplibs. See the example program
OTNCONAE in the library SYSOBJH.

If no conversion program is specified, by default, the corresponding
conversion table in the Natural file NATCONV.INI is used for the unload
([1SO8859_1->EBCDIC] ) and the load ([EBCDIC->ISO8859_1]) functions.

Table name for Load |Only activated if User-defined table has been selected. Load

function
Enter the name of a user-defined conversion table.

Table name for Only activated if User-defined table has been selected. Unload

Unload function
Enter the name of a user-defined conversion table.

Substitute line Only applies if source-code line numbers are used for statement references.|Unload

references
If line numbers are used as references in the source code, the line numbers

of referenced lines and the line number references are replaced with labels.
The sources are not modified in the database.
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Item Explanation Function

Include line numbers |If you choose this option, the line numbers will be transferred. Unload
(By default, line numbers in Natural objects are not transferred.)

Incorporate free rules |If Predict is installed, Predict rules associated with a map are incorporated |Unload
into the map source.

Leave data areas as  |Does not convert data area sources to the new internal data area format or|Unload

they are the old internal data area format (see below). This is the default. Load

Convert data areas  |Converts data area sources to the new internal data area format. Unload

into new internal Load

format For details, see Data Area Editor in the Editors documentation.

Convert data areas Converts data area sources to the old internal data area format. Unload

into old internal Load

format If one or more data area sources cannot be converted to the old internal
data area format, the Object Handler issues a corresponding message when
unloading is complete. In addition, in the Status column of the unload
report generated by the unload function, a corresponding remark appears
next to the names of the data area sources affected.

XREF

The tabbed page XREF of the Additional Options window contains the group boxes Load and
Unload. XREEF is only available when unloading or loading data in internal format, that is, if the
check box Transfer format has not been selected. Predict must be installed to process XRef data.

The items provided in the group boxes and the functions to which they apply are described in the
following section.

Item Explanation Function

On Unload: Unload
Unloads GPs (generated programs, that is, cataloged objects) and their cross-reference |Load
data, if any.
Load:
Loads GPs and their cross-reference data if cross-references exist in the work file.

Off Ignore XRef data. Unload

Load

No XRef data is processed.

Doc  |Predict definition required. Load
Loads cataloged objects only if Predict entries exist for the objects in the FDIC system file.

Force |XRef data and Predict definition required. Load
Loads GPs (generated programs) and their cross-reference data only if cross-references
exist in the work file and if Predict entries exist for the objects in the FDIC system file.
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Item Explanation Function

Special |Load GPs and XRef data. Load

Loads GPs and their cross-reference data (if any).
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On the tabbed page Parameters of the Settings window you can specify the following:

Item Explanation

Do not use parameters |If selected (default setting), no parameters are set.

Use global parameters |Used in connection with Set (see below).

Global parameters are used. See also Set Global Parameters below.

Set Only activated if Use global parameters has been selected.

(global parameters) Invokes the Unload/Load Parameters window. See Set Global Parameters below
for descriptions of keywords and valid input values.

Use Parameter Workplan |If selected, a Workplan of the type PARAMETER is used.

Select a Workplan from the combo box or type the name of a Workplan of the
type PARAMETER.

See also Workplans.

List Only activated if Use Parameter Workplan (see above) has been selected and

the name of a valid Workplan of the type PARAMETER was entered.
(Parameter Workplan)

Displays the contents of the Workplan specified.

Set Global Parameters

Only applies to the load or unload function.

You can use global parameter to change the settings for the objects to be processed with the load
or unload function, and to change the target environment for the load function. For example, you
can specify new names (or name ranges) under which the selected objects are unloaded to the
work file, or you can specify a different library into which the selected objects are loaded from the
work file.

If global parameters are specified during the unload function, the parameter settings affect the
objects before they are written to the work file. If they are specified during the load function, the
parameter settings affect the objects before they are written to the target environment.

Global parameters are set in the Unload/Load Parameters window.

» To invoke the Unload/Load Parameters window

»  In the Settings window, on the tabbed page Parameters, select the Use global parameters
option button and choose Set.
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The tabbed page Parameters contains the group boxes General and Load Target. The items provided
in these group boxes and the data you can specify are described in the following section.

= General
= | oad Target

General

The tabbed page General contains a table where the relevant parameters are listed in the Parameters
column. The values that can be specified to change the settings of the parameters are entered in
the columns Value and New Value.

New Value does not apply to the parameter Error number difference and target system file spe-
cifications for load functions.

If no value has been entered in Value, the value entered in New Value affects all objects to which
the specific parameter setting applies. If a value has been entered in Value, the value entered in
New Value only affects objects to which the specific parameter setting and the value entered in
Value apply.

If a value or new value is not relevant to the type of object to be processed, any value entered in
either column will be ignored. For example: Natural system error messages have no library name.
Therefore, when processing Natural system error messages, a value entered in Value or New
Value for the parameter Library will be ignored.

For valid parameter settings, see also parameter-settingin the section Direct Commands.

On the tabbed page General you can specify the following;:

Parameter Explanation

Name Value/New Value:

A single object name or a range of names: see Name in Name, Date and Time Specification
and Rules for New Values.

Library Value/New Value:

A single library name or a range of names: see Name and Rules for New Values.

Date Value/New Value:

A single date or a range of dates: see Date and Time in Name, Date and Time Specification,
and Rules for New Values.

User 1ID Value/New Value:

A single user ID or a range of user IDs: see Name and Rules for New Values.
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Parameter Explanation

Language code|Only applies when processing Natural system error messages or user-defined error
messages.

Value/New Value:

Up to 8 valid language codes such as code 4 for Spanish. If more than one language code
is specified, Value must contain the same number of language codes. In this case, the
language code in Value is replaced by the language code in the corresponding New Value.

Note: New Value does not apply to the long texts of Natural system error messages for
which English (code 1) is the only valid language.

Error number |Only applies when processing Natural system error messages or user-defined error
difference |messages.

A 4-digit positive or negative value (+/-nnnn) to be used as a new number range for error
messages. Start and end values must be provided in the Number from/to or Message
from/to boxes to validate whether the new range can be applied to the selected error
messages.

Example:

If Number from/to selects message numbers 1 to 10 and Error number difference is set
to 2000, the messages will be renumbered from 2001 to 2010. A value of -1000 in Error
number difference would cause a validation error.

FDT DBID Value/New Value:

A valid database ID (DBID) for the Adabas FDT.
FDT FNR Value/New Value:

A valid file number (FNR) for the Adabas FDT.
External path|Value/New Value:

The name of the path for external files.

Rules for New Values
The following applies to New Value for Name, Library, Date and User ID:

If New Value contains a range with an asterisk (*) such as ABC*, the number of characters before
the asterisk (*) determines the number of characters to be replaced in Value. This is also valid if
Value is shorter than the range specified in New Value (see the second example in Examples 2
below).

Examples:

1. If Name is ABCDEFG and New Value is set to 7YX*, the resulting object name is ZYXDEFG.

2. If Name is AB and New Value is set to ZYX*, the resulting object name is ZYX.
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3. If Date is 2005-03-26 and New Value is set to 2006*, the resulting object date is 2006-03-26.

Load Target

The tabbed page Load Target only applies to the load function.

The page contains the group boxes Load FNAT, Load FUSER and Load NCP where you can

specify the following;:

Item Explanation

Load FNAT: |The database ID (DBID) and file number (FNR) of the target FNAT system file. This system
file is used for all library objects whose library name starts with SYS, but not SYSTEM.

DBID

FNR In remote environments, you can also specify the Adabas password and cipher code.

Password

Cipher key

Load FUSER: |The DBID and FNR of the target FUSER system file. This system file is used for all library
objects whose library name does not start with SYS, and for the library SYSTEM.

DBID

FNR In remote environments, you can also specify the Adabas password and cipher code.

Password

Cipher key

Load NCP:  |The DBID and FNR of the target Adabas file into which the Natural command processor
sources are to be loaded. Additionally, you can specify the Adabas password and cipher

DBID code.

FNR

Password

Cipher key
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Workplans

Workplans define individual standard procedures for command execution, object selection and
parameter or option settings which can be used to further automate function processing.

Workplans are Natural objects of the type Text. They are, by default, stored in the library
WORKPLAN located in the current FUSER system file.

Creating, Selecting and Modifying Workplans

You can use the administration function (see the relevant section) to create a Workplan, select a
Workplan from a list, modify a Workplan, or change the default library for Workplans. The default
library can also be changed by using the Workplan-Library entry of the Profile option (see also
Profile Settings).

Contents of Workplans

A Workplan consists of a header (generated by the Object Handler) and an associated instructional
or textual part. Instructional parts contain Object Handler commands and parameter and/or option
settings. Textual parts contain plain text only. Header and instructional or textual parts can contain
comments (for example, the short description of the Workplan) that must start with the delimiter
characters /* and are restricted to one line.

There are six types of Workplan: PROCEDURE, SELECTION, LIST, PARAMETER, OPTION and
TEXT.

The table below lists the valid headers (to be entered if creating a Workplan outside the Object
Handler) for the corresponding types of Workplan and describes the contents of the instructional
or textual part. Additionally, it provides cross references to the clauses that apply when specifying
Object Handler direct commands. The Object Handler direct commands provided are explained
in the section Direct Commands.

Valid Headers Contents
Related Topic in Direct
Commands
TYPE PROCEDURE |An Object Handler command procedure. Basic Command Syntax
This Workplan can contain any combination of Object
Handler commands available for PROCEDURE. Enter a
sequence of commands separated by semicolons (;).
TYPE SELECTION |Selection criteria for objects. select-clause
This Workplan can be used in Object Handler Workplan
commands.

190 Tools and Utilities



Workplans

This Workplan can be used in Object Handler Workplan
commands.

Valid Headers Contents
: Related Topic in Direct
Commands
TYPE LIST A list of objects. select-clause

Object List - LIST
Workplan

TYPE PARAMETER

Parameters for the unload or load function.

This Workplan can be used to change attributes for the
objects to be processed such as the name of a new target
library where objects are loaded.

TYPE PARAMETER can be used in Object Handler
Workplan commands.

parameter-setting

TYPE OPTION

Options for the unload or load function, for example,
report settings.

This Workplan can be used in Object Handler Workplan
commands.

option-setting

TYPE TEXT

Comments or any other text that can be used for

Not applicable

documentation purpose.

Examples of Workplans

The following table lists examples of instructional parts contained in a Workplan.

Workplan Type

Instruction

Explanation

PROCEDURE

FINDLIB * LIB TEST

Check whether the library TEST exists.

PROCEDURE

UNLOAD A* LIB TEST

Local environments:

Unload from the library TEST into Work File 1 all Natural
programming objects and shared resources starting with A, and
all user-defined error messages; write the report into Work File
4.

Remote environments located on mainframe platforms:
Unload from the library TEST into Work File 1 on the server
system all Natural programming objects starting with A, and
all user-defined error messages; write the report into the
corresponding text member of the Workplan library.

SELECTION

* LIB TEST

Process all objects from the library TEST.

TEXT

This is a WorkpTan
comment.

Any text.
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This section covers the following topic:

= Example of Workplan Contents

Example of Workplan Contents

The following is an example listing of a PROCEDURE Workplan where the UNLOAD command is
executed:

TYPE PROCEDURE /* VERSION=03.01 NATURAL VERSION=04.02.01 PL=0 AUTHOR=SAG
DATE=2006-07-20 09:40:12

/* unload from library TEST with target Tibrary PRODO1

UNLOAD * LIB TEST OBJTYPE N

WITH NEWLIBRARY PRODO1

WHERE REPORT MYREPO1

Referencing Workplans

You can reference a Workplan by using Object Handler menu functions or direct commands (see
also the section Direct Commands).

The following syntax applies when referencing a Workplan with the Object Handler direct com-
mands described in the section Direct Commands.

(workplan-name
[ LIBRARY Tibrary-name ]
[DBID dbid[FNR fnr]][NAME vsam-name ]
[CIPHER cipher]

{ PASSHORD } ecvord
PSW p

)

The syntactical options are explained in the following section:
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= Keyword Explanation

Keyword Explanation

The table below describes the keywords and values that apply to the syntax for referencing

Workplans.
Keyword Values Default Value
workplan-name |The name of the Natural text member in the Workplan library |No default
to be used as the Workplan.
LIBRARY The name of the library where the Workplan is located. WORKPLAN
DBID The ID of the Adabas database where the Workplan library is |0
located. (current FNAT/FUSER)
FNR The number of the Adabas file where the Workplan library is |0
located. (current FNAT/FUSER)
NAME Only applies to objects on mainframes. blank
(current FNAT/FUSER)
The name of a valid VSAM file where the Workplan library is
located.
CIPHER Only applies to objects on mainframes. blank
(current FNAT/FUSER)
An 8-digit cipher code.
PASSWORD Only applies to objects on mainframes. blank
(current FNAT/FUSER)
An 8-character Adabas password.
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Name, Date and Time Specification

You can use a name, a date, a time or a range of names, dates and times to select Natural library
objects, Natural command processor sources, Natural-related objects, Natural DDMs (data defini-
tion modules on a remote mainframe platform) or external files.

Name

You can specify a name or a range of names.

In the list of options below, value is any combination of one or more characters:

Input

Items Selected

value

All items with names equal to value.

*

>

All items.

?

All items with any single character for each question mark (?) entered.

Leading
Characters

value*

All items with names that start with value.

Example: AB*
Selected: AB, AB1, ABC, ABEZ
Not selected: AA1, ACB

Wildcard

value?

All items with names that start with value and end with any single
character for each question mark (?) entered.

Example: ABC?
Selected: ABCA, ABCZ
Not selected: AXC, ABCAA

value?value?

value*value?

*value?value*

All items that match va/ue combined with asterisk (*) and question
mark (?) in any order.

Example: A?C*Z
Selected: ABCZ, AXCBBBZ, ANCZ
Not selected: ACBZ, ABDEZ, AXCBBBZA

Start Value

value>

All items with names greater than or equal to value.

Example: AB>
Selected: AB, AB1, BBB, ZZZ27777
Not selected: AA1, AAB

End Value

value<

All items with names less than or equal to value.

Example: AX<
Selected: AB, AWW, AX
Not selected: AXA, AY
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| Note: The parameter specification option New Value only allows leading characters (asterisk

(*) notation). See Rules for New Values in Set Global Parameters in the section Settings.

Date

All date values within the Object Handler are specified in international date format.

You can specify a date, a range of dates, a special date or a range of special dates. A date must be
specified in the format VY YY-MM-DD (YYYY = year, MM=month, DD = day).

In the list of options below, the underlined portion of a keyword represents its valid abbreviation,
and valueis any combination of one or more digits:

Input Value

Items Selected

Date

YYYY-MM-DD

All items with a date equal to ¥V V-MM-DD.

Example: 2003-02-15

Leading
characters

value*

All items with a date that starts with value.

Example: 2002*
Selected: 2002-01-01, 2002-12-31
Not selected: 2001-12-31, 2003-01-01

Start value

value>

All items with a date greater than value.

Example: 2002-05>
Selected: 2002-05-01, 2002-12-31, 2003-01-01, 2003-12-31
Not selected: 2002-04-31, 2001-12-31

Special dates can be used as value (see below).

End value

value<

All items with a date less than value.

Example: 2003-02<

Selected: 2002-05-01, 2002-12-31, 2003-01-01, 2003-01-31
Not selected: 2003-02-01, 2003-05-18

Special dates can be used as value (see below).

Special Dates

TODAY
(+/-nnnn)

All items with the date of the current day.

The day can be followed by +nnnn or -nnnn where nnnnhas a maximum
of 4 digits.

The resulting date is computed as the date of the current day plus or minus
nnnn days.

Example: If the current dateis 2003-03-01, TODAY +5 results in 2003-03-06.
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Input Value

Items Selected

YE

(2]

TERDAY

All items with the date of the day before the current day.

=<
()
=
—
o

All items with the date range of the current month.

Example: The current month is 2003-02.
Selected: 2003-02-01, 2003-02-30
Not selected: 2003-03-01

FMDATE: Starts with the first day of the current month.

TODATE: Ends with the last day of the current month.

If the values of FMDATE and TODATE are identical, the selection is restricted
to one day.

All items with the date range of the current year.

Example: The current year is 2003.
Selected: 2003-01-01, 2002-12-31
Not selected: 2002-31-12

FMDATE: Starts with the first day of the current year.
TODATE: Ends with the last day of the current year.

If the values of FMDATE and TODATE are identical, the selection is restricted

to one year.

| Note: The parameter specification option New Value only allows leading characters (asterisk

(*) notation). See Rules for New Values in Set Global Parameters in the section Settings.

Time

You can specify a time or a range of times. The time must be specified in the format HH: I I:SS (HH
=hours, 17 =minutes, SS=seconds).

In the list of options below, value is any combination of one or more digits:

Input Value

Items Selected

Time

HH:II:SS

All items with a time equal to HH: I I:SS.

Example: 14:15:16

Leading characters

value*

All items with a time that starts with value.

Example: 13:*
Selected: 13:00:00, 13:10:53, 13:59:59
Not selected: 12:59:59, 14:00:00
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This section describes work files and valid formats that apply to the unload, load and scan functions
of the Object Handler.

Object Handler functions invoked in a local environment will only process objects from this local
environment, with a work file located in the current local file system. Object Handler functions
invoked in a remote environment will only process objects from the same remote environment.
The work file used for the load or unload function is located in the same remote environment or
in your local file system.

See also General in Settings - Options, the section Work Files in the Operations documentation, the
statement DEFINE WORK FILE in the Statements documentation and the profile parameter WORK in
the Parameter Reference documentation.

Work File Assignment

This section covers the following topics:

= | ocal Environments
= Remote Environments

Local Environments

The following table lists the work files used by the Object Handler in local environments.

File Explanation

Work File 1 Used for the unload, load and scan functions.
Contains the data unloaded.

See also Transfer Work File in Tools.

Work File 3 Used for internal reports.

Contains scan and find results.

Work File 4 Used if the option Write report (see Settings - Options) is set. Write report is the default
setting for object processing.

Contains report data.

Work File 5 The target file for the Adabas FDTs (Field Definition Tables) loaded.

Work File 6 Used for the load function if the option Write restart information (see Restart Load
in Functions) is set.

Contains restart information data.
Work File 7 An internal work file.
Work File 9 An internal work file.
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File Explanation

Work File 10 Used if the trace mode is set.

See also Traces in Tools.

Work Files 11 to 15 |Internal work files.

Remote Environments

The following table lists the work files used in remote environments.

File Location Explanation

Work File 1 local system |If the option Local work file is set (see Settings - Options), this work file
is used for the unload, load and scan functions. It contains the data
processed.

Additionally, in mainframe environments, this work file is used to transfer
work files from the local environment to the server and vice versa as
described in Transfer Work File in Tools.

Work File 1 server system |If the option Local work file is not set (see Settings - Options), this work
file is used for the unload, load and scan functions. It contains the data
processed.

Additionally, in mainframe environments, this work file is used to transfer
work files from the local environment to the server and vice versa as
described in Transfer Work File in Tools.

Note that in a mainframe environment work files must be specified
properly. See also Natural User Access Method for Print and Work Files in
Configuring Natural in the documentation Natural Operations for

Mainframes.
Work File 3 local system |An internal work file.
Work File 9 local system |An internal work file.

Work Files 11 to 15 {local system |Internal work files.

Work File Format

There are two file formats for unloading objects in the source environment into work files and for
loading them from work files into the target environment: an internal format and the Transfer
format. Work files must be of internal format to transfer binary data. Work files must be of
Transfer format to transfer text data.

This section covers the following topics:

= |nternal Format
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= Transfer Format
Internal Format

The internal format is an internal record layout for work files that are used to transfer Natural
sources and cataloged objects, error messages, Natural command processor sources, Adabas FDTs
and non-Natural objects from one environment to another.

With the internal format activated, Natural objects are read from the source environment and
written to a Natural work file by using the unload function of the Object Handler. This work file
can be transported to another environment with standard file transfer services. In the target
environment, the objects can then be read from the work file and loaded into the local file or
database system with the load function of the Object Handler.

To transfer objects between identical platforms, use work files of internal format. Use portable
work files of internal format if you want to transport objects between different UNIX, OpenVMS
or Windows platforms, for example, from a little-endian machine to a big-endian machine. See
also Portable work file in Settings - Options, Portable Natural Generated Programs (Programming
Guide) and DEFINE WORK FILE (Statements documentation).

The Object Handler uses internal format by default. When using the internal format (Transfer
format check box not selected), Work File 1 must be of binary format. To achieve this, omit the file
extension or use the file extension .sag.

] Notes:

1. Work files created by the utility SYSPAUL must be processed in internal format.

2. For remote environments: Work files created by the utility NATUNLD on the server, must be
processed in internal format. The work files must be created on a server of the same platform
where NATUNLD was applied.

Transfer Format

See also Transfer format in the section Settings - Options.

The Transfer format is a general record layout for work files that contain load or unload data. This
format is platform-independent and can be used to transfer the sources of Natural objects, Natural
command processor sources, error messages and Adabas FDTs (Field Definition Tables) from one
hardware platform to another and between Windows and mainframe, UNIX or OpenVMS plat-
forms.

With the check box Transfer format selected, the unload function of the Object Handler reads
Natural objects from a hardware platform and then restructures them.

Formatted records are written to a Natural work file that can be transported to another platform
with standard file transfer services. On the target platform, the load function of the Object Handler
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then reads the objects from the work file and loads them into the local file or database system. The
objects read from the work file are restructured according to the structure of the new hardware
platform.

Specifying Work Files in Local Environments

If Transfer format is specified (check box Transfer format selected), Work File 1 must be of text
(ASCII) format. To achieve this, a file extension must be used, but not the file extension .sag. If
Transfer format is not specified, Work File 1 must be of binary format. To achieve this, omit the
file extension or use the file extension . sag.

Specifying Work Files in Remote Environments

Work File 1 must be defined in the server environment. If Transfer format is specified (check box
Transfer format selected), Work File 1 contains data of text (ASCII) format. If Transfer format is
not specified, Work File 1 contains data of internal format.

Handling Sources in Unicode/UTF-8

Transfer format is also used to unload or load sources of Natural objects in Unicode/UTF-8 (Uni-
versal Transformation Format, 8-bit form). If you specify the corresponding unload option
(WORKFILETYPE set to UTF-8 in command mode or Unicode work file in menu mode), all object
sources will be unloaded into a work file in UTE-8. If you specify the corresponding load option
(LOAD-CODE-PAGE in command mode or Load code page in menu mode), all object sources in UTF-
8 will be converted with the specified code page when they are loaded into a Natural system file.

Work Files from SYSTRANS

Work files created by the utility SYSTRANS must be processed in Transfer format. Work files that
contain object sources encoded in UTF-8 cannot be processed with SYSTRANS.
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37 Direct Commands

The Object Handler provides direct commands for the following purposes:

® To execute an Object Handler function such as unloading or loading objects in batch mode or
in direct command online mode without using Object Handler menus (see also Batch or Direct
Command Calls).

® To execute or reference a Workplan (see also the section Workplans).

® To be used as an instruction in a Workplan.

This section describes the basic command syntax and the individual clauses, parameter and option
settings available to perform these tasks. In addition, you can view examples that illustrate the
use of direct commands.

The symbols used in the syntax diagrams shown in this section are explained in System Command
Syntax in the System Commands documentation.

This section covers the following topics:

Basic Command Syntax
select-clause

Object List - LIST Workplan
parameter-setting
option-setting

Examples of Using Direct Commands

C L L L L L
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38 Basic Command Syntax

This section describes the Object Handler direct commands provided for executing Object Handler
functions and Workplans of the type PROCEDURE. It also describes the commands used for
migrating from the old utility SYSTRANS to the Object Handler.

For explanations of the variable values contained in the syntax diagrams shown in this section,
refer to the relevant sections in the Object Handler documentation. For explanations of the symbols
used in the syntax diagrams, see Systemn Command Syntax in the System Commands documentation.

‘EX ECUTE (procedure-workplan)

Executes a Workplan of the type PROCEDURE. See also the section Workplans.

‘UNLOAD select-clause [parameter-setting] [option-setting]

Unloads the objects defined in the select-clause with the parameters defined in parameter-
setting with the options defined in option-setting.

LOAD select-clause [parameter-setting] [option-setting]

Loads the objects defined in the seTect-c7ause with the parameters defined in parameter-setting
with the options defined in option-setting.
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LOADALL [parameter-setting] [option-setting]

Loads all objects from a work file with the parameters defined in parameter-setting with the
options defined in option-setting.

SCAN select-clause [option-setting]

Scans a work file for the objects defined in the se7ect-c7ause with the options defined in option-
setting.

‘SCANALL [option-setting]

Scans a work file for all objects with the options defined in option-setting.

‘FIND select-clause [option-setting]

Finds the objects defined in the select-clause with the options defined in option-setting and
writes a report of the objects found into Work File 3. In addition, a report of the objects found can
be written to Work File 4 or a specified report file.

FINDLIB select-clause [option-setting]

Finds the libraries for Natural objects or Natural command processor sources defined in the seiect -
clause with the options defined in option-setting and writes a report of the objects found into
Work File 3. In addition, a report of the objects found can be written to Work File 4 or a specified
report file.

DELETE select-clause [option-setting]

Deletes the objects defined in the select-clause with the options defined in option-setting.
Restriction: It is not possible to delete an FDT.

UNDELI select-clause [option-setting]
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Unloads delete instructions for the objects defined in the se7ect -c7ause with the options defined
in option-setting.

RESTART [restart-file]

Continues an interrupted load function. This is only possible if information was written to a restart
file during the aborted load. Restart load information can be written to Work File 6 or a specified
restart file. See also RESTART in the section option-setting (Direct Commands) and Restart Load.

‘DISPLAY STATISTICS

Displays statistics information about the objects processed.

‘SYSTRANS systrans-direct-command

Executes an Object Handler direct command issued in the syntax of the old utility SYSTRANS.
See also Migration from SYSTRANS to the Object Handler.
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The select-clause comprises either a Workplan of the type SELECTION or LIST, or selection
specifications for the objects, FDTs or applications to be processed.

This section describes the syntax that applies to the select-clause. The keywords and variable
values contained in the syntax diagrams represent the parameters that can be used to specify object
selection criteria. If indicated, a variable value must be supplied with a keyword.

Syntax of select-clause

The select-clause consists of one of the following options:

(selection-workplan)
(Tist-workplan)
object-selection
delete-instruction-selection

The selection-workplanand 1ist-workplan options are explained in SELECTION or LIST
Workplan below.

The use of object-selection depends on the object type, DDM, FDT or application you want to
process, for each of which the appropriate syntax and keywords are explained in the remainder
of this section.

The delete-instruction-selection options are explained in Delete Instructions for Selected
Objects.

SELECTION or LIST Workplan

A Workplan of the type SELECTION contains a header (TYPE SELECTION) and a selection from
one of the following types of object or file: Natural library objects, Natural-related objects, Natural
system error messages, Natural command processor sources, external files or Adabas FDTs (Field
Definition Tables).

A Workplan of the type LIST contains a header (TYPE LIST) and a selection list of objects as des-
cribed in the section Object List - LIST Workplan. Such an object list can be used for the UNLOAD,
LOAD or FIND command only.

For further information on using Workplans, see the section Workplans.
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Natural Library Object and DDM Selection

This selection is used to select Natural objects for processing including Natural DDMs, user-defined
error messages and shared resources.

The appropriate syntax is shown and explained in the following section.

= Syntax of Natural Library Object and DDM Selection

Syntax of Natural Library Object and DDM Selection

object-name
LIBRARY Tibrary-name

[NAME vsam-name]

DBID dbid FNR fnr {
[CIPHER cipher]

PASSWORD} assword]
PSW P

[OBJTYPE group-type]

SETNO set-number [SETUSER set-user][SETLIBRARY set-Tibrary] ]

[NATTYPE object-type]

[SCKIND object-kind]

[MODE object-mode]

[FMNUM error-number-from)

[TONUM error-number-to]

[SLKIND message-type]

[LANGUAGE Tanguages]

[DDMDBID ddm-dbid] [DDMFNR ddm-fnr]
[NATVERS natural-version]

[ DATE date ]
[FMDATE date-from] [TODATE date-to]

[ [SIZE size] ]
[FMSIZE size-from] [TOSIZE size-to]

[USERID user-id]

[TID terminal-id]

[except-clause]
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except-clause

EXCEPT

(object-name

|
|

[USERID user-id]
TID terminal-id]

[
)

[LIBRARY Tibrary-name]

[OBJTYPE group-type]

[SCKIND object-kind]

[NATTYPE object-type]

[MODE object-mode]

[SLKIND message-type]

[FMNUM error-number-from] [TONUM error-number-to]
[LANGUAGE Tanguages]

[DDMDBID ddm-dbid] [DDMFNR ddm-fnr]

[NATVERS natural-version]

DATE date
[FMDATE date-from] [TODATE date-to]

SIZE size
[FMSIZE size-from] [TOSIZE size-to]

J Notes:

1. For the command FINDLIB, only the following keywords are processed: LIBRARY, DBID, FNR,
NAME, CIPHER and PASSWORD or PSW.

2. When processing Natural DDMs on mainframes, you must set 0BJTYPE to D. In addition, some

keywords do not apply to DDMs, which is described below.

Keyword Explanation of Natural Library Object and DDM Selection

The keywords and valid values for the objects to be processed are described in the following sec-

tion.
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Keyword

Valid Values

Default Value

object-name

A valid object name or a range of names.
If object -name contains blank characters, it must be enclosed in double
quotation marks (" ").

See also Name in Name, Date and Time Specification.

none

LIBRARY A valid library name or a range of names. none
If OBJTYPE (see below) is set to D, the library name is ignored.
If SETNO is specified, a range of names is not allowed.
See also Name.
DBID Not valid for DDMs on mainframes (OBJTYPE set to D; see below). 0
(current
A valid database ID. FNAT/FUSER)
FNR Not valid for DDMs on mainframes (OBJTYPE set to D; see below). 0
(current
A valid file number. FNAT/FUSER)
NAME Only applies to objects on mainframes. Not valid for DDMs on blank
mainframes (OBJTYPE set to D; see below). (current
FNAT/FUSER)
A valid VSAM name.
CIPHER Only applies to objects on mainframes. Not valid for DDMs on blank
mainframes (O0BJTYPE set to D; see below). (current
FNAT/FUSER)
The 8-digit cipher code of the Adabas file where the objects are stored.
PASSWORD Only applies to objects on mainframes. blank
(current
or Not valid for DDMs on mainframes (0BJTYPE set to D; see below). FNAT/FUSER)
PSW
An 8-character Adabas password.
OBJTYPE Types of object are: *
D  DDMs (objects on mainframes only)
E  Natural error messages
N Natural programming objects
R Shared resources
*

Asterisk (all)

or a valid combination.

Exception:
Object type D cannot be combined with any other type.
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Keyword

Valid Values

Default Value

SETNO

Only applies to the unload and find functions and if Predict is installed.

Not applicable to application objects (see also Selecting Application
Objects).

A one- or two-digit number that identifies the retained set to be used
for the names of the objects to be processed. A retained set is created
with the save set option of the LIST XREF command.

If SETNO is specified, the value specified for object-name isignored.

For detailed information on Predict sets, refer to the Predict
documentation.

none

SETUSER

Only applies to the unload and find functions and if Predict is installed.

Not applicable to application objects (see also Selecting Application
Objects).

The ID of the user who created the Predict set. If no ID is specified, the
value of the system variable *USER (see also the System Variables
documentation) is used.

*USER

SETLIBRARY

Only applies to the unload and find functions and if Predict is installed.

Not applicable to application objects (see also Selecting Application
Objects).

The name of the library to be searched for a Predict set. If you do not

specify SETLIBRARY, the library specified with LIBRARY is used instead.

NATTYPE

Not applicable if 0BJTYPE is set to D.

One or more single-character codes for Natural object types:

P Program

N Subprogram

S Subroutine

C Copycode

H  Helproutine

T Text

7 Function

8 Adapter

G Global data area
L Local data area
A Parameter data area
M Map

4 Class

3 Dialog
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Keyword

Valid Values

Default Value

O O = O

*

Natural command processor
DDM (not on mainframes)
Object view

Resource (on mainframes only)

All object types

SCKIND

Not applicable if 0BJTYPE is set to D.

The kind of Natural programming objects.
Valid input values are:

= > O O

B

Source objects: objects that are only stored in source form.
Cataloged objects: objects that are only stored in cataloged form.
All source and cataloged objects.

All STOWed objects: source and cataloged objects with identical
date and time.

Source and cataloged objects if both exist.

Anmerkung: W and B are valid for the UNLOAD and FIND commands

only. For LOAD and SCAN, W and B are valid entries, but they are treated
like A (all objects). If data is processed in Transfer format, only S (source
objects) or A applies.

MODE

Not applicable if 0BJTYPE is set to D.

The programming mode of the Natural programming objects.
Valid input values are:

A
R
S

Any.
All objects in reporting mode.

All objects in structured mode.

FMNUM

A start number of Natural error messages.

Valid range: 1 to 9999.

TONUM

An end number of Natural error messages.

Valid range: 1 to 9999.

The value must be greater than or equal to the value of FMNUM, if
specified.

9999

or value of
FMNUM

(if specified)

SLKIND

The kind of Natural error message text.
Valid input values are:
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Keyword

Valid Values

Default Value

S Short text.
Cannot be applied to the DELETE command (see Basic Command
Syntax).

L Long text.
A Short and/or long text.
B Short and long text, if both exist.

LANGUAGE

Up to 8 valid language codes (for example, code 1 for English) of
user-defined error messages. An asterisk (*) selects all language codes.

DDMDBID

The valid database ID (1 to 65535) of a DDM.

UNLOAD, LOAD and SCAN: 0 denotes that no check is performed. DDMs
are processed, regardless of their database ID (DBID).

DDMFNR

The valid file number (1 to 65535) of a DDM.

UNLOAD, LOAD and SCAN: 0 denotes that no check is performed. DDMs
are processed, regardless of their file number (FNR).

NATVERS

The Natural version of Natural programming objects.

Valid version format: /RS

where I/is the 1-digit version, R the 1-digit release, and S the 2-digit
system maintenance level.

You can also specify a range of versions: see Name.

blank
(no check)

DATE

The save or catalog date of Natural programming objects, and the date
of shared resources.

You can add a time by inserting a blank between date and time. For the
format and ranges allowed, see Date and Time in Name, Date and Time
Specification.

Special terms allowed are YESTERDAY and TODAY. See Special Dates in
Date.

blank
(no check)

FMDATE

A start value:

The date on or after which Natural programming objects were cataloged
or saved, and the date of shared resources. The format is identical to
DATE. See Date.

Special terms allowed are YEAR, MONTH, YESTERDAY and TODAY. See
Special Dates in Date.

blank
(no check)

TODATE

An end value:

The date on or before which Natural programming objects were cataloged
or saved, and the date of shared resources. The format is identical to
DATE. See Date.

blank

(no check)

or high value
(if FMDATE
specified)
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Keyword Valid Values Default Value
Special terms allowed are YEAR, MONTH, YESTERDAY and TODAY. See
Special Dates in Date.
SIZE The size of Natural programming objects and shared resources (up to 7|0
digits). (no check)
FMSIZE A start value: 0
(no check)
The minimum size of Natural programming objects and shared resources
(up to 7 digits).
TOSIZE An end value: 0
(no check)
The maxir.ru%m size of Natural programming objects and shared resources | high value
(up to 7 digits). (if FMSIZE
specified)
USERID The ID of the user who saved or cataloged the Natural programming |blank
objects. (no check)
You can also specify a range of user IDs: see Name.
TID Not applicable if 0BJTYPE is set to D. blank
(no check)
The ID of the terminal where the Natural programming objects were
saved or cataloged (provided by the Natural system variable *INIT-ID).
You can also specify a range of terminal IDs: see also Name.
EXCEPT All items that match the selection criteria entered before EXCEPT are  |not applicable
checked against all parameters contained within the parentheses
following the keyword EXCEPT. If they match all these parameters too,
they are not processed.
| Notes:

1. Parameters that are irrelevant for 0BJTYPE are ignored. For example: DATE, SIZE and USERID
have no meaning for Natural error messages.

2. DBID, FNR, NAME, CIPHER and PASSWORD or PSW are ignored by the LOAD or SCAN command. These
parameters must instead be specified in the parameter-setting clause as described for
. and LOADFUSER. .. in Keyword Explanation of parameter-clause.

LOADFNAT.

3. If an object for shared resources contains blank characters, it must be enclosed in double quota-
tion marks (" ").
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Natural-Related Object Selection

This selection is used to select Natural-related objects for processing.
The appropriate syntax is shown and explained in the following section.

= Syntax of Natural-Related Object Selection

Syntax of Natural-Related Object Selection

object-name NATPATH natural-path-name

[ DATE date ]
[FMDATE date-from] [TODATE date-to]
[ SIZE size ]
[FMSIZE size-from] [TOSIZE size-to]
[ EXCEPT

(object-name NATPATH natural-path-name

[ DATE date ]
[FMDATE date-from] [TODATE date-to]

[ SIZE size ]
[FMSIZE size-from] [TOSIZE size-to]

)]

Keyword Explanation of Natural-Related Object Selection

The keywords and valid input values for the objects to be processed are described in the following
section.

Keyword Valid Values Default Value

object-name |Thename of a Natural-related object. If object -name contains blank |none
characters, it must be enclosed in double quotation marks (" ").

See also Name in Name, Date and Time Specification.

NATPATH NATDIR none
NATGUI_BMP
TMP_PATH
NATBIN
PROFILE_PATH
PARM_PATH
NATERR
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Keyword Valid Values Default Value
DATE The modification date of Natural-related objects. blank
(no check)
You can add a time by inserting a blank between date and time. For
the format and ranges allowed, see Date and Time in Name, Date and
Time Specification.
Special terms allowed are: YESTERDAY and TODAY.
See Special Dates in Date.
FMDATE A start value: blank
(no check)
The date on or after which Natural-related objects were modified.
The format is identical to DATE. See Date.
Special terms allowed are: Y EAR, MONTH, YESTERDAY and TODAY. See
Special Dates in Date.
TODATE An end value: blank
(no check)
The date on or before which Natural-related objects were modified. |, high value
The format is identical to DATE. See Date. (if FMDATE specified)
Special terms allowed are: YEAR, MONTH, YESTERDAY and TODAY. See
Special Dates in Date.
SIZE The size of Natural-related objects (up to 10 digits). 0
(no check)
FMSIZE A start value: 0
(no check)
The minimum size of Natural-related objects (up to 10 digits).
TOSIZE An end value: 0
(no check)
The maximum size of Natural-related objects (up to 10 digits). or high value
(if FMSIZE specified)
EXCEPT See EXCEPT in Natural Library Object and DDM Selection.

| Note: The NATPATH clause in the EXCEPT part is evaluated by the LOAD or SCAN command

only.

Natural-Related Debug Environment Selection

This selection is used to select Natural-related debug environments for processing.

Note that Natural-related debug environments exist on mainframe platforms only.

The appropriate syntax is shown and explained in the following section.
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= Syntax of Natural-Related Debug Environment Selection

Syntax of Natural-Related Debug Environment Selection

object-name

[LIB
[
[
[
| |
[

EXCEPT

)]

NATPATH DEBUG
LIBRARY Tibrary-name]

DBID dbid [FNR fnr] ]

NAME vsam-name]
CIPHER cipher]

(object-name
[LIBRARY Jibrary-name]

PASSWORD }
password

PSW

Keyword Explanation of Natural-Related Debug Environment Selection

The keywords and valid input values for the debug environments to be processed are described
in the following section.

Keyword Valid Values Default Value
object-name |A valid debug environment name or a range of names. none
See also Name in Name, Date and Time Specification.
LIBRARY A valid library name or a range of names. none
See also Name.
DBID A valid database ID. 0
(current FUSER)
FNR A valid file number. 0
(current FUSER)
NAME A valid VSAM name. blank
(current FUSER)
CIPHER The 8-digit cipher code of the Adabas file where the debug environments |blank
are stored. (current FUSER)
PASSWORD An 8-character Adabas password. blank
(current FUSER)
or
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Keyword Valid Values Default Value
PSW
EXCEPT See EXCEPT in Natural Library Object and DDM Selection. not applicable

] Note: DBID, FNR, NAME, CIPHER and PASSWORD or PSW are ignored by the LOAD or SCAN command.

These parameters must instead be specified in the parameter-setting clause as described
for LOADFNAT. .. and LOADFUSER. .. in Keyword Explanation of parameter-clause.

Natural-Related Profile Selection

This selection is used to select Natural-related profiles for processing.
Note that Natural-related profiles exist on mainframe platforms only.
The appropriate syntax is shown and explained in the following section.

= Syntax of Natural-Related Profile Selection

Syntax of Natural-Related Profile Selection

object-name
NATPATH PROFILE
[OBJTYPE profile-type]

[ DBID dbid[FNR fnr] ]

[NAME vsam-name]
[CIPHER cipher]

{ PASSWORD } s sword
PSW p

[ EXCEPT
(object-name
[OBJTYPE profile-type]
)]
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Keyword Explanation of Natural-Related Profile Selection

The keywords and valid input values for the profiles to be processed are described in the following

section.
Keyword Valid Values Default Value
object-name |A valid profile name or a range of names. none
See also Name in Name, Date and Time Specification.
0BJTYPE The type of profile: *
D Device profile
E Editor profile
M Map profile
p Parameter profile
* Asterisk (all profile types)
or any combination.
DBID A valid database ID. 0
(current FNAT)
FNR A valid file number. 0
(current FNAT)
NAME A valid VSAM name. blank
(current FNAT)
CIPHER The 8-digit cipher code of the Adabas file where the profiles are stored. |blank
(current FNAT)
PASSWORD An 8-character Adabas password. blank
(current FNAT)
or
PSW
EXCEPT See EXCEPT in Natural Library Object and DDM Selection. not applicable

] Note: DBID, FNR, NAME, CIPHER and PASSWORD or PSW are ignored by the LOAD or SCAN command.

These parameters must instead be specified in the parameter-setting clause as described
for LOADFNAT. .. and LOADFUSER. .. in Keyword Explanation of parameter-clause.
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Natural-Related DL/l Subfile Selection

This selection is used to select Natural-Related DL/I subfiles for processing.
Note that Natural-related DL/I subfiles exist on mainframe platforms only.

The appropriate syntax is shown and explained in the following section.

= Syntax of Natural-Related DL/l Subfile Selection

Syntax of Natural-Related DL/l Subfile Selection

object-name
NATPATH SUBFILE
[OBJTYPE subfile-type]

[ DBID dbid [FNR fnr] ]

[NAME vsam-name]
[CIPHER cipher]

{ PASSWORD } sssword
PSW p

[ EXCEPT
(object-name
[OBJTYPE subfile-type]
)]

Keyword Explanation of Natural-Related DL/I Subfile Selection

The keywords and valid input values for the DL/I subfiles to be processed are described in the

following section.

Keyword Valid Values

Default Value

object-name |A valid DL/I subfile name or a range of names.

See also Name in Name, Date and Time Specification.

none

OBJTYPE The type of DL/I subfile:

D NDB
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Keyword Valid Values Default Value
P |NsB
* ‘Asterisk (both subfile types)
DBID A valid database ID. 0
(current FDIC)
FNR A valid file number. 0
(current FDIC)
NAME A valid VSAM name. blank
(current FDIC)
CIPHER The 8-digit cipher code of the Adabas file where the DL/I subfiles are stored. blank
(current FDIC)
PASSWORD An 8-character Adabas password. blank
(current FDIC)
or
PSW
EXCEPT See EXCEPT in Natural Library Object and DDM Selection. not applicable

) Note: DBID, FNR, NAME, CIPHER and PASSWORD or PSW are ignored by the LOAD or SCAN command.

These parameters must instead be specified in the parameter-setting clause as described
for LOADFNAT. .. and LOADFUSER. .. in Keyword Explanation of parameter-clause.

Natural System Error Message Selection

This selection is used to select Natural system error messages for processing.

The appropriate syntax is shown and explained in the following section.

= Syntax of Natural System Error Message Selection

Syntax of Natural System Error Message Selection

[ EXCEPT

ERROR NATERROR

DBID dbidFNR
fnr [NAME
vsam-name]
[CIPHER
cipher]

[ { PASSWORD }
password

PSW

[FMNUM error-number-from] [TONUM error-number-to]
[SLKIND message-type]
[LANGUAGE Tanguages]
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(

)]

[FMNUM error-number-from] [TONUM error-number-to]
[SLKIND message-type]
[LANGUAGE Tanguages]

Keyword Explanation of Natural System Error Message Selection

The keywords and valid input values for the Natural system error messages to be processed are
described in the following section.

Keyword Valid Values Default Value
DBID Only applies to system error messages on mainframes. 0
(current FNAT)
A valid database ID.
FNR Only applies to system error messages on mainframes. 0
(current FNAT)
A valid file number.
NAME Only applies to system error messages on mainframes. blank
(current FNAT)
A valid VSAM name.
CIPHER Only applies to system error messages on mainframes. blank
(current FNAT)
The 8-digit cipher code of the Adabas file where the system error messages
are stored.
PASSWORD |Only applies to system error messages on mainframes. blank
(current FNAT)
or An 8-character Adabas password.
PSW
FMNUM A start number of system error messages. 1
Valid range: 1 to 9999.
TONUM An end number of system error messages. 9999
or value of FMNUM
Valid range: 1 to 9999. (if specified)
The value must be greater than or equal to the value of FMNUM if specified.
SLKIND See SLKIND in Natural Library Object and DDM Selection. A
LANGUAGE |Up to 8 valid language codes (for example, code 1 for English) of system |*
error messages.
An asterisk (*) selects all language codes.
EXCEPT See EXCEPT in Natural Library Object and DDM Selection.
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d Note: DBID, FNR, NAME, CIPHER and PASSWORD or PSW are ignored by the LOAD or SCAN command.

These parameters must instead be specified in the parameter-setting clause as described
for LOADFNAT. .. in Keyword Explanation of parameter-clause.

Natural Command Processor Selection

This selection is used to select Natural command processor sources for processing.
The appropriate syntax is shown and explained in the following section.

= Syntax of Natural Command Processor Source Selection

Syntax of Natural Command Processor Source Selection

object-name PROCESSOR ncp-Tibrary-name
DBID ncp-dbid FNR ncp-fnr[file-options]

[EXCEPT
(object-name

[LIBRARY ncp-Tlibrary-name]
)]

file-options

[NAME ncp-vsam-name]
[CIPHER ncp-cipher]

[ { PASSWORD

PSH } ncp-password

] Note: For the command FINDLIB, only the following keywords are processed: PROCESSOR,
DBID, FNR, NAME, CIPHER and PASSWORD or PSW.
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Keyword Explanation of Natural Command Processor Source Selection

The keywords and valid input values for the Natural command processor sources to be processed
are described in the following section.

Keyword Valid Values Default Value
object-name |Thename of a valid Natural command processor source or a range of names. |none
See also Name in Name, Date and Time Specification.
PROCESSOR A valid library name or a range of names. none
See also Name.
DBID The valid database ID of the Adabas file where the Natural command processor | Value of
sources are stored. LFILE 190
FNR The valid file number of the Adabas file where the Natural command processor | Value of
sources are stored. LFILE 190
NAME Only applies to Natural command processor sources on mainframes. blank
A valid VSAM name.
CIPHER The 8-digit cipher code of the Adabas file where the Natural command blank
processor sources are stored.
PASSWORD The 8-character Adabas password of the Adabas file where the Natural blank
command processor sources are stored.
or
PSW
EXCEPT See EXCEPT in Natural Library Object and DDM Selection.

] Note: DBID, FNR, NAME, CIPHER and PASSWORD or PSW are ignored by the LOAD or SCAN command.

These parameters must instead be specified in the parameter-setting clause as described
for LOADNCP. .. in Keyword Explanation of parameter-clause.

External File Selection

This selection is used to select external files for processing.

The appropriate syntax is shown and explained in the following section.
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= Syntax of External File Selection

Syntax of External File Selection

DATE date
[FMDATE date

SIZE size
[FMSIZE size

[ EXCEPT

|
|

)]

external-file-name PATH external-path-name

-from] [TODATE date-to]

-from] [TOSIZE size-to]

(external-file-name[PATH external-path-name]

DATE date

[FMDATE date-from] [TODATE date-to] ]

SIZE size

[FMSIZE size-from] [TOSIZE size-to] ]

Keyword Explanation of External File Selection

The keywords and valid input values for the external files to be processed are described in the

following section.

Keyword Valid Values Default Value
external-file-name|The name of an external file. none
If external-file-name contains blank characters, it must
be enclosed in double quotation marks (" ").
See also Name in Name, Date and Time Specification.
PATH The name of the path where the external file is located. none
DATE The modification date of external files. blank
(no check)
You can add a time by inserting a blank between date and
time. For the format and ranges allowed, see Date and Time
in Name, Date and Time Specification.
Special terms allowed are YESTERDAY and TODAY. See Special
Dates in Date.
FMDATE A start value: blank
(no check)
The date on or after which external files were modified. The
format is identical to DATE. See Date.
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Keyword Valid Values Default Value
Special terms allowed are YEAR, MONTH, YESTERDAY and
TODAY. See Special Dates.
TODATE An end value: blank
The date on or before which external files were modified. |(no check)
The format is identical to DATE. See Date. or high value
(if FMDATE specified)
Special terms allowed are YEAR, MONTH, YESTERDAY and
TODAY. See Special Dates.
SIZE The size of external files (up to 10 digits). 0
(no check)
FMSIZE A start value: 0
the minimum size of external files (up to 10 digits). (no check)
TOSIZE An end value: 0
The maximum size of external files (up to 10 digits). (no check)
or high value
(if FMSIZE specified)
EXCEPT See EXCEPT in Natural Library Object and DDM Selection.

| Note: The NATPATH clause in the EXCEPT part is only evaluated by the LOAD and SCAN com-

mands.

FDT Selection

This selection is used to select Adabas FDTs (Field Definition Tables) for processing.

For loading FDTs, see also FDTs in the section Object Specification.

The appropriate syntax is shown and explained in the following section.

= Syntax of FDT Selection

Syntax of FDT Selection

FDT
DBID dbid

FNR fnr[CIPHER cipher] [ {

FMENR fnr-start TOFNR fnr-end

PASSWORD} J ]
PSW p
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Keyword Explanation of FDT Selection

The keywords and valid input values for the FDTs to be processed are described in the following
section.

Keyword Valid Values Default Value
DBID The database ID of the FDT. none
FNR The file number of the FDT. none
CIPHER The 8-digit Adabas cipher code of the FDT. none

PASSWORD |The 8-character Adabas password of the FDT. |none

or
PSW

FMFNR Only applies to the FIND or UNLOAD command. |[none

A start value:
The file number (FNR) of an FDT.

TOFNR Only applies to the FIND or UNLOAD command. |none

An end value:
The file number (FNR) of an FDT.

Application Selection

This selection applies when working in a remote environment located on a mainframe, a UNIX
or an OpenVMS platform.

The selection is used for applications maintained in Natural Studio's application workspace and
the libraries or objects that belong to these applications.

The appropriate syntax is shown and explained in the following section.

= Selecting Base and Compound Applications
= Selecting Application Libraries
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= Selecting Application Objects
Selecting Base and Compound Applications

This selection only applies to the find function.

Syntax

APPLICATION APNAME application-name
[APTYPE application-type]
[COMPAPPLICATION compound-application-name]
[ EXCEPT
(APNAME application-name

[APTYPE application-type]
)]

Selecting Application Libraries

This selection only applies to the find function.

Syntax

APPLICATION APLIBRARY application-Ilibrary-name
[BASEAPPLICATION base-application-name]
COMPAPPLICATION compound-application-name]

[
[ DBID dbid [FNR fnr] ]
[

EXCEPT
(APLIBRARY application-library-name
[BASEAPPLICATION base-application-name]

)]

Selecting Application Objects

This selection only applies to the find and unload functions.
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Syntax

[
[
[
[

APPLTICATION APOBJECTS application-object-name
[BASEAPPLICATION base-application-name]
COMPAPPLICATION compound-application-name]
LIBRARY Tibrary-name]

object-specification]

EXCEPT

(APOBJECT application-object-name
[LIBRARY Tibrary-name]

[BASEAPPLICATION base-application-name]
[object-specification]

)]

Keyword Explanation of Application Selection

The keywords and valid input values for the applications, application libraries or application
objects to be processed are described in the following section.

Keyword

Valid Values

Default Value

APNAME

A valid name of a Natural application or a range of names.

See also Name in Name, Date and Time Specification.

*

APTYPE

A valid application type:

B Base application

0 Compound application

*

All: base and/or compound applications

COMPAPPLICATION

Only applies if APTYPE is set to * or B.

The name of a compound application to which the specified base
application belongs or a range of names.

Only base applications that belong to the specified compound
application(s) are selected; base applications that do not belong
to a compound application are not selected.

none

EXCEPT

See EXCEPT in Natural Library Object and DDM Selection.

not
applicable

APLIBRARY

The valid name of a library that belongs to a Natural base or
compound application or a range of names.

See also Name in Name, Date and Time Specification.

*
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Keyword Valid Values Default Value
BASEAPPLICATION The valid name of a Natural base application to which an *
application library or application object belongs.
See also Name in Name, Date and Time Specification.
DBID The valid database ID of an application library. 0
(no check)
FNR The valid file number of an application library. 0
(no check)
APOBJECT The valid name of an application object that belongs to a base or | *
compound application, or a range of names.
See also Name in Name, Date and Time Specification.
LIBRARY A valid library name or a range of names. *
If OBJTYPE is set to D (see Natural Library Object and DDM
Selection), the library name is ignored.
See also Name in Name, Date and Time Specification.
object-specification|Indicates that additional selection criteria can be specified for ~ |not
application objects as shown in the syntax diagram for Natural |applicable

library objects and DDMs: all items listed below LIBRARY
Tibrary-name can also be applied to application objects whereas
object-namein the EXCEPT clause is irrelevant for application
objects.

Object Selection for Delete Instructions

This selection is used to specify delete instructions for Natural library objects, DDMs, user-defined
error messages and Natural system error messages. The delete instructions are executed when a
work file of internal format is loaded in the target environment with the DELETEALLOWED option

specified.

The appropriate syntax is shown and explained in the following section.

= Syntax of Delete Instructions for Natural Library Objects and DDMs
= Syntax of Delete Instructions for User-Defined Error Messages
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= Syntax of Delete Instructions for Natural System Error Messages

Syntax of Delete Instructions for Natural Library Objects and DDMs

object-name
LIBRARY Tibrary-name

OBJTYPE{ g }

*
NATTYPE{ v }

[SCKIND object-kind]

Keyword Explanation of Delete Instructions for Natural Library Objects and DDMs

The keywords and valid values for the objects to be processed are described in the following sec-
tion.

Keyword Valid Values Default Value

object-name |A valid object name or a start value (va/ue*) for a range of names such as  |none
ABC*.

LIBRARY A valid library name. A range specification is not allowed. none

If OBJTYPE (see below) is set to D, the library name is ignored.
OBJTYPE A valid object-type code: *

D  DDMs (objects on mainframes only)

N Natural programming objects

Object type D cannot be combined with object type N.
NATTYPE Not applicable if 0BJTYPE is set to D. *

A Natural object type. Valid input values are:

* All object types

V DDMs (not on mainframes)

SCKIND Not applicable if 0BJTYPE is set to D. A

The kind of Natural programming objects.
Valid input values are:
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Keyword Valid Values Default Value
S Source objects. If used in the except-clause (see Syntax of Natural
Library Object and DDM Selection): objects that are stored only in source
form.
C Cataloged objects. If used in the except -clause: objects that are stored

only in cataloged form.

A All source and cataloged objects.

Syntax of Delete Instructions for User-Defined Error Messages

*

LIBRARY Tibrary-name
OBJTYPE E

FMNUM error-number-from
[TONUM error-number-to]
[SLKIND message-type]
[LANGUAGE Tanguages]

library-name denotes the name of a single library; a range specification is not allowed.

For explanations of the other elements used in this syntax, see Keyword Explanation of Natural

Library Object and DDM Selection.

Syntax of Delete Instructions for Natural System Error Messages

ERROR NATERROR

FMNUM error-number-from
[TONUM error-number-to]
[SLKIND message-type]
[LANGUAGE Tanguages]

For explanations of the elements used in this syntax, see Keyword Explanation of Natural System

Error Message Selection.
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Object List - LIST Workplan

An object list is a Workplan of the type LIST, which specifies object selection criteria for the objects
to be processed in the UNLOAD, LOAD or FIND command. An object list can be used as an alternative
to the select-clause and the SELECTION Workplan.

The following syntax applies to an object list:

TYPE LIST

{ object-type-and-Tlocation(object-name-description...) }

The syntactical options are explained in the following section. The keywords and variable values
contained in the syntax diagrams shown in this section represent parameters that are used to
specify object selection criteria. If indicated, a variable value must be supplied with a keyword.
Each syntax element (except for the ones enclosed in parentheses) must start on a new line and
end on the same line.

For explanations of the keywords contained in the syntax diagrams, refer to the section seiect-
clause.

Syntax of object-type-and-location

The syntax diagrams that apply to object -type-and-Tocationare shown in the following section.

= Natural Objects and DDMs

= Natural System Error Messages

= Natural Command Processor Sources
= Natural-Related Objects

= External Files

= FDTs

Natural Objects and DDMs

LIBRARY Tibrary-name

DBID dbid FNR fnr[NAME vsam-name] [CIPHER [ { PASSWORD } ]
. password
cipher] PSW

[ OBJTYPE group-type]

J Notes:

1. No ranges are allowed for 77brary-name.
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2. For DDMs on mainframe platforms,0BJTYPE must be set to D.

Natural System Error Messages

ERROR NATERROR

DBID dbid FNR fnr[NAME vsam-name] [CIPHER [ { PASSWORD } ]
. password
cipher] PSW

Natural Command Processor Sources

PROCESSOR ncp-Tibrary-name

cipher] PSW

[ DBIDdbidFNanr[NAMEvsam-name][CIPHER[ { PASSWORD} ] l
password

| Note: No ranges are allowed for ncp-Tibrary-name.

Natural-Related Objects

‘NATPATH natural-path-name ‘

External Files

‘PATH external-path-name ‘

FDTs

Syntax of object-name-description

The syntax diagrams that apply toobject -name-description are shown in the following section:

= Natural Objects

= Natural System Error Messages

= Natural Command Processor Sources
= Natural-Related Objects

= External Files
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= FDTs

Natural Objects

object-name [SCKIND object-kind]

error-number [ SLKIND message-type] [ LANGUAGE Tanguages]
FMNUM error-number-from TONUM error-number-to [SLKIND message-type] [LANGUAGE
languages]

Natural System Error Messages

error-number | SLKIND message-type] [ LANGUAGE Tanguages]

FMNUM error-number-from TONUM error-number-to[ SLKIND message-type] [ LANGUAGE }
lTanguages]

Natural Command Processor Sources

‘object-name ‘

Natural-Related Objects

‘re]ated—object-name ‘

External Files

‘externa]-fﬂe-name ‘

FDTs

PASSWORD

DBID dbid FNR fnr[CIPHER cipher] [ { PSH

} password ]
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Example of an Object List

The follwing is an example of a Workplan of the type LIST:

TYPE LIST
LIBRARY LIB-1 OBJTYPE N /* process Natural objects from library 'LIB-1'
( A* SCKIND S /* all sources objects whose names start with "A'
B1 /* source and/or cataloged object of 'Bl'
CDE> SCKIND C ) /* all cataloged objects with names greater than/equal
to 'CDE'
VA /* comment Tine
LIBRARY LIB-2 /* process Natural objects from library 'LIB-2'
/* including error messages and shared resources
€ = /* all source and/or cataloged objects
/* including shared resources
FMNUM 1 TONUM 100 /* error messages from 1 to 100

)
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parameter-setting

The parameter-setting clause is used to change attributes for the LOAD or UNLOAD command for
the objects to be processed and to define target destinations for the LOAD command (for example,
FNAT).

The following syntax applies to the parameter-setting clause:

WITH

(parameter-workplan)

parameter-clause

For an explanation of the syntax that applies to parameter-workpian, refer to Referencing Workplans
in the section Workplans.

This section covers the following topics:

Syntax of parameter-clause

The syntax of the parameter-cilause is shown in the following diagram. If indicated, a variable
value must be supplied with a keyword.

[NAME o7d-name] NEWNAME new-name ]

[LIBRARY old-Tibrary-name] ]
NEWLIBRARY new-1ibrary-name

LOADFNATDBID fnat-dbid LOADFNATFENR fnat-fnr
[LOADFNATNAME vsam-name]
[LOADFNATCIPHER fnat-cipher]

[ { LOADFNATPASSWORD }
LOADFNATPSW

LOADFUSERDBID fuser-dbid LOADFUSERFNR fuser-fnr
[LOADFUSERNAME fuser-vsam-name]
[LOADFUSERCIPHER fuser-cipher]

[ { LOADFUSERPASSWORD}

fnat-password ]

LOADFUSERPSW

LOADNCPDBID ncp-file-dbid LOADNCPFNR ncp-file-fnr
[LOADNCPNAME ncp-file-vsam-name]
[LOADNCPCIPHER ncp-file-cipher]

[ { LOADNCPPASSWORD }
LOADNCPPSW

fuser-password ]

ncp-file-password ]
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[FDTDBID old-fdt-dbid FDTFNR old-fdt-fnr] NEWFDTDBID new-fdt-dbid NEWFDTFNR

new-fdt-fnr

[ERRNUMDIFF modification-of-error-message-range]

NEWLANGUAGE

new-userid

[LANGUAGE oTd-Tanguage]

[DATE o/d-date] NEWDATE new-date

[USERID old-userid] NEWUSERID

[TID old-terminal-id] NEWTID
new-terminal-id

[PATH old-external-path-name]
NEWPATH new-external-path-name

new-language

Keyword Explanation of parameter-clause

The keywords and variable values (if relevant) of the parameter-clause are explained in the fol-

lowing section.

Keyword Values Restricted to
Command
NAME The object name to be checked if NEWNAME is specified.
NEWNAME A new object name.
Anmerkung: Not applicable to DDMs on mainframe platforms.
LIBRARY The library name to be checked if NEWLIBRARY is specified.
NEWLIBRARY A new library name.
Note for the LOAD function:
NEWLIBRARY does not affect the library name used in the delete
instruction of a work file that is processed with the DELETEALLOWED
option.
LOADFNATDBID The database ID (DBID) of FNAT libraries. LOAD
LOADFNATFNR The file number (FNR) of FNAT libraries. LOAD
LOADFNATNAME Only applies to objects on mainframes. LOAD
An FNAT VSAM file name.
LOADFNATCIPHER Only applies to objects on mainframes. LOAD
An FNAT cipher code.
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Keyword Values Restricted to
Command
LOADFNATPASSWORD  |Only applies to objects on mainframes. LOAD
An FNAT Adabas password.
or
LOADFNATPSW
LOADFUSERDBID The DBID of FUSER libraries. LOAD
LOADFUSERFNR The FNR of FUSER libraries. LOAD
LOADFUSERNAME Only applies to objects on mainframes. LOAD
An FUSER VSAM file name.
LOADFUSERCIPHER  |Only applies to objects on mainframes. LOAD
An FUSER cipher code.
LOADFUSERPASSWORD |Only applies to objects on mainframes. LOAD
An FUSER Adabas password.
or
LOADFUSERPSW
LOADNCPDBID The DBID of the Adabas file for Natural command processor sources. | LOAD
LOADNCPFNR The FNR of the Adabas file for Natural command processor sources. | LOAD
LOADNCPNAME Only applies to objects on mainframes. LOAD
The VSAM name of the Adabas file for Natural command processor
sources.
LOADNCPCIPHER The cipher code of the Adabas file for Natural command processor |LOAD
sources.
LOADNCPPASSWORD  |Only applies to objects on mainframes. LOAD
The Adabas password of the Adabas file for Natural command
or processor sources.
LOADNCPPSW
FDTDBID The DBID of the Adabas FDT (Field Definition Table) to be checked
if NEWFDTDBID is specified.
NEWFDTDBID A new DBID of the FDT.
FDTFNR The DBID of the FDT to be checked if NEWFDTFNR is specified.
NEWFDTFNR A new FNR of the FDT.
ERRNUMDIFF A number (positive or negative) that is to be added to the Natural
error messages during the UNLOAD or LOAD command.
ERRNUMDIFF can only be specified if FMNUM and TONUM (see
select-clause)have been specified as selection criteria. Otherwise,
it is not possible to check for valid results.
LANGUAGE Up to 8 valid language codes (for example, code 1 for English) of
Natural error messages to be checked if NEWLANGUAGE (see below) is
specified.
If Tanguage contains more than one language code, new-Tanguage
must contain the same numbers of language codes. Each 7Tanguage
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1. Parameters not applicable to the selection criterion processed are ignored.

Keyword Values Restricted to
Command
language code is replaced by the language code in the corresponding
position of new-Tanguage.
If Tanguage is not specified, new-1anguage must not contain more
than one language code.

NEWLANGUAGE Up to 8 valid language codes (for example, code 4 for Spanish) for
new user-defined error messages. This option does not apply to the
long texts of Natural system error messages for which English
(language code 1) is the only valid language.

See also LANGUAGE above.

DATE An object date.

You can add a time by inserting a blank between date and time. For
the format and ranges allowed, see Date and Time in Name, Date and
Time Specification.

NEWDATE A new object date.

NEWDATE can be a date followed by a time value. You can add a time
by inserting a blank between date and time. See also Date and Time
in Name, Date and Time Specification.

USERID The user ID to be checked if NEWUSERID is specified.

NEWUSERID A new user ID.

TID Only applies to objects on mainframes.

The terminal ID to be checked if NEWT ID is specified.

NEWTID Only applies to objects on mainframes.

A new terminal ID.
PATH The path name to be checked if NEWPATH is specified.
NEWPATH A new path name.
Notes:

2. LOADFNAT..., LOADFUSER. .. and LOADNCP. .. are used for the LOAD command only, and ignored

otherwise.

3. LOADFNAT. .. is used for libraries starting with SYS (except SYSTEM).

4. LOADFUSER. .. is used for libraries not starting with SYS (but including SYSTEM).

5. LOADNCP. .. is used for Natural command processor sources.
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The option-setting clause is used to change the default values of Object Handler command
options.

The syntax that applies to the option-setting clause is shown and explained in the following
section. The keywords and variable values contained in the syntax diagrams shown represent the
parameters that are used to specify the default values. If indicated, a variable value must be supplied
with a keyword.

Syntax of option-setting

WHERE

(option-workplan)

option-clause

The syntax diagram that applies to option-workplanis shown and described in Referencing
Workplans in the section Workplans.

The syntax of the option-clause is shown in the following section.

= Syntax of option-clause

Syntax of option-clause
ALL
REPLACE OBSOLETE
EXCEPT

transfer-options
internal-format-options

NOREPORT

NEWREPORT [f7Te-name]
REPORT [f7Te-name]
BATCHREPORT

NORESTART
RESTART [restart-file]

[NUMBERPROCESS number]
[FIXEDLENGTH]

[FDIC (dbid,fnr,password,cipher)]
[FSEC (dbid,fnr,password,cipher)]

YES
[ USE-FDDM { NO } ]
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{ NEWWORKFILE } e name { WORKFILETYPE} ‘ gg;ﬁzEIE] l l
WORKFILE WFTYPE -
UTF-8
[ADAFDUWORKFILE file-namel
{ WORKFILELOCATION } { PC }
WFLOC SERVER

Separators

Commas must be used as separators between the values following the FDIC and FSEC keywords,
or if a value is missing. For example: FDIC (10,21, ,2a).

If the session parameter ID (see ID - Input Delimiter Character in the Parameter Reference documen-
tation) has been set to a comma, use a slash (/) as the separator between values.

transfer-options

TRANSFER

SYSTEM-TABLE
CONVERSION—TABLE{ USER-TABLE ]
[conversion-program)

[SUBSTITUTE]
[INCLUDE-LINE-NUMBERS]
[UPPERCASE-TRANSLATION]
[INCORPORATE-FREE-RULES]
[LOAD-CODE-PAGE code-page-name]
[DA-FORMAT data-area-format]

internal-format-options

ON
OFF
XREF { DOC
FORCE
SPECIAL
[DELETEALLOWED]
[NOSYMBOLTABLE]
[VERSIONCHECK]
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Keyword Explanation of option-setting

The keywords and the variable values (if relevant) of option-setting are explained in the follo-

wing section:

Option

Explanation

Restricted to
Command

REPLACE

Replaces existing objects according to the option specified:

ALL All objects (default setting).

OBSOLETE  All objects with a date older than the date of the
object in the load file.

EXCEPT All objects except those with a date newer than the
date of the object in the load file.

LOAD
LOADALL

TRANSFER

Set Transfer mode.

The data is read and written in Transfer format. For valid options,
see Keyword Explanation of transfer-options.

UNLOAD
LOAD
SCAN

NOREPORT

Specifies the report file setting:

No data is recorded to a report file. This is the default setting for
the FIND and FINDLIB commands.

NEWREPORT

Specifies the report file setting:

Report data is recorded and written to Work File 4 or f77e-name.
An existing file will be overwritten.

REPORT

Specifies the report file setting:

Report data is recorded and written to Work File 4 or f77e-name.
This is the default setting for the commands UNLOAD, LOAD, LOADALL,
SCAN, SCANALL and DELETE.

BATCHREPORT

Not applicable in a remote Natural Development Server
environment.

Specifies the report setting for batch processing or when using the
OBJHAPI Application Programming Interface:

Report data is either written to SYSOUT or output on the screen
respectively (report data is not written to a file).

NORESTART

No restart information is written to a file.

LOAD

RESTART

Restart information is written to Work File 6 or restart-file.

LOAD
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Option Explanation Restricted to
Command
NUMBERPROCESS Specifies the number of objects to be processed. LOAD
SCAN
The LOAD or SCAN command stops execution after the number
specified.
FIXEDLENGTH Sets the format of the unload work file to a maximum record length |UNLOAD
of fixed size.
Every data record contains 256 bytes if written in internal format,
or 100 bytes in Transfer format.
FDIC Specifies the system file FDIC to be used for processing: UNLOAD
LOAD
the database ID (db7d), file number (fnr), password (password) |pELETE
and cipher code (cipher) of the Adabas file.
If no values (or 0) are specified, the current FDIC system file is used.
FSEC Specifies the system file FSEC to be used for processing: UNLOAD
LOAD
the database ID (db7d), file number (fnr), password (password) |pELETE
and cipher code (cipher) of the Adabas file.
If no values (or 0) are specified, the current FSEC system file is used.
USE-FDDM Specifies that the FDDM system file is used for processing: see UNLOAD
Keyword Explanation of USE-FDDM below. LOAD
FIND
DELETE
NEWWORKFILE Specifies the work file to be used. UNLOAD
or LOAD
WORKFILE The UNLOAD or LOAD data is transferred into/from Natural Work |scaN
File 1. If NEWWORKF I LE is specified, the data overwrites the contents
of the existing work file or fills a new work file from the top.
Otherwise, the data is appended.
WORKFILETYPE Not required by the LOAD and SCAN commands, which automatically |[UNLOAD
or choose the appropriate work file type and ignore this keyword if |LOAD
WFTYPE specified. SCAN

The work file type of Natural Work File 1 when data is read and
written in internal format:

DEFAULT Default binary work file.
PORTABLE  Portable work file.
UTF-8 Unicode/UTE-8 encoded binary work file.

UTEF-8 only applies to the unload function and if
TRANSFER is specified.
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Option Explanation Restricted to
Command
If UTF -8 is specified, you cannot use the options
CONVERSION-TABLE, SUBSTITUTE and
INCORPORATE-FREE-RULES.
(See also Work File Format in Work Files.)
If WORKFILETYPE has not been specified, the current type is used.
ADAFDUWORKFILE |The complete path name assigned to the work file (Natural Work |LOAD
File 5) into which Adabas FDT data is loaded.
WORKFILELOCATION|Only applies to remote environments. UNLOAD
or LOAD
WFLOC Specifies the location of the unload, load or scan work file when |scaN
using Object Handler functions in connection with SpoD (Single
Point of Development).
Valid input values are:
SERVER The work file is located on the server, in the remote
environment. This is the default setting.
PC The work file is located in a local Windows directory, on
the client.

The keywords and the variable values (if relevant) of transfer-options and internal-format -
options are explained in the following section:

= Keyword Explanation of transfer-options
= Keyword Explanation of internal-format-options
= Keyword Explanation of USE-FDDM

Keyword Explanation of transfer-options

When using the TRANSFER keyword, you can specify the following options:

Option

Explanation

Restricted to
Command

CONVERSION-TABLE

the following conversion tables:
SYSTEM-TABLE:

The internal Natural conversion table.

USER-TABLE:

Converts data processed in Transfer format by using either of |UNLOAD

LOAD
SCAN
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Option

Explanation

Restricted to
Command

A user-defined conversion table if conversion-programhas
been specified. This program must be stored in the library
SYSOBJH or one of its steplibs; see the example programs
OTNCONAE and OTNCONEA in the library SYSOBJH.

If no conversion-programis specified, the corresponding
conversion table is used in NATCONV.INI
([I1SO8859_1->EBCDIC] or [EBCDIC->ISO8859_1]).

SUBSTITUTE

Replaces line references by labels during the unload in Transfer
format.

This option only applies if your source-code line numbers are
used for statement references. If so, the line numbers of
referenced lines and the line number references are replaced by
labels. The sources are not modified in the database.

UNLOAD

INCLUDE-LINE-NUMBERS |Transfers line numbers during the unload in Transfer format. |UNLOAD
By default, line numbers in Natural objects are not unloaded.
UPPERCASE-TRANSLATION |Translates any source code into upper case during the load in |LOAD
Transfer format.
By default, source code in Natural objects is not translated.
INCORPORATE-FREE-RULES |Incorporates source text of Predict free rules associated with a |[UNLOAD

map into a map source during the unload in Transfer format if
Predict is installed.

LOAD-CODE-PAGE

Specifies the code page to be used for converting object sources
encoded in Unicode/UTF-8 (Universal Transformation Format,
8-bit form).

If you use this option, all object sources unloaded into a work
file in UTF-8, will be converted with the specified code page
when they are loaded into a work file.

If you specify *CODEPAGE as code-page-name, the value
assigned to the system variable *CODEPAGE is used (see the
System Variables documentation).

If code-page-name is not specified, the source objects are
converted with the code page used when unloading them.

If LOAD-CODE-PAGE is specified, you cannot use the options
CONVERSION-TABLE and UPPERCASE-TRANSLATION.

LOAD
LOADALL

DA-FORMAT

Specifies format conversion of data area sources.

Possible values are:

N  Converts data areas to the new internal data area format.

0 Converts data areas to the old internal data area format.

UNLOAD
LOAD
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Option

Explanation

Restricted to
Command

*  Does not convert data areas. This is the default.

See also the data area conversion options described in Transfer

in Settings - Options.

Keyword Explanation of internal-format-options

When using internal-format-options, you can specify the following;:

Option

Explanation

Restricted to
Command

XREF

Only applies if Predict is installed.

Loads or unloads XRef data of cataloged Natural objects. You can specify

one of the following values:

LOAD
UNLOAD

ON

UNLOAD:

data (if any).

LOAD:

if cross-references exist in the work file.

Unloads cataloged objects and their cross-reference

Loads cataloged objects and their cross-reference data

OFF

No XRef data is processed. This is the default.

DOC

Only applies to LOAD.

the objects in the FDIC system file.

Loads cataloged objects only if Predict entries exist for

FORCE

Only applies to LOAD.

Loads cataloged objects and their cross-reference data
only if cross-references exist in the work file and if
Predict entries exist for the objects in the FDIC system
file.
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Option

Explanation

Restricted to
Command

SPECIAL Only applies to LOAD.

Loads cataloged objects and their cross-reference data
(if any).

DELETEALLOWED

Processes delete instructions from work files created by the utility NATUNLD
when loading objects in internal format.

LOAD

NOSYMBOLTABLE

Only applies to objects on mainframes.

Unloads cataloged Natural library objects without their corresponding
internal Natural symbol tables.

This will reduce the amount of disk storage required. However, this is only
useful for a production environment, as several application development
functions which require the symbol tables will then not be available; in
addition, the profile parameter RECAT=0N (see the Parameter Reference
documentation) will not apply.

UNLOAD

VERSIONCHECK

Only applies to objects on mainframes.

Checks the Natural version of the cataloged object to be loaded. The Natural
version under which the objects were cataloged and written to the work file
is compared with the current Natural version. Objects cataloged under a
Natural version higher than the current one will be rejected.

VERSIONCHECK can only be used if data is loaded in internal format, that is,
if the TRANSFER option is not specified.

LOAD

Keyword Explanation of USE-FDDM

Only applies when processing Natural library objects on UNIX, OpenVMS or Windows plat-

forms.

Specifies that the FDDM system file is used for processing.

If the FDDM file has been activated in the NATPARM module, the default setting is YES.

The following applies when specifying the values YES or NO:

Value |Explanation

YES |[UNLOAD, FIND and DELETE:

If the parameter NATTYPE is set to V, DDMs are only processed from the library SYSTEM located in
the FDDM file or the file specified by the database ID (DBID) and the file number (FNR).

No DDMs are processed if the parameter NATTYPE is set to *, or if NATTYPE is a combination of any
Natural object types that does not include the type V.
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Value |Explanation

LOAD:
DDMs are loaded into the library SYSTEM located in the FDDM file.

See also NATTYPE in Natural Library Object and DDM Selection in select-clause.
NO |UNLOAD, FIND and DELETE:

DDMs are processed from the libraries specified.

LOAD:

DDMs are loaded into the libraries specified.
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Examples of Using Direct Commands

This section provides examples for using Object Handler direct commands.

() Tip: For additional examples, you can view the command generated for an Object Handler

function. This command is automatically displayed when you use a wizard. In advanced-
user mode, you can activate the display of the command by either entering the Object
Handler command SET ADVANCEDCMD ON or setting the parameter
Display-Cmd-in-Advanced-Mode to Y (Yes) in the Object Handler profile (see also Profile
Settings).

Unloading Objects for the Same Platform

This section contains examples of how to unload objects in internal format to a work file in order
toload them on the same platform, within either a local mainframe, UNIX, OpenVMS or Windows
environment:

Unload all Natural programming objects (source objects only) from library ABC:

UNLOAD * LIB ABC OBJTYPE N SCKIND S

Unload all Natural programming objects (cataloged objects only) from library ABC:

UNLOAD * LIB ABC OBJTYPE N SCKIND C

Unload all Natural programming objects (cataloged objects and source objects) from library
ABC:

UNLOAD * LIB ABC OBJTYPE N SCKIND A

Unload all Natural programming objects (source objects only) from library ABC to load in library
ABCNEW:

UNLOAD * LIB ABC OBJTYPE N SCKIND S WITH NEWLIBRARY ABCNEW

On a mainframe: Unload all DDMs whose names start with EMP and which point to database
88:

UNLOAD EMP* LIB * OBJTYPE D DDMDBID 88

On UNIX, OpenVMS or Windows: Unload all DDMs whose names start with EMP and which
point to database 88:

UNLOAD EMP* LIB * OBJTYPE N NATTYPE V DDMDBID 88

On UNIX, OpenVMS or Windows: Unload all DDMs whose names start with EMP from library
VLIB to load in library VLIBNEW:
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UNLOAD EMP* LIB VLIB OBJTYPE N NATTYPE V WITH NEWLIBRARY VLIBNEW

® Unload all user-defined error messages from library ERRLIB to load in library NEWERR:

UNLOAD * LIB ERRLIB OBJTYPE E SLKIND A WITH NEWLIBRARY NEWERR

® On Windows: Unload all Natural programming objects (cataloged objects and source objects)
from library ABC to a portable work file on a PC:

UNLOAD * LIB ABC OBJTYPE N WHERE WORKFILE C:\WF1.SAG WORKFILETYPE PORTABLE

or

UNLOAD * LIB ABC OBJTYPE N WHERE WORK C:\WF1.SAG WFT P

Unloading Objects for Different Platforms

This section contains command examples of how to unload objects in Transfer format to a work
file in order to load them on a different platform such as unloading in a mainframe and loading
in a UNIX, an OpenVMS or a Windows environment.

® Unload all Natural programming objects (source objects only) from library ABC:

UNLOAD * LIB ABC OBJTYPE N WHERE TRANSFER

® Unload all Natural programming objects (source objects only) and user-defined error messages
from library ABC:

UNLOAD * LIB ABC WHERE TRANSFER

® Unload all Natural programming objects (source objects only) from library ABC with fixed record
length:

UNLOAD * LIB ABC OBJTYPE N WHERE TRANSFER FIXEDLENGTH

Loading Objects in Internal Format

This section contains command examples of how to load objects from a work file in internal format.

® Load all objects to library LIBNEW and replace any that already exist:

LOADALL WITH NEWL LIBNEW WHERE REPLACE ALL

® Load all object with target library TGTLIB to the new target library NEWTGT:
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LOAD * LIB TGTLIB WITH NEWLIBRARY NEWTGT

* Load the user-defined error messages 1000 to 1500 from library ERRLIB only:

LOAD * LIB ERRLIB OBJTYPE E FMNUM 1000 TONUM 1500

Loading Objects in Transfer Format

This section contains command examples of how to load objects from a work file in Transfer format.

® Load all objects to library LIBNEW and replace any that already exist:

LOADALL WITH NEWL LIBNEW WHERE TRANSFER REPLACE ALL

® Load all object with target library TGTLIB to new target library NEWTGT:

LOAD * LIB TGTLIB WITH NEWLIBRARY NEWTGT WHERE TRANSFER

Batch Processing in a Remote Environment

You can use direct commands to unload objects in batch mode from a remote Natural Development
Server (NDV) environment or load objects in batch into a remote NDV environment.

The examples in this section illustrate the use of direct commands in batch to transfer objects from
one remote NDV environment to another.

= |nput Commands in CMSYNIN File
= |nput Data in CMOBJIN File
= Explanation of File Contents

Input Commands in CMSYNIN File

MAP ENVIRONMENT=UX1 SUNNAT63 6312 SAG
SYSOBJH

UNMAP

MAP ENVIRONMENT=MF1 IBM2 4742 SAG
SYSOBJH

UNMAP

FIN
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Input Data in CMOBJIN File

UNLOAD * LIB SAG-TEMP 7%

WHERE TRANS WFLOC PC WORK D:\NAT-Work\wl.dat REPORT
SHOW STATISTICS

END

LOADALL WHERE TRANS WFLOC PC WORK D:\NAT-Work\wl.dat 7%
REPLACE ALL REPORT

SHOW STATISTICS

END

Explanation of File Contents

MAP ENVIRONMENT=UX1|Maps to an NDV environment on a UNIX or an OpenVMS platform.
SUNNAT63 6312 SAG

SYSOBJH Invokes the Object Handler (on the Windows client) that receives the following
three commands from the input data in the CMOBJIN file:

UNLOAD * LIB SAG-TEMP %
WHERE TRANS WFLOC PC WORK D:\NAT-Work\wl.dat REPORT

Causes the Object Handler to unload all objects from library SAG-TEMP in the
remote UNIX or OpenVMS environment into the work file contained in the local
Windows directory D:\NAT-Work\w1.dat.

SHOW STATISTICS
Writes statistical data about the unloaded objects to the CMPRINT output file.
END

Terminates the Object Handler.
UNMAP Unmaps the NDV environment on the UNIX or OpenVMS platform.

MAP ENVIRONMENT=MF1|Maps to an NDV environment on a mainframe platform.
IBM2 4742 SAG

SYSOBJH Invokes the Object Handler (on the Windows client) that receives the following
three commands from the input data in the CMOBJIN file:

LOADALL WHERE TRANS WFLOC PC 7%
WORK D:\NAT-Work\wl.dat REPLACE ALL REPORT

Causes the Object Handler to load all objects from the work file in the local
Windows directory D:\ NAT-Work\w1.dat into the remote mainframe environment.

SHOW STATISTICS
Writes statistical data about the loaded objects to the CMPRINT output file.

END
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Terminates the Object Handler.

UNMAP Unmaps the NDV environment on the mainframe platform.

FIN Terminates the Natural batch session.
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Batch Condition Codes and User Exit Routines

This section describes the condition codes returned for Object Handler functions in batch mode
and the user exit routines available for function processing.

Condition Codes Returned in Batch

Object Handler processing in batch mode terminates with one of the following condition codes:

Condition Code |[Explanation

0 Object Handler process terminated successfully.

30 An internal Object Handler error occurred.

40 An error was detected in the Object Handler command.

50 An error occurred during Object Handler processing.

60 A Natural Security error occurred during Object Handler processing.
99 A Natural error occurred during Object Handler processing.

Applying User Exit Routines

The Object Handler user exit routines are supplied as source objects in the Natural system library
SYSOBJH. These source objects are named SRC-EXnn, where nn denotes the number of the user
exit routine.

» To activate a user exit routine

m  CATALOG or STOW source object SRC-EXnn under the name 0BJHEXnn in the Natural system
library SYSOBJH.

Different names are used to guarantee that the source object (possibly modified according to
your requirements) and the cataloged object of the user exit routine are not overwritten by
an update installation.

For detailed descriptions of the user exit routines, see the source objects of SRC-EXnn in the
library SYSOBJH.
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User Exit Routines Available

The following user exit routines are available:

= OBJHEXO01 for Processing Failures
= OBJHEXO02 for Object Rejection

OBJHEXO01 for Processing Failures

Whenever a condition code is set to a value greater than 0 (zero) in batch mode, the user exit rou-
tine OBJHEXO1 (if available) will be invoked before the Object Handler stops processing. With
this user exit routine, you can specify whether to continue or terminate Object Handler processing.
In the case of termination, you can change the condition code. For further details, see the source
of the user exit routine SRC-EX01 in the Natural system library SYSOBJH.

OBJHEXO02 for Object Rejection

If the Object Handler load function was executed successfully in batch mode (with Condition Code
0), but one or more objects were rejected during loading (for example, not replaced), before the
Object Handler stops processing, the user exit routine OBJHEXO2 (if available) is invoked. With
OBJHEXO02, you can specify whether to continue or terminate Object Handler processing. In the
case of termination, you can set a condition code. For further details, see the source of the user
exit routine SRC-EX02 in the Natural system library SYSOBJH.
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Tools

The Object Handler provides special features in the Tools menu to display status information and
reports, check and modify trace settings and transfer work files to and from remote environments.

Status

Displays the Object Handler functions currently used, the user environment, the Workplan library
and the current usage of Work Files 1 to 15.

» To display the status

s From the Tools menu, choose Show Status.

Last Result

Displays the last internal command issued by the processing interface of the Object Handler and
possible return codes and messages.

» To display the last result

s From the Tools menu, choose Last Result.

Traces

Activates or deactivates the trace function. Traces record internal Object Handler program flows
to provide control information for error diagnoses. The trace option is set off by default.

» To change the setting

s From the Tools menu, choose Trace Setting.

» To maintain permanent trace files in remote environments

»  From the Actions menu, choose Change Workplan Library and proceed as described in
Remote Environments in Change Workplan Library in the section Administration.
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Reports

Lists the objects processed with the unload, load, scan or find function, and records errors that
may interrupt processing. The report option is set on by default and is displayed after the unload,
load, scan or find function has been executed.

» To display the contents of the latest report file

s From the Tools menu, choose Show Report File.

» To change the settings in local environments

1  From the Options menu, choose Settings and the tabbed page General.

2 Inthe Settings window, on the tabbed page Options, select the option button Use additional
options and choose the Set button.

3 Choose the tabbed page General.

For possible settings, see General in the section Settings - Options.

» To maintain permanent report files in remote environments

= From the Actions menu, choose Change Workplan Library and proceed as described in
Remote Environments in Change Workplan Library in the section Administration.

Transfer Work File

Only applicable to remote environments located on mainframe platforms.

Transfers the contents of work files from local environments to mainframe servers and vice versa.
The work files must be of corresponding types. See also Work File Format in the section Work
Files.
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Options

The Object Handler provides the Options menu to invoke functions and/or activate (deactivate)
modes and options. Note that the items on the Options menu do not apply to all Object Handler
functions, and, therefore, may not be available on all Options menus. Additionally, the availability
of items depends on the processing mode used (advanced user or wizards) and the status of
function processing.

Settings

The Settings option invokes the Settings window where you can specify option settings for the
unload, load or scan function and parameter settings for the unload or load function. For further
information, see the section Seftings.

Profile

This option is available in the Options menu in the Welcome to the Natural Object Handler
window.

The Profile option invokes the SYSOBJH - Profile window where you can define an individual
profile for your Object Handler utility. See also the section Profile Settings.

Advanced User

This option is available in the Options menu in the Welcome to the Natural Object Handler
window.

The Advanced User option activates function processing in advanced-user mode as described in
Advanced User in the section Functions.

Free Format Editing

With the Free Format Editing option activated, an edit area is supplied for creating a new Workplan:
see New Workplan in Administration in the section Functions.
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Details

This option only applies to functions executed in advanced-user mode.

The Details option activates the selection criteria specified in the appropriate Details window of
objects to be processed. For further information, see the section Object Specification.

Single Objects

This option applies to the result lists generated by Object Handler functions in advanced-user
mode. It does not apply to the scan function.

With the Single Objects option activated, source objects (Src) and cataloged objects (Gp) are listed
in separate table rows.

Display Command

This option applies to functions executed in advanced-user mode. It does not apply to the view
function.

With Display Command activated, the Object Handler command generated for a function is dis-
played before the function is executed. This provides you the option to cancel the operation. In
addition, you can save the command as Workplan of the type PROCEDURE as described in the
section Workplans.
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47 Profile Settings

You can define an individual profile for your Object Handler utility by modifying the standard
Object Handler user profile and specifying general or user-defined parameter settings, such as
activating advanced-user mode by default, or specifying default settings for work files, report files
and Workplans.

» To invoke the profile option

1  In the Welcome to the Natural Object Handler window, from the Options menu, choose
Profile.

The SYSOBJH - Profile window appears which provides all functions required for maintaining
individual profiles.

2 Select the option(s) required and choose the OK command button to save your modifications.
The default is that the settings of the previous Object Handler session are used at session startup.

The Object Handler profile is stored as text file SYSOBJH.PRU in the following directory of the
Natural Configuration Utility: Local Configuration File\Installation Assignments\<Path to profile
parameters>.
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Migration from SYSTRANS to the Object Handler

You can migrate from the old utility SYSTRANS to the Object Handler by using the two methods
described in this section.

Converting Individual Commands

You can convert SYSTRANS direct commands to the corresponding Object Handler direct com-
mands by using the Object Handler direct command provided for migration. This migration
command automatically converts the command syntax used by SYSTRANS to the command
syntax used by the Object Handler.

» To convert a single command
1  Use the following Object Handler direct command:
SYSTRANS

followed by a SYSTRANS direct command.

The specified SYSTRANS command is converted to the corresponding Object Handler com-
mand.

2 Specify any subsequent command for the Object Handler in the syntax that applies to the
SYSTRANS utility.

The syntax of SYSTRANS remains valid for the duration of the Object Handler session.

Example of a SYSTRANS Command:

The following is an example of two consecutive SYSTRANS utility commands and their correspon-
ding Object Handler commands.

Old SYSTRANS commands: TRANSCMD EXECUTE UNLOAD N FROM LIB1 NAME ETID
END

New Object Handler command: SYSOBJH SYSTRANS EXECUTE UNLOAD N FROM LIBI
NAME ETID END

Subsequent Object Handler command in END

SYSTRANS syntax:

Example of SYSTRANS Batch Processing;:

The following is an example of processing a SYSTRANS utility command in batch by using map
input data, and the corresponding Object Handler command and input data.
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Old SYSTRANS batch sequence:

SYSTRANS

U

NONSN,Y NN, N, N

N

SRCLIBI,PGMI,*, TGTLIBI

New Object Handler batch sequence:

SYSOBJH SYSTRANS

U

NONSN,Y, N,N,N,N

N

SRCLIBI,PGMI,*, TGTLIBL

Processing SYSTRANS Commands with OBJHAPI

You can use the OBJHAPI Application Programming Interface (supplied in the Natural system
library SYSOBJH) to execute an Object Handler command in the syntax of the SYSTRANS utility.

If you use OBJHAPI for this purpose, you have to specify the parameter
P-EXTENSIONS-EXEC-SYSTRANS-CMD in the program that invokes OBJHAPI. For details, see the
example program DOC-API supplied in the library SYSOBJH.

Unsupported SYSTRANS Options

The Object Handler does not support the following SYSTRANS direct command options:
WORK-FILE-INPUT, SPECIAL-CONVERSION, RULE-LOAD and UNLOAD-RULES.
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SYSAPI Utility - APIs of Natural Add-On Products

The utility SYSAPI is used to locate and test Application Programming Interfaces (APIs) provided
by Natural add-on products such as Entire Output Management. This can be done either in a local
Windows environment or in a remote environment located on a Windows, a UNIX, an OpenVMS
or a mainframe platform.

The API of a Natural add-on product is a Natural subprogram (cataloged object) that is used for
accessing and possibly modifying data or performing services that are specific to an add-on product
or a subcomponent.

The API of a Natural add-on product is supplied in the Natural library and/or system file provided
for objects that are specific to a particular Natural add-on product. For instructions on using the
API of a Natural add-on product, refer to the documentation of the respective add-on product.

For each API of a Natural add-on product, the utility SYSAPI provides a functional description,
one example program and API-specific keywords.

Related Topics:

® SYSEXT - Natural Application Programming Interfaces - Utilities documentation

Prerequisites

® The appropriate Natural add-on product must be installed at your site.
® The version of the Natural add-on product installed must support the SYSAPI utility features.

® The Enable Plug-ins option must be selected. This option is selected by default. For details, see
Workspace Options in the section Setting the Options in the Using Natural Studio documentation.

Invoking and Terminating SYSAPI

This section provides instructions for invoking and terminating the SYSAPI utility.

» To invoke SYSAPI

= Enter the following system command:

SYSAPI
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When invoking SYSAPI, the plug-in for the utility SYSAPI is activated and the SYSAPI utility
window appears with the root node SYSAPI - APIs of Natural Add-on Products as shown
in the example below:

#~. SYSAPT ULility M=] B9

S¥SAPI - APIs of MNatural Add-on Producks

» To restart SYSAPI

= Ifyou want to restart SYSAPI during the current Natural session, as an alternative to the start
method mentioned earlier, from the toolbar, choose the following icon:

iify

This icon appears after initially invoking SYSAPI, when the plug-in for the utility SYSAPI is
activated.

» To terminate SYSAPI

m  Choose the standard Windows close function.

SYSAPI Tree View Items

This section describes the structure of the tree in the SYSAPI utility window and the nodes and
items contained in the tree view.

Starting with the SYSAPI - APIs of Natural Add-on Products root node at the top tree level you
can expand the following node hierarchy:

= Natural Add-On Product Node
= AP| Group Node
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= APl Node

Natural Add-On Product Node

Each Natural add-on product installed at your site has its own node, which contains one or more
subordinate API group nodes.

API Group Node

Each API group node represents a particular API feature provided for the Natural add-on product
of the parent node. An API group node contains all APInodes that relate to the particular feature.

APl Node

An API node name consists of the name of the API subprogram and a brief description of its
functional purpose. API nodes are sorted by API names.

An API node contains the following API-specific items:

Item Explanation

Keywords All keywords relevant to the API. See also the functions Select Keyword and List All
Keywords.

Description A text object or program that contains a description of the API. The description comprises
purpose, function and calling conventions of the API and keywords relevant to the API.

Example Program|An example program or subprogram of how to invoke the APL

Performing SYSAPI Utility Functions

The SYSAPI utility can be used to perform operations on API-specific text objects (descriptions)
and example programs or functions on API groups such as finding APIs relevant to a current task
by specifying keywords.

Object operations include functions such as List, Open and Execute, which correspond to the
standard functions available when maintaining or executing a Natural object of the type text or
program. These functions can be performed by using the context menu associated with each object.
For details of these functions, refer to the relevant sections in the Using Natural Studio documenta-
tion.

The section below describes the functions that can be performed on an API group:

= Select Keyword
= | jst All Keywords
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= Refresh

Select Keyword

This function is used to list all API nodes of a selected API group to which a specified keyword
applies.

» To list APIs by keyword

1

Select the API group node of a Natural add-on product, open the context menu and choose
Select Keyword or press SHIFT+K.
The Select Keyword window appears.

From the drop-down list box, select a keyword as shown in the example of a Select Keyword
window in the SYSEXT utility documentation.

Choose the OK button.

The keyword is indicated in the node name of the selected API group.
Expand the API group node.
A list of all API nodes to which the specified keyword applies appears for the selected API

group. The window looks similar to the corresponding window of the SYSEXT utility (see
the example in the SYSEXT utility documentation).

If required, to return to the complete list of all API nodes available in the API group node
(default setting), in the Select Keyword window, select the asterisk (*).

List All Keywords

This function is used to list all keywords available for a selected API group.

» To list all keywords of an API group

1

Select an API group node, open the context menu and choose List All Keywords or press
SHIFT+A.

The All Keywords window appears where the root node indicates the name of the Natural
add-on product and the name of the selected API group.

The window looks similar to the All Keywords window of the SYSEXT utility (see the
example in the SYSEXT utility documentation).
Expand the root node.

A list of all keywords available for the selected API group appears. You can expand the key-
word nodes and display all API nodes to which the keyword applies.
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Refresh

This function updates the current SYSAPI environment settings. This can be required, for example,
when you change the language code (system variable *LANGUAGE) to adapt API descriptions
and keywords to another language if the Natural add-product supports different languages for
its API descriptions and keywords.

» To refresh SYSAPI environment settings

1  Select the root node SYSAPI - APIs of Natural Add-on Products, open the context menu and
choose Refresh or press SHIFT+R.

A Refresh window appears.

2 Choose the OK button to confirm the refresh or choose Cancel to abort the operation.
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SYSCP Utility - Code Page Information

The SYSCP utility is used to obtain information on code pages available in the current Natural
Windows environment.

This helps avoid problems that can occur when a code page is not defined in Natural or when
source objects are converted to an incorrect code page or Unicode format.

For detailed information on how Natural supports Unicode and code pages and Unicode-specific
items, see the descriptions and presentations in the SYSEXV application and Related Topics below.

Related Topics:

® Unicode and Code Page Support: Natural documentation

® Unicode: Unicode Consortium at web site at hittp://www.unicode.org/

ICU: IBM ICU Documentation at web site http://www-01.ibm.com/software/globalizati-
on/iculindex.jsp

* IBM Converter Explorer documentation at web site http://demo.icu-project.org/icu-bin/convexp

Invoking and Terminating SYSCP

Instructions for invoking and terminating the SYSCP utility are provided in the following section.

» To invoke the SYSCP utility

= Enter the following system command:

SYSCP

A SYSCP Utility - All Code Pages window similar to the example below appears:
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SYSCP Utility - Code Page Information

5‘|’5EP Utility - All Code Pages H=] |

Wiew  Help
Code Page Mame Aftibutes Unitz
R T T
Ldobhe-Standard-Encoding 1 1
BOCT-1 EZL 1 4
Eigs ADL 1 - 2
EigS5-HESCS ADL 1 - 2
CEST-32 AZL 1 - 3
EUC-ER ADL 1 - 2
Extended UNIX Code Packed Format for Japanese LDL 1 - 3
GEZ312 ADL 1 - 2
EK ADL 1 - 2
GE_Z231Z2-80 EDL 2 - 2
HZ-GE-2312 ASL 1 - 4
IEM-Thai E3L 1 - 1
IEMOOS5S A3L 1 - 1
IEMO1140 EZL 1 - 1
IEMO1141 EZL 1 - 1
IEMO114: E3L 1 - 1
IEMO1145 E3L 1 - 1
IEMO1144 EZL 1 - 1
IEMO1145 E3L 1 - 1 ;I
|

This window is opened by the All Code Pages function, which is executed by default when
you invoke the SYSCP utility.

All SYSCP utility functions are provided in the View menu. They are explained in the
remainder of this documentation.

The Help menu provides online help information about the SYSCP utility.

» To terminate SYSCP

s Choose the standard Windows close function.
Or:

From the View menu, choose Exit.
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All Code Pages

This function opens the SYSCP Utility - All Code Pages window, which provides a list of all code
pages available in your current Natural Windows environment. The list is sorted in ascending
order by code page name.

The columns contained in the window and the options provided for each code page listed are
described in the following section:

= Columns of Code Page List
= Context Menu Options

Columns of Code Page List

The columns contained in the list of code pages are described in the following section:
® Code Page Name
This column lists the IANA name of the code page.

The IANA (Internet Assigned Numbers Authority) name is the standard and unambiguous
name of the code page. The IANA name is used by Natural as the default code page name (see
the CP profile parameter described in the Parameter Reference documentation) for conversions to
and from Unicode. The IANA name is returned by the *CODEPAGE system variable (see the System
Variables documentation).

If no IANA name is specified, the internal ICU name is listed instead. This is indicated by ICU
Name:, which is used as a prefix for all ICU names.

You can use the Show All Names option of the context menu to display all code page names
specified for a code page.

= Attributes
This column displays a three-letter code, which represents the attributes of the code page: see
the Show Attributes option of the context menu for details.

® Units

This column indicates the code units (minimum and maximum numbers of bytes) assigned to
the code points.
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Context Menu Options

For the code page selected, you can use the context menu to obtain further information on the
code page or to test code-point assignments of characters.

» To open the context menu

1 From the code page list, select the code page required.

2 Click the right mouse button.
Or:
Press SHIFT+F10.
The context menu appears.
The options provided in the context menu are described in the following section:

= Show Attributes
= Show All Names
= Test Conversion

Show Attributes

This option can be used to display the attributes of the code page selected. Attributes are character

sets and languages supported by the code page. Attributes and codes that represent each attribute
are listed in the following table:

Code | Attribute

ASCII character set.
EBCDIC character set.

Double-byte or multi-byte character set for languages such as Japanese and Chinese.

Single-byte character set.

Right-to-left direction.

—| ™| »n| ol m| >

Left-to-right direction for bi-directional languages such as Arabic and Hebrew.
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Show All Names

This option can be used to display all names that can be specified for the code page selected:
® IANA name

If not specified, this field is blank.
®" JCU name

= Alias names

One or more alternate names used for the code page.
Test Conversion

You can test code-point conversion from a selected code page to the default code page (value of
*CODEPAGE) defined with the CP profile parameter:

® from an alphanumeric character string to Unicode code points and vice versa, or

® from hexadecimal values to Unicode code points and vice versa.

The test conversion dialog box of a code page (here: windows-1250) shown in the example below
contains the following information:

® the code page name,

" the byte units (minimum and maximum numbers of bytes) assigned to the code points,

® an alphanumeric character string and its equivalent hexadecimal values and

* the corresponding Unicode code points.
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[f]s¥scP utility - Test Conversion

Code page name:  windows-1250

Code page unitz: 1 -1 [ritirnuim, maximum of bytes)

Code Page Characters

Alphanumernic:  |EYS08

T o
FREREEEEEEEEEEEEEEEEE

)]
)]

[}

Unicode

Code paints: |nn41 |nn42 |nn43 |nnzn |nuzn |nnzn |unzn |nnzn |nnzn |nnzn

|nnzu |nnzn |nnzn |nnzn |nuzn |nnzn |unzn |nnzn |nnzn |nnzn

|nnzu |nnzn |nnzn |nnzn |nuzn |nnzn |unzn |nnzn |nnzn |nnzn

|nnzu |nnzn |nnzn |nnzn |nuzn |nnzn |unzn |nnzn |nnzn |nnzn

Test I (] | Help

» To convert a character or code point

1  Enter a literal string in the Alphanumeric box.
Or:
Enter hexadecimal values in one or more Hexadecimal boxes.
Or:
Enter Unicode code points in one or more Unicode boxes.

The boxes not used for input are deactivated.

2 Choose Test or press ENTER.

The value entered in one of the boxes is converted to its equivalent code points or literal string.

3 Choose OK to close the Test Conversion dialog box.
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Unicode Properties

This function is used to display the Unicode properties for a Unicode character or a Unicode code
point as shown in the example of the letter A below:

[f]s¥SCP Utility - Unicode Properties =] E3 |
Wiews  Help

Unicode character: I
Unicode code point: IEH:|41

Character name: LATIM CAPITAL LETTER A

~ Unicode Properties

Alphabetic Contral
Alphanumeric  Space
Lower caze Whitezpace
Upper caze Blank

it Punctuation

Hexadecimal Combining
Graphic Surrogate
Printable Right to left

apply

The Unicode Properties function can also be used to view the code point assigned to a character.

» To display the code-point assignment and Unicode properties

1  Inthe Unicode character box, enter the character whose code point and properties you want
to view.

Or:
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In the Unicode code point box, enter the code point whose character and properties you want
to view.

2 Choose Apply or press ENTER.

The value entered in one of the boxes is converted to its equivalent character or code point
whose Unicode properties are displayed in the window.

A Unicode property shown in boldface letters denote that this property applies to the character
such as Alphabetic in the example above.

For explanations of the Unicode character properties displayed in the window, refer to Unicode
Consortium's documentation Unicode Character Database at web site http://www.unico-
de.org/Public/4.1.0/ucd/UCD.html.

General Information

This function provides information on the current ICU and Unicode versions.
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51 SYSERR Utility

When you develop a Natural application, you may want to separate error or information messages
from your Natural code and manage them separately. This makes it easy for you, for example, to
standardize messages, to have predefined message ranges for different types of message, to
translate messages into other languages or to attach to a message a long text that explains it in
more detail.

The SYSERR utility provides the option to write application-specific messages. In addition, you
can use the SYSERR utility to customize the texts of the existing Natural system messages.

General Information on Messages

Invoking SYSERR

SYSERR Utility Window and Functions

Converting Natural System Short Messages

Generating Message and Text Files

Managing Messages in Different Libraries

¢ ¢ ¢ € € e ¢

Application Programming Interface USR0020P

301



302



52 General Information on Messages

B MESSAGE TYPES ettt ettt 305
B MESSAGE LANGUAGES ... eeeeeeee ittt ettt ettt et e e e oo ettt e e e e e e et e e e e e e e e aaeea e 305
B |SSUING MESSAGES ... ettt ee ettt ettt ettt e e e e ettt et e e e e e e e e 306
= Retrieving Natural System Short MESSAGES .........coouiiiiiiiiiiiii e 307
= Retrieving User-Defined Short MESSAZES ......vvvviiiiiiiiiii i 307
= Obtaining Message INFOrMation ..............eiiiiiiiii e 308

303



General Information on Messages

This section contains information on the types of message and message languages that can be
managed with the SYSERR utility and how messages are issued and retrieved in your Natural

system environment.

The following graphic illustrates the features of the SYSERR utility and how messages are processed

within Natural:

Text Files

—

(UMEX and Windows only)

User-Defined
Messages

FMAT/FUSER

Library 1

Matural System
Messages
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Message Types

There are two types of message: Natural (system) messages and user-defined messages:

Natural system messages are issued by the Natural nucleus and Natural utilities. Natural system
messages are delivered by Software AG and stored as message files in the Natural Err directory.
Natural system messages begin with NAT, followed by a four-digit number, for example, NAT0230.

User-defined messages are issued by applications written by a user. User-defined messages are
stored as message files in libraries (including SYS-libraries) in the system file FUSER or FNAT.

A message can be translated into different languages. Each language is stored in a separate mes-
sage file. A maximum of 9999 messages can be stored per library and message file.

There are four types of message text:

® Natural system short message

® Natural system long message

User-defined short message

User-defined long message

A short message is the one-line message which is displayed in the message line when the corre-
sponding error situation occurs.

A long message is a detailed explanation of the corresponding short message and includes
instructions for solving problems.

@ Caution: Keep in mind that any modifications of Natural system messages can result in

wrong messages or a loss of modifications when a new Natural version is released.

Message Languages

Messages can be created in up to 60 languages as described for the system variable *LANGUAGE in
the System Variables documentation.

The following rules and restrictions apply:

® Natural system short messages must be entered in English first, and can then be translated into
any other language.

® Natural system long messages can be entered in English, but cannot be translated into other
languages.
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® User-defined short messages can be entered in any language, and then be translated into any
other language.

® User-defined long messages can be entered in any language, but only if the corresponding short
message in the same language already exists.

Issuing Messages

This section contains information on the Natural statements INPUT and REINPUT that are used to
issue a Natural system short message or a user-defined short message in a Natural program.

» Toissue a Natural system short message in a program
»  Specify one of the following Natural statements:
INPUT WITH TEXT *-nnnn
or
REINPUT WITH TEXT *-nnnn
where nnnnis the number of the requested message (you can omit leading zeros).
» Toissue a user-defined short message in a program
= Specify one of the following Natural statements:
INPUT WITH TEXT *nnnn
or

REINPUT WITH TEXT *nnnn

where nnnn is the number of the requested message (you can omit leading zeros).
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Dynamic Replacement of Message Text

A message text can contain variable parts that are identified by the notation : n:, where n represents
occurrences 1 to 7. These variable parts are replaced by a value at runtime.

For details, see operand3 in the section INPUT Syntax 1 - Dynamic Screen Layout Specification and
operand3in the section REINPUT in the Statements documentation.

Retrieving Natural System Short Messages

When a program references a Natural system short message, Natural looks for the requested
message number in the Natural Err directory in the following order:

1. Under the current language code as determined by the system variable * LANGUAGE,
2. Under language code 1 (English).

If neither of the above is found, a program references a message that does not exist and you only
receive the message number prefixed with NAT, for example, NAT0230.

Retrieving User-Defined Short Messages

When a program references a user-defined short message, Natural first looks for the requested
message number nnnn under the current language code as determined by the system variable
*LANGUAGE (see the System Variables documentation). If that message does not exist, Natural looks
for the requested message number nnnn under language code 1 (English). If that message does
not exist either, Natural looks for message number n000 (where n is the first digit of the requested
message number) under language code 1.

These three search steps are first performed in the current library. If nothing is found there, further
libraries are searched in the same way until a corresponding message is found.

The sequence of libraries for the search is as follows:

1. The current library as determined by the system variable *LIBRARY - ID,

2. The steplibs; if Natural Security is installed, the sequence in which the steplibs are specified in
the Natural Security profile of the current library,

3. The default steplib as determined by the system variable *STEPLIB,
4. The library SYSTEM in the system file FUSER (*),
5. The library SYSTEM in the system file FNAT (*¥).
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(*) If the name of the current library begins with SYS, SYSTEM FNAT is searched before SYSTEM
FUSER.

Obtaining Message Information

When you receive a short message, you may be looking for additional information on the problem
situation.

® With the system command HELP, you can display Natural system long messages or user-defined
long messages.

® With the system command LASTMSG, you can list the short test of the message(s) that occurred
last and additional information on the error situation. The information displayed includes
associated error messages that possibly preceded the last message.

Both commands are described in the System Commands documentation.
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Invoking SYSERR

This section describes alternative methods of invoking the SYSERR utility window SYSERR -
Error Messages. From this window, you can execute all SYSERR functions available for creating
and maintaining user-defined or Natural system messages. The window components and mainte-
nance functions are explained in the section SYSERR Utility Window and Functions.

Invoking SYSERR for User-Defined Messages

User-defined message files are stored in a library. You can invoke the SYSERR utility either for a
list of all messages that exist for a library and the current language code defined for your Natural
environment, or messages that exist for a particular language code. In the Logical View of the
Natural Studio tree view, the messages are stored per language in the library subnode Error
Messages.

» To invoke SYSERR for messages of the current language in a library

1  From the Natural Studio tree view, select the required library node.
Or:

Issue the following system command:

LOGON Tibrary-1ID

where 7ibrary-IDis the name of the required library.

2 From the Tools menu, choose Development Tools and Error Messages.
Or:
Issue the following system command:

SYSERR

A SYSERR - Error Messages window similar to the example below appears:
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ES?SERR - Error Messages E

File Edit Wiew

Options  Help

SRS smE- | BHLE (R FR (BBl

n0oz
0003
o004
n0os
n0os
n0o7
noos
noog
no1n
noll
001z
0013
o014
0015
n0lo
o017
001
n01s
n0zn
00zl
n0zz
0023
n0z4
n0z5
O0zZ6
1

Input

Message
Message
Meszzage
Message
Message
Message
Message
Messzage
Message
Meszsage
Meszzage
Message
Message
Meszzage
Message
Message
Message
Message
Messzage
Message
Meszsage
Meszzage
Message
Message
Meszzage

numher
mumber
numher
numher
mumber
numher
number
mumber
numher
mumber
numher
numher
mumber
numher
numher
mumber
numher

6. ¥
| »

Samp.:sample test

Num:l!

§hon:|1nput nissing.

Long
Text:

Expl.:

Action;

Input walue missing in field XYZ.

Field ¥¥Z must not be empty.
Enter an alphanumeric walue.

Enter walue in field XYZ.

Brevious | Mest I Mew

| ShontoLongl

|T0tal of 30 meszages listed from range 1 - 39999, Last number uzed: 0030  Librany: |TESTLIB Language: |[1] Englizh v

The window contains a list of all message files stored in the specified library for the current
language code.

If no message file exists for the specified library, the window is empty.

» To invoke SYSERR for messages of a particular language in a library

1 Expand the tree node of the required library in the Logical View. The messages are listed per
language in the Error Messages subnode.

2 In the Error Messages subnode, double-click on the language required.

Or:

Select the required language, invoke the context menu by pressing sHIFT+F10, and choose Open.

The SYSERR - Error Messages window appears with the list of messages that exist for the
specified language.
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Invoking SYSERR for Natural System Messages

Natural system messages cannot be accessed directly from the Natural Studio tree view or with
a Natural system command. You need to invoke the SYSERR utility for any library first and then
choose a SYSERR menu function as described in the following instructions.

» To invoke SYSERR for Natural system messages

1

From the Natural Studio tree view, select the required library node.
Or:

Issue the following system command:

LOGON Tibrary-ID

where 7ibrary-I0D can be the name of any library.

From the Tools menu, choose Development Tools and Error Messages.
Or:

Issue the following system command:

SYSERR

From the File menu, choose Open Lib/Lang,.

A SYSERR - Open Lib/Lang dialog box appears as shown in the example in the section File
Menu.

From the Library drop-down list box, select <natsys> or remove the library ID and leave the
box blank, and, from the Language box, select a language.

Choose OK to confirm your selection.

The SYSERR - Error Messages window appears with the list of all Natural system messages.
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From the SYSERR - Error Messages window, you can invoke all SYSERR utility functions
available for creating and maintaining user-defined or Natural system messages:

ESYSERR - Error Messages E

Eile Edit Wew Options Help
H@SF | ree- BB E 2 én BRELL |

Samp.: sample test

Num.: I

Shart: IInput, nissing.

0002 Message nuwber 2

0003 Message nuwber 3

0004 Message number 4.

0005 Message number 5. Long
3
7
g

0006 Message mmber Text  |Input value missing in field X¥Z.

0007 Message number
0008 Message number 8.
0002 Message number 9. Expl: |Field X¥Z must not be empty.
0010 Message nuwber 10. Enter an alphanumeric walue.
0011 Message nuwber 11.
0012 Message number 12.
00135 Message nuwber 13.
0014 Message nuwber 14.
0015 Message number 15.
0016 Message number 16.
0017 Message number 17.
0015 Message nuwber 15.
0019 Message number 19.
0020 Message nuwber 20.
0021 Message number 21.
0022 Message nuwber 22,
0023 Message number 23.
0024 Message nuwber 24,
0025 Message nuwber 25,
0026 Message number Zf.r:J
13

Action: [Enter value in field X¥Z.

Brevious | Hest I Mew | Short toLongl

|Total of 30 messages listed from range 1 - 9939, Last number uged: 0030 Libran: |TESTLIB Language:|[1]Eninsh v

The window is divided into two sections that contain data on messages available in the current
library:

" The left section with a list box displaying all messages available for the current language.

* Theright section displaying the fields with the text of the current message. The current message
is the message selected (highlighted) in the list box.

If no message exists for the specified library, both sections are empty.

The SYSERR - Error Messages window provides menus and command buttons for executing
SYSERR utility functions. As an alternative to menus and command buttons, you can execute most
of the functions by using toolbar buttons.

There are context menus available for several elements in the list box and the dialog boxes provided
with the SYSERR functions. To invoke the context menu for an element, click on the element
required with the right mouse button or select the element and press sHIFT+F10. The commands
available are either cut and paste functions or correspond to the commands in the menus or to
command buttons.

Some menu items are used to switch between modes or set a status. The check mark next to a
menu item indicates which mode or status is active.
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List Box

The list
short m

box appears in the left section of the SYSERR - Error Messages window. It contains the
essages of one language for one library. The short texts are preceded by the message

number. The messages are sorted by the message number in ascending order.

If amessage file contains more than 200 messages, for performance reasons, not all messages are
read in one step. When initially opening the SYSERR - Error Messages window, up to 200 messages
are read from the message file at once, and about 30 of them are displayed in the list box. Scrolling
down the list with the vertical scroll bar, the next 200 messages are read and displayed as soon as

the scro

Choose
Menu.

11 bar reaches the bottom of the list box.

the Read All menu option, to read all remaining messages in one step as described in Edit

The selected (highlighted) short message is the current message. It is displayed in the right section
of the SYSERR - Error Messages window. There, you can modify the short and long texts of the

current

Fields

message. See also Fields.

The foll

owing fields appear in the right section of the SYSERR - Error Messages window:

Field

Explanation

Samp.

Output field that appears above the Num. field if a sample message exists for the current language
and library.

Samp. displays the text of the sample message.

To create and use a sample message, see Sample in Options Menu.

Num.

Displays the number of the current message. It corresponds to the selected message in the list box.

To display another message or to create a new one, replace the current number by another valid
number.

The maximum message number for a library and language is 9999. The message number 0000 is
not allowed.

Short

Modifiable field displaying the short message text of the current message number.

The input of the short message is mandatory. A new message can only be saved if text has been
entered in the Short field. Therefore, if no text is displayed for the current message, the message
number is free and can be assigned to a new message.
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Field

Explanation

To extend the default field length, see Short Message Length 72 in Options Menu.

To copy sample messages into the Short field, see Sample in Options Menu and Copy in Command
Buttons.

To copy text from the Short into the Long field, choose Short to Long.

Long

Modifiable fields displaying the long message text of the current message.
Long consists of three input areas:
Text Extended version of the short message text.

Expl.  Further explanation of the message.

Action The action to be taken to resolve a problem, if relevant.
The input in Long is optional.

To copy text from the Short into the Long field, choose Short to Long.

Command Buttons

The following commands can be executed by using command buttons:

Command Explanation

Copy

This button is only visible if a sample message exists for the current language and library.

Copy appears under the toolbar, in the right upper section of the SYSERR - Error
Messages window.

Copies the text of a sample message (see Sample in Options Menu) into the Short field
(see Fields) of the current message.

Previous / Add |Toggles between Previous and Add, and Previous and Update depending on the status
Previous / Update |of the current message:

Previous Scrolls from the current message to the previous message if no modification
was made.

Add Adds a new message to the message file.

Update  Saves the current message to the message file after modification.

Anmerkung: You can only save a message if text was entered in the Short field (see
Fields).
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Command

Explanation

Next / Reset

Toggles between Next and Reset, depending on the status of the current message:

Next Scrolls from the current message to the next message if no modification was
made.

Reset Resets modifications made to the current message and displays the original
message.

New

Searches for the next free message number starting from the current message, and opens
input fields to create a message for the number found. Free means that this message
number is available and has not been assigned to another message of any language.

The search direction is downwards by default. However, the default direction can change
to upwards if a previous search was performed in an upward direction by using the
alternative function New Message (see Edit Menu).

Upwards searches for the next lower message number, downwards searches for the next
higher message number from the current message.

As an alternative to New or New Message, you can also create a new message by
replacing the number in the Num. field.

Short to Long

Copies the text of the Short field to the first line of the Long field.

File Menu

This section describes the functions available in the File menu.

Function

Explanation

New Lib/Lang

Only applies to libraries and languages for which no messages exist.

Opens a new library and/or adds a new language. See also To switch libraries and/or
languages.

Open Lib/Lang

Only applies to libraries and languages for which messages already exist.
Opens another library and/or changes the language.

See also To switch libraries and/or languages.

Open File

This function does not apply for accessing data on mainframe servers.

Selects an existing message file from a Natural Err directory (FNAT or FUSER) or from
another directory.

See also the section Generating Message and Text Files.

Print

Invokes the print function.

A dialog box prompts you to:

Tools and Utilities
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Function

Explanation

= Enter the range of messages.

® Mark the Long texts printout option if you want to print the long message in addition
to the short message.

® Specify layout parameters and select the output device: Printer or Source. The initial
assignment is the default printer set by Windows.

To display the output in the source work area, use the system command LIST. If
required, use the system command SAVE and the Natural object type text to save the
contents of the source work area.

See also To print all Natural system messages.

Exit

Terminates the SYSERR utility.

» To print all Natural system messages

1 Perform the steps described in Invoking SYSERR for Natural System Messages.

2 From the File menu, select Print.

» To switch libraries and/or languages

1  From the File menu, select New Lib/Lang if no messages exist.

Or:

From the File menu, select Open Lib/Lang if messages exist.

A SYSERR - New Lib/Lang or SYSERR - Open Lib/Lang dialog box similar to the example
below appears:

[FlsYSERR - New Lib/Lang

Librany:

Language:

Cancel |
Help |

2 From the Library drop-down list box, select a library and a language.

In the example above, the new language code 6 (Dutch) is selected for the library TESTLIB.
TESTLIB already contains messages but no messages for language code 6.

3 Choose OK to confirm your selection.
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An empty SYSERR - Error Messages window appears for the specified library and language.

Or:

If the Open Lib/Lang menu option was selected, a list of messages appears that exist for the
specified library and language.

Edit Menu

This section describes the functions available in the Edit menu.

Command Explanation

Cut Supported clipboard functions.
Copy

Paste

Undo Standard edit functions.
Delete

New Message

Searches for the next free message number starting from the current message, and opens
input fields to create a message for the number found. Free means that this message
number is available and has not been assigned to another message of any language.

Upwards or Downwards specifies the search direction: Upwards searches for the next
lower message number, Downwards searches for the next higher message number from
the current message. See also the alternative New command button.

As an alternative to New Message or the New command button, you can also create a
new message by replacing the number in the Num. field.

Delete Selected

Removes all messages selected (highlighted) in the list box. A dialog box prompts you to
confirm the action.

Delete All

Removes all messages displayed in the list box. A dialog box prompts you to confirm the
action.

When all messages of a message file have been deleted, the message file is deleted too.

Read All

Reads all messages from a message file into the list box in one step. This command applies
to message files with more than 200 messages.

Otherwise, for performance reasons, only 200 messages are read by default when the
SYSERR - Error Messages window is opened. Additional messages can be displayed by
scrolling down the list box to the end or by using the Read All menu option.

Translate

Supports the creation of messages for different languages. Applies to short messages only.
See To translate languages below.
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» To translate languages

1  From the Edit menu, choose Translate.

A SYSERR - Select Languages dialog box similar to the example below appears:

EE?SERR - 5elect Languages
Language:
(1] Englizh ak.
[Z] German
Cancel
Help

|5&Iect languages far translation.

2 Select one language or more into which you wish to translate the current message and choose
OK.

3 A SYSERR - Translate dialog box similar to the example below appears:

[F{SYSERR - Error Messages
File Edit Wiew Options Help

S@EF 2R | BHEAH 2 2 &ee 2l
Num.:ll_

SR ] SYSERR - Translate [ x|
ooos File Options  Hel

pooa o0 =F e

o0 Arailable [SngUE0EE L. v o b it st se e ana s a e
a00&

0007 Language I Shart Text

ooosE 1) Englizh Input missing.

0009 | (2] German |

nola (3] French

OOLL 4y spanish

oolz

no13 Eresinms | ext
ool4

ggig | Library: [ TESTLIB Number: |1
0017 Message nuwber 17.

0015 Message number 185.

0019 Messadge number 19.
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4  The dialog box always lists the current language of the short text (in the example above,
English) in the first position followed by the new language(s) selected in Step 1.

The SYSERR - Translate dialog box provides the following menu options, command buttons
and fields:

File > Exit Closes the SYSERR - Translate dialog box and returns to the SYSERR
- Error Messages window.

Options > Select Languages |Invokes a dialog box from which you can select one or more languages
to be added to the current message number (unless selected earlier,

during Step 1).

Available languages The language code(s) of the language(s) already available for the current
message number.

Language The code and language of the current language and the new language(s)
selected.

The current language is always listed in the first position.

Short Text The text of the short message.

Previous / Update Same as described for Previous / Update in Command Buttons.
Reset / Next Same as described for Reset / Next in Command Buttons.

Help > SYSERR Help Displays help text on SYSERR utility functions.

5  Enter the translation in the Short Text field of the relevant language(s).

6  Choose Update. The language code(s) of the new language(s) appears under Available lan-
guages.

View Menu

This section describes the functions available in the View menu.

Function Explanation
Languages Provides an overview of the languages available for one message number. You can choose
Display among the following views:

Compressed Displays the language code(s) that exists for a short

and long message. For short messages, the language
codes are listed next to Short, for long messages next
to Long.

See also Example of Compressed.
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Function

Explanation

Extended Short Displays the language code(s) that exists for a short
message next to the message number.

Extended Long Displays the language code(s) that exists for a long
message next to the message number.

You can keep the SYSERR - Language Display dialog box open while maintaining
messages, and use the Reload command button any time you want to refresh the overview
list.

Filter Display

Applies in connection with the Set Filter function.

If Set Filter is enabled, the Filter Display function displays the short messages that match
the filter criteria defined with the Set Filter function.

If Filter Display is enabled, the filter criteria specified with the Set Filter function are
displayed above the list box.

To disable the Filter Display and list all messages, again choose the Filter Display option
from the menu.

See also Filtering Messages.

Set Filter

Defines a filter for displaying short messages and shows the filtered messages in the list
box. See also Filtering Messages.

Set Filter must be enabled in order to use the Filter Display function.
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Example of Compressed

@EYSERR - Language Display Compressed x|

aool
aooz
ooos
ooo4
aans
Qo0&
aooy
aoos
aoos
aolLo
ooll
oola
aols
ool4
ooLs
aaléa
aol’y
ools
aoLs
aozo
oozl
ooga

short:
short:
short:
short:
short:
Short:
short:
short:
short:
short:
short:
short:
short:
short:
short:
short:
Short:
short:
short:
short:
short:
short:

15 Long:1l
Lonog:
Long:
Londg:
Long:
Long:
Long:
Londg:
Lorng:
Long:
Lorg:
Lomng:
Lonog:

245 Long:l
Londg:
Long:
Long:
Lorg:
Londg:
Lorng:
Long:
Londg:

FRFHRHFFHFHFFRFRRFRFRRFRFRRRFRFRFRRRRR®R

I el ST e S e e

1

1

T e S S S

=l

Reload | Help |

Libraty: |TE5TLIE= o

In the example above, the short text (Short) for message number 14 exists in English = (1), German
(2), Spanish (4), and Italian (5). The long text (Long) for message number 14 exists in English (1).
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Filtering Messages

» To filter short messages

1 From the View menu, choose Set Filter.
A SYSERR - Set Filter dialog box similar to the example below appears:
[FSYSERR - Set Filter |
Filker walues:
| * 0O ¥ Find whole words
 And [T Case sensitive
" Mot
[ Cancel Help
The dialog box provides the following filtering options:
Filter values There are four fields in which you can enter the character string(s) to be used in
the filter.
Or/And/Not You can select one of the following Boolean operators:
Or The filter selects one or more of the character strings
entered in Filter values. This is the default setting.
And The filter selects all of the character strings entered in
Filter values.
Not The filter selects none of the character strings entered
in Filter values.
The operator is ignored if you only fill one of the Filter Value fields.
Find whole words|If marked (default), the filter only allows searching for entire words and not parts
of words.
Case sensitive If marked, the filter only allows searching for letters that exactly match the lower
and/or upper case specified.
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2 Specify the criteria to be used for the filter:

Filter walues:
buffer " Or ¥ Find whole words
s &n.:g [T Caze sensitive
pDDl ........ 7
" Mot
Ok I Cancel Help
|

In the example above, the filter selects all short messages that contain both the words buffer
and pool.

3  Choose OK.

If the search criteria entered match the character strings contained in the short messages, the
matches are displayed in the list box and the Set Filter and Filter Display functions are ena-
bled.

4  Toremove a filter and list all messages, choose Filter Display to disable the function.

If the Set Filter function is enabled, alternatively, you can execute the filter function by choosing
Filter Display.

Options Menu

This section describes the functions available in the Options menu.
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Function Explanation
Sample Invokes the SYSERR - Maintain Sample Message dialog box where you create a sample
message to be used as a master for creating new short messages or replace the text of
existing short messages.
If you enter the string 0000 anywhere in the SYSERR - Maintain Sample Message
dialog box (combined with text or not), the string 0000 is replaced by the number of the
new message or the current message when copying the message.
You can define one sample message for each language and library.
If you created a sample message, the Samp. field appears with the text of the sample
message.
To copy the text of the sample message into the Short field, use the Copy command
button (see Edit Menu). Alternatively, you can enter . C in the Short field if this field is
empty.
Layout See Layout.
Shift Short Left |If enabled, automatically shifts the text of a short message to the left margin when adding
a new message or choosing Update after modification.
Short Message |This option does not apply to a remote environment located on a UNIX, OpenVMS or
Length 72 mainframe platform.
If enabled, the Short field (see Fields) is extended to a maximum input of 72 characters.
The default field length is 65 characters, which is the maximum input in UNIX, OpenVMS
and mainframe environments.
Size Resizes the dialog box:
Startup Resizes the dialog box to the size it had at startup.
Full List Box|Resizes the dialog box to display the short message in full length.
Confirm Enables/disables a pop-up window to confirm:
Window
= The new message number.
= That the text of the short message is copied into the first line of the Long field if Short
to Long was chosen.
= That the text of the sample message (if available) is copied into the Short field if Copy
was chosen.
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Function Explanation
Import Text File | This function does not apply to a remote environment located on a mainframe platform.

Imports a text file and converts it into a message file. Note that you always need to

specify the full path of a file.

From (text file) The name of the text file from which the
message file will be generated.

To (message file) The name of the message file into which
the text file will be generated. Default is
the full path name of the current library
and message file.

For user-defined messages, the file name
must be NnnAPMSL.MSG. For Natural
system messages, the file name must be
NrnnLmmmm.MSG.

For further information on file formats and generating message and text files, see the

relevant section.

Export Message | This function does not apply to a remote environment located on a mainframe platform.
File

Exports a message file and converts it into a text file. Note that you always need to
specify the full path of a file.

From (message file) The name of the message file from which
the text file will be generated. Default is
the full path name of the current library
and message file.

For user-defined messages, the file name
must be NnnAPMSL.MSG. For Natural
system messages, the file name must be
NnnLmmmm.MSG.

To (text file) The name of the text file that will be
generated.

For further information on file formats and generating message and text files, see the
relevant section.
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Layout
The Layout option allows specification of valid message ranges to categorize messages. Overlapping
of ranges is possible. A new message can only be added if its number is within the range specified

in the layout.

The layout definition applies to all languages. It is stored in the English message file.

An example layout definition is shown below:

[FSYSERR - Maintain Layout Definition

From| To D' escription
0001 |00Z5 |Main Menu

Q020 0050 Subfunction 1

0051 0100  Subfuncrtion Z

] % Cancel Help

| Librany | TESTLIE

In the fields From and To, specify the message range. In the Description field, enter text that
describes the message category.

To insert or delete rows, mark a row and press the INS or DEL key. If the maximum of 18 rows is
displayed, you may have to delete or overwrite another row before you can insert a new one.

Toolbar Buttons

The toolbar buttons represent the following menu items or command buttons:

Toolbar Button |Menu Item/Command Button Menu
=3 New Lib/Lang File
= Open Lib/Lang File
= Print File
g Exit File
3 Cut Edit
Copy Edit
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Toolbar Button |Menu Item/Command Button Menu

i) Paste Edit

'3} Undo Edit

= New Message > Upwards Edit

H New Message > Downwards |Edit

| Read All Edit

i Translate Edit

= Filter Display View

5 Sample Options
IEl Layout Options
= Size > Startup Options
iy Import Text File Options
Lt Export Message File Options
= Previous -

= Next -

= Update .

& Reset -
Status Bar

The status bar on the bottom of the SYSERR - Error Messages window displays the following;:

® The total number of messages that exist in the specified library for the current language, the
possible message range 1 to 9999, and the last message number used.

This information is only displayed when initializing SYSERR, opening another library or when

using the Read All menu option described under Edit Menu.

® Natural system messages or the ID of the current library.

® The code and name of the current language.
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Online Help

You can obtain online information on using the SYSERR utility.

» To view the overview of the online documentation

s Choose the Help menu.
Or:

Press F1 when no dialog box is open.

The overview page of the SYSERR Ultility documentation appears.

» To view context-sensitive help

= Choose the Help button in a dialog box.
Or:
Press F1 in a dialog box.

Help information specific to the task you are performing appears.
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If your terminal does not display certain characters correctly or if your terminal cannot display
lower-case characters, it is possible to convert the characters of Natural system short messages
with the SENSYS-D dialog box.

» To convert characters of messages

1 Inthe Logical View of the Natural Studio tree view, select the System Libraries node and
then SYSERR.

Or:

Issue the following system command:

LOGON SYSERR

where 7ibrary-IDis the name of the required library.

2 From the SYSERR library, select the Dialogs subnode and then SENSYS-D.
Or:
In the command line, enter the following:

SENSYS-D
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A SENSYS-D dialog box similar to the example below appears for the current language:

EEENEYS—D - Functions for Matural Short Messages

Function Help

Message range;

Language:

- Igggg Scan value: a0

- Replace wvalue: a0

3  Specify a range of messages.
If required, enter hexadecimal values in the Scan value and Replace value boxes.
4  From the Function menu, choose one of the following:

Function Explanation

Uppercase Messages Converts messages to upper case. Once converted to upper case, you
cannot convert them back to lower case. To recover lower-case messages,
unload the messages by using the Object Handler, save the transfer file
and, when required, reload the messages by using the Object Handler.
See also the Object Handler documentation.

Scan Character Hex Scans for hexadecimal characters entered in the Scan value box.

Scan and Replace Scans hexadecimal characters entered in the Scan value box and replaces
them with the hexadecimal characters entered in the Replace value
box. This function may be useful, for example, to replace special signs.

Replace using Replaces the characters of a message by the character set defined in the

SECSET-N SECSET-N subprogram. SECSET-N is stored in the SYSERR subnode
Subprograms.

Display Message Enables or disables the display of a message in hexadecimal format.

Hexadecimal

Display Char Table for Enables or disables this function to determine the characters your

Terminal terminal can represent.

Processing Log Enables or disables the processing log to view the results of the functions
executed.
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Generating Message and Text Files

You can create messages as text files in any environment outside Natural and convert them into
message files to be maintained with the SYSERR utility. Message files are created and maintained
with the import and export functions of the SYSERR utility.

Message files are created in a platform-independent format, which is portable across any Natural-
supported UNIX, OpenVMS and Windows platforms. For example, a message file created in a
Natural for Windows environment, can be copied onto a UNIX or an OpenVMS platform without
manual conversion; the necessary endian conversion is performed by Natural. For further infor-
mation, see Portable Natural System Files in the Operations documentation and Transferring Natural
Generated Programs in the Programming Guide.

Storing a Message File

The message files must be stored with the file extension .MSG in the Natural Err directories.
The message files are stored in the following Natural directories:

Natural \NATAPPS\FUSER\ 7ibrary-ID\Err
Natural\Natural version\FNAT\ 7ibrary-ID\Err
Natural\Natural version\Err

User-defined message files are stored in the Err subdirectory of the library in the FNAT or FUSER
system file from which the application is executed, the steplib, or the SYSTEM library.

For Natural system messages, the message files must be stored in the Err subdirectory in the
Natural root directory. Natural system messages are stored in eight message files.

Creating a Text File

For Natural system or user-defined messages, the import function of the SYSERR utility generates
a message file from one text file.

To create such a text file, you must use a specific layout, as shown in the following example:
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Example:

NAT

0010

0100

0010E NO MESSAGE TEXT DEFINED!

0020E MISSING/INVALID SYNTAX; UNDEFINED VARIABLE-NAME.
0025E ERROR IN ENTRY FOR NUMBER OF RECORDS TO BE PROCESSED.
0050E INCORRECT FIELD SPECIFICATION IN 'WHERE' CLAUSE.
##PLEASE CHECK PROGRAM

#FOR ERRORS

0100E FUNCTION NOT AVAILABLE.

Explanation:

NAT The prefix of the message number to be displayed with the message. The default prefix is
NAT for Natural system messages and the library ID for user-defined messages.

or

library-1D

0010 The four-digit starting number of a range of messages.

0100 The four-digit ending number of a range of messages. All message numbers that are defined
in this text file must be within this range.

0010E NO MESSAGE TEXT DEFINED!

This is the short message for message number 0010. The E is mandatory and means error.
This message will be issued with the following Natural statement:

REINPUT *0010

Explanatory long messages must be placed immediately below this short message; each of
these additional lines must start with a hash/number (¥) sign. Up to 20 additional lines of
long message text are allowed for each short message.

Generating a Message File

The SYSERR utility provides the option to generate a message file from a text file.

For user-defined messages, one output message file can be created in one language for each
library. Each message file must be stored in the Err subdirectory of that library.
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Naming Conventions

For user-defined messages, the name of the message file must be:

NnnAPMSL.MSG

where nn is the language code (01 - 60), for example 01 for English.
For Natural system messages, the name of the message file must be:
NnnLmmmm.MSG

where nn is the language code to be used and mmmm the starting number of the message range. The
ranges of message numbers are fixed, as defined during Natural system installation, for example:

NOILOOOO  Messages1-1999
NO1L2000  Messages 2000 - 2999

» To generate a message file

»  See the Import Text File function of the Options menu described in the section SYSERR Uti-
lity Window and Functions.

Recreating a Text File

The SYSERR utility provides the option to recreate a text file for message text maintenance. This
is done by reconverting a messages file into a text file.

» To recreate a message text file

»  See the Export Message File function of the Options menu described in the section SYSERR
Utility Window and Functions.
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57 Managing Messages in Different Libraries

You can transfer messages between different libraries and move, rename, find, list or delete mes-
sages in different libraries. For a transfer, you can copy the messages to and from a file.

» To copy/move, rename, find, list or delete messages

»  Use the appropriate Natural Studio functions described in the Using Natural Studio documen-
tation.

Or:

Use the Object Handler as described in the relevant documentation.

» To transfer messages using files

»  Use the Export Message File and Import Text File functions described in the section Options
Menu.

Or:

Use the Object Handler as described in the relevant documentation.
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58 Application Programming Interface USR0020P

The application programming interface USR0020P in the Natural system library SYSEXT is provided
to read messages from the FNAT or FUSER system file. Thus, it is possible, for example, to have
long messages displayed in an application (as part of your own user-defined help system) without
having to use the Natural system library SYSERR.

Log on to the Natural system library SYSEXT and, in the command line, enter the command MENU.
In the list provided, mark the program USR0020P with a question mark (?). A window is then
displayed, in which you can select the function to be executed for the program. If you enter an I,
further information on the use of USR0020P is displayed.
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59 SYSEXT Utility - Natural Application Programming

Interfaces
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SYSEXT Utility - Natural Application Programming Interfaces

The utility SYSEXT is used to locate and test Natural Application Programming Interfaces (APIs)
contained in the current system library SYSEXT either in a local Windows environment or in a
remote environment located on a Windows, a UNIX, an OpenVMS or a mainframe platform.

A Natural APl is a Natural subprogram (cataloged object) that is used for accessing and possibly
modifying data or performing services that are specific to Natural, a subcomponent or a subproduct.
The purpose of a Natural AP is to retrieve or modify information or use services that are not
accessible by Natural statements.

Related Topics:

= Application Programming Interfaces - Natural Security documentation

® SYSAPI - APIs of Natural Add-on Products - Utilities documentation

Prerequisite

® The Enable Plug-ins option must be selected. This option is selected by default. For details, see
Workspace Options in the section Setting the Options in the Using Natural Studio documentation.

Basic Features of SYSEXT

For each Natural API, the utility SYSEXT provides a functional description, one example program
and API-specific keywords.

The following diagram is an overview of the Natural objects and major features SYSEXT provides
to test and implement an API:
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SYSEXT Utility

Matural Application Programming Interfaces (APIs)

APl Objects Features

- AP| subprogram - List of APls by nams

- Example program for tesfing - Lizt of APls by keyword

- Text cbject with funclicnal - List of all keywaords
descripficn

- Cbject operations

Objects Provided for Natural APIs

The types of Natural object typically provided for each Natural API are listed in the following
section. The section does not list additional objects that may be required for particular APIs.

All API-related objects are contained in the library SYSEXT on the system file FNAT.

In the following table, nnnn denotes the 4-digit number assigned to the API. All API objects that
relate to one another have identical numbers.

Object Name |Explanation

USRnnnnN |The API subprogram (cataloged object) that performs the designated function.

USRnnnnP |An example program (source object) that can be used to test the effect of the API.

The example program invokes the corresponding subprogram USRnnnnN.

USRnnnnT | A text object that contains a description of the corresponding API. The description comprises
purpose, function and calling conventions of the API and relevant keywords.
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@ Caution: Do not modify the source objects EXT-XML1 and EXT-XML2. They are required
for configuring the SYSEXT utility and intended for Software AG internal use only.

Invoking and Terminating SYSEXT

This section provides instructions for invoking and terminating the SYSEXT utility.

» Toinvoke SYSEXT

= Enter the following system command:

SYSEXT

Or:

From the Tools menu, select Development Tools > Application Programming Interfaces.
When invoking SYSEXT, the plug-in for the utility SYSEXT is activated and the SYSEXT utility

window appears with the root node SYSEXT - Application Programming Interfaces as shown
in the example below:

#-. SYSEXT Utility =]

SYSEXT - Applicakion Programming Interfaces

» To restart SYSEXT

»  If you want to restart SYSEXT during the current Natural session, as an alternative to the start
methods mentioned above, from the toolbar, choose the following icon:

&

This icon appears after initially invoking SYSEXT, when the plug-in for the utility SYSEXT is
activated.

» To terminate SYSEXT

s Choose the standard Windows close function.
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SYSEXT Tree View ltems

This section describes the nodes and items contained in the tree view of the SYSEXT utility window.

If you expand all tree nodes, the tree looks similar to the example below:

#- SYSEXT Utility =]
=

IH@. USROD10M: Get 'SYSPROF' Information
=5 Kevwords of USROOLOM
[ sYSPROF

=5 DEID
-[E5 PR
=8 FMAT

H-({7y USROO11M: Information about logical file

({73 USRO0DZOM: Read any error text From FNAT | FUSER

{7y USROD40M: Get bype of last error

H-({73 USROOSOM: Get 'SYSPROD' Information

({73 USRODG0M: Copy LFILE definition from 'FHAT' to 'FUSER!
-y USRO0B0M: Handle TypeMame of Editor Contents -

| | Dl

Each Natural APTis represented by an API node that contains the example program, description
and keywords that relate to this API. The API node name consists of the name of the API subpro-

gram (USRnnnnN) and a brief description of its functional purpose. The nodes are sorted by API
names.

The following items are provided in an API node:

Item Explanation

Keywords All keywords relevant to the API. See also the functions Select Keyword and List All
Keywords in Performing SYSEXT Utility Functions.

Description A text object (USRnnnnT) that contains a description of the API. The description
comprises purpose, function and calling conventions of the API and keywords relevant
to the APL

Example Program | An example program (source object USRnnnnP) of how to invoke the API.
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Performing SYSEXT Utility Functions

The SYSEXT utility functions can be used to perform operations on API-specific text objects (des-
criptions) and example programs or find APIs relevant to a current task by specifying a keyword.

Object operations include functions such as List, Open and Execute, which correspond to the
standard functions available when maintaining or executing a Natural object of the type text or
program. These functions can be performed by using the context menu associated with each object.
For details of these functions, refer to the relevant sections in the Using Natural Studio documenta-
tion.

The section below covers the following topics:

= Select Keyword
= | jst All Keywords
= Refresh

Select Keyword

This function is used to list APIs by keyword.

» To list APls by keyword

1  Select the root node SYSEXT - Application Programming Interfaces, open the context menu
and choose Select Keyword or press SHIFT+K.

The Select Keyword window appears.

2 From the drop-down list box, select a keyword as shown in the example below:
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5

SYSEXT - Select Keyword _ (O] x|

| @l

LANGLAGE

*LEVEL
*53TEPLIE
*TIMESTMP
ADABAS

AREA

A5
ASTERISK

EIT

ELUFFER
ELFFER POOL
EYTE

EYTE SWAPPING

=~

Choose the OK button.

The root node SYSEXT - Application Programming Interfaces with Keyword appears for
the selected keyword.

Expand the root node.

The nodes of all APIs to which the specified keyword applies are displayed as shown in the

example of keyword *LANGUAGE below:

#=. SYSEXT - Application Programming Interfaces M=l

SYSEXT - Application Prograrmming Interfaces with Kewword *LANGUAGE
--1::_] JSRO120M: Read NATURAL Short Error Message

--1::_] JSROZ21M: Read NATURAL Lang Error Message

--1::_] JSRO320M: Read User Shart Error Message From FRAT or FUSER,
--1::_] SR1027M: Search user shark errar message

--1::_] JSR.1030M: Langquage code conversion

--1::_] IJSR.3320M: Find User Short Ervar Message From FMAT aor FUSER

If desired, to return to the display of all API nodes (default setting), in the Select Keyword

window, select the asterisk (*).
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List All Keywords

This function is used to list all keywords for the APIs available in the current system environment.

» To list all APl keywords

1  Select the root node SYSEXT - Application Programming Interfaces, open the context menu
and choose List All Keywords or press SHIFT+A.

The All Keyword window appears as an additional window with the root node SYSEXT -
All Keywords of Application Programming Interfaces.

2 Expand the root node.

A list of all keywords is displayed as shown in the example below:

#+. SYSEXT - All Keywords _ (O]
F

SYSEXT - All Keywords of Application Programming Inkerfaces
-5 *ERROR-MR
{5 *ERROR-TA
=28 *LaMGUAGE
--{;] USRO120M: Read MATURAL Shaort Error Message

--{;] USROZZ1M: Read MATURAL Long Error Message

--{:J USRO320M: Read User Shart Error Message from FRAT or FLISER
--{;] USR1027M: Search user short error message

--{;] JSR1030M: Language code conversion

--{:J USR3320M: Find User Short Error Message from FMAT or FUSER.

+-f=5 *LEVEL

{55 *STEPLIE

#-E8 *TIMESTMP

+-{E8 ADABAS

{5 AREA

=3 asc

-8 ASTERISK

- BT hd
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Refresh

This function updates API information in the tree view using the data from the objects contained
in the current library SYSEXT. The refresh is only required if an API description or a keyword was
modified or if a text object was removed.

Note: Do not modify the source objects EXT-XML1 and EXT-XML2. They are required for
configuring the SYSEXT utility and intended for Software AG internal use only.

» To refresh API information

1  Select the root node SYSEXT - Application Programming Interfaces, open the context menu
and choose Refresh or press SHIFT+R.

A Refresh window appears.

If you access a remote environment on a mainframe, you must specify the parameter SORT in
the map environment settings as indicated below:

SORT=(WRKSIZE=50)

For details on mapping a server, see Accessing a Remote Development Environment in the
documentation Remote Development Using SPoD. For details on SORT, refer to the Parameter
Reference of Natural for Mainframes.

2 Choose the OK button to confirm the refresh or choose Cancel to abort the operation.

Using a Natural API

If you want to use a Natural API contained in the SYSEXT system library, perform one of the fol-
lowing steps:

® Define the SYSEXT system library in the FNAT system file as a steplib library for the user
library which contains the Natural objects that use this API. Thus, no API-specific actions are
required when upgrading your Natural version.

® Copy the required API to the SYSTEM system library in the FNAT system file. Thus, you only
need to check a single library for APIs when upgrading your Natural version.

® Copy the required API to the SYSTEM library in the FUSER system file (not recommended).
® Copy the required API to the user library (or one of its steplibs) in the FUSER system file which

contains the Natural objects that use this API (not recommended).

An API can only be used in the Natural version with which it is delivered. It cannot be executed
in any other Natural version. Therefore, it is strongly recommended that APIs are stored only in
the FNAT system file.
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SYSEXV Utility

The utility SYSEXV provides example programs to illustrate new features of current Natural ver-
sions. All programs are available as source objects and display a detailed functionality description
when they are executed. Example programs for non-current Natural versions are also available.

This chapter covers the following topics:

Executing Example Programs of Current Versions

» To execute an example program of a current version
1  Enter the following system command:
SYSEXV
Or:
Log on to the SYSEXV library:
LOGON SYSEXV

and continue by entering

VERSTION

As a result, a menu is displayed from which you can choose a Natural version.

2 Choose a version from the menu.

As aresult, acommented menu is displayed from which you can choose an example program
relevant to the selected version.

3 Choose a program.

As a result, the program is executed.

Executing Example Programs of Non-current Versions

» To execute an example program of a non-current version

1  Log on to the SYSEXV library:

LOGON SYSEXV

2 List the text object A-README.
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| Note: Do not modify the text object A-README.

A-README lists and comments example programs for non-current versions.

3 Choose a program and execute it.

Terminating the SYSEXV Utility

» To terminate the SYSEXV utility

= In the SYSEXV utility menu, choose OK.
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SYSMAIN Utility - Object Maintenance

The SYSMAIN utility is used to perform object maintenance functions such as copy, move, replace,
delete and import.

¢ ¢ ¢ ¢ ¢ ¢ ¢ ¢ e e e e

General Information on SYSMAIN
Invoking and Terminating SYSMAIN
Listing Objects

Finding Objects

Copying Objects

Moving Objects

Deleting Objects

Renaming Objects

Importing Objects

Using SYSMAIN with Subprogram
XRef Considerations

Security Considerations for Administrators

355



356



62 General Information on SYSMAIN

The SYSMAIN utility is used to perform object maintenance functions, such as copy, move and
delete, within a local Windows environment or within a remote environment located on a Windows,
a mainframe, a UNIX or an OpenVMS platform.

The following diagram is a basic illustration of the SYSMAIN functionality:
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SYSMAIN Utility

Object Maintenance

List Copy
Find Move
Delete Rename
Rename |mport
System System
File File
Source Target
Environment Environment

Objects that can be maintained with the SYSMAIN utility comprise programs, subprograms, maps
and data definition modules (DDMs).

In most cases, SYSMAIN utility functions can be accomplished by using drag-and-drop or copy/cut-
and-paste functionality or menu functions provided within the library workspace of the Natural
Studio (see also Managing Natural Objects and Using Natural Libraries in the Using Natural Studio
documentation).

However, there are SYSMAIN utility functions that cannot be covered by library workspace fea-
tures such as using different system files for object processing, specifying the transfer of cross-
reference (XRef) data and performing object maintenance functions online or in batch mode by
using a subprogram.
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Invoking and Terminating SYSMAIN

This section provides instructions for invoking and terminating the SYSMAIN utility online.

For instructions on invoking and executing SYSMAIN online or in batch mode with a subprogram,
see Using SYSMAIN with Subprogram.

Invoking SYSMAIN

» To invoke the SYSMAIN utility

1  Enter the following system command:

SYSMAIN

An Object Maintenance dialog box similar to the example below appears with the SYSMAIN
utility menu:

Eﬂhject Maintenance
@ List " Delete
™ Find " Rename
" Copy ™ Import
" Move:
ok ([ Corcel |t

2 Select the radio button that corresponds to the required function by choosing any of the follo-
wing methods:

Click a radio button.

Or:

Use DOWN ARROW or UP ARROW to navigate to a radio button.
Or:

Press one of the following shortcut keys:

SHIFT+L for List
SHIFT+F for Find
SHIFT+C for Copy
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SHIFT+M for Move
SHIFT+D for Delete
SHIFT+R for Rename
SHIFT+I for Import

3  Choose OK.

(Cancel exits the SYSMAIN utility.)

An Object Maintenance dialog box appears for the selected function as shown in the following
example of Copy:

iEDhiEEt Maintenance - Copy |
—Source
Library: | IS0z ~| DEID: |3|:| FMR.: |3t|
FDIC/FSELC. .. |
Marne: |*
Type —Code
% Programming Dbject Types... | v sSource v Cataloged
™ Yiews (DDM) ™ #REF

Liser ID: I Date: | 00,00,0000 Tirre: IIIIIII:IIIIII

—Target

Library: | TESTLIE ~| oBro: |3c| FrRs |30
FDIC/FSELC. .. |

Marne: |*

¥ Confirm on replace v Rename

oK, Cancel Help
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Terminating SYSMAIN

» To terminate the SYSMAIN utility

m  Choose Cancel.

Or:

Choose the standard Windows close button.
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64 Listing Objects

The List function is used to list a range of objects in a source environment and/or display the
source code of single or multiple objects.

This section provides instructions for specifying list options in the Object Maintenance - List
dialog box.

» To list objects

1  Inthe Library list box, enter the name of the library that contains the object(s) you want to
list or select a library from the drop-down list.

The default is the current library. The Library list box does not apply to DDMs (data definition
modules) in a remote mainframe environment. Therefore, the box disappears when the Views
(DDM) check box is selected.

2 Inthe DBID (database ID) and FNR (file number) boxes, replace the values if the library is
not in the current system file. The default is the current FNAT or FUSER, or FDIC for DDMs
on mainframes. In a remote environment, you can specify security information for these files
as described in File Security for Remote Environments.

3 Inaremote environment, use the FSEC/FDIC button if you want to specify security informa-
tion for the system file FSEC or FDIC for XRef data; see also File Security for Remote Environ-
ments and XRef Considerations.

4  Inthe Name box, enter the name of a single object or specify a range of names; see Specifying
a Range of Names. The default is asterisk (*), indicating all objects.

5 In the Type group box, select the type(s) of object by choosing one of the following options:

Select Programming (default) for all types of object (including program and subprogram)
except DDM. You can limit the types of object by choosing Object Types and selecting or
deselecting the required item(s) from the list provided:

" To select list items:
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Click on a single item.

Or:
Press UP ARROW or DOWN ARROW to go to and select the required item.

Or:
Press and hold down CTRL or SHIFT and click on multiple non-consecutive or consecutive
items respectively.

Or:
Press SHIFT+UP ARROW Or SHIFT+DOWN ARROW to select multiple consecutive items.

Or:
Choose Select All to select all items.

® To deselect list items:
Press and hold down CTRL and click on a selected item again.

Or:
Choose Deselect All if all items have been selected.

Or:
Select Views (DDM) for DDMs only.

In the Code group box, select Source and/or Cataloged to list all objects for which either the
source object or the cataloged object, or both exist. The default is both the source object and
the cataloged object.

In the User ID box, enter the ID of a user if you want to list only the objects that were last
saved or cataloged by this user. The default is no user ID.

In the Date box, enter a start date to list only objects that were saved or cataloged on or after
this date. A date must be entered in the format associated with the preset value in the Date
box. The default dateis 0000.00.00 (no date). The date is given in the format Y'Y YVY.MM.DD(YYYY
= year, ¥M=month, 00 = day).

If you have specified a date, you can enter a start time in the Time box to list only objects that
were saved or cataloged at or after this time. The default time is 00: 00 (no time). The time is
given in the format HH: I (HH=hours, ]I =minutes).

Choose Object List when you have finished specifying object selection criteria.
If you have specified a single object name, proceed with Step 13.

If you have specified a range of object names, proceed with Step 10.
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10 A dialog box similar to the example below appears with a list of all matching objects:

Eﬂhject Maintenance - List Ed |

Source Library: SAGTEST DEID: 030 FRR: 030, #2 objects Found,

Qbject Type S)C  UserID

el Proaram SIC . aMo .

PGM2 Progran 5 EMo

PG Program s EMo

FaMg Program 2 EMo

FiEMS Progranm S GMo

FGME Program s oMo 7
Select all List Cancel Help |

11 Select or deselect single or multiple objects by proceeding as described in To select/deselect
list items.

12 Choose List to display the source code of the selected objects.

(Cancel exits the dialog box without any action.)

13 The Object Maintenance - List dialog box is closed and the Object Maintenance menu
appears.

In addition, for each object selected, an Object Listing window similar to the example below
appears, with the source code of the object:

‘B! HELLD [SAGTEST] - Object Listing

o010 t’f The "Hello world!"™ example in MNatural.
ooz0 *

o030 DISPLAY "Hello world!"™

0040 END /% End of prograum

M5n il
”*II I [ 3

The window title shows the name of the object (here: HELL0) and the name of the library (here:
SAGTEST) where the object is stored. The Object Listing window is identical to the window
that appears when using the LIST system command.

14 From the Object Maintenance menu, choose Cancel to exit SYSMAIN and activate an open
Object Listing window.
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65 Finding Objects

The Find function is used to locate single or multiple objects in single or multiple libraries and
display the source code of the objects found.

This section provides instructions for specifying search options in the Object Maintenance - Find
dialog box.

» To find objects

1

In the Library list box, enter the name of the library in which you want to search for objects
or select a library from the drop-down list. The default is the current library. If you enter an
asterisk (*), a dialog box appears (see Step 10), where you can select multiple libraries from
a list of all libraries available in the specified system file.

The Library list box does not apply to DDMs (data definition modules) in a remote mainframe
environment. Therefore, the box disappears when the Views (DDM) check box is selected.

In the DBID (database ID) and FNR (file number) boxes, replace the values if the library is
not in the current system file. The default is the current FNAT or FUSER, or FDIC for DDMs
on mainframes. In a remote environment, you can specify security information for these files
as described in File Security for Remote Environments.

In a remote environment, use the FSEC/FDIC button if you want to specify security informa-
tion for the system file FSEC or FDIC for XRef data; see File Security for Remote Environments.

In the Name box, enter the name of a single object or specify a range of names; see Specifying
a Range of Names. The default is asterisk (*), indicating all objects.

In the Type group box, select the type(s) of object by choosing one of the following options:

Select Programming (default) for all types of object (including program and subprogram)
except DDM. You can limit the types of object by choosing Object Types and selecting or
deselecting the required item(s) from the list provided:

" To select list items:
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Click on a single item.

Or:
Press UP ARROW or DOWN ARROW to go to and select the required item.

Or:
Press and hold down CTRL or SHIFT and click on multiple non-consecutive or consecutive
items respectively.

Or:
Press SHIFT+UP ARROW Or SHIFT+DOWN ARROW to select multiple consecutive items.

Or:
Choose Select All to select all items.

® To deselect list items:
Press and hold down CTRL and click on a selected item again.

Or:
Choose Deselect All if all items have been selected.

Or:
Select Views (DDM) for DDMs only.

In the Code group box, select Source and/or Cataloged to find all objects for which either the
source object or the cataloged object, or both exist. The default is both the source object and
the cataloged object.

In the User ID box, enter the ID of a user if you want to find only the objects that were last
saved or cataloged by this user. The default is no user ID.

In the Date box, enter a start date to find only objects that were saved or cataloged on or after
this date. A date must be entered in the format associated with the preset value in the Date
box. The default dateis 0000.00.00 (no date). The date is given in the format Y'Y YVY.MM.DD(YYYY
= year, ¥M=month, 00 = day).

If you have specified a date, you can enter a start time in the Time box to find only objects
that were saved or cataloged at or after this time. The default time is 00: 00 (no time). The
time is given in the format +#H: 11 (HH=hours, II=minutes).

Choose Object List when you have finished specifying object selection criteria.
If you have specified a single library, proceed with Step 13.

If you have entered an asterisk (*) in the Library list box, proceed with Step 10.
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10 A dialog box similar to the example below appears with a list of all libraries available in the
specified system file:

Object Maintenance - Find
From DBID/FMR.
S STEM 030030 ﬂ ] 4
TEMP 030,030
TESTDAY 030,030 Cancel
TESTEPL 030,030
TESTLIE 030,030 - Seleck all
TESTHDY 030030 -
THP1 GENTECRA [

11 Select or deselect single or multiple libraries by proceeding as described in To select/deselect
list items.

12 Choose OK.

(Cancel exits the dialog box without any action.)

13 A dialog box similar to the example below appears with a list of all matching objects:

Eﬂhject Maintenance - Find |

Source Library: SAGTEST DBID: 030 FMR: 030, 23 objects Found,

Cbject Type S/C UserID
a1 Program s EMo -
Mz Program 2 EMo
GM3 Progranm S GMo
M4 Progran 5 EMo
GMS Program s EMo
GME Progranm s ao wl

Select Al |

The Skip button only appears if you selected multiple libraries.

List Cancel Help |

The dialog box shows the library locations, the number of objects found and the object names
and types. It also indicates whether a source (S) and/or a cataloged (C) object exists and the
ID of the user who saved and/or cataloged an object.
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14

Select or deselect single or multiple objects by proceeding as described in To select/deselect
list items.

Or:

Choose Skip if you do not want to select any objects from the current dialog box but open
the dialog box for the next library with matching objects if found. Dialog boxes are opened
in alphabetical order of library names.

15 Choose List if you want to list the source code of the selected objects.
(Cancel exits the dialog box without any action.)

16 The Object Maintenance - List dialog box is closed and the Object Maintenance menu
appears. In addition, for each object selected, an Object Listing window similar to the
example below appears, with the source code of the object:

‘8! HELLD [SAGTEST] - Object Listing

oo10 t’f The "Hello world!"™ example in Matural. -

oozo *

ooso DISPLAY "Hello world!"™

o040 END /% End of program

Msn hd

| I 4 I I ]
The window title shows the name of the object (here: HELL0) and the name of the library (here:
SAGTEST) where the object is stored. The Object Listing window is identical to the window
that appears when using the LIST system command.

17 From the Object Maintenance menu, choose Cancel to exit SYSMAIN and activate an open
Object Listing window.
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The Copy function is used to copy single or multiple objects from a source environment to a target
environment. The objects remain unchanged in the source environment. If the target environment
already contains an object with the same name as the object to be copied, you can specify whether
you overwrite the object in the target environment or give the copied object a new name.

This section provides instructions for specifying copy options in the Object Maintenance - Copy
dialog box.

» To copy objects

1  In the Source group box, specify the object(s) you want to copy:

In the Library list box, enter the name of the source library that contains the object(s) you
want to copy or select a library from the drop-down list. The default is the current library.
The Library list box does not apply to DDMs (data definition modules) in a remote mainf-
rame environment. Therefore, the box disappears when the Views (DDM) check box is
selected.

In the DBID (database ID) and FNR (file number) boxes, replace the values if the source
library is not in the current system file. The default is the current FNAT or FUSER system
file, or FDIC for DDMs on mainframes. In a remote environment, you can specify security
information for these files as described in File Security for Remote Environments.

In a remote environment, use the FSEC/FDIC button if you want to specify security infor-
mation for the system file FSEC or FDIC for XRef data; see File Security for Remote Envi-
ronments and XRef Considerations.

In the Name box, enter the name of a single object or specify a range of names; see Specifying
a Range of Names. The default is asterisk (*), indicating all objects.

In the Type group box, select the type(s) of object by choosing one of the following options:
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Select Programming (default) for all types of object (including program and subprogram)
except DDM. You can limit the types of object by choosing Object Types and selecting or
deselecting the required item(s) from the list provided:

* To select list items:
Click on a single item.

Or:
Press UP ARROW or DOWN ARROW to go to and select the required item.

Or:
Press and hold down CTRL or SHIFT and click on multiple non-consecutive or consecutive
items respectively.

Or:
Press SHIFT+UP ARROW Or SHIFT+DOWN ARROW to select multiple consecutive items.

Or:
Choose Select All to select all items.

® To deselect list items:
Press and hold down CTRL and click on a selected item again.
Or:
Choose Deselect All if all items have been selected.

Or:
Select Views (DDM) for DDMs only.

In the Code group box, select Source and/or Cataloged to copy either the source object or
the cataloged object, or both. The default is both the source object and the cataloged object.

If Predict is installed, you can select the XREF check box to process XRef data. See also the
section XRef Considerations.

In the User ID box, enter the ID of a user if you want to copy only the objects that were last
saved or cataloged by this user. The default is no user ID.

In the Date box, enter a start date to copy only objects that were saved or cataloged on or
after this date. A date must be entered in the format associated with the preset value in the
Date box. This value is determined by the DTFORM profile parameter described in the Para-
meter Reference documentation. The default date is 0000.00.00 (no date). The date is given
in the format YYYY.MM.DD (YYYY = year, MM=month, DD = day).

If you have specified a date, you can enter a start time in the Time box to copy only objects
that were saved or cataloged at or after this date and time. The default time is 00: 00 (no
time). The time is given in the format HH:II (HH=hours, I] = minutes).
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2 Inthe Target group box, specify the target environment for the object(s) selected for processing:

In the Library list box, enter the name of the target library to which you want to copy the
object(s) or select a library from the drop-down list. The default is the current library. If
you want to create a library, enter the name of a new library. The Library list box does not
apply to DDMs (data definition modules) in a remote mainframe environment. Therefore,
the box disappears when the Views (DDM) check box is selected.

In the DBID (database ID) and FNR (file number) boxes, replace the values if the target
library is not in the current system file. The default is the current FNAT or FUSER, or FDIC
for DDMs on mainframes. In a remote environment, you can specify security information
for these files as described in File Security for Remote Environments.

In a remote environment, use the FSEC/FDIC button if you want to specify security infor-
mation for the system file FSEC or FDIC for XRef data; see File Security for Remote Envi-
ronments and XRef Considerations.

In the Name box, you can enter a new name for the object copied in the target environment
or specify a range of new names by using asterisk (*) notation; see Specifying a Range of
Names. The default asterisk (*) specifies that all objects contained in the target environment
are replaced if relevant.

Use the Confirm on replace check box to confirm (default) or reject an object replacement.
See also Confirm on replace below.

Select the Rename check box (selected by default) to give the copied objects new names in
the target environment. The check box is dimmed for DDMs in a remote mainframe envi-
ronment where you cannot rename DDMs. See also Rename below.

3  Choose OK when you have finished specifying the source and target environments.

If you have entered a single name in the Name box of the Source group box, skip the following
instructions and proceed with Confirm on replace in Step 5.

If you have specified a range of names in the Name box of the Source group box, an additional
dialog box similar to the example below appears with a list of all matching objects:
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mﬂhject Maintenance - Copy E |

Source Library: SA&GTEST DBID: 030 FMR: 030, 9 objects Found.

Target Library; TESTLIE DBID: 030 FMNR: 030

Dhject Type 3/C  UserID

SRETAN Program S GMO .

FaM2 Program S GO

PG Proaram s GMo

PGaMY Progran 5 GMO

PiaMS Program S GMo

PGME Program s o 7
Select Al oy Cancel Help |

The dialog box shows the library locations, the number of objects found and the object names
and types. It also indicates whether a source (S) and/or a cataloged (C) object exists and the
ID of the user who saved and/or cataloged an object.

4  Select or deselect single or multiple objects by proceeding as described in To select/deselect
list items.
5 Choose Copy to process the selected object(s).
(Cancel exits the dialog box without any action.)
= If the Rename check box has been selected, an additional dialog box similar to the following
example appears that displays, one after the other, each object to be copied. (No additional
dialog box appears if a single name, rather than a range, is entered in the Name box of the
Source group box.)
Object Maintenance - Copy |
—Source objeck
Library SAGTEST 030,030
Object: PGMI (Source and Gp)
— Target object
Library: TESTLIE 030,030
Object: |
I, Skip Close
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Choose one of the following options:

In the Object box of the current object, enter a new name for the object in the target envi-
ronment. Choose OK to confirm the rename.

Or:
Choose Skip (or ALT+S) if you want to remove the current object from the list of selected
objects and proceed with the next object.

Or:
Choose Close to exit the dialog box without any action.

* If the Confirm on replace check box has been selected and if the target environment already
contains an object with the same name as the object to be copied, an additional dialog box
appears with a warning message.

Confirm or reject object replacement by choosing one of the following buttons:
Yes to confirm each object replacement individually one after another.

Or:
Yes to All to confirm all object replacements in one go.

Or:
No to not replace the current object.

Or:
Cancel to exit the dialog box without any action.

6  After all objects have been copied, the Object Maintenance - Copy dialog box is closed and
the Object Maintenance menu appears.
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67 Moving Objects

The Move function is used to transfer an object from a source environment to a target environment.
The object is deleted from the source environment and added to the target environment. If the
target environment already contains an object with the same name as the object to be moved, you
can specify whether you overwrite the object in the target environment or give the copied object
a new name.

This section provides instructions for specifying move options in the Object Maintenance - Move
dialog box.

» To move objects

1  Inthe Source group box, specify the object(s) you want to move:

In the Library list box, enter the name of the source library that contains the object(s) you
want to move or select a library from the drop-down list. The default is the current library.
The Library list box does not apply to DDMs (data definition modules) in a remote mainf-
rame environment. Therefore, the box disappears when the Views (DDM) check box is
selected.

In the DBID (database ID) and FNR (file number) boxes, replace the values if the source
library is not in the current system file. The default is the current FNAT or FUSER, or FDIC
for DDMs on mainframes. In a remote environment, you can specify security information
for these files as described in File Security for Remote Environments.

In a remote environment, use the FSEC/FDIC button if you want to specify security infor-
mation for the system file FSEC or FDIC for XRef data; see File Security for Remote Envi-
ronments and XRef Considerations.

In the Name box, enter the name of a single object or specify a range of names; see Specifying
a Range of Names. The default is asterisk (*), indicating all objects.

In the Type group box, select the type(s) of object by choosing one of the following options:
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Select Programming (default) for all types of object (including program and subprogram)
except DDM. You can limit the types of object by choosing Object Types and selecting or
deselecting the required item(s) from the list provided:

* To select list items:
Click on a single item.

Or:
Press UP ARROW or DOWN ARROW to go to and select the required item.

Or:
Press and hold down CTRL or SHIFT and click on multiple non-consecutive or consecutive
items respectively.

Or:
Press SHIFT+UP ARROW Or SHIFT+DOWN ARROW to select multiple consecutive items.

Or:
Choose Select All to select all items.

® To deselect list items:
Press and hold down CTRL and click on a selected item again.

Or:
Choose Deselect All if all items have been selected.

Or:
Select Views (DDM) for DDMs only.

In the Code group box, select Source and/or Cataloged to move either the source object or
the cataloged object, or both. The default is both the source object and the cataloged object.

If Predict is installed, you can select the XREF check box to process XRef data. See also the
section XRef Considerations.

In the User ID box, enter the ID of a user if you want to move only the objects that were
last saved or cataloged by this user. The default is no user ID.

In the Date box, enter a start date to move only objects that were saved or cataloged on or
after this date. A date must be entered in the format associated with the preset value in the
Date box. This value is determined by the DTFORM profile parameter described in the Para-
meter Reference documentation. The default date is 0000.00.00 (no date). The date is given
in the format YYYY.MM.DD (YYYY = year, MM=month, DD = day).

If you have specified a date, you can enter a start time in the Time box to move only objects
that were saved or cataloged at or after this date and time. The default time is 00: 00 (no
time). The time is given in the format HH:1I (HH=hours, II = minutes).
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2 Inthe Target group box, specify the target environment for the object(s) selected for processing:

In the Library list box, enter the name of the target library where you want to place the
object(s) or select a library from the drop-down list. The default is the current library. If
you want to create a library, enter the name of a new library.

The Library list box does not apply to DDMs (data definition modules) in a remote mainf-
rame environment. Therefore, the box disappears when the Views (DDM) check box is
selected.

In the DBID (database ID) and FNR (file number) boxes, replace the values if the target
library is not in the current system file. The default is the current FNAT or FUSER, or FDIC
for DDMs on mainframes. In a remote environment, you can specify security information
for these files as described in File Security for Remote Environments.

In a remote environment, use the FSEC/FDIC button if you want to specify security infor-
mation for the system file FSEC or FDIC for XRef data; see File Security for Remote Envi-
ronments and XRef Considerations.

In the Name box, you can enter a new name for the object in the target environment or
specify a range of new names by using asterisk (*) notation; see Specifying a Range of
Names. The default asterisk (*) specifies that all objects contained in the target environment
are replaced if relevant.

Use the Confirm on replace check box to confirm (default) or reject object replacement. See
also Confirm on replace below.

Select the Rename check box (selected by default) to give the moved objects new names in
the target environment. The check box is dimmed for DDMs in a remote mainframe envi-
ronment where you cannot rename DDMs. See also Rename below.

3  Choose OK when you have finished specifying the source and target environments.

If you have entered a single name in the Name box of the Source group box, skip the following
instructions and proceed with Confirm on replace in Step 5.

If you have specified a range of names in the Name box of the Source group box, an additional
dialog box similar to the example below appears with a list of all matching objects:
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mﬂhject Maintenance - Move E |

Source Library: SAGTEST DBID: 030 FMR: 030, 22 objects Found,

Target Library: TESTLIE DEID: 030 FRR: 030

Dhject Type 3/C  UserID

SRETAN Program SiC GMO P

FaM2 Program S MO

PG Proaram S GMo

PGaMY Progran 5 Mo

PiaMS Program s GMo

PGME Program s oMo v
Select Al [Mowve Cancel Help |

The dialog box shows the library locations, the number of objects found and the object names
and types. It also indicates whether a source (S) and/or a cataloged (C) object exists and the
ID of the user who saved and/or cataloged an object.

4  Select or deselect single or multiple objects by proceeding as described in To select/deselect
list items.
5  Choose Move to process the selected object(s).
(Cancel exits the dialog box without any action.)
= If the Rename check box has been selected, an additional dialog box similar to the following
example appears that displays, one after the other, each object to be moved. (No additional
dialog box appears if a single name, rather than a range, is entered in the Name box of the
Source group box.)
Object Maintenance - Move |
—Source objeck
Library SAGTEST 030,030
Object: PGMI (Source and Gp)
— Target object
Library: TESTLIE 030,030
Object: |
I, Skip Close
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Choose one of the following options: In the Object box of the current object, enter a new
name for the object in the target environment. Choose OK to confirm the rename.

Or:
Choose Skip (or ALT+S) if you want to remove the current object from the list of selected
objects and proceed with the next object.

Or:
Choose Close to exit the dialog box without any action.

*= If the Confirm on replace check box has been selected and if the target environment already
contains an object with the same name as the object to be moved, an additional dialog box
appears with a warning message.

Confirm or reject object replacement by choosing one of the following buttons:
Yes to confirm each object replacement individually one after another.

Or:
Yes to All to confirm all object replacements in one go.

Or:
No to not replace the current object.

Or:
Cancel to exit the dialog box without any action.

6  After all objects have been moved, the Object Maintenance - Move dialog box is closed and
the Object Maintenance menu appears.
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68 Deleting Objects

The Delete function is used to delete single or multiple objects from a source environment.

This section provides instructions for specifying delete options in the Object Maintenance -
Delete dialog box.

» To delete objects

1

In the Library list box, enter the name of the library that contains the object(s) you want to
delete or select a library from the drop-down list. The default is the current library. The

Library list box does not apply to DDMs (data definition modules) in a remote mainframe
environment. Therefore, the box disappears when the Views (DDM) check box is selected.

In the DBID (database ID) and FNR (file number) boxes, replace the values if the library is
not in the current system file. The default is the current FNAT or FUSER, or FDIC for DDMs
on mainframes. In a remote environment, you can specify security information for these files
as described in File Security for Remote Environments.

In a remote environment, use the FSEC/FDIC button if you want to specify security informa-
tion for the system file FSEC or FDIC for XRef data; see File Security for Remote Environments
and XRef Considerations.

In the Name box, enter the name of a single object or specify a range of names; see Specifying
a Range of Names. The default is asterisk (*), indicating all objects.

In the Type group box, select the type(s) of object by choosing one of the following options:

Select Programming (default) for all types of object (including program and subprogram)
except DDM. You can limit the types of object by choosing Object Types and selecting or
deselecting the required item(s) from the list provided:

" To select list items:

Click on a single item.
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Or:
Press UP ARROW or DOWN ARROW to go to and select the required item.

Or:
Press and hold down CTRL or SHIFT and click on multiple non-consecutive or consecutive
items respectively.

Or:
Press SHIFT+UP ARROW Or SHIFT+DOWN ARROW to select multiple consecutive items.

Or:
Choose Select All to select all items.

* To deselect list items:
Press and hold down CTRL and click on a selected item again.

Or:
Choose Deselect All if all items have been selected.

Or:
Select Views (DDM) for DDMs only.

In the Code group box, select Source and/or Cataloged to delete all objects for which either
the source object or the cataloged object, or both exist. The default is both the source object
and the cataloged object.

If Predict is installed, you can select the XREF check box to delete XRef data. See also the
section XRef Considerations.

In the User ID box, enter the ID of a user if you want to delete only the objects that were last
saved or cataloged by this user. The default is no user ID.

In the Date box, enter a start date to delete only objects that were saved or cataloged on or
after this date. A date must be entered in the format associated with the preset value in the
Date box. The default date is 0000.00.00 (no date). The date is given in the format ¥y YY.MM.0D
(YYyY=year, MM=month, 0D = day).

If you have specified a date, you can enter a start time in the Time box to delete only objects
that were saved or cataloged at or after this time. The default time is 00: 00 (no time). The
time is given in the format #H: 11 (HH=hours, II = minutes).

Choose Object List when you have finished specifying object selection criteria.

If you have entered a single name in the Name box, skip the following instructions and proceed
with Confirm on delete in Step 11.
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If you have specified a range of names in the Name box, an additional dialog box similar to
the example below appears with a list of all matching objects:

Eﬂhject Maintenance - Delete Ed |

Source Library: SA&GTEST DBID: 030 FMR: 030, 194 objects Found,

Dhject Type 3/C  UserID
M1 Program SIC 0 GMO .
Mz Program 2 EMo
GM3 Proaram s GEMo L
M4 Progran 5 EMo
GMS Program s EMo
GME Program s Mo 7

Select Al Deleke Cancel Help |

The dialog box shows the library location, the number of objects found and the object names
and types. It also indicates whether a source (S) and/or a cataloged (C) object exists and the
ID of the user who saved and/or cataloged an object.

10 Select or deselect single or multiple objects by proceeding as described in To select/deselect
list items.

11  Choose Delete to process the selected object(s).
(Cancel exits the dialog box without any action.)

If the Confirm on delete check box has been selected, an additional dialog box appears with
a warning message.

Confirm or reject object deletion by choosing one of the following buttons:
Yes to confirm each object deletion individually one after another.

Or:
Yes to All to confirm all object deletions in one go.

Or:
No to not delete the current object.

Or:
Cancel to exit the dialog box without any action.

12 After all objects have been deleted, the Object Maintenance - Delete dialog box is closed and
the Object Maintenance menu appears.
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69 Renaming Objects

The Rename function is used to give single or multiple objects new names within a source envi-

ronment.

The Rename function does not apply to data definition modules (DDMs) in a remote environment
on a mainframe platform.

This section provides instructions for specifying rename options in the Object Maintenance -
Rename dialog box.

» To rename objects

1 Inthe Source group box, specify the object(s) you want to rename:

In the Library list box, enter the name of the library that contains the object(s) you want to
rename or select a library from the drop-down list. The default is the current library.

In the DBID (database ID) and FNR (file number) boxes, replace the values if the library
is not in the current system file. The default is the current FNAT or FUSER, or FDIC for
DDMs on mainframes. In a remote environment, you can specify security information for
these files as described in File Security for Remote Environments.

In a remote environment, use the FSEC/FDIC button if you want to specify security infor-
mation for the system file FSEC or FDIC for XRef data; see File Security for Remote Envi-
ronments and XRef Considerations.

In the Name box, enter the name of a single object or specify a range of names; see Specifying
a Range of Names. The default is asterisk (*), indicating all objects.

In the Type group box, select the type(s) of object by choosing one of the following options:
Select Programming (default) for all types of object (including program and subprogram)

except DDM. You can limit the types of object by choosing Object Types and selecting or
deselecting the required item(s) from the list provided:
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* To select list items:
Click on a single item.

Or:
Press UP ARROW or DOWN ARROW to go to and select the required item.

Or:
Press and hold down CTRL or SHIFT and click on multiple non-consecutive or consecutive
items respectively.

Or:
Press SHIFT+UP ARROW Or SHIFT+DOWN ARROW to select multiple consecutive items.

Or:
Choose Select All to select all items.

* To deselect list items:
Press and hold down CTRL and click on a selected item again.

Or:
Choose Deselect All if all items have been selected.

Or:
Select Views (DDM) for DDMs only (not applicable to DDMs on mainframes).

* In the Code group box, select Source and/or Cataloged to rename either the source object
or the cataloged object, or both. The default is both the source object and the cataloged
object.

If Predict is installed, you can select the XREF check box to process XRef data. See also the
section XRef Considerations.

* In the User ID box, enter the ID of a user if you want to rename only the objects that were
last saved or cataloged by this user. The default is no user ID.

* In the Date box, enter a start date to rename only objects that were saved or cataloged on
or after this date. A date must be entered in the format associated with the preset value in
the Date box. This value is determined by the DTFORM profile parameter described in the
Parameter Reference documentation. The default date is 0000.00.00 (no date). The date is
given in the format YYYY.MM.DD (YYYY = year, MM=month, DD = day).

If you have specified a date, you can enter a start time in the Time box to rename only
objects that were saved or cataloged at or after this date and time. The default time is 00: 00
(no time). The time is given in the format HH:1I (HH=hours, I] = minutes).

2 In the Target group box, you can specify the following;:
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* In the Name box, enter a new name or a range of new names by using asterisk (*) notation;
see Specifying a Range of Names. The default asterisk (*) denotes that all objects specified
in the Name box of the Source group box are to be renamed.

= Use the Confirm on replace check box to confirm (default) or reject object renaming. See
also Confirm on replace below.

3 Choose OK when you have finished specifying the renaming conditions.

If you entered a single name in the Name boxes of the Source and the Target group boxes,
skip the following instructions and proceed with Confirm on replace in Step 5.

If you entered a range of names in the Name box of the Source group box, an additional dialog
box similar to the example below appears with a list of all matching objects:

Eﬂhject Maintenance - Rename |

Source Library: SA&GTEST DBID: 030 FMR: 030, 194 objects Found,

Cbject Type S)C  UserID
M1 Program SIC aMo a
Mz Program 2 MO
GM3 Progranm S GMO 1
M4 Progran 5 GEMO
GMS Program s GMo
GME Program s o 7

Select Al BEnanme Cancel Help |

The dialog box shows the library locations, the number of objects found and the object names
and types. It also indicates whether a source (S) and/or a cataloged (C) object exists and the
ID of the user who saved and/or cataloged an object.

4  Select or deselect single or multiple objects by proceeding as described in To select/deselect
list items.

5  Choose Rename to process the selected object(s).

(Cancel exits the dialog box without any action.)
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= If you specified a range of names in the Name box, an additional dialog box similar to the

following example appears that displays, one after the other, each object to be renamed:

Object Maintenance - Copy |

—Source object
Library SAGTEST 030/030
Cbject: PGMI (Source and Gp)

—Target object
Library: TESTLIE 030/030

Object: |

2K, Skip Close

Choose one of the following options:
In the Object box of the current object, enter a new name. Choose OK to confirm the rename.

Or:
Choose Skip (or ALT+S) if you want to remove the current object from the list of selected
objects and proceed with the next object.

Or:
Choose Close to exit the dialog box without any action.

If the Confirm on replace check box has been selected and if the target environment already
contains an object with the same name as the object to be renamed, an additional dialog
box appears with a warning message.

Confirm or reject object replacement by choosing one of the following buttons:
Yes to confirm each object replacement individually one after another.

Or:
Yes to All to confirm all object replacements in one go.

Or:
No to not replace the current object.

Or:
Cancel to exit the dialog box without any action.
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6  After all objects have been renamed, the Object Maintenance - Rename dialog box is closed
and the Object Maintenance menu appears.

Tools and Utilities 391



392



70 Importing Objects

The Import function of SYSMAIN is used to copy objects (files) from an external source to a
Natural library. Alternatively, you can use the unload and load functions of the Object Handler
(see the relevant documentation).

When you import objects, the file directory FILEDIR.SAG of the target library is automatically
updated to contain information on the newly imported objects. Be aware that Natural will not
update the file directory FILEDIR.SAG if you use a non-Natural function or facility (such as the
Windows Explorer) to copy objects to a Natural library. As a result, you cannot access the objects
contained in this library. FILEDIR.SAG contains internal library information required by Natural
such as programming mode (structured or reporting), object form (source object and/or cataloged
object) and user ID.

The objects to be imported with SYSMAIN must have been created with Natural.
| Note: You cannotimport shared resources into a remote environment located on a mainframe

platform.

» To import an object

1  Inthe Source group box, specify the object(s) you want to import:

* In the Path box, enter the name of the path of the folder that contains the objects you want
to import. The default is the directory path used when starting Natural.

Or:
From the Directory list box, select the path of the folder that contains the objects you want
to import.
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Remember that a file containing a Natural object must have the appropriate extension as
indicated in the following example:

& U\ NATIMPORT _ O] x
File Edit View Favorites Tools Help r';’
DBack v o v T | 'Search = Folders | & %
Address |t:".~ UANATIMPORT -| Go |Links *
MName = | Type

[#IOOM 1 NS0 NSO File

&| DOCUMENT it HTTML DocUrment
#]G0ALMSG NSG File

™| GRAPHIC 1.gif GIF Image

[#]MAF 1.MSM NS File
[#]PGEM1MGP MGP File

| | B
& objects  |14.7 KB &J Local intranet v

In the Name box, enter the name of a single object you want to import or specify a range
of names; see Specifying a Range of Names. The default is asterisk (*), indicating all objects.

* In the Code group box, select Source and/or Cataloged to import the object either as a
source object or a cataloged object, or both. The default is both the source object and the
cataloged object.

2 Inthe Target group box, specify the target environment for the objects to be imported:

® In the Library list box, enter the name of the library into which you want to import the
objects or select a library from the drop-down list. The default is the current library. If you
want to create a library, enter the name of a new library.

® In the DBID (database ID) and FNR (file number) boxes, replace the values if the target
library is not in the current system file. The default is the current FNAT or FUSER, or FDIC
for DDMs on mainframes. In a remote environment, you can specify security information
for these files as described in File Security for Remote Environments.

* In a remote environment, use the FSEC/FDIC button if you want to specify security infor-
mation for the system file FSEC or FDIC for XRef data; see File Security for Remote Envi-
ronments and XRef Considerations.
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* In the User ID box, enter the ID of the user you want to appear in the object properties or
object directory information. If you leave the box empty (default), the ID specified with the

*USER system variable is used (see also the System Variables documentation).

= Use the Confirm on replace check box to confirm (default) or reject object replacement. See

also Confirm on replace below.

3 Choose Object List when you have finished specifying the source and target environments.

If you entered a single name in the Name box, skip the following instructions and proceed

with Confirm on replace in Step 5.

If you specified a range of names in the Name box, an additional dialog box similar to the

example below appears with a list of all matching objects:

Object Maintenance - Import

Path: LAMATIMPORT, & objects Found.
Target Library: TESTLIE DBID: 030 FMR: O30

|

Chbject Tywpe SiC

oMl ooM Source
L OCUMENT . Rk Resource
501 Global Daka SOUrceE
GRAPHIC . gif Resource
MoP1 Map Source
Pkl Proaram Cataloged

Seleck Al Imnpork Cancel Help

The dialog box shows the name of the source path, the number of objects found and the object
names and types. It also indicates whether a source (S) and/or a cataloged (C) object exists.

4  Select or deselect the required object(s) from the list:
® To select list items:
Click on a single item.

Or:

Press UP ARROW or DOWN ARROW to go to and select the required item.

Or:

Press and hold down CTRL or SHIFT and click on multiple non-consecutive or consecutive

items respectively.
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Or:
Press SHIFT+UP ARROW Or SHIFT+DOWN ARROW to select multiple consecutive items.

Or:
Choose Select All to select all items.

® To deselect list items:
Press and hold down CTRL and click on a selected item again.

Or:
Choose Deselect All if all items have been selected.

5  Choose Import to process the selected object(s).
(Cancel exits the dialog box without any action.)

If the Confirm on replace check box has been selected and if the target environment already
contains an object with the same name as the object to be imported, an additional dialog box
appears with a warning message.

Confirm or reject object replacement by choosing one of the following buttons:
Yes to confirm each object replacement individually one after another.

Or:
Yes to All to confirm all object replacements in one go.

Or:
No to not replace the current object.

Or:
Cancel to exit the dialog box without any action.

6  After all objects have been imported into the specified library, the Object Maintenance -
Import dialog box is closed and the Object Maintenance menu appears.

An imported objects is contained in the library folder appropriate for its type. For example,
a Natural object of the type program is contained in the Programs folder (in the Logical View)
of the library. If a type of object is imported for which no folder yet exists, Natural automati-
cally creates the appropriate folder when performing the Import.
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Using SYSMAIN with Subprogram

The MAINUSER subprogram is an Application Programming Interface, which allows you to
perform SYSMAIN utility functions from any user-written object (subroutine, program or subpro-
gram) as an alternative to using SYSMAIN utility menus. Upon completion of the SYSMAIN
function, the utility is terminated and control is returned to the object from which the request was
issued. MAINUSER can be used in either online or batch mode. An example of a callable routine
is the MAINCALL program, which is supplied in the SYSMAIN system library.

This section provides instructions for using MAINUSER and the syntax that applies when specifying
commands for executing SYSMAIN utility functions.

Invoking and Executing MAINUSER

» To invoke and execute MAINUSER

m  Issue a CALLNAT statement that contains the following syntax elements:

CALLNAT

"MAINUSER'

command error message library

where the variable values denote the following parameters:

Parameter |Natural Data Explanation
Format/Length

command |A250 The command string to be executed by SYSMAIN: see Using
Commands.

error N4 The return code issued by SYSMAIN at the end of processing to
indicate a normal end of processing or an error.

message |A72 The message corresponding to the error given online.

Tibrary |A8 The name of the library containing the utility SYSMAIN; by default,

this is the library SYSMAIN. (This parameter is provided for
compatibility reasons only.)

Using Commands

SYSMAIN functions can be executed using commands issued as a parameter of the MAINUSER

subprogram.

A command consists of keywords and variable values. For each SYSMAIN function to be performed,
the keywords and variable values are shown in the corresponding syntax diagrams below and
explained in the section Keywords and Variables in Commands. The symbols in the syntax diagrams
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correspond to the syntax symbols used for system commands. These symbols are explained in
System Command Syntax in the System Commands documentation.

The sequence of the command syntax is not completely fixed. The following rules apply:

® SYSMAIN function, object type and object name must be the first three parameters of the com-
mand string.

® A period (.) indicates the end of a command. If this character is detected anywhere within a
command string, all subsequent data is ignored.

* In the syntax diagrams, FM or IN is shown instead of the FROM keyword to make the diagrams
easier to read; however, FROM can always be used as a synonym for FM or IN and vice versa.

® The syntax of the where-clause and the with-clause is identical for each command.

LIST and FIND Command Syntax

The following command syntax applies to the find and list functions:

ALL
LIST CATALOGED
{ n } SAVED name [ IN[LIBRARY] Tib-name ] [where-clause][with-clause]
EIND
STOWED
VIEW
Examples of LIST and FIND

LIST VIEW * IN TESTLIB

L SAVED TEST* IN TESTLIB TYPE PNS FNR 6

L SA TEST* IN TESTLIB FNR 6 DBID 2 TYPE PM FMDATE 2007-01-01
FIND PROG1 IN * DBID 1 FNR 6

F STOWED MAINMENU IN SYS* WHERE DBID 1 FNR 5

FIND ALL PROGZ IN PROD* FNR 27 DBID 1
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COPY and MOVE Command Syntax

The following command syntax applies to the copy and move functions:

ALL

CATALOGED
{ Copy} SAVED name [ FM[LIBRARY] T7ib-name ] [where-cTlause]

MOVE STOWED

VIEW TO [LLBRARY] 7ib-name [where-clause][with-clause]
RESOURCE

Examples of COPY and MOVE

COPY PROGI1 FM TESTORD TO ORDERS DBID 1 FNR 6 REP

C PGM* FM TESTLIB TO PRODLIB WITH REP TYPE PNS

C VIEW PERS FM OLDLIB FNR 10 TO NEWLIB FNR 16 REPLACE
MOVE VIEW PERSONNEL FM OLDLIB FNR 20 TO NEWLIB FNR 24
M PROGL TO NEWLIB

M STOWED * FM OLDLIB TO NEWLIB WHERE DBID 100 FNR 160 WITH XREF Y

DELETE Command Syntax

The following command syntax applies to the delete function:

ALL
CATALOGED
SAVED . .
DELETE STOWED name [ IN[LIBRARY] 7ib-name ] [where-clause][with-clause]
VIEW

RESOURCE
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Examples of DELETE

DELETE SA * IN LIBTEST TYPE GLA
D * IN TESTORD TYPE PM

D VIEW FINANCE IN TESTLIB DBID 12 FNR 27

RENAME Command Syntax

The following command syntax applies to the rename function:

ALL

CATALOGED )
SAVED name AS new-name[with-clause]

RENAME STOWED FM[LIBRARY] 7ib-name [where-clause]

VIEW

RESOURCE TO [LIBRARY] 77ib-name [where-clause]

Examples of RENAME

RENAME PGM1 AS PROGL

R PGM1 AS PROGl1 FM TESTLIB DBID 1 FNR 5 TO PRODLIB DBID 2 FNR 6

IMPORT Command Syntax

The following command syntax applies to the import function:

ALL
CATALOGED
SAVED
STOWED name FM[PATH] path-name
VIEW
RESOURCE

IMPORT

TO[LIBRARY] 7ib-name [where-clause]l[with-clause]
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Examples of IMPORT

IMPORT ALL PGM* FM D:\NAT-PROGRAMS TO IMP-LIB

I RES resl.bmp FM D:\RESOURCES TO IMP-LIB

where-clause

[WHERE] [DBID dbid] [FNR fnr]
[DIC (dbid,fnr,password,cipher)]
[SEC (dbid,fnr,password,cipher)]

Separators

Commas must be used as separators between the values following the DIC and SEC keywords, or
if a value is missing. For example: DIC (10, ,secret,2a).If the ID session parameter (see also ID
- Input Delimiter Character in the Parameter Reference documentation) has been set to a comma, use
a slash (/) as the separator between values.

with-clause

[WITH] [TYPE type] [FMDATE date] [FMTIME time]

[USER user-id] [ XREF { E } ]

[REPLACE] [RCOP] [NOPROMPT] [HELP]

STRUCT
SM

REPORT

Keywords and Variables in Commands

This section explains the keywords and corresponding variable values (if required) used in a
command.
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Keywords are listed alphabetically. Letters in italics represent variable values that must be supplied
with a keyword. For each variable value, the Natural data format and length is indicated.

Keyword Value Natural Data |Explanation
Format/Length
ALL name A9 Only applies to programming objects.
The name of the object to be processed or a range of names; see
Specifying a Range of Names. Any saved (source) objects and/or
cataloged objects are processed.
CATALOGED|name A9 Only applies to programming objects.
The name of the cataloged object to be processed or a range of
names; see Specifying a Range of Names.
SAVED name A9 Only applies to programming objects.
The name of the saved (source) object to be processed or a range
of names; see Specifying a Range of Names.
STOWED name A9 Only applies to programming objects.
The name of an object (or a range of names) for which the saved
(source) and the cataloged object are to be processed (see also
Specifying a Range of Names). Only an object that exists as both
a saved (source) object and a cataloged object is processed.
The exceptions to this are copycode and text, neither of which
can be cataloged. However, they are included in processing
when this option is specified.
VIEW name A32 Only applies to DDMs (data definition modules).
The name of the DDM to be processed or a range of names; see
Specifying a Range of Names.
RESOURCE [name A255 Only applies to shared resources.
The name of the shared resource to be processed or a range of
names; see Specifying a Range of Names.
FROM Tib-name A8 Specifies a source library or a source path.
or or or
M path-name A253 The source library or path contains the object to be processed.
or
IN
TO lib-name A8 Specifies a target library.
AS new-name A8 The new name to be given to an object when it is renamed with
or the RENAME command. Format/length A8 applies to
A32 programming objects, A32 to DDMs and A255 to shared
or resources.
A255
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Keyword

Value

Natural Data
Format/Length

Explanation

LIBRARY

lib-name

A8

An optional keyword that indicates the name (77b-name) of a
source or a target library. If you omit the keyword and
respective value, the library where you logged on before you
invoked SYSMAIN is used for processing.

The source library contains the object to be processed. The target
library is the library to which the object is to be copied or moved,
or where the object is renamed.

17b-name must be specified immediately after the FROM/FM/IN
or TO keyword. If LIBRARY is used, it must be entered between
FROM/FM/IN or TO and 77b-name.

PATH

path-name

A253

Only applies to the IMPORT command.

An optional keyword that indicates the name (path-name) of
a source path.

path-name mustbe specified immediately after the FROM/FM/IN
or T0 keyword. If PATH is used, it must be entered between
FROM/FM/IN or TO and path-name.

WHERE

where-clause

An optional keyword that indicates the start of a where-clause.

The where-clause must always follow the FROM/FM/IN or TO
keyword and the library name (77b-name) or path name
(path-name) if relevant; the sequence of the keywords and
values within the clause can be specified in any order.

DBID

dbid

N5

The database ID (DBID) of a source or a target system file.

The source system file contains the object to be processed. The
target system file is the system file to which the object is to be
copied or moved, or where the object is renamed if relevant.

Valid DBIDs are 1 to 65535.

If no DBID or FNR (file number) is specified, the following
applies:

The DBID and FNR of the system file where the current library
resides are always used.

For example: if you specify a library contained in the FUSER
system file, the DBID and FNR of this file are used.

See also the section File Security in Remote Environments.

FNR

fnr

N5

The file number (FNR) of a source or a target system file.

The source system file contains the object to be processed. The
target system file is the system file to which the object is to be
copied or moved, or where the object is renamed if relevant.
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Keyword

Value

Natural Data
Format/Length

Explanation

Valid FNRs are 1 to 65535.

If no DBID or FNR is specified, the following applies:

The DBID and FNR of the system file where the current library
resides are always used.

For example: if you specify a library contained in the FUSER
system file, the DBID and FNR of this file are used.

See also the section File Security in Remote Environments.

DIC

abid

fnr
password
cipher

A80

Specifies the environment of the FDIC source and/or target
system file: database ID (db7d), file number (fnr), Adabas
password (password) and Adabas cipher code (cipher).

See also the section File Security in Remote Environments.

SEC

dbid

fnr
password
cipher

A80

Specifies the environment of the FSEC source and/or target
system file: database ID (db7d), file number (fnr), Adabas
password (password) and Adabas cipher code (cipher).

See also the section File Security in Remote Environments.

WITH

with-clause

An optional keyword that indicates the startofa with-clause.

The keywords and values of the with-cTause canbe specified
in any order, and the with-clause can be placed in any
location within the command string, except in the first three
positions.

TYPE

type

A20

The type(s) of object to be processed as listed in TYPE
Specification below.

FMDATE

date

A10

The start date of a time period:
All objects which were saved or cataloged on or after the
specified date are processed.

A date must be specified in a valid Natural date format. The
default format is the international format YYYY-MM-DD (YYYY =
year, MM=month, DD = day), for example, 2006-05-20.

FMTIME

time

A5

Only applies if FMDATE is specified.

Specifies a start time:
All objects which were saved or cataloged at or after the
specified time (and date) are processed.

A time must be specified in the format H#: 11 (HH=hours, I =
minutes), for example, 11:33.

USER

user-id

A8

A user ID:
All objects that were saved or cataloged by the specified user
are processed.

Tools and Utilities

405



Using SYSMAIN with Subprogram

Keyword

Value

Natural Data
Format/Length

Explanation

XREF

or

Al

Only applies to programming objects and if Predict is installed.

Indicates whether XRef data stored in Predict system files is to
be processed.

You can specify one of the following values:

N XRef data is not processed, except when using the DELETE
command. If a cataloged object is deleted, SYSMAIN always
deletes any existing XRef data for this object.

Y All XRef data is processed.

See also the section XRef Considerations.

REPLACE

Activates the replace option used ina with-clause.

An object with the same name in the target environment is
replaced by the object to be processed.

Anmerkung: If an object is replaced it is also deleted from the

Natural buffer pool; any existing cross-reference records are
also deleted.

RCOP

Specifies that a copy of the object being renamed is to be made.

NOPROMPT

Not applicable in batch mode.

Disables (NOPROMPT) the SYSMAIN prompts.

With NOPROMPT, no confirmation screen is displayed.

For example, before any deletion, SYSMAIN prompts you for
confirmation.

HELP

This keyword is provided for compatibility reasons only.

STRUCT
or
SM

Only applies to the IMPORT command.

Indicates structured mode described in Natural Programming
Modes in the Programming Guide.

REPORT

Only applies to the IMPORT command.

Indicates reporting mode described in Natural Programming
Modes in the Programming Guide.

A period (.) indicates the end of a command. If this character is
detected anywhere within a command string, all subsequent
data is ignored.
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TYPE Specification

The following table lists all valid object-type codes for programming objects that can be used with

the TYPE keyword:

o
o
o
(1]

Object Type

Program

Subprogram

Subroutine

Map

Helproutine

Dialog

Processor

Parameter data area

Global data area

Local data area

Copycode

Text

Class

Function

View (DDM)

O | N | Al Ol | D |l W] T|XZ| OWV| =Z| ©

Adapter

*

All programming object types.

Specifying a Range of Names

All SYSMAIN functions provide the option to specify either a name or a range of names for the

libraries or the objects to be selected.

The valid asterisk (*) notations for name ranges are listed below where vaue denotes any combi-

nation of one or more characters:
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Input Objects or Libraries Selected
* All objects or libraries.
value* All objects or libraries with names that start with va/lue.

Example: AB*
Selected: AB, AB1, ABC, ABEZ
Not selected: AA1, ACB

value*value*

All objects or libraries that match va/ue combined with one or two asterisks (*) in any
order.

Example: A*C*
Selected: ABCZ, AXXCBBBZ, ANCZ
Not selected: ABDEZ, ACBBBZA
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All cross-reference (XRef) data stored in the Predict system file for a cataloged programming object
can be processed with SYSMAIN.

The Predict system file is determined by the value assigned to the profile parameter FDIC (see
FDIC - Predict System File in the Parameter Reference documentation) in the parameter file or at the
start of the Natural Studio session.

You can override the current FDIC settings for the duration of the current SYSMAIN function by
using the FSEC/FDIC button and changing the entries in the FDIC group boxes (see File Security
in Remote Environments) or specifying the DIC keyword in a SYSMAIN command (see also where-
clausein Using SYSMAIN with Subprogram).

The XREF check box in the Code group box or the XREF keyword in a SYSMAIN command indi-
cates whether SYSMAIN should process XRef data.

If Predict has not been installed, you can clear the XREF check box (or set XREF to N) to not perform
a validation of Predict files. This is the default setting.

Processing of XRef Data

No XRef data is processed if the XREF check box is cleared or if the XREF keyword is set to N when
using a SYSMAIN command.

XRef data is processed if the XREF check box is selected or if XREF is set to Y.

Regardless of what setting you choose, XRef data is always deleted when a programming object
is deleted.

If XRef data is to be processed, the following actions are applied during SYSMAIN processing:

® SYSMAIN checks whether XRef data exists in the Predict source system file for the specified
programming object.

* If a programming object is to be deleted from the target environment, XRef data is deleted from
the Predict target system file.

® If a programming object is copied to a new environment, the XRef data of the programming
object is copied from the Predict source system file to the Predict target system file. The library
name is changed accordingly and, in the case of the rename function, the object name is also
changed.

® If the move function is executed, the XRef data of the programming object is deleted from the
Predict source system file.
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XRef Processing Errors

If any of the following inconsistencies occur during SYSMAIN processing of XRef data, all proces-
sing for the object or function is terminated and an error message is displayed:

® The value of the XREF option in Natural Security is set to Y and you cleared the XREF check
box or set XREF to N respectively.

® The XREF check box is selected (or XREF set to Y) and the FDIC file(s) being used are not valid
Predict files.
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This section describes the security aspects of the SYSMAIN utility.

File Security in Remote Environments

In a remote environment located on a mainframe, a UNIX or an OpenVMS platform, file security
(that is, passwords and cipher codes) relates to the security that has been defined for a system file
in an Adabas environment. If file security has been defined for a system file, you need to specify
a password and a cipher code for the source and/or target system file required before you perform
a SYSMAIN function. Otherwise, Adabas will issue an appropriate error message. You do not
have to provide security information for the default system files assigned to you at the start of the
SYSMAIN utility.

Security information for FSEC and/or FDIC system files can only be specified if Natural Security
and/or Predict respectively are installed.

In a remote mainframe environment, the security information of the system files refers to the
corresponding profile parameters FNAT, FUSER, FDIC and FSEC described in the Parameter Reference
documentation.

In a remote UNIX or OpenVMS environment, the security information of the system files refers
to the corresponding profile parameters FDIC and FSEC described in the Parameter Reference docu-
mentation.

The following system files and objects or data contained in the files can be affected by security
protection:

® FNAT or FUSER with programming objects and FDIC with DDMs on a mainframe platform;
® FDIC with XRef data (UNIX, OpenVMS and mainframe);

® FSEC with Natural Security profile (UNIX, OpenVMS and mainframe).

» To specify security information for FNAT or FUSER, or FDIC for DDMs on mainframes

1  Inthe Object Maintenance dialog box of a SYSMAIN utility function, change the entry in the
DBID or FNR box in the Source and/or Target group boxes.

The Password and Cipher boxes appear below DBID and FNR.

2 Enter the appropriate security information:

In the Password box, enter the 8-character Adabas password for the FNAT or FUSER source
and/or target system files.

In the Cipher box, enter the 8-character Adabas cipher code for the FNAT or FUSER source
and/or target system files.
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» To specify security information for FDIC (XRef data) or FSEC

1  Inthe Object Maintenance dialog box of a SYSMAIN utility function, choose the FDIC/FSEC
button in the Source and/or Target group boxes.

An Object Maintenance - Source or Object Maintenance - Target dialog box similar to the
example below appears:

Object Maintenance - Source |
—FDIC
DEID: |0 EMR: |0
Passwiord: Ciphet:
—FSEC
DBID: |0 EMR: |0
Password: Cipher:

................................

] o iZancel Help

2 Inthe FDIC and/or FSEC group boxes, enter the appropriate security information for the
FDIC system file (if Predict is installed) and/or the FSEC system file (if Natural Security is
installed):

DBID The database ID (DBID) of the source or the target database where the FDIC or FSEC
system file is stored. Valid DBIDs are 1 to 65535.

The default value is 0 (zero) for the current FDIC or FSEC system file.

FNR The file number (FNR) of the source or the target database where the FDIC or FSEC system
file is stored. Valid FNRs are 1 to 65535.

The default value is 0 (zero) for the current FDIC or FSEC system file.

Password |The 8-character Adabas password for the FDIC or FSEC source and/or target system files.

Cipher The 8-character Adabas cipher code for the FDIC or FSEC source and/or target system
files.

The file security specifications in the Object Maintenance dialog boxes are retained for the dura-
tion of the current SYSMAIN function.
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» To specify security information for system files using commands

s For FSEC:
Use the SEC keyword of the where-clause described in Using SYSMAIN with Subprogram.
Or:
For FDIC and XRef data:
Use the DIC keyword of the where-clause described in Using SYSMAIN with Subprogram.
Or:
For FNAT or FUSER:

Use the DBID and FNR keywords of the where-clause described in Using SYSMAIN with Sub-
program.

Natural Security

Two aspects must be considered when using the SYSMAIN utility within a Natural Security
environment:

= Defining the Natural Security Environment
= Restricting Use of SYSMAIN under Natural Security

Defining the Natural Security Environment

The source and target libraries can be within one Natural Security environment or within two
different Natural Security environments. These environments must be defined to the SYSMAIN
utility.

The definition of the Natural Security environment(s) to be used can be specified in the FSEC
group boxes of the Object Maintenance - Source and Object Maintenance - Target dialog boxes.

By default, SYMAIN uses the current FSEC settings as specified with the FSEC profile parameter
in the parameter file or at the start of the Natural Studio session. You can override these settings
by changing the entries in the FSEC group boxes. The new settings remain in effect for the duration
of the current SYSMAIN function. When you execute SYSMAIN with a subprogram using com-
mands (see Using SYSMAIN with Subprogram), the SEC keyword should be used to specify the
file security and assignments of the request.

Once the source and target environments have been determined, SYSMAIN verifies both the
source libraries and the target libraries with Natural Security. The source and/or target database
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and file must correspond to the database ID (DBID) and file number (FNR) specified in the library
security profile; if these values are not specified, default values are taken from the security profile.

Restricting Use of SYSMAIN under Natural Security

The use of the SYSMAIN utility itself can be restricted, or the use of the source and target libraries
to be handled with the SYSMAIN utility can be restricted. The use of SYSMAIN utility functions
when invoked with the MAINUSER subprogram can be controlled separately. See Protecting Ulti-
lities in the Natural Security documentation for details.
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The utility SYSNCP is used to define command-driven navigation systems for Natural applications.

The Natural Command Processor (NCP) consists of two components: maintenance and runtime. The
utility SYSNCP is the maintenance part which comprises all facilities used to define and control
navigation within an application. The PROCESS COMMAND statement (see the Statements
documentation) is the runtime part used to invoke Natural programs.

Prerequisites for Windows

This section lists the prerequisites required for installing the command processor under Windows:

Adabas for Windows.

Logical file (LFILE) 190 (NCP Command Proc); this file is set as default in the Natural parameter
file, do not modify it.

FDT "SYSTEM-NCTP"; see the README file in the folder "demodb".

Depending on the size of the command processor, the values of the Adabas parameters LP and
NH may have to be adjusted. If these values are too small, you receive error NAT3145 (see the
Adabas documentation). With Adabas for Windows Version 5.1, the parameters LP and NH
have become obsolete.

Introducing the SYSNCP Utility

Applications which enable users to move from one activity to another activity by using direct
commands far exceed in usability the ones which force the user to navigate through menu hierar-
chies to a desired activity.
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SYSNCP Utility Main Menu
|
' . I
Document File
Maintenance Maintenance
1 |
' | ™ r i ™y
File Delate Cisplay Deleta
Document Documeant File File
A
Display A .
Document DELETE FILE

The figure above illustrates the advantage of using direct commands. In an application in which
menu hierarchies form the basis for navigation, a user wishing to advance from the Display
Document facility to the Delete File facility would have to return to the Main Menu via the docu-
ment branch and then enter the file branch. This is clearly less efficient than accessing the Delete
File facility directly from the Display Document facility.

Below is information on:

= Object-Oriented Data Processing

= Features of the Command Processor

= Components of the Command Processor
= What is a Command?
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= Creating a Command Processor

Object-Oriented Data Processing

The Natural command processor is used to define and control navigation within an application.
It could be used, for example, to define a command DISPLAY DOCUMENT to provide direct
access to the Display Document facility. When a user enters this command string in the Command
line of a screen (for which this command is allowed), the Natural command processor processes
the input and executes the action(s) assigned to the command.

In contrast to menu-driven applications, the command-driven applications implemented with the
Natural command processor take a major step toward object-oriented data processing. This
approach has the following advantages:

The design of an application need not depend on the way in which a certain result can be reached,
but only on the desired result itself. Thus, the design of an application is no longer influenced
by the process flow within its components.

The processing units of an application become independent of one another, making application
maintenance easier, faster and much more efficient.

Applications can be easily expanded by adding independent processing units. The resulting
applications are, therefore, not only easy to use from an end-user's view, but also easier to
create from a programmer's view.

The Natural command processor has the following additional benefits:

Less Coding

Instead of having to repeatedly program lengthy and identically structured statement blocks
to handle the processing of commands, you only have to specify a PROCESS COMMAND
statement that invokes the command processor; the actual command handling need no longer
be specified in the source code. This considerably reduces the amount of coding required.

More Efficient Command Handling

As the command handling is defined in a standardized way and in one central place, the work
involved in creating and maintaining the command-processing part of an application can be
done much faster and much more efficiently.

Improved Performance

The Natural command processor has been designed with particular regard to performance
aspects: it enables Natural to process commands as fast as possible and thus contributes to
improving the performance of your Natural applications.
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Features of the Command Processor

The Natural command processor provides numerous features for efficient and user-friendly
command handling;:

Flexible Handling of Commands
You can define aliases (that is, synonyms for keywords), and abbreviations for frequently used
commands.

Automatic Check for Uniqueness of Abbreviated Keywords

The command processor automatically compares every keyword you specify in SYSNCP with
all other keywords and determines the minimum number of characters in each keyword required
to uniquely identify the keyword. This means that, when entering commands in an application,
users can shorten each keyword to the minimum length required by the command processor
to distinguish it from other keywords.

Local and Global Validity of Commands

You can specify in SYSNCP whether the action to be performed in response to a specific command
is to be the same under all conditions or situation-dependent. For example, you can make the
action dependent on which program was previously issued. In addition, you can define a com-
mand to be valid under one condition but invalid under another.

Error Handling for Invalid Commands
You can attach your own error-handling routines to commands or have error input handled by
Natural.

Functional Security

With Natural Security, library-specific and user-specific conditions of use can be defined for the
tables generated with SYSNCP. Thus, for your Natural applications you can allow or disallow
specific functions or keywords for a specific user. This is known as functional security. See also
the section Functional Security in the Natural Security documentation.

Help Text

In SYSNCP, you can attach help text to a keyword or a command. Then, by specifying a PROCESS
COMMAND ACTION TEXT statement, you can return command-specific help text to the pro-
gram.

Online Testing of Command Processing

If the execution of a command does not produce the intended result, you can find out why the
command was not processed correctly by using the PROCESS COMMAND statement (see the
Statements documentation) and the EXAM* sample test programs (source form) provided in the
Library SYSNCP. The endings of the EXAM-* program names appear as abbreviations at the
top border line of the relevant action windows (for example, EXAM-C appears as C).

» To test a command processor at runtime

1 Enter the direct command EXAM to list all test programs. The Demonstrate PROCESS
COMMAND Statement window is displayed.
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2 Enter Function Code O to open a processor.
3 Enter the name of the processor.

4  Choose any of the Functions Codes listed (for example, C for CHECK) to apply command
actions.

5  Enter Function Code Q to close the processor.

Components of the Command Processor

The Natural command processor consists of two parts: a development part and a runtime part:

The development part is the utility SYSNCP, which is described in this section. With the utility
SYSNCP you define commands (as described below) and the actions to be performed in
response to the execution of these commands. From your definitions, SYSNCP generates decision
tables which determine what happens when a user enters a command. These tables are contained
in a Natural member of type Processor.

The runtime part is the statement PROCESS COMMAND, which is described in the Statements
documentation. This statement is used to invoke the command processor within a Natural
program. In the statement, you specify the name of the processor to be used to handle the
command input by a user at this point.

What is a Command?

A command is any sequence of values entered in the Command line which is recognized and
processed by an application. Commands can contain up to three elements:

Function:
One or more valid keywords. For example, MENU or DISPLAY DOCUMENT.

Parameter Indicator:
Optional. A keyword which introduces command data.

Command Data:
Information to be sent to a function. Command data can be alphanumeric or numeric, for
example, the name or the number of the file to be displayed.
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Display Docurment Murmber 49
'Y
A A
‘. T | T
Keyword (or its synonym) Farameter Data
Indicator

Function: a valid combination of keywords

Command: a sequence of valuas entered in the command line

Commands are always executed from a situation within an application; the position where this
situation is reached is referred to as a location. Commands take the user from one location to
another location; thus, each command can be viewed as a vector:

DISPLAY DOCUMENT
Menu - Display Document

Old Location Command Mew Location

The location from which a certain command can be issued can be restricted on a system-wide or
user-specific basis. On a system-wide basis, for example, the functions specified within commands
can be local or global. A global function can be issued from any location while a local function can
only be issued from specified locations. Restrictions can be placed on keywords and functions,
however, if Natural Security is active in your environment.
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Creating a Command Processor

The utility SYSNCP is used to create and maintain command processors. A command processor
contains decision tables which determine what happens when a user enters a valid command.

The creation of a command processor is a cumulative operation involving several steps, from
header definition, which establishes general defaults for the processor, to keyword definition,
function definition and the linking of actions to functions. Special editors are provided by SYSNCP
for the purpose of specifying keywords, functions and actions.

Matural Utility SYSNCP

Command Processor

Source
Header
Kaywords
Natural Object
Frocessor
Functions

Runtime Actions

The end product of command processor development is a complex command processor source,
which, when cataloged, generates a Natural object of type Processor. Whenever this object is
referenced by the Natural statement PROCESS COMMAND, the runtime system of the Natural

command processor is triggered.

The following is a summary of the steps necessary to create a command processor.
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» To create a command processor

1

Verify/Modify the Session Profile.

SYSNCP itself uses a Session Profile which contains various parameters which control how
SYSNCP is to perform certain actions and how information is to be displayed. Desired
modifications can be made and the resulting profile can be saved with a given user ID. See
the section Session Profile.

Initialize the Command Processor.
The name of the command processor and the library into which it is to be stored are specified.

Define Global Settings (Header).

Various global settings for the command processor are defined. For example, descriptive text
for keywords during editing, minimum and maximum length for keywords, in which sequence
keywords are to be processed at runtime, runtime error-handling, and whether PF keys can
be used at runtime to invoke functions. See the section Header Records.

Define Keywords.

Each keyword which is to be processed by the command processor is defined together with
an indication as to whether the keyword is to be entered as the first, second or third entry of
a command. Keyword synonyms can also be defined as well as parameter indicators. User
text can be defined for each keyword. This text can subsequently be read at runtime using
the PROCESS COMMAND ACTION TEXT statement. See the section Keyword Maintenance.

Define Functions.

Functions are defined by validating keyword combinations. A function can be defined as
local (can only be invoked from a specific location within an application) and/or global (can
be invoked from anywhere within an application). See the section Function Maintenance.

Define Runtime Actions.

The actions to be taken by the command processor when a command is issued at runtime are
specified. Example actions are: fetch a Natural program, place a command at the top of the
Natural stack, place data at the top of the Natural stack, change contents of the Command
line. See the section Runtime Actions.

Catalog Command Processor.

The resulting source is cataloged as a Natural object (type Processor) in the designated
Natural library. The command processor can now be invoked by a Natural program using
the PROCESS COMMAND statement. See the section Processor Cataloging.
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Invoking SYSNCP

» To invoke the SYSNCP utility

Enter the system command SYSNCP.

The Processor Source Maintenance menu is displayed:

18:22:53 FxAkxx NATURAL SYSNCP UTILITY ***+*x* 2000-05-22
User SAG - Processor Source Maintenance -

Code Function

Select Processor
Create New Processor
Modify Header

Define Keywords

Define Functions
Define Runtime Actions
Catalog Processor
Administrator Services
Help

Exit

V> (O U TR I =Z W,

Code .. _ Name .. SAGTEST_ Library .. SYSNCP__

Logon to SYSNCP accepted.

Command ===

Ent@r=PFl===PF2===PF3===PFl===PF5===PFo===PF7===PF8===PF9===PFLO-=PF11l-=PFl2--=
Help Cmd Exit Last List Flip Canc

From this menu, you can invoke all functions necessary to create and maintain a command
processor. To invoke a function, enter the code letter in the Code field.

Note: When you invoke the SYSNCP utility or restart SYSNCP, the user exit NCP-USR1 is

invoked for dynamic customization purposes: see the program NCP-USR1 delivered in the
Natural system library SYSNCP.

428

Tools and Utilities



SYSNCP Utility

Help

For help on individual input fields (and also on some output fields) in SYSNCP, place the cursor
on the field and press PF1.

Processor Selection

The Select Processor function results in a list of all existing command processor sources with
related information. If Natural Security is installed, only those sources are listed which can be
cataloged to a library to which you are allowed to log on. These restrictions do not apply to those
users who have administrator status.

» To invoke the Select Processor function

1 In the Processor Source Maintenance menu, enter Function Code S.

2 Press ENTER.

The following information is provided for each processor:

Name |The name of the command processor.

Library | The name of the Natural library for which a processor is created. When the processor is
cataloged, it is stored in this library.

User ID | The ID of the user who created the processor.

Date  |The date the processor was created.

Status |The stage of development of the processor. For possible status values, see Current Status in
the section Header Records.

Cat Indicates if the processor has been cataloged.

Note: With the user exit NCP-SELX (delivered in the Natural system library SYSNCP),

you can limit the display to certain processors.

3  Inthe Ac field, enter any character to select a processor.

The Processor Source Maintenance menu is displayed, where the name of the selected processor
is automatically placed in the Name field.

If you enter a question mark (?) in the Ac field, a window is be displayed, listing other possible
options.

The name and library name of a command processor can be one to eight characters long. It can
consist of upper-case alphabetical characters (A - Z), numeric characters (0 - 9) and the special
Characters: ll-l" H/ "’ l‘$”, Yl&”, YI#H, ”+” and ll_H.
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Header Records

The header maintenance facility defines various global settings for a command processor. These
definitions are collectively referred to as a header. Seven header maintenance screens are provided
for creating and modifying headers. Header settings for a command processor can be updated at
any stage of development (see the following section). After the settings have been modified, the
status of a command processor is always set to Header (see also Current Status).

Below is information on:

= Create New Processor

= Modify Header - General Explanations
= Keyword Runtime Options - Header 1
= Keyword Editor Options - Header 2

= Miscellaneous Options - Header 3

= Command Data Handling - Header 4
= Runtime Error Handling - Header 5

= Statistics - Header 6

= Status - Header 7

Create New Processor

» To create a new command processor

1  In the Processor Source Maintenance menu, enter Function Code N (Create New Processor),
the name of the command processor to be created, and
the name of the Natural library in which the command processor is to be later cataloged.

2 Press ENTER.
The first header maintenance screen is displayed.

The first header maintenance screen and the following ones are filled with default values that can
be edited.
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Modify Header - General Explanations

The Modify Header function is used to maintain an existing header; that is, to modify the various
header settings for a given command processor.

» To modify an existing header

1  In the Processor Source Maintenance menu, enter Function Code H (Modify Header),
the name of the corresponding command processor, and
the name of the library into which this command processor has been cataloged.

2 Press ENTER.

The first header maintenance screen is displayed.

3  Modify any input field in the header maintenance screens described below.

4  Press ENTER to confirm modifications.

Seven different screens are available for the definition and maintenance of a processor header (for
the definition of a header, see the previous section).

» To navigate between the header maintenance screens

s Use prs (forward) or PF7 (backward).

Each of the screens contains the following information:

Name The name of the command processor.

Library The name of the library into which the resulting command processor object is to be placed
after being cataloged.

DBID, ENR The database ID and file in which the specified library is located.

Created by The user ID of the Natural user who initialized this command processor.

Date The date the command processor was initially created.

Current Status

The command processor status:

Init
Header
Keysave
Keystow
Function
Action
Object

Frozen

The command processor has been initialized.

The header for the command processor has been created/modified.
Keywords have been defined and saved.

Keywords have been checked and stowed.

Keyword combinations have been defined.

Runtime actions have been defined.

An object form of the command processor has been created.

The command processor has been frozen.

Tools and Utilities

431



SYSNCP Utility

Copied  The command processor has been copied.

Error An error has been detected.

Keyword Runtime Options - Header 1

When you select the Modify Header function (as described above), the Processor Header Mainte-

nance 1 screen is displayed:

16:40:19 xxxxEx NATURAL SYSNCP UTILITY *xxx%

2000-05-04

User SAG - Processor Header Maintenance 1 -

Modify Processor

Created by SAG Date 2000-04-29

Keyword Runtime Options:

First Entry used as ....... Action
Second Entry used as ....... Object
Third Entry used as ....... Addition
Minimum Length ............. 1
Maximum Length ............. 16

Dynamic Length Adjustment .. -

Keyword Sequence ........... 123

Alternative Sequence .......
Local/Global Sequence ...... LG

Name SAGTEST

Library SYSNCP  DBID 10 FNR 32

Current Status Init

Processor Header with name SAGTEST for library SYSNCP has been added.

Command ===

Enter-PFl---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Help Cmd Exit Last List

= s Canc
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Various attributes which are to apply for the keywords defined for the command processor are
entered on this screen.

Field

Explanation

First Entry used as

A descriptive text which is to be associated with all keywords which are entered as
the first entry (entry type 1) when defining a keyword sequence.

For example, if the first keyword of a keyword sequence is to represent the action to
be performed (DISPLAY, DELETE, etc.), the descriptive text "Action" could be entered
in this field.

The first four characters of the text entered in this field appear under the column
heading Use in the Keyword Editor as described in the section Keyword Maintenance.

Second Entry used as

A descriptive text which is to be associated with all keywords which are entered as
the second entry (entry type 2) when defining a keyword sequence.

If, for example, the second keyword of a keyword sequence is to represent the object
to be used (DOCUMENT, FILE, etc.), the descriptive text "Object" could be entered
in this field.

The first four characters of the text entered in this field appear under the column
heading Use in the Keyword Editor as described in the section Keyword Maintenance.

Third Entry used as

A descriptive text (TITLE, PARAGRAPH, etc.) which is to be associated with all
keywords which are entered as the third entry (entry type 3) when defining a keyword
sequence.

The first four characters of the text entered in this field appear under the column
heading Use in the Keyword Editor as described in the section Keyword Maintenance.

Minimum Length

The minimum length permitted when defining a keyword. Valid values are 1 - 16
characters. The default is one character.

Maximum Length

The maximum length permitted when defining a keyword. Valid values are 1- 16
characters. The default is 16 characters.

Dynamic Length
Adjustment

The following values are permitted:

+ At runtime, each keyword must be entered in its entirety.

- Atruntime, each keyword can be abbreviated provided that it retains uniqueness
with respect to other keywords.

S The number of characters which must be entered for a given keyword is to be
specified during keyword definition in the ML field of the Keyword Editor as
described in the section Keyword Maintenance.

Keyword Sequence

The sequence in which keyword entries are to be processed at runtime. Possible
values are 1, 2, 3 and P (for parameter indicator); the default sequence is 12, which
means first the first keyword entry and then the second keyword entry. See also the
field E as described in the section Keyword Maintenance.

Alternative Sequence

An alternative sequence in which keywords are to be processed at runtime in the
event that the default sequence (specified above) results in an error during runtime.
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G

Field Explanation
Local/Global This option specifies the order of command validation to be performed at runtime.
Sequence Possible values are:

L Command is to be validated as a local command.

Command is to be validated as a global command.

The default validation sequence is LG, which means that the command is to be
validated first as a local command and then (if necessary) as a global one.

Keyword Editor Options

- Header 2

Further keyword attributes can be entered on the Processor Header Maintenance 2 screen:

Field Explanation

Header 1 for User Text | These two fields are used to enter a descriptive text which appears in the Keyword

Header 2 for User Text | Editor above the column reserved for user text. This text is also output during
runtime when the TEXT option is specified with the PROCESS COMMAND
statement as described in the Statements documentation.

Prefix Character 1 This field and the next three are used to attach a hexadecimal prefix to keywords.

This enables the processing of internal keywords which cannot be represented
by a normal keyboard. When the command processor is cataloged, all prefix
characters in keywords are replaced by the hexadecimal values specified.

If a non-blank character is entered in one of the Prefix Character fields, the
specified character is replaced by the hexadecimal value specified in the
Hexadecimal Replacement field.

Hex. Replacement 1

The value specified in this field replaces the character specified in the field Prefix
Character and is used as a prefix for a keyword at runtime.

Prefix Character 2

See above Prefix Character 1.

Hex. Replacement 2

See above Hex. Replacement 1.

Keywords in Upper Case

This option specifies whether keywords are to be translated to upper case in the
Keyword Editor and the application:

Y Keywords entered in the Keyword Editor are automatically converted to
upper case. In the application, end-users can enter the keywords in upper
or lower case.

N Keywords entered in the Keyword Editor are not converted to upper case.
In the application, end-users must enter the keywords exactly as they appear
in the Keyword Editor.

Unique Keywords This option specifies whether keywords within the processor must be unique.
Y Each keyword defined must be unique within this processor, regardless of
its type.
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Field

Explanation

N Each keyword defined for a given keyword type (1, 2, 3 or P) must be
unique.

Miscellaneous Options - Header 3

Miscellaneous options can be entered on the Processor Header Maintenance 3 screen:

Field

Explanation

Invoke Action
Editor

This option specifies whether the Runtime Action Editor is to be activated from the
Function Editor (see the sections Runtime Action Editor and Define Functions).

Y The Runtime Action Editor is invoked whenever a valid keyword combination is
defined in the Function Editor.

N The Runtime Action Editor is suppressed in the Function Editor.

Anmerkung: If you use the user exit NCP-REDM (delivered in the Natural system library

SYSNCP), you should set this option to Y; otherwise, invalid runtime action values cannot
be detected in time and can lead to runtime errors.

Catalog User
Texts

This option specifies whether user texts are to be cataloged with the command processor.

Y Text portions of the edit line (Keyword Editor; see the section Define Keywords)
and the user text portion of the action line (Runtime Action Editor) are bound to the
associated keyword or function when the command processor is cataloged. This text
can then be read at runtime using the TEXT option of the PROCESS COMMAND
statement.

N Texts are not cataloged with the command processor and cannot be read at runtime.

Security Prefetch

This option specifies whether security checking is to be performed when the command
processor is initially invoked during runtime or at each command evaluation.

Y If Natural Security is installed, security checking is performed for all keywords when
the processor is invoked.

N If Natural Security is installed, security checking is performed with the evaluation
of each keyword.

If option Y is selected, security checking is performed only once for all keywords when
the command processor is invoked. Since the checking procedure takes time, evaluation
of the first command is comparatively slow at runtime, while the evaluation of all
remaining commands is comparatively fast. Conversely, if option N is selected, the
evaluation time for each command is always the same because security is checked for
each keyword individually before it is evaluated.
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Field

Explanation

Command Log
Size

Commands processed at runtime can be stored in a command log area by the command
processor. Specify in the input field the number of KBs storage space allocated to
command logging:

0 No storage space is allocated to command logging. Command logging is inactive.

1 1KB of storage space is allocated to command logging. Command logging is active.

Implicit Keyword
Entry

This option specifies whether a keyword of type 1 is to be retained as an implicit keyword
for all subsequent commands.

1 If a command is entered which only contains a keyword of type 2, the command
processor assumes the most recently entered keyword of type 1 as implicit keyword.

N Option is disabled.

Command
Delimiter

This option specifies the character used to separate commands if more than one command
is specified in the Command line. At runtime, only the first command will be executed.

For example:

DISPLAY CUSTOMER; MODIFY CUSTOMER; PRINT.

PF-Key may be
Command

This option specifies whether commands can be allocated to PF keys: if the command
processor receives at runtime a command line which contains all blanks, it checks if a
PF key has been pressed by the user.

Possible values are:
The identifier for this PF key (system variable *PF-NAME) is used as the command.

The content of the *PF-KEY system variable is used as the command.

If *PF-NAME is empty, the content of the *PF-KEY system variable is used instead.

zZ <= = »

PF keys cannot be used as command, Natural error NAT6913 is issued with message
"Command line not accepted".

For more information on the system variables *PE-NAME and *PF-KEY see the System
Variables documentation.

Command Data Handling - Header 4

The attributes to be entered on the Processor Header Maintenance 4 screen specify how command
data are handled for a function; command data are optional.
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Options are:

Field Explanation

Data Delimiter Specifies the character to be used to precede data. Default data delimiter is "#".

Example: ADD CUSTOMER #123

Data Allowed Specifies if data input is allowed at runtime.

A runtime error occurs if data is found.
Data is dropped if present.

Data is placed at the top of the Natural stack. No verification is performed.

= @ g Zz

Data is checked and keyword entries of type P (parameter indicator) are
evaluated.

Example of Y: DISPLAY CUSTOMER NAME=SMITH

More than one Item  |Only applies if the option Data Allowed is set to Y. Specifies whether more than
Allowed one data string is permitted.

N A runtime error occurs if more than one data string is found.
D All data after the first data string are dropped.

Y More than one data string is permitted.

Example: ADD ARTICLE #111 #222
As long as uniqueness is guaranteed, the data delimiter can be omitted.

Example: ADD ARTICLE 123

Maximum Length Only applies if the option Data Allowed is set to Y.
of one Item Specifies the maximum number of characters allowed for a data string. If the
specified maximum is exceeded, a runtime error occurs. Valid range: 1 - 99.

Item Must be Numeric|Only applies if the option Data Allowed is set to Y. Specifies whether each data
value must be an integer value.

Y Data input must be a positive integer value. If not, a runtime error occurs.

N Data can be of any type.

Put to Top of Stack Only applies if the option Data Allowed is set to Y. Specifies where data is to be
placed.

Y Datais placed at the top of the Natural stack.

1-9 Datais placed in the nth occurrence of the DDM field RESULT-FIELD. If the
occurrence has already been filled as a result of a runtime action, it is
overwritten.

If Error, Drop all Data |Only applies if the option Data Allowed is set to Y or N. Specifies the reaction to a
data evaluation error:
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Field Explanation

If an error occurs during evaluation of the data, data is discarded and processing
continues.

If an error occurs during data evaluation, control is given to the error handler
as described below.

Runtime Error Handling - Header 5

The attributes to be entered on the Processor Header Maintenance 5 screen specify how to handle

runtime errors:

Field

Explanation

General Error Program

The name of the program which is to receive control when an error is detected
during runtime processing by the command processor. The Natural stack
contains the following information when this program is invoked:

Error Number (N4)
Line Number (N4)

Status (A1)
Program Name (AS8)
Level (N2)

If no error program and no specific error handling is specified (see below), the
program with the name as contained in the Natural system variable *ERROR-TA
is invoked; otherwise, a Natural system error message is issued.

Keyword not found

Indicates whether an action has been specified that is to be performed if a
keyword could not be found.

Keyword missing

Indicates whether an action has been specified that is to be performed if the
keyword type is missing.

Keyword Sequence Error

Indicates whether an action has been specified that is to be performed in the
case of a keyword sequence error.

Command not defined

Indicates whether an action has been specified that is to be performed in the
case of an undefined command.

Data disallowed

Indicates whether an action has been specified that is to be performed in the
case of disallowed data.

Data Format/Length Error

Indicates whether an action has been specified that is to be performed in the
case of a format/length error.

General Security Error

Indicates whether an action has been specified that is to be performed if an error
is detected during a general security check.

Keyword Security Error

Indicates whether an action has been specified that is to be performed if an error
is detected during a keyword security check.
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Field Explanation

Command Security Error |Indicates whether an action has been specified that is to be performed if an error
is detected during a command security check.

Statistics - Header 6

The Processor Header Maintenance 6 screen contains only output fields which report statistical
data about the keywords specified for a command processor.

The following statistical information is provided:

Field Explanation

Entry n Keywords The number of keywords of type 1 defined in the command processor (not
including synonyms).

Entry n Keywords + Synonyms |The sum of keywords of type n and their assigned synonyms.

Highest IKN for Entry n The largest Internal Keyword Number for the keyword of type n.
Possible Combinations The number of possible combinations for keywords defined.
Cataloged Functions The number of keyword combinations currently cataloged.
Status - Header 7

The Processor Header Maintenance 7 screen contains only output fields which report the time
and the date when parts of the command processor were executed or modified.

Keyword Maintenance

Keywords are the basic components for defining functions. Before it is possible to define keywords,
the header maintenance records must be created (see the section Header Records).

= Define Keywords
= Editor Commands
= Positioning Commands
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= |ine Commands
Define Keywords

Keywords used in commands are created with the Define Keywords function and the Keyword
Editor. The Keyword Editor is similar to existing Natural editors except that lines of the editor are
broken up into separate fields. Most of the editor commands (see the relevant section) and the
line commands (see the relevant section) which are used in the Natural program editor can also
be used in the Keyword Editor.

» To invoke the Keyword Editor

1  In the Processor Source Maintenance menu, enter Function Code K (Define Keywords).

2 Press ENTER.

The Keyword Editor screen is displayed.

The Keyword Editor screen is shown below. Several keywords have already been defined to serve
as examples for this section.

09:42:39 - SYSNCP Keyword Editor - 2000-05-04
Modify Keywords Name SAGTEST Library SYSNCP DBID 10 FNR 32
I Line E Use Keyword IKN ML Comment

1 1 Acti MENU 1004 1

2 1 Acti DISPLAY 1002 2

3 S Syno SHOW 1002 1

4 1 Acti DELETE 1001 2

5 S Syno PURGE 1001 1

6 S Syno ERASE 1001 1

7 1 Acti FILE 1003 4

8 P Parm NAME 4002 2

9 2 Obje FILE 2001 4

10 P Parm NUMBER 4001 2

11 2 Obje DOCUMENT 2003 2

12 1 Acti INFORMATION 1005 1

13

14
= ==== = ==== ===== A]] ====== ==== == =============c===========c==============-=
Command ===

Ent@r=PFil===PF2===PF3===PFl===PF5===PFE===PF7 ===PF@===PF9===PFlO==PFL1l-=PFil2===
Help Cmd Exit Last List Flip -1 Al Top Bot Info Canc
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Enter in the Keyword Editor all the keywords which you want to have in your command language.
These can be entered in any order desired, except synonyms, which must immediately follow the
keywords they are related to. To each keyword you assign a type which specifies to which part
of command syntax the keyword belongs. Rules of command syntax for a command processor
are specified in the processor header; see Keyword Runtime Options - Header 1 in the section
Header Records. For example, you can specify whether a keyword is to be of type 1 (entered in first
position in a command), type 2, type 3, a synonym for another keyword or a parameter indicator.

Note: A command language requires a strict syntax because, to date, no computer is capable

of understanding semantics. Word type is, therefore, the only practical way to communicate
meaning in a command language.

In the example above, the keywords DELETE and DISPLAY are defined as keywords of type 1.

As specified in the processor header, these keywords denote actions. The keyword DOCUMENT
is defined as a keyword of type 2 and it denotes an object. The keyword FILE, however, is defined
as both type 1 and 2, and it can, therefore, denote an action or an object, depending on where it is

positioned in the command. It is possible to compose the two keyword types to make commands,
such as DELETE FILE and FILE DOCUMENT.

You can save the keywords you have entered by issuing the SAVE or STOW command from the
Command line. In addition to saving the keyword definitions in source form, the STOW command
performs a consistency check on them. Once a keyword is stowed successfully, it is given an
internal keyword number (IKN) which is used at runtime to evaluate a command. Synonyms are
always linked to a master keyword and always take the IKN of their master.

Each line in the Keyword Editor contains the following fields:

Field Explanation
I Output field. An information field which can contain the following values:
E Indicates that a definition error has been detected.
X Line is marked with X.
Y Line is marked with Y.
Z Line is marked with both X and Y.
S Scan value found in this line.
Line Output field. The line number of the editor.
E Specifies the entry type for a keyword; that is, the position the keyword is to be entered in a

command: first, second or third position, synonym or parameter indicator.

For instance, in the Keyword Editor screen example above the keyword DELETE is of entry
type 1 and DOCUMENT of type 2. Using these keywords, the command DELETE DOCUMENT
can be defined.

The field takes any of the following characters as input:
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Field

Explanation

The keyword defined in this line is to be used as the first titem in a command sequence.
The keyword defined in this line is to be used as the second titem in a command sequence.

The keyword defined in this line is to be used as the third titem in a command sequence.

nNn W N =

The keyword defined in this line is to be used as a synonym for the preceding keyword
with titem type 1, 2, 3 or P.

P The keyword defined in this line is to be used as a parameter indicator in a command
sequence.

* No keyword is to be defined in this line. Instead, the line is to be used solely as a comment
line.

? This symbol is an output value which indicates an invalid keyword specification.

Use

Output field. The value displayed is determined by the value entered in the preceding field E:

1-3 The first four characters of the user text specified in the processor header for the first,
second and third keyword entries respectively are displayed. See also Keyword Editor
Options - Header 2 in the section Header Records.

S SYNO, the abbreviation for synonym, is displayed.
P PARM, the abbreviation for parameter indicator, is displayed.

Keyword

Enter the keyword to be defined. Embedded blanks are not permitted. If you have specified in
the processor header that keywords can only be upper case, then keywords are always translated
to upper case, regardless of how they are entered. Otherwise, the case remains as entered.

The maximum and minimum length of keywords depends on the settings specified in the header
(default: 1 - 16 characters). Keywords must be unique unless specified otherwise in the header.
Keyword prefixes can be used as described in Keyword Editor Options - Header 2 in the section
Header Records.

IKN

Output field. The Internal Keyword Number (IKN) is an identifier assigned to each valid
keyword. IKNs are useful for testing and debugging. They are allocated only when a keyword
is successfully stowed (see also the STOW command under Editor Commands). Each keyword
is assigned a unique IKN, except synonyms, which take the IKN of their master term (see the
Keyword Editor screen example above: DISPLAY and SHOW).

ML

Input and output field indicating the minimum length of a keyword. The field is an input field
if S is specified in the Dynamic Length Adjustment field of the processor header as described
in Keyword Runtime Options - Header 1, Header Records. In this case, you must specify the number
of characters which must be entered for the keyword. For all other input, this field contains the
minimum number of characters of a keyword a user must specify to avoid ambiguity with other
keywords.

For instance, in the Keyword Editor screen example above, keyword MENU requires only input
of M while keyword DISPLAY requires input of DI to avoid ambiguity with keyword DELETE.

Comment

Enter free text for a keyword. There are no input restrictions. The user text is included in the
cataloged command processor if the field Catalog User Texts is set to Y in the header definition
as described in "Miscellaneous Options - Header 3", Header Records. It can be read at runtime
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Field

Explanation

using the TEXT option of the PROCESS COMMAND statement. The header text appearing at
the top of this column is controlled by the header definition fields "Header for User Text 1" and
"Header for User Text 2".

Editor Commands

In the Command line of the Keyword Editor, you can enter the following commands:

Command |Function

ADD Adds ten empty lines to the end of the editor.

CANCEL |Returns to Processor Maintenance Menu.

CHECK |Tests the keyword source for consistency.

EXIT Returns to Processor Maintenance Menu.

HELP Displays valid escape characters and other useful processor settings.

INFO Displays information on the keyword on which your cursor is positioned.

LET Undoes all modifications made to the current screen since the last time ENTER was pressed.

POINT Positions the line in which a line command .N is entered to the top of the current screen.

RECOVER |Returns keyword source that existed before last SAVE/STOW.

RESET Deletes the current X and Y line markers.

SAVE Keyword source is saved.

SCAN Scans for the next occurrence of the scan value.

STOW Keyword source is stowed and Internal Keyword Numbers (IKNs) are generated for valid
keywords.

Positioning Commands

Editor positioning commands are the same as the ones provided for the Natural program editor.
For more information, see the description of the program editorprogram editor in the Editors
documentation.

The last line of the editor contains an output field which informs you of where your display is
located in the editor. The following output values are displayed:
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Top |Editor is currently positioned at the top of the keyword source.

Mid |Editor is currently positioned at the center of the keyword source.

Bot |Editor is currently positioned at the bottom of the keyword source.

Emp|Editor is currently empty.

All |The entire source is contained on the current screen.

Line Commands

Line commands in the Keyword Editor are the same as in the Natural program editor with the
exception of the commands .] and .S, which cannot be used.

Each command is entered beginning in the E field; the remaining part of the command is entered
in the Keyword field, as illustrated in the screen below:

09:42:39 - SYSNCP Keyword Editor - 2000-05-04
Modify Keywords Name SAGTEST Library SYSNCP DBID 10 FNR 32
I Line E Use Keyword TKN ML Comment

1 1 Acti MENU 1004 1

2 1 Acti DISPLAY 1002 2

3 S Syno SHOW 1002 1

4 . Acti i(3)TE 1001 2

5 S Syno PURGE 1001 1

@ Caution: When you move (.M) or copy (.C) lines, ensure that individual keywords are
always moved or copied together with their synonyms.

When you delete (.D) lines, the corresponding keywords and any functions containing these key-
words will not be deleted from the database until you issue the STOW editor command. As long
as you do not issue the STOW command, these functions will still be displayed within the Function
Editor.

Function Maintenance

Functions are composed of the keywords entered in the Keyword Editor. Before it is possible to
define functions, the keywords must be successfully stowed (see the section Keyword Maintenance).

= Define Functions

= Editor Commands

= Direct Command QUICK-EDIT
= | ocal and Global Functions
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= Procedure for Validating Functions
Define Functions

Use the Define Functions function and the Function Editor to specify functions and compose valid
commands which can be accessed from a specific location.

» To invoke the Function Editor

1  In the Processor Source Maintenance menu, enter Function Code F (Define Functions).

2 Press ENTER.
The Function Editor screen is displayed.

The Function Editor displays all possible combinations of the keywords stowed in the Keyword
Editor.

The screen below, shows the Function Editor with keywords used as examples in the Keyword
Editor screen in the section Keyword Maintenance:

09:45:53 wossesns (MATURAL SYSNCP UTRHILLTY #ewsessss 2000-05-04
User SAG - Function Editor -
Edit Global Combinations Name SAGTEST Library SYSNCP DBID 10 FNR 32

Global

I Ac Action Object Addition Global Local Any Loc
DELETE
DELETE DOCUMENT Yes
DELETE FILE Yes
DISPLAY
DISPLAY DOCUMENT Yes
DISPLAY FILE Yes
FILE
FILE DOCUMENT Yes
FILE FILE Yes
INFORMATION Yes
INFORMATION DOCUMENT
INFORMATION FILE

Repos: _ . mmmmms mmmms mmmmme

Command ===

Enter=PFl===PF2===PF3===PFl===PF5===PFG===PF7 ===PF8===PFY===PFLO==PFLLl==PFLl2===

Help Cmd Exit Last List Flip + Top Loc Loct+ Canc
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You have to validate each keyword combination that you want to designate as a valid function in
your application. A keyword combination can be validated as a global function, local function or
both. A global function can be invoked from anywhere in an application, whereas a local function
can only be invoked from a specific location within an application.

Two fields in the upper left corner of this screen indicate the current validation mode (local or
global) and the location for which keyword combinations can currently be validated. In the screen
above, the text "Edit Global Combinations" indicates that global mode is active. If the local mode
were active, the text "Edit Local Combinations" would appear here. In the screen above, the text
"Global" appears below this text. This indicates that global validation can be performed for all of
the combinations listed. In local mode, in this field the name of the location appears for which
local validation can be performed (for example, "Local DISPLAY FILE").

The Function Editor contains the following columns:

Column |Explanation

I Output field. The following values are output as a result of function editing.

Runtime action edited.
Referenced locations displayed.

Validation issued.

™ < O o

Validation removed.

Ac Action to be taken. The following values can be entered:

VG Validate as global function.

VL Validate as local function.

RG Remove validation as global function.

RL Remove validation as local function.

DL Display all functions which reference the specified function as a local function.

EG Invoke the Runtime Action Editor for a global function (see Runtime Action Editor in the
section Runtime Actions).

EL Invoke the Runtime Action Editor for a local function (see Runtime Action Editor in the
section Runtime Actions).

+G  Invoke global mode, so that you can maintain any global functions.

+L  Invoke local mode for the current line, so that you can maintain local functions for this
line.

IN Information about keywords in this line.

Action |These three columns are used to display all possible combinations of currently defined keywords.

Object

The text which appears at the top of each keyword column is controlled by the fields First Entry
Addition|used as, Second Entry used as and Third Entry used as as specified in the processor header (see
Keyword Runtime Options - Header 1 in the section Header Records).
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Column |Explanation

Global |If the function has been defined as a global command, Yes appears in this field.

Local If the function has been defined as a local command, Yes appears in this field for the current
location (only displayed in local mode).

Any Loc |Any Location. If the function has been defined as a local command anywhere else within the
processor, Yes appears in this field for any other location.

Editor Commands

In the Command line of the Function Editor, you can enter the following commands:

Command Function

ANY ON Enable the column Any Loc.

ANY OFF  |Disable the column Any Loc (the column will be filled with question marks). This allows for
faster scrolling in the Function Editor. Moreover, the third repositioning field is available.
Also, processing-in-progress information windows will not be displayed.

FIELD Display keyword-specific combinations.
GLOBAL Activate global mode.

LOC Position to next location group.

LOC+ Position forward by one location.

SINGLE ON |Display only single-word functions.
SINGLE OFF |Display all possible combinations.
TOP Position to top of list.

Direct Command QUICK-EDIT

The direct command QUICK-EDIT enables you to quickly define local/global functions, as well
as the corresponding runtime actions, by entering keywords or IKNs directly. This may be helpful
for extremely large command processors. Note, however, that the location from which the com-
mand can be issued is not verified and navigation may not function correctly at runtime.

Local and Global Functions

To understand the concept of local and global functions, you have to picture each valid keyword
combination as a location in your application (for example, a location called Display File). In the
Function Editor, you specify the commands which can be issued from this location, as well as from
which locations this location can be reached using the command DISPLAY FILE.
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Local and Global Connections within a Sample Application:

—» Global Connection A / /

--# Local Connection MenL EETEHED
rf T h\.
F f h %
# r L] (Y
. o .' ..'\. . .
r _'I 5 L]
& _I'. . %
¢ %
i 13
& r r 1 ) &
. File Delste Y
7 Document File “
-"-' zz 3 i " " * \\
’ ! - -l"' \-".' b x\ h .
o ¢« N
Display - > Delste Display
Documeant Document File

In the sample application above, the Menu and Information locations are the only locations which
have been designated as global. Thus, they can be accessed directly from all of the remaining
locations in the application. All locations have been designated as local to the location Menu,
except Information. The only way to get from the location Display File to Display Document is
via Menu.

Procedure for Validating Functions

The Function Editor operates in two modes: global and local. From global mode you can validate
global functions and from local mode you can validate global and local functions. Global mode is
the default mode. You can determine whether the editor is in global or local mode by the output
field above the I field in the editor. If the editor is in global mode, then Global is displayed. If the
editor is in local mode, then the location for which local functions are to be validated is displayed.
Below is a general procedure for validating global and local functions for an application.

» To validate global and local functions

1 With the Function Editor in global mode, enter VG (validate global) in the Ac field next to
the corresponding action to validate all global functions.
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Press ENTER.

The Runtime Action Definition screen appears.

2 Press PF3 to return to the Function Editor.

Yes appears under the column heading Global beside the validated functions.

3  Enter +L in the Ac field for each global function validated in the previous step, to switch to
local mode.
Press ENTER.

4  Enter VL (validate local) in the Ac field for each function that is to serve as a location for this
global function.

Press ENTER.

The Runtime Action Definition screen appears.

5  Press PF3 to return to the Function Editor.

Yes appears under the column heading Local beside the validated functions.

6  To validate local functions for a local location: Enter +L (invoke local mode) in the Ac field for
each location validated in the previous step, to validate all local functions which are to be
used from this location.

Press ENTER.

7  Enter VL (validate local) in the Ac field for each function that is to serve as a local function
for the current location.

8  Press PF3 to return to the Function Editor.
Yes appears under the column heading Local beside the validated functions.

| Note: If in the command processor header (Processor Header Maintenance 3) the field

Invoke Action Editor is set to Y, in addition, the window Runtime Action Definition (see
Runtime Action Editor in the section Runtime Actions) is displayed for each action.

Runtime Actions

Once valid keyword combinations have been identified as either local or global functions in the
Function Editor, it is possible to link each function with one or more runtime actions. Runtime
actions consist of one or more steps which are to be carried out whenever a function is issued.

Below is information on:

= Define Runtime Actions

Tools and Utilities 449



SYSNCP Utility

= Runtime Action Editor

Define Runtime Actions

There are two different locations in SYSNCP from which you can define runtime actions: the
Function Editor (see the section Function Maintenance) and the Result Editor. The Result Editor
is explained in this section, including how to specify runtime actions for a function.

» To invoke the Result Editor

In the Processor Source Maintenance menu, enter Function Code R (Define Runtime Actions).

Press ENTER.

The Result Editor screen is displayed:

09:47:03 **xxx%x NATURAL SYSNCP UTILITY *****
2000-05-04
User SAG - Result Editor -

List defined combinations

Name SAGTEST

Library SYSNCP

DBID 10 FNR

32
I Ac Location Command Result

________ < Global > MENU KR
< Global > INFORMATION SF
DELETE FILE DISPLAY FILE SF
DELETE DOCUMENT DISPLAY DOCUMENT SF
DISPLAY FILE DELETE FILE SF
DISPLAY DOCUMENT DELETE DOCUMENT SF
DISPLAY DOCUMENT FILE DOCUMENT SF
FILE DOCUMENT DELETE DOCUMENT SF
FILE DOCUMENT DISPLAY DOCUMENT SF
MENU DELETE FILE KCS
MENU DELETE DOCUMENT KCCS
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MENU DISPLAY FILE KRCS

Command ===

Enter-PF1---PF2---PF3---PF4---PF5---PF6---PF7---PF8---PF9---PF10--PF11--PF12---

Help Cmd Exit Last List Flip + Top Loc-- Loct+ Canc

The Result Editor contains all of the local and global functions specified in the Function Editor.
Each line in the editor represents the location from which a command can be issued (Location
field), the command itself (Command field) and an abbreviated summary of the action to be carried
out when the command is issued (Result field).

The fields of the screen are explained in detail in the table below:

Field

Explanation

I

Output field. Information on the last action carried out on this line.

Ac

Action to be taken. The following values can be entered:

DI Display the runtime action definitions for this function.
ED Edit the runtime action definitions for this function.

PU Purge this function.

Location

Output field.

The location within the application from which the command (see Command field below) can
be issued. If the function is global, then < Global > appears in this field (the command can be
issued from any location).

Command

Output field. The command.

The contents of the Location and Command fields may be truncated if very long keywords are
used.

Result

Output field.

Contains an abbreviated summary of the action to be performed when the command is issued.
The first character represents the Keep Location information (see the following section); for all
other characters, see the Runtime Action Definition table below.
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Runtime Action Editor
The Runtime Action Editor is used to define the actions to be taken when a command is issued
from a specific location. The editor can only be invoked for functions which have been defined as

global or local functions. The editor can be invoked either from the Function Editor or the Result
Editor.

» To invoke the Runtime Action Editor from the Function Editor

1  Inthe Acfield, enter EG (edit global) for global functions.
Or:

In the Ac field, enter EL (edit local) for local functions.

2 Press ENTER.

» To invoke the Runtime Action Editor from the Result Editor

1  Inthe Ac field, enter ED.

2 Press ENTER.

The Runtime Action Definition window is displayed:

Runtime Action Definition

Location .... DISPLAY DOCUMENT

Command ..... DELETE DOCUMENT

Keep Location .... S

Data allowed ..... Y More than one .... N Max. Length ...... 99
Numeric .......... N TOP of STACK ..... Y Error: Drop ...... Y

A  Runtime Action Definition
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Actions are always associated with an origin and a destination. The origin is the location from
which the command is issued, and the destination is the command itself. Thus, it is possible to
link different actions to a command based on the context in which it is used.

In the Runtime Action Editor, you also specify whether the location is to remain the same after
the actions have been carried out, or whether the command itself is to become the new current
location.

Actions are specified by entering a single-letter code in the left column of the editor. Enter any
parameters accompanying an action in the field next to the code. If the characters "/*" are entered
in this field, all subsequent input is considered a comment. If you omit a required parameter, you
will be prompted for input.

The sequence in which actions are performed at runtime is determined by the order of entry in
the editor (from top to bottom). Thus, if a FETCH is specified, all of the actions specified below it
are not to be performed.

The Runtime Action Editor contains the following fields:

Field Explanation

Location Output field. The location from which the command is issued. If the function is defined
as global, the field shows < Global >.

Command Output field. Command for which actions are to be specified.

Keep Location |Specifies whether the current or a new location is to be active once the actions have been
performed. A value in this field only affects commands with a specified EXEC option.
Possible values are:

K Keep current location. The actions to be performed affect the current location only.

S Setnew location (global/local). Once the actions are performed, the command processor
makes the command the new current location. Every command entered subsequently
has to be either a local command of this new location or a global command.

Anmerkung: The defined actions themselves have no influence on the location; that is, any

action performed does not cause the current location to be changed.

Other Options |All other options are related to the handling of parameters provided with this command
sequence. For further information, see Command Data Handling - Header 4 in the section
Header Records.

To activate the header defaults of these options, enter an asterisk (¥).

» To define runtime actions

1 Invoke the Runtime Action Definition window as described earlier.
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In the field A, enter an action code and the corresponding action in the field opposite to it:

Code |Runtime Action Definition

\Y Default value. No runtime action is specified.

T Text which can be read at runtime using the TEXT or GET option of the PROCESS COMMAND
statement.

M  |Modify command line. The data are placed in the command line.

C Command. This command is placed at the top of the Natural stack. If an asterisk (¥) is specified
here, the name of the program which issued this PROCESS COMMAND statement is put on
top of the stack (STACK TOP COMMAND "*PROGRAM). (*)

D Data. These data are placed on top of the Natural stack. (¥)

F Natural program name. The program is invoked with a FETCH statement. (*)

S Natural STOP statement. The statement is executed at runtime. (*)

E The value specified in this line is to be moved immediately into the system variable *ERROR-NR.

R A return code is entered in the DDM field RETURN-CODE as described in PROCESS
COMMAND in the Statements documentation.

1 to 9|A text string. This value is entered into the multiple DDM field RESULT-FIELD as described

in PROCESS COMMAND in the Statements documentation.

Comment line.

* These actions are only performed with the EXEC option of the PROCESS COMMAND
statement.

Press Pr3 to leave the Runtime Action Definition window.

Note: The user exit NCP-REAM allows you to use some or all of the above codes. The user

exit NCP-REEM allows you to modify the line that follows the heading of the Runtime
Action Definition table. The user exit NCP-REDM allows you to define default values for
runtime action definitions (if you use this user exit, see also Invoke Action Editor in the
section Header Records). All user exits mentioned above are delivered in the Natural system
library SYSNCP.

Processor Cataloging

Once you have specified runtime actions for all of the functions you want to use in your command
processor, you should catalog the command processor. Cataloging a command processor generates
a Natural object of type Processor.

» To catalog a command processor

1

In the Processor Maintenance menu, enter Function Code C (Catalog Processor),
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the name of the command processor to be cataloged,
and the name of the Natural library in which the command processor is to be cataloged.

2 Press ENTER.

Note: If you have Natural Security installed, you have to allow the use of your command

processor as described in the Natural Security documentation in the section Functional
Security.

Note for Windows, UNIX and OpenVMS:
Unlike on mainframes, SYSNCP does not create a report when cataloging a command processor.

Administrator Services

SYSNCP provides facilities for the administration of command processors. Only system adminis-
trators, as defined in Natural Security, are authorized to access these services.

» To access the administrative services

1  Inthe Processor Source Maintenance menu, enter Function Code A (Administrator Services).

2 Press ENTER.

The Administrator Services screen is displayed:

09:49:11 Fxkxk NATURAL SYSNCP UTILITY *x**x%* 2000-05-04
User SAG - Administrator Services -

Code Function

Select Processor

Copy Processor Source

Delete Processor Source

Print Source/0Object/NCP-Buffer
Unload Processor to Work File 3
Load Processor from Work File 3
Freeze Processor Source
References from Natural Security
Help

Exit

D X T C U O O wm

Code .. _ Name .. SAGTEST_ Library .. SYSNCP__
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Command ===

Ent@r=PFl===PF2===PF3===PFl===PF5===PFG===[PF7===PFE===PF9===PFLO==PFll==[PF12===
Help Cmd Exit Last List Flip Canc

] Note: If you do not have Natural Security installed, be aware that all other users have

administrator status.
Below is information on:

= Select Processor

= Copy Processor Source

= Delete Processor Source

= Print Source/Object/NCP Buffer
= Unload Processor

= | oad Processor

» Freeze Processor Source

= References from Natural Security

Select Processor
See the section Processor Selection.
Copy Processor Source

In copying processor sources, you have the choice of copying the entire processor or only selected
sources (header, keywords, functions, runtime action definitions).

» To copy a command processor

1 In the Administrator Services menu, enter Function Code C.

2 Press ENTER.

The Copy Processor Source window is displayed to provide source and target information:

Copy Processor Source

Source Target
Name ........ SAGTEST_
Library ..... SYSNCP___ SYSNCP___
DBID ........ 10 10
FNR .. ....... 32 32
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Password ....
Cipher Key ..

Replace ..... NO_

3 Inthe Source fields, enter the name of the processor to be copied, and the library, database
ID (DBID) and file number (FNR) in which the processor is stored. The default values corre-
spond to the processor specified on the Administrator Services menu.

In the Target fields, enter the name of the processor to be copied to, and the library, database
ID (DBID) and file number (FNR) into which the processor is to be copied.

In the Cipher Key field, enter the appropriate password and/or cipher key if the source and/or
target file is protected by a password and/or cipher key.

In the Replace field, enter YES if you want to overwrite a processor in the target environment.
The default for this field is NO.

4  Press ENTER.

The following window is displayed to select sources:

Copy Processor Source

Mark Copy Source Target

_ Header .......... .. ... ... yes no

_ Keywords ............co v, yes no

_ Functions ................... yes no

Runtime Action Definitions .. no no

Source Name SAGTEST Library SYSNCP DBID 10 FNR 32
Target Name TEST2 Library SYSNCP DBID 10 FNR 32
Replace ... NO

5 Inthe appropriate Mark fields, enter any character to select the sources you want to copy.

6  Press ENTER.
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Delete Processor Source

This function is used to delete processor sources.

» To delete a command processor

1 In the Administrator Services menu, enter Function Code D.

2 Press ENTER.

The Delete Processor Source window is displayed.

3 Specify the name of the processor to be deleted, and the library, database ID and file number
in which the processor is stored. If the file is protected by a password and/or cipher key, you
also have to enter the appropriate password and/or cipher key.

4  Press ENTER.

The following window is displayed to select the sources to be deleted:

Delete Processor Source

Mark Delete Available

_ Header .......... .. .. 0. ov ... yes

_ Keywords ............c0.u.u... yes

_ Functions ................... yes

_ Runtime Action Definitions .. yes

Name SAGTEST Library SYSNCP DBID 10 FNR 32

To the right of each processor source (header, keywords, functions, runtime action definitions)
is a field which indicates whether the source exists. As command processor creation is a
cumulative activity, you cannot delete a source without deleting all sources which are based
on it. Thus, for example, in the screen above, you cannot delete the source of the functions
without also deleting the source of the runtime action definitions.

5 Intheappropriate Mark fields, enter any character to select each source indicated as Available.

6  Press ENTER.

458 Tools and Utilities



SYSNCP Utility

Print Source/Object/NCP Buffer

In addition to processor sources, you can also print the processor object and the NCP.

» To print a command processor item

1 In the Administrator Services menu, enter Function Code P.

2  Press ENTER.

The Print Source/Object/NCP-Buffer window is displayed.

3 Specify the name of the processor to be printed, and the library, database ID and file number
in which the processor is stored. If the file is protected by a password and/or cipher key, you
also have to enter the appropriate password and/or cipher key.

4  Press ENTER.

5  The following window is displayed to select items for printing:

Print Source/0Object/NCP-Buffer

Mark Print Available
_ Header .......... .. ..o v.... yes
_ Keywords ...........c.ou.uin... yes
_ Functions ................... yes
_ Runtime Action Definitions .. yes
_ Processor Object ............ yes
NCP-Buffer .................. no
Printer ..... ... . ...,
Name SAGTEST Library SYSNCP DBID 10 FNR 32

To the right of each processor source (header, keywords, functions, runtime action definitions)
is a field which indicates whether the item exists.

Possible input values for the Printer field are the logical printer ID, VIDEO or SOURCE; see
also DEFINE PRINTER in the Statements documentation.

6  Inthe appropriate Mark fields, enter any character to select the items you want to have
printed and enter the logical printer name or the value VIDEO or SOURCE in the Printer field.

7  Press ENTER.
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Unload Processor

» To unload a command processor

1 In the Administrator Services menu, enter Function Code U.

2 Press ENTER. The Unload Processor to Work File 3 window is displayed:

Unload Processor to Work File 3

Source Target
Name ........ SAGTEST_
Library ..... SYSNCP___ SYSNCP___
DBID ........ 10
FNR ......... 32
Password ....
Cipher Key ..
Report ...... NO

3 Inthe Source fields, enter the name of the processor to be unloaded, the library, database ID,
and file number in which the processor can be found; the default value is the processor specified
in the Administrator Services menu. Enter the appropriate password and/or cipher key if
the file is protected by a password and/or cipher key.

4  In the Report field, enter YES if you want a report to be produced. Default is NO. You do not
have to use a file extension. If you wish to use an extension, you must use the file extension

" "

.sag".

5  Press ENTER.

When the processor is unloaded, all processor sources (header, keywords, functions, runtime
action definitions) are written to Work File 3.

Note: Use the Object Handler to transfer command processors from one hardware platform
to another.
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Load Processor

» To load a command processor

1
2

3

4
5

In the Administrator Services menu, enter Function Code L.

Press ENTER.

The Load Processor from Work File 3 window is displayed for loading processors from Work
File 3 to a Natural library:

Load Processor from Work File 3

Replace existing processors .. N
Produce Toad report .......... NO_

In the Replace existing processors field, enter Y or N (defaultis N) to specify whether existing
processors with the same name are to be replaced by the processor to be loaded.

In the Produce load report field, enter YES (default is NO) if you want a report to be produced.

Press ENTER.

Note: Input for the processor name and the library into which the processor is to be loaded

is taken from the work file.

Freeze Processor Source

You can freeze a processor in its current state to prevent users from modifying it further.

» To freeze a command processor

1
2

In the Administrator Services menu, enter Function Code F.
Press ENTER. The Freeze Processor Source window is displayed.

Specify the name of the processor to be frozen, and the library, database ID and file number
in which the processor is stored. If the file is protected by a password and/or cipher key, you
also have to enter the appropriate password and/or cipher key.

Press ENTER.

In the following window, specify with Y or N whether modification of the processor sources
is to be allowed or not. Default is Y.

Press ENTER.
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References from Natural Security

This function is only available if Natural Security is active in your environment. It is used to
delete functional security references from Natural Security.

If functional security is defined for a processor in Natural Security, references are created automa-
tically. These references are stored in the FNAT/FUSER system files along with the processor
sources, not in FSEC.

» To invoke References from Natural Security function

1 In the Administrator Services menu, enter Function Code R.

2 Press ENTER.

The Delete References window appears.

3 Specify the name of the processor, and the library, database ID and file number in which the
processor is stored. If the file is protected by a password and/or cipher key, you also have to
enter the appropriate password and/or cipher key.

4 Press ENTER.
5 Inthe following window, you can delete main references, function references and auxiliary

references.

For further information on functional security for command processors, refer to the section Furnc-
tional Security in the Natural Security documentation.

Session Profile

A session profile is a collection of user-definable defaults which determine how the SYSNCP
screens appear or how SYSNCP reacts to input. In a session profile, for example, you can determine
which command processor you want as default for a session or which colors you want assigned
to screen attributes. In SYSNCP, there is a standard session profile called STANDARD which is
issued to all new users. You can create several different session profiles and activate them as
required.

Administrators for SYSNCP can access and modify any session profile in SYSNCP. Other users
can access all session profiles, but can modify only those session profiles which are created under
their user ID or which have the same name as their user ID.

» To define or modify a session profile

m  Issue the PROFILE command from the Command line of the Processor Source Maintenance
menu.
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The first of three session profile maintenance screens is displayed.
Below is information on:

= Session Profile Name

= Session Parameters - Profile 1

= Color Attributes - Profile 2

= Miscellaneous Attributes - Profile 3

Session Profile Name

The standard profile STANDARD or the value of the system variable *USER is taken as default
for the profile name.

If you are defining a new session profile, the parameters/attributes are defaults. You can modify
these defaults as required and save them by entering the new name and pressing PF5.

The field Session Profile Name on each profile screen is both an input and output field. Thus, it is
possible to define, read or save another profile from any of these screens by entering its name in
the Profile Name field and pressing PF5 or PF4, respectively.

Session Parameters - Profile 1

On the first profile maintenance screen, you can modify the following fields:

Field Explanation

Apply Terminal Control 1 | These fields can be used to enter the parameters of a SET CONTROL
statement to be issued by SYSNCP at startup.

Apply Terminal Control 2

For example, when you enter Z in any of the fields, SYSNCP issues the
statement SET CONTROL 'Z°'.

Default Processor Name The default command processor name to be used for this session.

Default Processor Library ~ |The Natural library to be used to store a command processor.

Cancel Reaction Specifies whether a warning is to be issued whenever the requested
modification is not completed and the CANCEL command is issued.

W Issue warning,.

B Back out and cancel without issuing warning.

Clear Key Allowed Specifies whether clear key is allowed.

N Clear key disallowed.
Y Clear key active and has same effect as CANCEL.

Default Cursor Position Specifies placement of the cursor.
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Field Explanation

1 Cursor to be positioned in first field of the screen.

C Cursor to be positioned in command line.

Exec/Display Last Command |Specifies action to be taken as a result of the LAST command:

E Execute last command issued in command line.

D Display last command issued in command line.

Color Attributes - Profile 2

On the second profile maintenance screen, you can assign colors to various screen attributes, or
overwrite existing color assignments.

By specifying the following color codes, you can assign the following colors:

Code [Color

BL |Blue

GR |[Green

NE |Neutral
PI |Pink

RE |Red

TU |Turquoise
YE |Yellow

For color assignments to screen attributes, see also the terminal command %= in the Terminal
Commands documentation.

Miscellaneous Attributes - Profile 3

The following attributes can be specified on the third profile maintenance screen:

Field Explanation

Message Line Position |The line on which messages are to be displayed. The value 21 is recommended.
See also the terminal command %M in the Terminal Commands documentation for
more information.

Text for PF5 Key The PF5 function key is reserved for global (session-wide) use. The text to be
displayed on the PF-key line for PF5 can be entered in this field.

Command for PF5 Key |The PF5 function key is reserved for global (session-wide) use. The command to
be executed when PF5 is pressed can be entered in this field.
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In addition, the screen displays when and by which user this profile was last modified.
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75  svsrec Utility

The utility SYSRPC is used to maintain remote procedure calls.

@ Basic SYSRPC Functions

@ Service Directory Maintenance
& Stub Generation

@ Calculating Size Requirements

[ Server Command Execution

Related Topics:

For information on how to apply the SYSRPC utility functions to establish a framework for
communication between server and client systems, refer to the Natural Remote Procedure Call
(RPC) documentation.

For explanations of expressions relevant to the SYSRPC utility, see also the section Natural RPC
Terminology in the Natural Remote Procedure Call (RPC) documentation.

The use of SYSRPC can be controlled by Natural Security: see Protecting Utilities in the Natural
Security documentation.

For information on Application Programming Interfaces provided to maintain remote procedure
calls, see Application Programming Interfaces for Use with Natural RPC in the Natural Remote Proce-
dure Call (RPC) documentation.
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This section provides instructions for starting and terminating the SYSRPC utility and describes
the main features and functions provided by the utility.

Invoking SYSRPC

» To invoke the SYSRPC utility

1
2

From the library workspace in the Natural Studio tree view, select a library.

From the Tools menu, choose Configuration Tools and Remote Procedure Call.
Or:

In the Command line, enter the following command:

SYSRPC

The SYSRPC - Remote Procedure Call window appears and displays the service directory
tree view for the library specified. This is indicated in the name of the directory root node:
Service Directory [71ibrary-name].

When you invoke SYSRPC for the first time for a library, as shown in the example below, the
tree view contains example (dummy) data. The name of the service directory root node is
Example Service Directory which will change to Service Directory [77brary-name] when
you use the Save or Save As function (see Menu Bar below), regardless of any tree view
modifications. For a list of possible root names, see Root Node Names in the section Service
Directory Maintenance.
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S?SRPE - Remote Procedure Call
Object  Edit Tools Help

=] E3

HoHH G | gl oo

e Service Directory

= - SYSRPC
I::I ....... E TESTS
.......... E TESTS2
.......... E TESTS
.......... E TESTS4
.......... E TESTSR
.......... E TESTSE
- @ TESTS?

Press Chl+F12 to expand the whole tree.

S

The menus and toolbar buttons in the SYSRPC - Remote Procedure Call window provide all
functions required to maintain a service directory, generate stub subprograms (interface objects)

and execute server commands.

Terminating SYSRPC

» To terminate the SYSRPC utility

= Inthe SYSRPC - Remote Procedure Call window, from the Object menu, choose Exit.

Or:
Choose ALT+F4.
Or:

Choose the standard Windows close function.
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If a window appears with a message saying that subprogram NATCLTGS is missing (needed at
runtime), choose Yes to confirm the generation of NATCLTGS, or choose No to cancel the opera-
tion.

Service Directory Tree

The tree view in the SYSRPC - Remote Procedure Call window displays all items (tree nodes)
required for service directory maintenance. For explanations of the tree nodes, see Tree Nodes in
Service Directory Maintenance. For explanations of the tree node hierarchy, see Service Directory
Concept in Service Directory Maintenance.

Do not confuse a tree node of the service directory with the node to which an RPC connection is
established (see Natural RPC Terminology in the Natural Remote Procedure Call documentation).

You can manipulate the tree nodes by using the functions provided with the menu bar, the toolbar
and the context menu described below.

You can expand or collapse tree nodes by choosing the toggle = (expand) or the toggle = (collapse)
in front of a tree node. Alternatively, you can choose the ARROW keys. Double-click on an expan-
dable tree node to display all subordinate items.

» To expand all nodes of a tree

s Inthe SYSRPC - Remote Procedure Call window, select the root node and choose Expand
Tree from the context menu.

Or:

Choose CTRL+F12.
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Menu Bar

The menus, menu items and equivalent shortcut keys (if available) provided to execute SYSRPC
functions are described in the following section.

Menu [Menu Item and Shortcut|Explanation

Object|Open Opens a service directory:
From the Type drop-down list box, select the type of service directory (default
is SERVDIRX or NATCLTGS) and, if required, in the Library text box, replace
the name of the library (default is the current library).
The non-modifiable text box underneath Library displays the database ID

(DBID), the file number (FNR) and the type of Natural file (FNAT = system,

FUSER = user) for the library specified.

Save Saves the service directory in the current library.

CTRLA4S

Save As Saves the service directory in another library.

Properties Invokes the Properties of Service Directory dialog box. It provides
information on the generation of the service directory:

Object The name of the service directory.

Generated by = The name of the Natural utility.

Environment  If the directory was generated in a local environment, the
value Tocal is displayed. Otherwise, the name of a remote
server is displayed.

Library The name of the library in which the service directory was
generated.

User The ID of the user who generated the service directory.

Time stamp The date and the time at which the service directory was
last modified.

Tree view nodes The number of tree nodes including the service directory
root node.

Expiration time The remote directory data is loaded at runtime. The
expiration time in seconds determines the period of
validity of this data. If directory data is requested after
the expiration time set, it will automatically be reloaded.
If the expiration time is set to 0, the remote directory data
will not be reloaded.

Exit Terminates SYSRPC.
CTRL+F4
Edit |New Item

Tools and Utilities
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Menu

Menu Item and Shortcut

Explanation

Creates a new tree node item. Depending on the tree node selected, you
have the following choices:

Node
Corresponding toolbar button:

Logical Service (EntireX)
Corresponding toolbar button:

RPC Server
Corresponding toolbar button:

Library
Corresponding toolbar button:

Service (Subprogram)

5| O| | |2

Corresponding toolbar button:

See also the section Natural RPC Terminology in the Natural Remote Procedure
Call (RPC) documentation and Location Transparency in the section Service
Directory Maintenance for explanations of relevant expressions.

Rename Modifies the name of a tree node.
CTRL+F2
Delete Removes a tree node.
Cut Cuts, copies or pastes a tree node.
CTRL+X
Copy
CTRL+C
Paste
CTRL+V
Find Invokes the Find Item window to search for a name:
CTRL+F
Find what Enter an alphanumeric search string of up to 32
characters.
Case sensitive Select this check box to distinguish between uppercase
and lowercase characters.
Whole words only Select this check box to search for complete character
strings only.
Choose OK to start searching and move to the first hit, which is highlighted.
Corresponding toolbar button: #
Find Next Searches for additional instances of the search string specified in the Find
CTRL+F3 Item window and moves to the next hit if one exists.

Corresponding toolbar button: #
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Menu Menu Item and Shortcut|Explanation
Tools |Ping Sends an internal message to verify server connections described in the
CTRL+F9 section Server Command Execution.
Corresponding toolbar button: ‘ﬁ
Terminate Server  |Sends an internal message to terminate server connections as described in
the section Server Command Execution.
Terminate EntireX |Requests termination of an EntireX Broker service as described in the section
Broker Service Server Command Execution.
Corresponding toolbar button: )E
Single Stub Generates single stub subprograms (interface objects) as described in
Generation Generating Single Stubs with Parameter Specification in the section Stub
CTRL+F8 Generation.
Stub Mass Performs calculations for size requirements of RPC calls as described in the
Calculation section Calculating Size Requirements.
CTRL+F5
Stub Mass Generates single or multiple stub subprograms (interface objects) online or
Generation batch as described in Using the Stub Mass Generation Function in the section
CTRL+F6 Stub Generation.
Stub Generation Generates stub subprograms (interface objects) or parameter data areas
from IDL (PDAs) from IDL files as described in Generating Stubs or PDAs from IDL
CTRLA+F7 Files in the section Stub Generation.
Help Displays SYSRPC help text:

SYSRPC Utility - Overview

Server Command Execution (Ping, Terminate)
Expiration Time

Logon Option

Transport Protocol

Location Transparency

Service Directory Tree

Generating Single Stubs with Parameter Specification
Generating Multiple Stubs

Generating Stubs or PDAs from IDL Files
Calculating Size Requirements
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Toolbar

The toolbar buttons that provide quick access to frequently used SYSRPC functions are described
in the following section.

Toolbar Button | Function

Adds a new tree node item. See also the corresponding menu: Edit > New Item > Node.

&E M‘L

Adds a new logical service (EntireX) item. See also the corresponding menu: Edit > New
Item > Logical Service (EntireX).

Adds a new RPC server item. See also the corresponding menu: Edit > New Item > RPC
Server.

El'-li

e

B

Adds a new library item. See also the corresponding menu: Edit > New Item > Library.

]
T

Adds a new service (subprogram) item. See also the corresponding menu: Edit > New Item
> Service (Subprogram).

Finds a character string. See also the corresponding menu: Edit > Find.

Finds the next character string. See also the corresponding menu Edit > Find Next.

Pings RPC servers. See also the corresponding menu: Edit > Ping.

Terminates an EntireX Broker service. See also the corresponding menu: Edit > Terminate
EntireX Broker Service.

AR

Context Menu

The context menu provides alternative ways of executing the commands and functions provided
by the menus and the toolbar in the SYSRPC - Remote Procedure Call window.

In addition, the context menu provides the following:

® the command Expand Tree (described earlier in Service Directory Tree),
" the Logon Option (see Service Directory Maintenance) and

* the option to specify the Transport Protocol (see Service Directory Maintenance).
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The SYSRPC utility provides functions used to maintain a service directory in order to connect
the client's calling program to a subprogram on a server.

The service directory information is stored in the NATCLTGS subprogram and the XML-formatted
SERVDIRX file (Natural text object) in the library that is defined with the profile parameter RPCSDIR
(see the Parameter Reference documentation). If RPCSDIR is set, the service directory maintenance
functions reference the library specified with RPCSDIR. If RPCSDIR is not set (this is the default),
the library where you are logged on is referenced. In this case, log on to the library (or one of its
steplibs) used by the client at runtime before you perform a service directory maintenance function.

The name of the library referenced for service directory maintenance is indicated in the root node
of the service directory tree view (see Tree Nodes). If RPCSDIR is set, the root node contains Central,
which indicates that the library displayed in the window is not the library where you are
currently logged on, but the central library specified with RPCSDIR.

For further information on how to apply the service directory maintenance functions, refer to
Specifying RPC Server Addresses described in Operating a Natural RPC Environment in the Natural
Remote Procedure Call (RPC) documentation.

Attention:

If NATCLTGS is stored in the Natural system library SYSRPC, we strongly recommend that you
move NATCLTGS to the application library (or one of its steplibs) used by the client.

Service Directory Concept

The main items of a service directory are node, server, library and service (subprogram). The
hierarchical structure of these items is displayed as a tree view in the SYSRPC - Remote Procedure
Call window (see also Service Directory Tree in Basic SYSRPC Functionality). The highest level
(root node) of the tree view is Service Directory and the lowest is service (subprogram).

The node and server names specified in the service directory are either physical names or logical
names and logical services.

This section covers the following topics:

= Physical Nodes and Servers
= | ocation Transparency
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= Example of a Service Directory
Physical Nodes and Servers

Physical node and server names denote the names of real nodes (valid TCP/IP or Entire Net-Work
addresses) and servers.

In the Example of a Service Directory below, two servers are defined for one node. Both servers
are connected to the same node: ETB045. The remote CALLNAT to subprogram SUB1 is executed on
server NRPC001, whereas subprograms SUB2 and SUB3 are executed on server NRPC002.

The server names specified here must be identical to the server names specified for the server with
the profile parameter SRVNAME described in the Parameter Reference documentation. Analogously,
the node name in the service directory must be identical to the node name specified for the server
with the profile parameter SRVNODE described in the Parameter Reference documentation.

Location Transparency

Location transparency is a concept where physical node names can be replaced by logical node
names, and a combination of physical node and server names can be replaced by logical services.

Logical node names and logical services are defined with EntireX and are assigned to physical
node and server names at Natural runtime.

See also Example of a Service Directory and Using Logical Services and Logical Node Names.
Related Topics:

® Using Location Transparency in Operating a Natural RPC Environment in the Natural Remote Proce-
dure Call (RPC) documentation.

® The relevant sections in the EntireX documentation.
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Example of a Service Directory

[R|sYSRPC - Remote Procedure Call [II[E]

Object  Edit Tools Help

EEEE EIEYIEER

5-F NRPCOD!
5 SYSTEM

[ suB1

=¥ NRPCO0T-LOGICAL
=g SYSTEM
e [EE SUBT
=5, LOGBROKER=NODE
= NRPCO0Z
[ - £a SYSTEM
o [EH SUB2
& suea

4

In the example of a service directory above, theicon E indicates that NRPCO01-LOGICAL is alogical
service. LOGBROKER=NODE indicates that NODE is the logical node name.

Tree Nodes

This section describes the tree nodes contained in the service directory tree view. Each tree node
is identified by a different icon.

You can manipulate the tree nodes by using the functions provided by the menu bar, the toolbar
and the context menu described in Basic SYSRPC Functionality.

Icon Tree Node Explanation
r‘ﬂ[ r‘ﬁf Service The service directory root node indicates the name of the library from which the
=rLieEE Directory service directory was read: Service Directory [77brary-namel.
root

For example: If you invoked the SYSRPC utility from the library USERLIB, the
root reads Service Directory [USERLIB].

If the profile parameter RPCSDIR is set, the root node reads Central Service
Directory [USERLIB], which indicates that the service directory is read from a
central library specified with RPCSDIR.

For explanations of other root node names that can occur, see Root Node Names
in Error Situations.

n m Node

The name of the node to which the remote CALLNAT is sent.
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Icon

Tree Node

Explanation

Maximum name length:

Physical nodes: 32 characters

Logical nodes: 192 characters

Depending on the setting of the Logon Option, either of the following icons is
displayed:

n Logon =No

m Logon = Yes

See also Logon Option below.

d s

Server

The name of the server on which the CALLNAT is to be executed.
Maximum name length: 32 characters

Depending on the setting of the Logon Option, either of the following icons is
displayed:

E Logon =No

% Logon = Yes

See also Logon Option below.

X3 X

Logical Service

The name of a logical service.
Maximum name length: 192 characters

Depending on the setting of the Logon Option, either of the following icons is
displayed:

E Logon =No

E Logon = Yes

See also Logon Option below.

= Library SYSTEM or the name of the library to which your client application is logged on
during the execution of the remote CALLNAT.
E Service The name of the remote subprogram to be accessed from the client.
(Subprogram)

Maximum number of entries: 500 subprograms.

The section below contains information on:

Tools and Utilities
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= Root Node Names in Error Situations
= Selection Criteria for Node and Server
= Using Logical Services and Node Names

Root Node Names in Error Situations

This section lists root node names that can occur if subprograms or text objects required by the
service directory are missing, explains possible reasons and provides resolution advice.

Node Name Reason

Resolution

Service Directory
from NATCLTGS
[Tibrary-name]

The text object SERVDIRX is
missing.

This is indicated by the icon m

From the Object menu, choose Save As or Save.

SERVDIRX is generated into the library for which
SYSRPC was invoked and the name of the root node
changes to Service Directory [1ibrary-namel.

Example Service |Thesubprogram NATCLTGS and

From the Object menu, choose Save As or Save.

subprogram DEF-GS (delivered
in the Natural system library
SYSRPC) are missing.

DEF-GS contains example data.

Directory the text object SERVDIRX are
missing. NATCLTGS and SERVDIRX are generated into the
library for which SYSRPC was invoked and the name
of the root node changes to Service Directory
[Tibrary-namel.
Empty tree NATCLTGS, SERVDIRX and the |1. Create at least one new item for a node and a

server or create at least one logical service.

2. Save the modifications.

NATCLTGS and SERVDIRX are generated into the
library for which SYSRPC was invoked and the name
of the root node changes to Service Directory
[Tibrary-namel.

Selection Criteria for Node and Server

At Natural runtime, the selection of a node and a server depends on the value of the service
(subprogram) and library tree nodes. Comply with the following conditions:

Non-conversational CALLNAT

1. The library tree node must contain the name of the current application library or SYSTEM.

2. The subprogram referenced in the CALLNAT statement must be contained in the service (subpro-
gram) tree node, which belongs to the library tree node in point (1).

Conversational CALLNAT

1. The library tree node must contain the name of the current application library or SYSTEM.
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2. All subprograms specified in the OPEN CONVERSATION statement must be contained in a service
(subprogram) tree node, which belongs to the library tree node in point (1).

The node and server used for a non-conversational or conversational CALLNAT are taken from the
superior node and server tree nodes of the library tree node in point (1).

Using Logical Services and Node Names

You can define logical services and logical node names. For an example of logical services and
logical node names, see Example of a Service Directory.

» To define a logical service

= Select the Service Directory root node, open the Edit menu and choose New Item and Logical
Service (EntireX).

Or:

Select the Service Directory root node and choose New Item and Logical Service (EntireX)
from the context menu.

» To define a logical node name

m  Select the tree node for the required node, choose Rename from the context menu or press
F2, and replace the existing value by the following:

LOGBROKER=node-name
where node -name denotes the logical EntireX Broker name.
» To remove a logical node name

= Select the tree node for the required node, choose Rename from the context menu or press
2, and replace the string LOGBROKER= by an EntireX Broker name.

» To display physical names defined for logical services or nodes

m  Use the ping command as described in the section Server Command Execution.

Ping invokes a window that displays the physical node and server names defined for a logical
service or a physical node name defined for a logical node.
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Logon Option

If the Logon Option is set, for each CALLNAT request, the client initiates a Natural logon to the
server using the current library name on the client, regardless of the library specified in the service
directory. You can use the Application Programming Interface USR4008N to specify a different
library; see also Logging on to a Different Library in Using the Logon Option in the Natural Remote
Procedure Call (RPC) documentation.

After the remote CALLNAT has been executed (successfully or not), the server library is reset to its
previous state. For more information, see Using the Logon Option in the Natural Remote Procedure
Call (RPC) documentation.

The Logon Option can be set at server or node level and applies to all definitions made at a hier-
archically lower level. If the Logon Option has been set for a certain server, it applies to all asso-
ciated library and subprogram definitions.

» To set the Logon Option

1  Inthe Service Directory tree view, select the tree node of a node, a server or a logical service
and choose Logon Option from the context menu.

2 Choose Yes to set the Logon Option for the server. (The default is No.)

If the Logon Option has been set successfully for the node selected, the icon indicating a node

changes from n to m

If the Logon Option has been set successfully for a logical service, the icon indicating a logical

service changes from E to E

If the Logon Option has been set successfully for the server selected, the icon indicating a

server changes from E to %

Transport Protocol

» To specify the transport protocol

»  In the Service Directory tree view, select the tree node of a node, a server or a logical service
and choose Transport Protocol and ACI for EntireX Broker ACI protocol from the context
menu.
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A stub subprogram (interface object) is a Natural subprogram that is used to connect the client's
calling program to a subprogram on a server.

Client stub subprograms are actually not required if automatic Natural RPC (Remote Procedure
Call) execution is used with the one important exception described below. However, it can be
advantageous to generate stub subprograms as explained in Stubs and Automatic RPC Execution
in the section Operating a Natural RPC Environment in the Natural Remote Procedure Call (RPC)
documentation.

Note for EntireX RPC Servers:

A stub subprogram is required if the IDL (Interface Definition Language) definition of the subpro-
gram you want to call on an EntireX RPC server contains a group structure. In this case, you must
define the same group structure in a stub subprogram by using the appropriate SYSRPC stub
generation functions described in this section.

You can generate a stub subprogram from new parameter definitions or from existing definitions
in a subprogram.

@ Caution: The subprogram used for generating a stub subprogram can no longer be referenced

in the local environment on the client side. The stub generation function completely changes
the source of the subprogram so that it becomes unusable for local program calls.

The following sections describe the functions and commands provided to generate single or mul-
tiple stub subprograms:

® Generating Single Stubs with Parameter Specification

® Generating Multiple Stubs

® Generating Stubs or PDAs from IDL Files
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Generating Single Stubs with Parameter Specification

The Single Stub Generation function provides the option to generate single stub subprograms
(interface objects) online by using a stub generation window where you either type in the parameter
definitions required or read them in from an existing subprogram.

Using the Single Stub Generation Function

This section provides instructions for generating single stub subprograms (interface objects) by
using the Single Stub Generation function.

» To generate a single stub subprogram

1

In the SYSRPC - Remote Procedure Call window, from the Tools menu, choose Single Stub
Generation.

Or:
In the SYSRPC - Remote Procedure Call window, press CTRL+FS.

The Input for Stub Generation dialog box appears.

In the Name text box, enter the name of the stub subprogram to be generated.

The name of the stub subprogram must be identical to the name of the remote CALLNAT pro-
gram.

If required, in the Library text box, enter the name of the library into which you want to
generate the stub subprogram. The text box is preset to the name of the current library.

DBID, FNR is a non-modifiable text box that displays the database ID (DBID), the file number
(FNR) and the type of Natural file (FNAT = system, FUSER = user) for the specified library.

From the Compression drop-down list box, select compression type 0, 1 or 2 (default is 1);
see Using Compression described in Operating a Natural RPC Environment in the Natural Remote
Procedure Call (RPC) documentation.

Choose OK.

= If the name entered in the Name text box corresponds to the name of an object that already
exists in the specified library, a window appears with an appropriate message:

Choose Yes if you want to modify existing parameter definitions. If the specified name is
identical to a cataloged object of the type subprogram, the Stub Generation window appears
where the parameters definitions of the respective subprogram are contained in a table. If
the specified name is identical to a stub subprogram for which also a source object exists,
all field attributes (see also Specifying Parameters) from a previous stub generation are
retained. Otherwise, all field attributes are set to M (modifiable).
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Or:
Choose No if you want to create new parameter definitions. The Stub Generation window
appears with empty table cells.

Note that you can still keep old definitions, even after you have entered new values if you
abort execution by choosing Cancel.

= If the name entered in the Name box does not correspond to the name of an object contained
in the specified library, an empty Stub Generation window appears.

4  Inthe Stub Generation window, add or modify the parameters to be used in the stub subpro-
gram: Enter a value or select it from a drop-down list box as described in Specifying Parame-
ters.

5  Choose OK to generate the stub subprogram and to exit the Stub Generation window.

A window appears which confirms that the stub subprogram is generated into the specified
library. In addition, the window indicates the size the stub subprogram requires for sending
data from the client to the server or vice versa. The size includes internal RPC information
used for the stub subprogram. The indication of the size helps you configure the middleware
layer used; for example, the Broker attribute file when EntireX Broker is used.

The following message appears in the window when you generate a stub subprogram from
the example subprogram TESTS5 (see Example 1 below):

Stub TESTS5 is generated in Tibrary TEST
It requires:
Send length: 2249 bytes
Receive length: 2221 bytes

If dynamic parameters, X-arrays or X-group arrays are used, this message only indicates the
minimum length requirements. The actual length requirements can only be determined during
program execution and may be different from call to call.

If the Send Tength or the Receive Tength exceeds the Entire Net-Work limit of 32000 bytes,
a window appears with a corresponding warning:

Choose Y (Yes) to continue, or N (No) to cancel the generation.

If you choose Y (Yes), this setting is kept for the entire SYSRPC session, that is, you can continue
generating stub subprograms without receiving further warnings.

If the total data (without internal RPC information) sent or received exceeds the limit of
1073739357 bytes (which is 1 GB minus 2467 bytes of internal RPC information), SYSRPC
stops processing and issues a corresponding error message. This error message displays the
subtotal of the data in bytes that could be transferred at the field up to which the subtotal was
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calculated. The corresponding field is then marked. In this case, reduce the amount of data
and then continue generating the stub subprogram.

If the stub subprogram was generated in the Natural system library SYSRPC, you must move
the stub subprogram to the application library or steplib using the Natural transfer utility
SYSMALIN or the Object Handler. Note that you may have to recatalog the source of the stub
subprogram in the target environment.

Specifying Parameters

In the table cells provided in the Stub Generation window, you can enter the parameter definitions
that are used in the stub subprogram (interface object). You can specify a maximum of 5000
parameters. Unless indicated in the table below, input in the boxes is mandatory.

Field Description

Level The level of the field.

A level can be a number in the range from 01 (highest level) to 99 (lowest level). The leading
0 is optional.

See also Defining Groups and Example 2 for an example of a group definition.

Attribute The attribute of the parameter:
M (modifiable - INOUT), 0 (output - OUT) or I (input - IN).

Parameters assigned a level number of 2 or greater are considered to be a part of a group.
Parameters within a group must have the same attribute as the immediately preceding
group that is assigned one level higher. For nested groups, this is the attribute of the group
with the highest level. For an example of a group definition, see Example 2.

If a stub subprogram has been generated from a subprogram, the attribute is M by default
and may need modification.

If a stub subprogram has been generated from another stub subprogram, the attribute
values specified for the original stub subprogram are retained.

The generated stub subprogram contains a comment that indicates the attribute specified
for the parameter: IN, OUT or INOUT.

Type A Natural data format such as N (numeric) and G (group), or K (Kanji). Natural data formats
C (attribute control) and Handle are not allowed.

For a description of Natural data formats, see Format and Length of User-Defined Variables
and Special Formats in the section User-Defined Variables in the Programming Guide.

Length The length of the parameter or DYNAMIC.
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Field Description

This field does not apply to the following Natural data formats: D (date), G (group), L (logical)
and T (time).

The Natural data format A is restricted to 1073739357 bytes, Natural data format B is restricted
to 536869678 bytes.

DYNAMIC indicates a dynamic parameter and applies to the Natural data formats A and B.

Precision Only applies to Natural data formats N (numeric) and P (packed). Optional.

The precision of the parameter, that is, the number of digits after the decimal point.

Dimension |Only applies to arrays. Optional.
Yal3
The first, second and third dimension of the parameter.

An X-array or an X-group array is specified by entering an asterisk (*) for a dimension.

See also Defining X-Arrays and X-Group Arrays.

The section below contains information on:

= Defining Groups
= Defining X-Arrays and X-Group Arrays

Defining Groups

You only need to define a group structure for a client Natural object that calls a non-Natural object
located on an EntireX RPC server. The group structure must correspond to the IDL definition in
EntireX. A group structure is not required for a client Natural object that calls a subprogram
located on a Natural RPC server.

Group arrays and X-group arrays passed from a client Natural object to a stub subprogram must
be contiguous. Therefore, we strongly recommend that you always pass a complete array to the
stub subprogram by using asterisk (*) notation for all dimensions. We also strongly recommend
that you use identical data definitions in the client Natural program, the stub subprogram and
the server program.

(  Caution: Any group definitions in a subprogram will be ignored when a stub subprogram

is generated from this subprogram. In this case, you must define the group again on the
Stub Generation screen and adapt the dimension of the group elements accordingly.
(Dimensions defined within a group are propagated to the parameter definitions at a lower
level.) If you generate a stub subprogram from another stub subprogram that contains a
group, the group definitions will be retained.

See also Example 2 for an example of a group definition.
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Defining X-Arrays and X-Group Arrays

If any dimension of a parameter is extensible, all other dimensions of the parameter are also
extensible. If you define extensible and fixed dimensions for a parameter in a subprogram, the
stub generation function issues a warning and automatically changes the fixed dimension to an
extensible dimension as demonstrated in Example 3. In a group structure, you can define either
an extensible or a fixed dimension for each level. There is no automatic change of a fixed dimension
to an extensible dimension between levels.

Natural RPC only supports extensible upper bounds. All X-arrays and X-group arrays in the
generated DEFINE DATA PARAMETER area of the stub subprogram are therefore defined as (1:7*).

@ Caution: If you generate a stub subprogram from a subprogram that contains an X-array

or X-group array with an extensible lower bound, the extensible lower bound will be con-
verted to an extensible upper bound.

For an example of a group with an extensible dimension, see Example 3.

Examples of Stub Generation

This section provides examples of Natural subprograms and the stub subprograms (interface
objects) generated from them.

The parameter definitions indicated below are extracted from example subprograms, which are
supplied in the Natural system library SYSRPC.

Example 1

The following DEFINE DATA PARAMETER area (example subprogram TESTS5) shows four modifiable
parameters and the corresponding parameter definitions in the Stub Generation window:

DEFINE DATA

PARAMETER
01 #fIDENTIFIER (A10)
01 #N-OF-ID (I4)
01 #FREQ (P5.2)
01 #A100 (A100/5,4)
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Stub Generation
Level | Attribute | Type | Length | Precision | Dimension 1|Dimension 2| Dimension 3
101 M A |10
2101 |M I 4
3101 |M P 5
4101 M A |100 5 4
Example 2

The following DEFINE DATA PARAMETER area (example subprogram TESTS6) shows a nested group

structure and the corresponding parameter definitions in the Stub Generation window:

DEFINE DATA
PARAMETER

01 GROUP-1(10)
02 A (A20)
02 B (A20)

02 GROUP-2(20)
03 C (A10/5)

03 D (A10)

01 LINE (A) DYNAMIC

Stub Generation

Level | Attribute | Type |Length Precision |Dimension 1|Dimension | Dimension
2 3
1|01 M G 10
2102 |M A 20
3|02 M A 20
4102 |M G 20
503 |M A 10 5
6(03 |M A 10
7|01 M A DYNAMIC
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Example 3

The following DEFINE DATA PARAMETER area (example subprogram TESTS7) shows a nested group
structure with extensible dimensions and the corresponding parameter definitions in the Stub
Generation window.

DEFINE DATA
PARAMETER
01 GROUP-1(10)
02 A (A20)
02 B (A20)
02 GROUP-2(0:*)
03 C (A10/5)
03 D (A10)
01 LINE (A) DYNAMIC

Stub Generation
Level | Attribute| Type |Length Precision|Dimension 1|Dimension|Dimension
2 3
101 M G 10
2102 |M A |20
3102 M A 120
4|02 M G *
5|03 M A 110 5
6|03 |M A |10
7101 |M A |DYNAMIC
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You can generate single or multiple stub subprograms (interface objects) in either online or batch
mode by using the Stub Mass Generation function or the command SYSRPC SGMASS. Either method
will invoke a window that indicates the send and receive lengths required by the specified subpro-
gram(s).

Using the command or function, field attributes will be generated as described in Specifying
Parameters in the section Generating Single Stubs with Parameter Specification.

You generate stub subprograms from subprograms.

Using the Stub Mass Generation Function

This section provides instructions for generating single or multiple stub subprograms (interface
objects) by using the Stub Mass Generation function.

» To perform the Stub Mass Generation function

1 Inthe SYSRPC - Remote Procedure Call window, from the Tools menu, choose Stub Mass
Generation.

Or:

In the SYSRPC - Remote Procedure Call window, press CTRL+F6.

An SYSRPC - Input for Stub Mass Generation dialog box similar to the example below

appears:
[SYSRPC - Input or stub Mass Generation |
M arne: RPCH
Source brany:  [SAGTEST T arget library: IS,&GTEST
DEID, FMNR: 30, 30 [FUSER] DEID. FMR: 30,30 [FUSER]
Cormpression: m
ak. I Cancel | Help
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2 Inthe Name text box, enter the name of the stub subprogram to be generated or specify a
range of names. The text box is preset to asterisk (*), indicating all subprograms. For valid
entries, see Name in Name Specification and Compression.

The name(s) of the stub subprogram must be identical to the name(s) of the remote CALLNAT
program(s).

/) Important: If you do not specify a name, with few exceptions (see below), all subpro-

grams in the current library will be converted to stub subprograms.

If required, in the Source library text box, enter the name of the library that contains the
subprogram(s) from which you want to generate the stub subprogram(s). The text box is
preset to the name of the current library.

Target library is a read-only text box that contains the name of the current library into which
the stub subprograms are generated.

DBID, FNR are non-modifiable text boxes that display the database ID (DBID), the file
number (FNR) and the type of Natural file (FNAT = system, FUSER = user) for the source and
target libraries entered.

From the Compression drop-down list box, select compression type 0, 1 or 2 (default is 1);
see Using Compression described in Operating a Natural RPC Environment in the Natural Remote
Procedure Call (RPC) documentation.

3  Choose OK.

The SYSRPC - Stub Generation in Library window appears for the library specified (here:
SAGTEST) with the tabbed pages Summary and Details.

The Summary page contains a report that indicates the send and receive length requirements
of the subprograms (objects) selected as shown in the following example:
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[N|SYSRPC - Stub Generation in Library SAGTEST E3 |

Summary | Detals |

|Generation Criteria:

Object name or range: BPC*
Compression: 1

|Generation PResults:

Muwher of objects found: E
Maximum =send length: 541
Mazximum receive length: &4l

Ani error has occocurred.
For more information, select the Details tab.

ak. Cancel Help

The report is organized in two sections, which contain the following information:

* Generation Criteria:
The criteria based on which the stub subprograms were generated: a single object name or
a range of names (here: RPC*) and the compression (here: 1).

® Generation Results:
The number of objects selected for the stub generation.

The maximum buffer sizes all generated stub subprograms require for sending and receiving
data from the client.

If the stub generation fails, a message at the bottom of the page indicates this error.
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The Details page contains a list of all generated stub subprograms similar to the example
shown below:

[{R|SYSRPC - Stub Generation in Library SAGTEST x| |

Surnmary Details |
!Hame Type Send Length Receive Length Meszsage
BPCCALLL N 239 232
BPCCALLZ N Maximum =ize of walue buffer exceeded. Sum:
BPCCALLZ N 373 391
BPCCALL4 N 541 &dl
BPCCALLE N £2Z4 236

Cancel | Help

The list is sorted in alphabetical order of object names (Name column) and contains informa-
tion on the following;:

" the type of object from which the stub subprogram was generated (here: N for subprogram)
in the Type column,

* the buffer sizes each object requires for sending (Send Length) and receiving (Receive
Length) data from the client,

® and a possible comment on each stub generation in the Message column.

If the stub generation fails, an error message is displayed next to the objects affected (here:
RPCCALL2).
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Using the SYSRPC SGMASS Command

You can enter the command SYSRPC SGMASS in the Command line for generating stub subprograms
(interface objects) online.

The report produced by the command corresponds to the report described for the Stub Mass
Generation function.

The syntax that applies to SYSRPC SGMASS is illustrated in the diagram below:

SYSRPC SGMASS [name] [compression]

The syntactical items name and compression are explained in the section Name Specification and
Compression.

Name Specification and Compression

You can specify the objects (subprograms) to be selected for stub generation and the type of com-
pression to be used:

= Name
= Compression

Name

You can specify an object name or a range of names. The specification of an object name or a range
of names is optional.

@ Caution: If you do not specify an object name or a range of names, with few exceptions (see

below), all subprograms in the current library will be converted to stub subprograms.
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Valid name specifications are described below where value is any combination of one or more
alphanumeric characters:

Input Objects Selected

*

All subprograms.

This is the default setting.

value |A subprogram with a name equal to value.

value* |All subprograms with names that start with value.

value |All subprograms with names less than or equal to value.

value |All subprograms with names greater than or equal to value.

Exceptions to Names

In the Natural system library SYSRPC, SYSRPC SGMASS exempts from stub generation all subpro-
grams with names that start with any of the following prefixes: RDS, RPC, NAT, NAD or NSC.

In user libraries, SYSRPC SGMASS exempts from stub generation the subprogram NATCLTGS.

Compression

You can specify any of the following compression types: 0, 1, 2. The specification of compression
is optional. The default type used for stub generation is 1.

See also Using Compression described in Operating a Natural RPC Environment in the Natural Remote
Procedure Call (RPC) documentation.
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Generating Stubs or PDAs from IDL Files

An IDL (Interface Definition Language) file contains definitions of the interface between client
and server.

The Stub Generation from IDL function provides the option to generate stub subprograms
(interface objects) and/or parameter data areas (PDAs) from EntireX IDL files.

You can generate stubs from IDL files by using either the Stub Generation from IDL function or
the command SYSRPC SGIDL.

The following section provides instructions for using the Stub Generation from IDL function.

» To generate stubs or PDAs from an IDL file

1

In the SYSRPC - Remote Procedure Call window, from the Tools menu, choose Stub Gene-
ration from IDL.

Or:

In the SYSRPC - Remote Procedure Call window, press CTRL+F7.
Or:

In the Command line, enter SYSRPC SGIDL.

The Input for Stub Generation from IDL File dialog box appears.
In the Path or file name text box, enter the complete path to the folder or the file that contains

the IDL definitions or choose Browse to select a file from a folder.

If required, in the Library text box, enter the name of the library into which you want to
generate the stub subprogram. The text box is preset to the name of the current library.

DBID, FNR is a non-modifiable text box that displays the database ID (DBID), the file number
(FNR) and the type of Natural file (FNAT = system, FUSER = user) for the specified library.

Choose OK.

The Generate Stubs from IDL window similar to the example below appears for the specified
library:
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[H|SYSRPC - Generate Stubs from IDL in Library SAGTEST [Hi[=] [E3

=] D:\Program FilezhSaftware AGNE ntirex\E amplezhBroker BEPChclient's
-- Cornrnernts
= [ Library ExAMPLE |5
= [#] Program 'CALLC' 15
. Define Data Parameter
-1 Operation (411 In
-1 Operand_1 [14] In
-1 Operand_2 [14] In
-1 Function_Fesult [14] Out
- End-Define
- ] Program 'POWER' |5
e8| Program 'HELLD' |5

‘| | |

ak. I Cancel | Help |

| Select the Library check box far all defintions. & context menu 1z avalable.

All definitions contained in the selected IDL file are displayed in a tree view where the
Library node indicates an EntireX RPC IDL library and each set of IDL definitions is contained
in a Program node. The Comments node contains commentary text such as a description of
the definitions contained in an IDL file.

4  Select the node(s) that contain the sets of IDL definitions from which you want to generate
the stub subprogram(s) or PDA(s):

* For stub subprograms:
Select the check box of a Library node to generate stub subprograms from all Program
nodes contained in that Library node.

Or:
Select the check boxes of individual Program nodes to generate stub subprograms from the
specified Program nodes only.

You can change the name of a stub subprogram by using a selection list as described in
Building a Selection List. Otherwise, the stub subprogram will be named after the corre-
sponding Program node.
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® For PDAs:
Select the Library node(s) or the required Program node(s) and choose Mark for parameter
data area from the context menu.

A list appears that displays the set(s) of IDL definitions for each node selected as shown in
the example of a selection list below. The check boxes of all IDL definitions are selected for
PDA generation. You can deselect a PDA by clearing the check box next to it in either the
tree view or the selection list as described in Building a Selection List.

You can change the name of a PDA as described in Building a Selection List. Otherwise,
the PDA will be named after the corresponding Program node where the following conver-
sion rules apply:

® For anode name of 7 characters, an A is added to the PDA name. For example, node name
PDATEST1 is converted to PDA name PDATESTA.

® For anode name of 6 characters or less, an A is added to the PDA name in the 8th position
and each empty position between node name and A is filled with a dash (-). For example,
node name TEST1 is converted to PDA name TEST1--A.

5 Choose OK.

For each item selected, a message box appears confirming successful generation of the stub
subprogram or the PDA.

Building a Selection List

You can use a selection list to change the name of a stub subprogram (interface object) or a PDA,
or deselect or select the nodes from which to generate a stub subprogram and/or a PDA.

» To build a selection list

1  Inthe Generate Stubs from IDL window, select the check box of a Library node or the check
box(es) of Program node(s) and choose Build selection list to rename or mark object types
from the context menu.
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A selection list appears that displays the selected Program nodes as shown in the example

below:
S‘rSRPE - Generate Stubs from IDL in Library SAGTEST |_ [O] x|
=l D:\Program Files\Saftware AGAE nfireX\Ezamples\Broker RPCuclients [ IDL Library [8ias) | DL Name | [ Subprogiam | | Foa
- Comments ExaMPLE CALC B cac O calc--4
& CJ Library ‘EXAMPLE 5 EXAMPLE POWER K POWER | POWER-4

(1 [ Program ‘CALC |s
&+ [¥] Program 'POWER' |5
B M} Frogram 'HELLD!' |=

ExtMPLE HELLO [~ HELLO [X HELLO-£

4| | i

0K I Cancel Help |

| Select the Libray check box for all definitions. & context menu iz available. |

The selection list displays all nodes selected in the tree view where the IDL Library (Alias)
column corresponds to the Library node and the IDL Name column corresponds to the Pro-
gram node. In the example above, the Program nodes CALC and POWER are selected for stub
generation and the Program node HELLO is selected for PDA generation.

2 Inthe Subprogram and/or PDA columns, select the check boxes of the sets of IDL definitions
from which you want to generate stub subprograms and/or PDAs.
You can deselect an item by clearing a check box.

3  If you want to change the name of a stub subprogram or a PDA, select the required table cell
and replace the current entry.

4  If you want to remove one or more table rows, select the required rows and choose Clear
Row(s) from the context menu.

5 If you want to close the selection list, choose Close Table from the context menu.
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You can calculate the buffer size (in bytes) stubless RPC calls require for sending data from the
client to the server or vice versa. The indication of the size helps you configure the middleware
layer used; for example, the Broker attribute file when EntireX Broker is used. If desired, you can
also perform size calculations for stub subprograms (interface objects), even though sizes are
already calculated when generating the stub subprograms.

Size calculations are performed with either the Stub Mass Calculation function or the direct
command SYSRPC CSMASS whereby the direct command can be used in online or batch mode.
Either method will invoke a window that indicates the send and receive lengths required by the
specified subprogram(s).

Using the Stub Mass Calculation Function

This section provides instructions for calculating size requirements by using the Stub Mass Cal-
culation function.

» To perform Stub Mass Calculation

1 Inthe SYSRPC - Remote Procedure Call window, from the Tools menu, choose Stub Mass
Calculation.

Or:

In the SYSRPC - Remote Procedure Call window, press CTRL+F5.

An SYSRPC - Input for Stub Mass Calculation dialog box similar to the example below

appears:
5‘|"5RPE - Input for Stub Mas= Calculation |
M arne: RPCH
Source lbrany: |SAGTEST T arget librany: IS,&GTEST
DEID. FMR: 30, 30 [FUSER] DEID, FMA: 30,30 [FUSER]
Compression: H
ak. I Cancel | Help
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2 Inthe Name text box, enter the name of the subprogram for which to calculate the size or
specify a range of names. The text box is preset to an asterisk (*) for all subprograms. For valid
names, see Name in Specification and Compression.

If required, in the Source Library text box, enter the name of the library that contains the
subprograms specified. The text box is preset to the name of the current library.

The Target Library text box does not apply to the mass calculation function.

DBID, FNR are read-only text boxes that display the database ID (DBID), the file number
(FNR) and the type of Natural file (FNAT = system, FUSER = user) for the source and target
libraries entered.

From the Compression drop-down list box, select compression type 0, 1 or 2 (default is 1);
see Using Compression described in Operating a Natural RPC Environment in the Natural Remote
Procedure Call (RPC) documentation.

3  Choose OK.

The SYSRPC - Calculation of Buffer Sizes for Stubless RPC in Library window appears for
the library specified (here: SAGTEST) with the tabbed pages Summary and Details.

The Summary page contains a report that indicates the send and receive length requirements
of the subprograms (objects) selected as shown in the following example:
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E?SRPE - Calculation of Buffer Sizes for Stubless RPC in Library SAGTEST

Sumrmary Detallz

ICalculation Criteria:

Object name or range: BPC*
Conpression: 1

ICalculation Results:

MNumber of objects fowund: L

Mazximuam send length: &d6
Maximuam receiwve lengch: 532

A error has occurred.
For more information, select the Details tab.

Cancel Help

The report is organized in two sections, which contain the following information:

* Calculation Criteria:
The criteria based on which the calculation was made: a single object name or a range of
names (here: RPC*) and the compression (here: 1).

* Calculation Results:
The number of objects selected for the size calculation. The maximum buffer sizes all
selected objects require for sending and receiving data from the client.

If the size calculation fails, a message at the bottom of the page indicates this error.
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The Details page contains a list of all objects selected for the calculation similar to the example
shown below:

E?SRPE - Calculation of Buffer Sizes for Stubless RPC in Library SAGTEST Ed |

Surmmary Detailz
|Hame Type Send Length Receive Length Message
BPCCALLL N =39 232
BPCCALLZ N Maximam =size of wvalue buffer exceeded. Sum:
EPCCALLZ N 368 Zd6
FPCCALL4 N &dE Loz
EPCCALLLE N ZZd 215

dl | 2

Cancel | Help

The list is sorted in alphabetical order of object names (Name column) and contains informa-
tion on the following:
= the type of object used for the calculation (here: N for type subprogram) in the Type column,

" the buffer sizes each object requires for sending (Send Length) and receiving (Receive
Length) data from the client,

® and a possible comment on each object calculation in the Message column.

If the size calculation fails, an error message is displayed next to the objects affected (here:
RPCCALL2).
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Using the SYSRPC CSMASS Command

You can enter the command SYSRPC CSMASS in the Command line for calculating size requirements
online.

The report produced by the command corresponds to the report described for the Stub Mass
Calculation function.

The syntax that applies to the command SYSRPC CSMASS is illustrated in the diagram below:

SYSRPC CSMASS [name] [compression]

The syntactical items name and compression are explained in the section Name Specification and
Compression.

Name Specification and Compression

You can specify the objects (subprograms) to be selected for size calculation and the type of com-
pression to be used:

= Name
= Compression

Name

You can specify an object name or a range of names. If you do not specify a name or a range of
names, the size of all subprograms contained in the current library will be calculated.

Valid name specifications are described below where value is any combination of one or more
alphanumeric characters:

Input Objects Selected

*

All subprograms.

This is the default setting.

value |A subprogram with a name equal to value.

value* |All subprograms with names that start with value.

value< |All subprograms with names less than or equal to value

value> |All subprograms with names greater than or equal to value.
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Compression

You can specify any of the following compression types: 0, 1, 2. The specification of compression
is optional. The default type used for stub generation is 1.

See also Using Compression described in Operating a Natural RPC Environment in the Natural Remote
Procedure Call (RPC) documentation.
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Server Command Execution

The SYSRPC utility provides the server execution commands ping and terminate. They are used
to control active servers that have been defined in the service directory. The ping command sends
an internal message to the server to verify a server connection. Terminate either sends an internal
message to the server requesting termination of a single server task, or issues a command to

EntireX Broker requesting termination of all server tasks associated with an EntireX Broker service.

The server execution commands reference the service directory in the library that is defined with
the RPCSDIR profile parameter (see the Parameter Reference documentation). If RPCSDIR is not set
(this is the default), the library where you are currently logged on is used. The name of the library
is indicated in the root node of the service directory tree view.

In addition, when a ping or a terminate command is issued, the Message Display window appears
that displays the following:

® Physical node and server names defined for a logical service, or

® Physical node names defined for logical nodes.

Message Display Window

The ping and terminate commands invoke the Message Display window. This window provides
the columns Message, Node and Server that display the message returned from the server and
the physical name of the node and the server selected (see the instructions below).

Physical names are also displayed for logical specifications: a logical node name is resolved into
the physical node name and a logical service is resolved into the physical node and server name
as defined in the service directory.

However, logical specifications will not be resolved if the following applies:

* Logical service:
The pinged or terminated logical service is not active, or the physical node(s) and server(s)
defined for the logical service have not been defined in the Location Transparency directory of
EntireX Broker. In this case, the Message Display window displays a corresponding message
from the server, the term *LOCTRAN in the Node column and the logical service name (as defined
in the service directory) in the Server column.

* Logical node:
The pinged or terminated logical node is not active, or the physical node defined for the logical
node has not been defined in the Location Transparency directory of EntireX Broker. In this
case, the Message Display window displays a corresponding message from the server and the
entry LOGBROKER= node-name (as defined in the service directory) in the Node column.
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Pinging a Server

The following section provides instructions for pinging an RPC server by using menu functions.

For an alternative method of pinging an RPC server, see the Application Programming Interface
USR2073N described in the Natural Remote Procedure Call (RPC) documentation.

» To ping a server

= Inthe Service Directory tree view, select a server or a node and choose Ping from the context
menu.

Or:
Choose CTRL+F9.
Or:

Choose the following toolbar button:

&

Selecting an EntireX Broker node will ping all servers that belong to this node.

The Message Display window appears and displays the physical names of the node(s) and
server(s) and the message returned from the server(s).

If the pinged server(s) are active, the server(s) return the message:

Server V.R.S.PL on operating system

where Server denotes the type of server;

V.R.S.PL denotes the 1-digit version V, the 1-digit release R, the 1-digit system maintenance
level S, and the 1- or 2-digit patch level PL of the server;

operating systemdenotes on which operating system the server runs.

Example message: Natural RPC Server 6.3.1.0 on WNT-x86.
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Terminating a Server

The SYSRPC utility provides two commands to terminate a server: Terminate Server and Termi-
nate EntireX Broker Service.

Terminate Server terminates a single server task by sending an internal message to the server. If
a server is associated with multiple server tasks (including replicas on mainframe platforms), you
can either terminate each server task separately by using Terminate Server, or terminate all server
tasks in one go by using the Terminate EntireX Broker Service command.

Terminate EntireX Broker Service terminates all server tasks associated with an EntireX Broker
service by calling EntireX Broker's Command and Information Services (ETBCIS; for details, see
the EntireX documentation). The term service here summarizes all server tasks that run with the
same server name on the same or on different platforms.

The following section provides instructions for terminating a single server task or an EntireX
Broker service by using menu functions.

For alternative methods of terminating servers, see Terminating a Natural RPC Server and the
Application Programming Interface USR2073N, and Terminating the EntireX Broker Service and the
Application Programming Interface USR2075N described in the Natural Remote Procedure Call
(RPC) documentation.

» To terminate a single server task

1  In the Service Directory tree view, select a server node and choose Terminate Server from
the context menu.

The Message Display window appears with the name of the node and the server, and the
message returned from the server.

If a server is terminated, the server returns the following message:

Terminating Server V.R.S.PL on operating system

where Server denotes the type of server;

V.R.S.PL denotes the 1-digit version VI, the 1-digit release R, the 1-digit system maintenance
level S, and the 1- or 2-digit patch level PL of the server;

operating systemdenotes on which operating system the server runs.

Example message: Terminating Natural RPC Server 6.3.1.0 on WNT-x86.

2 If the Logon Option is set in the service directory, logon data (user ID, password and library
name) is sent to the server with the terminate command, as is usual for the CALLNAT. The
Security Token Data window pops up and requests user ID and password if no Natural

520 Tools and Utilities



Server Command Execution

Security is installed on the client side and no logon data is set with the Application Program-
ming Interface USR1071N for the current Natural session.

If LOGONRQ=0N (see also Using Security in the Natural Remote Procedure Call (RPC) documenta-
tion) has been set on the server side, logon data must be sent from the client with the terminate
command.

If Natural Security is installed on the server, the logon data transferred must enable a logon
to the Natural system library SYSRPC.

» To terminate an EntireX Broker service

1  Inthe Service Directory tree view, select a server node and choose Terminate EntireX Broker
Service from the context menu.

Or:

Choose the following toolbar button:

&

The SYSRPC - Terminating EntireX Broker Service dialog box appears.
2 Ifrequired for the logon, enter the appropriate user ID and password for EntireX Broker.
If you want to terminate server tasks that are involved in a conversation, select the Terminate

immediately check box to request immediate termination. If this check box is not selected
(this is the default setting), all server tasks involved in a conversation remain operational.

If you do not want this dialog box to appear repeatedly during the current SYSRPC session,
choose Do not show this dialog again.
3 Choose OK to terminate the EntireX Broker service.

The Message Display window appears, which displays the name of the node and the server
and the number of server tasks terminated.
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Tamino Server Extensions

Tamino allows you to develop, implement, administrate and execute Server Extensions. Tamino
Server Extensions can be used to extend the query and mapping Tamino Server functionality by
adding user-defined logic. For a description of the functionality available with Tamino Server
Extensions, see the Tamino documentation.

In order to extend the Tamino functionality, you install Tamino Server Extension Packages in
Tamino databases. These packages contain (among other data) Tamino Server Extension Objects
based on COM or on Java. Methods of these objects can then be used to extend the query or
mapping functionality of the Tamino Server.

Server Extension Objects based on COM can be implemented in Natural. Please check the Natural
Release Notes for information about the Tamino version needed as a prerequisite.

Overview

This document focuses on the Natural-specific implementation details of Tamino Server Extensions
and the Natural tools and techniques used in this process. Essential background information that
should help you develop valid Server Extension Function code is contained in the Tamino docu-
mentation. You should read the corresponding chapters of the Tamino documentation carefully
before starting to develop Tamino Server Extensions.

® To develop Natural-based Server Extensions, you use the Natural Class Builder. A Tamino
Server Extension is developed as a NaturalX class that implements interfaces corresponding to
a predefined structure. To support the implementation of these interfaces, certain predefined
Natural modules are delivered with Natural.

® To deploy a Natural-based Tamino Server Extension in the target environment, you use the
usual Natural deployment tools.

® To register your Tamino Server Extension, you use the Natural REGISTER command.
Once you have developed, installed and registered your Natural-based Tamino Server Extension
using Natural development tools, you can assign it to a Tamino database and use it in a Tamino

schema using the usual Tamino tools. For a detailed description of the usage of these tools, see
the Tamino documentation.

* To select methods of your Natural-based Tamino Server Extension into a Server Extension
Package and to create a package file, you use the SXS Analyzer.

= To install and administrate Server Extensions in a Tamino database, use the Server Extensions
Administration as provided by the Tamino Manager.

® To assign Server Extension functions to a Tamino schema, use the Tamino Schema Editor.

" Server Extensions can be traced using the SXS Trace.
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Developing a Tamino Server Extension

The following topics are covered.

= Overview

= Set the Library SYSEXSXS as Steplib
= Create a New Library for Your Project
= Create a NaturalX Class

= Create the Object Data Area

= Edit the Object Data Area

= |ink the Connection Interface

= |mplement the Method Connect

= Add Server Extension Functions

= Save and Catalog the Class

Overview

The Natural Class Builder is used to develop a Tamino Server Extension. A Natural-based Tamino
Server Extension is a NaturalX class that implements interfaces corresponding to a predefined
structure. To support the implementation of these interfaces, certain predefined Natural modules
are delivered with Natural:

® An Interface Module (Copycode) containing the declaration of the Connection interface defined
by Tamino.

® Parameter Data Areas containing parameter definitions for the different types of Server Exten-
sion functions.

Set the Library SYSEXSXS as Steplib
When implementing a Tamino Server Extension in Natural, you can use a number of predefined
Natural modules contained in the sample library SYSEXSXS. This makes sure that your Tamino

Server Extension conforms to the interface defined by Tamino. In order to use these modules in
your Tamino Server Extension project, first define the library SYSEXSXS as steplib.

» To define the library SYSEXSXS as steplib:

Start the Natural Configuration Utility.

Select the Natural parameter file you are working with.

1
2
3 Choose Edit > Find to locate the parameter STEPLIB.
4  Enter SYSEXSXS into the list of steplibs.

5

Save the Natural parameter file.

Tools and Utilities 525



Tamino Server Extensions

6  Close the Natural Configuration Utility.
7 Restart Natural Studio.

Create a New Library for Your Project

It is recommended to put all Natural modules for one Tamino Server Extension into one Natural
library. Therefore first create a new Natural library for your project.

» To create a new library:

1  Select User Libraries in the library workspace.
2  Select New in the context menu.

3 Choose a name for the library.
Create a NaturalX Class

A Tamino Server Extension is implemented as a NaturalX Class. Therefore create a new class.

» To create a new class:

Select your library in the library workspace.

Select New Source > Class in the context menu.

1

2

3  Choose a name for the class.

4  Select Save in the context menu.
5

Choose a name for the class module.
Create the Object Data Area

An Object Data Area in a NaturalX class is used to contain variables that shall keep their value
during the lifetime of an instance of the Tamino Server Extension.

» To create an Object Data Area and link it to your class:

1  Select your class in the library workspace.
2 Select New > Object Data Area in the context menu.

3 Choose a name for the Object Data Area.
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Edit the Object Data Area

The Object Data Area of a Tamino Server Extension should at least contain an object handle to
hold a reference to the Tamino callback object during the lifetime of an instance of your Tamino
Server Extension. The Tamino callback object is passed by Tamino to the Server Extension when
it loads the Extension. You can use the methods of the callback object to call Tamino functionality
from inside your Tamino Server Extension functions.

» To add an object handle for the callback object to your Object Data Area:

Double-click on the Object Data Area in the library workspace to edit it.
In the Data Area Editor select Insert > Handle.

Choose a name for the object handle (e. g. CALLBACK).

Select "Object" as handle type.

Click the Add button.

Click the Quit button.

N O U o W N =

If you so wish, add further variables to the Object Data Area as required by your Server
Extension.

8  Close the Data Area Editor and save the Object Data Area.
Link the Connection Interface

A Tamino Server Extension must implement the Connection interface ISXSConn. This interface is
declared in the interface module ICONN-C in the library SYSEXSXS. To be able to locate the
interface module, you must have defined the library SYSEXSXS as steplib. Link this interface
module to your class.

» To link the interface module to your class:

1 Select your class in the library workspace.
2 Select Link > Interface Module in the context menu.

3 Select the interface module ICONN-C in library SYSEXSXS.
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Implement the Method Connect

The method Connect of the ISXSConn should store a handle to the callback object in the Object
Data Area. This allows the Server Extension Functions to access Tamino functionality.

» To implement the method Connect:

1  Fully expand the branch "Interfaces" of your class in the library workspace.

2 Select the subprogram node "CONNECT". This is the default name for the subprogram that
will implement the method Connect.

3  If you so wish, rename the subprogram to a name of your choice by selecting Rename in the

context menu.

4 Double-click on the subprogram node to create and edit the method subprogram.

The implementation of the Connect method must include both the Object Data Area of the class
and the Parameter Data Area of the method Connect. The body of the method must assign the
Callback object handle from the Parameter Data Area to the corresponding object handle defined
in the Object Data Area, as shown in the example below.

” ifd Object Edit ¥iew Environment Program Lbrary Tools Window Help =2
[BroEsscuc BAREEFS S| 0 aex =ls o
| AN AN EARB S RS
] =] define data N
! - parameter UsSing SxsSchn—a 3
{:2 MTS _I object using myodsa =
Elﬁ MYSHS end-define o
=g Classes * =
é___n&. MYSYSOLASS J I:allbac}c 1= sxsch-a.callback =
#- ¢ Object Data - o
#{ Interface ModlUles m
=@ Interfaces >
By [CONNECT -
=G Methods -
Y, CONNECT -
[ CONNECT g
=@ Parameter Data HH
s SHSCN-A =
H-{y Subprograms
®-{y Local Data Areas &
-y NATADC EF
-7 MATAHC =l
= Logical View | e FlatView | pm File view | q LI_I
Cornmand: | j Library: [MYSxS Emvironment: |LD|:aI ‘
| Linegs® [ coll | see15z [ovR ETRUCT 4
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You can also add further initialization code to the method Connect as required by your Server
Extension.

Add Server Extension Functions
You can now start to add your own Server Extension Functions to the class. First you will create

a new interface for your class to contain the Server Extension Functions. Then you will add the
individual functions to that interface.

» To create a new interface:

—_

Select the node "Interfaces" of your class in the library workspace.
2 Select New in the context menu.

3  Choose a name for the interface.

» To create a new Server Extension Function :

Select your interface in the library workspace.
Select New > Method in the context menu.
Choose a name for the method.

Select the method

Q1 &= LW N =

Select Link > Parameter Data Area.

Tamino distinguishes different types of Server Extension Functions. Depending on the type of
Server Extension Function to be implemented, choose the corresponding Parameter Data Area:

Function Data

Map In function: Parameter Data Area SXSMI-A
Map Out function: |Parameter Data Area SXSMO-A
On Delete function: |Parameter Data Area SXSDL-A
Event function: Parameter Data Area SXSEV-A
Query function: Parameter Data Area SXSQU-A

These Parameter Data Areas are contained in the library SYSEXSXS. To be able to locate the
Parameter Data Areas, you must have defined the library SYSEXSXS as steplib.

| Note: The Parameter Data Area SXSQU-A is just an example. Query functions can have

user-defined parameters. Thus it is not possible to define a common Parameter Data Area
for them. If you want to create a query function, please consult the Tamino documentation
and check which parameter types are allowed in query functions. Then create your own

Parameter Data Area in your project library that matches the needs of your query function.
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» To implement the Server Extension Function:

1  Select the subprogram node that represents the method implementation.

2 If you so wish, rename the subprogram to a name of your choice by selecting Rename in the

context menu.

3 Double-click on the subprogram node to create and edit the method subprogram.

The implementation of the method must include both, the Object Data Area of the class and the
Parameter Data Area assigned to the method. The body of the method contains the coding specific

to the Server Extension Function.

” ie Object Edit View Ernvironment Program  Ubrary Tools Window Help

lBrmasncsucr FHEE 8| 8[E

| e glo e T

B Y -

- 28 MYSKSCLASS
=@ Object Data
B MYODA
&y Interface Modules
=g Interfaces
%y ICONNECT
=-68) IMYSKSFUNCTIONS
=g Methods
Sk, MYSYSFUNCTION

-G Subprograms

= Logical View | o FlatView | g File View |

=

B MTS [
@ MYSHS

=g Classes [ |

-
4| | &

define data

parameter usSing sSxsStmi-a
object using myoda
end-define

*

* ... Zerver Extension code...
*

end

|

Comrmand: |

| Library: MvSxs

Environment; ILDCEll ‘

Lregs | Col4 | Size 154

[evr FTRUCT

® Close the Program Editor and save the subprogram.

To add further Server Extension functions, repeat "To create a new Server Extension Function".
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Save and Catalog the Class

Finally save the class and recatalog the whole project library.

1. Select your class in the library workspace.
2. Select Save in the context menu.
3. Select your library in the library workspace

4. Select Cat All in the context menu.

Using Callbacks

Tamino callbacks are interfaces of the Tamino Server that can be used in a Server Extension
Function. They enable access to both the various databases that can be administrated by the
Tamino Server and system information available in the running Tamino Server. To use a Callback
function from within a Natural-based Tamino Server Extension, do the following:

® Consult the Tamino documentation to find out the parameters of the callback function you wish
to use.

® In the Object Data Area of the NaturalX class that implements your Tamino Server Extension
you have defined an object handle as a reference to the callback object. Send a corresponding
method call to this object handle.

Deploying a Tamino Server Extension

Having developed the NaturalX class that implements your Tamino Server Extension, deploy it
into the target environment with the usual Natural deployment tools, for instance the Object
Handler. A Tamino Server Extension must be installed on the same machine where the Tamino
server is running.

Register the class in the target environment under an arbitrary COMSERVERID. If necessary, see
the NaturalX documentation on COMSERVERIDs and the different options of the REGISTER
command.
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Installing a Tamino Server Extension

Installing a Natural-based Tamino Server Extension is the same procedure as installing any COM-
based Tamino Server Extension:

1. Use the SXS Analyzer to create a Server Extension Package. In the SXS Analyzer, select as the
file to analyze the type library of your NaturalX class. As with any NaturalX class, the type
library is located in the directory <natdir>\<natvers>\Natural\Etc\<comserverid>\<class-
name>\<version> where <natdir>isthe Natural installation directory, <natvers> the installed
Natural version, <comserverid>the COMSERVERID under which the class was registered,
<classname> the class name and <version> the class version (currently always "v1"). Proceed
as usual with the SXS Analyzer to create a Server Extension Package.

2. Install the Server Extension Package into a Tamino database using the Server Extensions
Administration as provided in the Tamino Manager.

3. Afterwards you can use the Tamino Server Extension as usual, for instance in XQuery functions
or to map XML sub-documents in the Tamino Schema Editor.

Tamino Server Extension Example

The Natural sample library SYSEXSXS contains a simple Natural-based Tamino Server Extension
as a programming example. The sample works on the Employees schema and maps parts of the
schema, the salary data, on Server Extension Functions. These functions work as follows:

® Whenever an Employee element is inserted into the schema, the salary data of this Employee
is passed to the Map In function SXSStoreToFile. This function creates a file in the TEMP direc-
tory and stores the data into the file.

® Whenever an Employee element is read from the schema, the salary data of this Employee is
requested from the Map Out function SXSRetrieveFromFile. This function opens the correspon-
ding file in the TEMP directory and reads the data from the file.

® Whenever an Employee element is deleted from the schema, the On Delete function SXSDelete-
File is called. This function deletes the corresponding file in the TEMP directory.

The sample Employees schema and some sample data are contained in the RES subdirectory of
the sample library SYSEXSXS.

The sample can be driven comfortably using the Tamino Demo application contained in the sample
library SYSEXINS. To run the sample Tamino Server Extension, proceed as follows:

1. Install the sample Tamino Server Extension in a Tamino database as described above in
"Deploying a Tamino Server Extension" and "Installing a Tamino Server Extension".
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Start the dialog MENU in the library SYSEXINS.
Set the Tamino URL to your Tamino database.
Enter "NATSXSDemoData" as collection name.

o ok D

Execute "Define Tamino Schema" and select the schema "EmployeeSXSSchema.tsd" from the
RES subdirectory of the sample library SYSEXSXS.

6. Execute "Load Tamino Data" and select the data file "EmployeeSXSData.xml" from the RES
subdirectory of the sample library SYSEXSXS.

7. Execute the sample queries and update records. Note that part of the Employee data (the salary
data) is now handled by the Tamino Server Extension.

8. Delete the Employee data.
9. Delete the Employee schema.
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